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About This Manual

Edupoint Educational Systems, LLC. develops software with multiple release dates for the software
and related documentation. The documentation is released in multiple volumes to meet this
commitment.

This document serves as a reference for Edupoint's recommendations and Best Practices for
Synergy processes. Due to the complex nature and myriad configurations possible within the
Synergy software, it is not feasible to include every possible scenario within this guide.

Conventions Used in This Manual

« Bold indicates user interactions such as a button or field on the screen.
« [talics indicate the option to select or text to enter.
« Notes, Tips, References, and Cautions display in the margin to provide additional information.

{ N )
Notes provide additional information O T'ES suggestfadvanceipptlzns or
about the subject. w ot er ways of approaching the

subject.

\. J \. S

{ N/ N
References list another source of Cautions warn of potential problems.

information, such as another manual Take special care when reading
or website. these sections.

7 N\ 7

Before You Begin

Before installing any of the Edupoint family of software products, be sure to review the system
requirements and make sure the district's computer hardware and software meet the minimum
requirements.
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Software and Document History

Document Release Software
Version Date Release

Description

9.0 Dec 2018 2019.01

Updates:

Added Instructional Hours functionality to the District Calendar
and School Calendar

Added Updating the Attendance Calendar for an Emergency
Closure Day

Updated STU202 — Student Schedule to include Additional
Filters section

Added Prescheduled Courses option to OSM201 — Student
Schedule Analysis, MST413 — Student Schedule Analysis, and
STU415 — Student Schedule List

Added Removing FTE Segments with No Valid Day on the
Student Classes Screen to Schedule Based FTE chapter,
Schedule Verification, and STU806 — Schedule Verification
Extract

Added Lock Section When Grades Taken option to Section
Lock

Added Transferring Students with Course Requests and
Scheduled Classes

Arranged Reports in alphabetical order

Updated Student Selection tab screenshot to include the new
Grade column Mass Assigning Sections

Added Mass Assigning Course Requests by Current Course
Added Schedule Matrix
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Document Release Software
Version Date Release

Description

Updates:

« Added Deleting Meeting Days to Meeting Days and Period
Rotation

« Updated Setting College Credit to include E: Eligible as an
option for setting college credit.

« Added Selecting Pathways for Scheduling to Houses and
Teams Overview

« Updated Individually Assigning Houses and Teams to include
Pathways Houses and Pathways Teams

« Updated Mass Assigning Houses and Teams to include
Pathways Houses and Pathways Teams

« Added Assigning Pathways Houses and Pathways Teams to
Sections to Assigning Houses and Teams

« Added Mass Assigning Houses and Teams to Sections and

0L i 2041 2020 Counselors to Assigning Houses and Teams

« Added Selecting Students and Student Groups to Mass
Assigning Course Requests

« Added Graduation Requirements to Individually Assigning
Course Requests

« Updated OSM411 — Class List to include Meeting Days and
Sort Options

« Updated STU202 — Student Schedule to include condensed
schedule output and personal information options field

o Added STU408.L — Class List with Meeting Days and Sort
Options

« Added Setting Virtual Schools

« Added Adding Equivalent Courses to a Merged Course in
Managing District Courses

Updates:

« Updated STU806 — Schedule Verification Extract to include
Exlude ADA/ADM and Enter Codes filters

« Updated STU419 — Section Seating Chart to include Display
Options

11.0 Mar 2020 2021

« Added the Move to Student Course Request option to Teacher
Course Recommendation

« Added Enable View of Course Duration option to School
Scheduling Options

« Added Using the Schedule Status Screen in Scheduling Tools
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Schedule and Course Overview

Synergy SIS uses two main processes to create class schedules: Master Schedule Builder and
Mass Scheduling. Large secondary schools typically use Master Schedule Builder to schedule
students into groups. Smaller schools or elementary schools use Mass Scheduling, as these school
types frequently offer only one or two sections for a given course.

There are several differences between the Mass Scheduling and Master Schedule Builder
processes. When using Mass Scheduling, Synergy SIS places students into sections after the user
creates them. In Master Schedule Builder, the system builds the sections and also schedules
students into them.

|| See the Synergy SIS — Master Schedule Builder Guidefor more
information about the Master Schedule Builder process.
Mass Scheduling Master Schedule Builder
Analyzer
User Created Analyzer
Sections
Loader
Builder
Optimizer/Balancer {Svstem Creates Sections)

mm
.

-~
Scheduler

Administrators primarily use the Course module to set up courses within a district and school. The
Mass Scheduling module uses Option Sets to assign students to courses, and displays any schedule
requests that students or parents make. The Scheduling module allows individual scheduling as well
as district course and school information.
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Certain screens within Synergy SIS are available in multiple areas, and administrators typically
control access to Schedule and Course locations. You can have access to either Course screens or
Schedule screens depending on your role.

See the Synergy SIS — Grading and Course History Administrator Guide
|_-J for more information on the CTE Programs screen under the Course
node.

Implementation Considerations

Review all standards and rules that apply to a student’s schedule prior to starting the Mass
Scheduling process. Before scheduling, review the list of common considerations below.

Core Courses

« Grade Levels — Certain grades have required core courses, such as English, Math, and Social
Studies.

« Specific Student Groups — Students that take part in various activities, such as Marching Band
and ROTC, must attend a group-specific class at a certain time.

Course Requirements

« Prerequisites — Students must pass certain courses before they are eligible to attend others.
For example, a student must normally take Spanish 1 before they are able to register for
Spanish 2.

« Corequisites — Certain courses require another course to be taken consecutively. For
example, Biology requires a consecutive Lab course during the same semester.

Alternate Course Requests

Alternate course requests are backup course preferences used if the student cannot take their
primary requested course.

« Request Types — You can use various options to handle alternate requests. For example, a
one-to-one alternate allows a student to select an alternate core course in the same
department if the first is unavailable. Global alternates allow students to select multiple
electives and rank them by choice.

« Duplicate Courses — The Mass Scheduling process allows multiple options for duplicate
course requests, including scheduling/rejecting all requests or accepting only one.

« Term/Teacher Preference — You can allow students to select their course preferences when
making requests.

Edupoint Proprietary and Confidential
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Scheduling Options

« Teacher Aides — You can create a generic “teacher aide” course for students that sign up to
become an aide.

« Maximum Seats — Schools schedule students based on the maximum number of seats
defined for a section or the maximum seats defined for a room. Many schools choose the
section option, as this allows flexibility to adjust class sizes for teacher considerations and
room constraints.

« Prescheduling — Prescheduling students limits options when using Mass Scheduling screens,
but you can use this for specific students, such as those repeating a course for credit.

Class and Student Grouping

« Teams — Schools create teams to keep sections assigned to the same teacher or period.
« Houses — Schools create houses to organize students into the same sections.

« Wheels — Schools use course wheels to group sets of courses together so that all courses
occur during the same year.

Mass Scheduling Checklist

Before beginning the Mass Scheduling process, make sure to do the following:

1. Gather information on the course catalog, pre/corequisite courses, and a list of changes for
the new school year.

2. Update changes to room numbers or room capacity on the School Room screen under the
System module, Setup folder.

3. Update any necessary teacher information on the Staff screen.

4. Complete the New Year Rollover process.

|| See the Synergy SIS — New Year Rollover Guide for more information on
the New Year Rollover process.
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Use the checklist below to review the suggested order of tasks for Mass Scheduling. After finalizing
the schedule, complete any scheduling for new students or any schedule updates on the Walk In
Schedule screen.

Task ‘ Completed
Scheduling Options Setup
« Define the terms and periods for the new school year in the School
Setup screen.

« Update courses in the District Course screen.

« Opt-into any new courses and opt-out of unused courses though the 0
School Course screen.

« Identify any changes to staff, classes offered, and House and Team
assignments.

« Make any necessary changes to the School Scheduling Options
screen.
Enter Student Course Requests
« Setup ParentVUE/StudentVUE if allowing students to make online
course requests if needed.

« Mass assign Period Restrictions using Mass Assign House and Team

if needed.
« Mass assign course requests to students using Mass Assign Course 0
Requests if needed.
« Enter and maintain student course requests in the Schedule Request
screen.
« Have students complete online course requests in ParentVUE and
StudentVUE if needed.
Review Reports
O
« Review reports to verify data and determine scheduling.
Create Initial Master Schedule
o Copy last year's master schedule for reference. a
« Create a new Option Set, or copy an existing one.
« Create sections within the created Option Set.
Review Reports
« Review reports to verify initial section offerings with student course
requests. a

« Modify course requests and sections as needed after analyzing
reports.

o Preschedule students as needed.

Edupoint Proprietary and Confidential
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Task Completed

Create Additional Test Schedules

19

« Copy the initial Option Set to a new Option Set (Ex: 15/16 Test Copy).

« Check out a copy of the new Option Set. m
« Select scheduling rules and options for this Option Set.

o Run the schedule.

Analyze Scheduling Results

« Review the results of the scheduling in the Option Set. O
« Screen any conflicts using in the Schedule Student screen of the
Option Set.
Review Reports
« Analyze reports for review of scheduling results.
Run Final Test Schedules
« Copy the tested Option Set to a new Option Set for updating and O
rescheduling (Ex: 15/16 Working).

« Modify Schedule Requests as necessary.
Finalize Schedule
« Copy the final option set with student results to a new option set (Ex:

15/16 Final Master Schedule)

« Runthe Update Schedule process. This copies the Master Schedule a
from Mass Scheduling to Schedule.

« Hide the Mass Scheduling module.
o Print student schedules using the STU202 report.
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Lookup Table Setup

Some drop-downs and checkbox lists use values configured in lookup tables. Hover over a field to
view a tooltip icon that indicates which table controls the field.

Cpen Lookup Table
Revelation-Phone Type

| Home >  480-555-1

055-3

Cell
Fax
=
Home

Mobile
Pager

Work

Lookup Table Values Example

Product-owned lookup tables use hard-coded values that are core to the programming and cannot
be changed. You can customize other lookup tables to match district specifications and state
reporting needs.

( )
|| Consult the list of lookup tables for your state in the appropriate State
Reporting Guide to identify tables that require a specific value.

-
\

The Name of the table is listed and the Namespace lists the business
object the table belongs to at the top of the table. The Locked value
. indicates if the table is locked and product-owned.

MName: Dwelling Type Namespace: K12.Demographics Locked: No

Dwelling Type Lookup Table
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Add Values to Lookup Tables

Hover over the field and click the tooltip icon 9t open the Lookup Table

O screen in a new window for editing. This allows you to quickly edit values.

*  Refresh the original Synergy SIS screen after modifying values in lookup
tables to view changes.

1. Navigate to Synergy SIS > System > Setup > Lookup Table Definition.
2. Locate the appropriate table.

@ Early College Scholar
@ Education Level

English Prof
= Enter Code
= ;ra;e

@ Graduation Plan
@ Graduation Semester
PAD Tree

Namespace: K12 Name: Enter Code Locked: N
[ Use Code as the State Code
All values reported to state will be used from the lookup code and not evaluate to the State Code unless the State Code is non-blank for a given value

©  Lookup Values + Add

. o State Federal
ListOrder = Description = s +| Year | Year
Code Code * *
Start End
n- 0 E1 New to District - - -
nn 0 R1 Previously In School - - -
nn 0 R2 Return from Last Year

Enter Code Lookup Table

Click Add in the Lookup Values section to add a new line.
Enter a ListOrder to display the list in a specific order if needed.
Enter a Code. This value must be unique.

o 0k~ w

Enter a Description. This information displays as an option in the drop-down.

The lookup values are sorted by ListOrder first, then by Code, and
==/ then by Description.

7. Enter the Other SIS code to import data during the conversion process from another student
records system.

8. Enter the State Code, if assigned.

9. Enterthe Alt Code 3 and Alt Code SIF if used for reporting or system interoperability
purposes, if needed.

10. Enterthe Ed-Fi Code if your district is part of the Ed-Fi Alliance if needed.

See your State Reporting Guide to identify if there is a specific code
L-J required
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11. Enter a Year Start and/or Year End date to activate or deactivate the code if appropriate.

Inactive codes show in historical data but are not available for
==l selection for new records.

12. Click Save.

Assign a State Reporting Code to an Existing Lookup Table Value

{ See your State Reporting Guide for more information. ]

1. Navigate to Synergy SIS > System > Setup > Lookup Table Definition.

2. Locate the appropriate table.

3. Enter the appropriate state reporting Code, State Code, or Alt Code 3 on a populated
Lookup Value line.

MNamespace: K12 Name: Enter Code Locked: N
Use Code as the State Code
All values reported o state will be used from the lockup code and not evaluate to the State Code unless the State Code is non-blank for a given value

©  Lookup Values + Ade (-]

owersis ¢ siteCose | ACoses

New to District

E2 Re-Enter

R In School

R2 Return from Last Year

Enter Code Lookup Table

4. Click Save.

Deactivate a Lookup Table Value

This procedure describes how to deactivate a lookup table value containing codes that are no longer
valid. Deactivated values are no longer available for selection but remain in Synergy SIS for
historical reporting purposes.

Do not modify or delete lookup table values that contain outdated state

A reporting codes. These are still used for historical reporting purposes.
Instead, deactivate the value and then add a new lookup table value that
contains the updated state reporting codes.

1. Navigate to Synergy SIS > System > Setup > Lookup Table Definition.

2. Locate the appropriate table.
3. Remove the text in State Code on the lookup value line.

Copyright 2009-2020 Edupoint Educational Systems, LLC



Schedule and Course Guide

24 Chapter 2: Scheduling Setup

4. Selectthe last year the lookup table value is valid in the Status Year End field.

MNamespace: K12 Name: Enter Code Locked: N
[0 Use Code as the State Code
All values reported te state will be used from the lcokup code and not evaluate to the State Code unless the State Code is non-blank for a given value

@  Lookup Values + add

H ListOrder 4|  Code ¢ Description 4 State Code ¢ AliCode3
“- 0 1 New to District
“n i 2 Re-Enter
n o} R1 Previously In School
n + R2 Return from Last Year

Enter Code Lookup Table

5. Click Save.

Sort Lookup Values

Click the arrows in any column heading to temporarily change the sort order of the Lookup Values
section.

MNamespace: K12 Name Enter Code Locked: N
[ Use Code ss the State Code

All values reported to state will be used from the lookup code and not evaluate to the State Code unless the State Code is non-blank for a given value

@ Lookup Values + Add o

«
Q
g
&

*

Status
Lii ListOrde: D iptit 4 Other SIS State Cod Alt Code 3 | M1 M
- e o — A " PO——

“ ] E1 New to District - -
“n ] £2 Re-Enter - -
““ o R1 Previously In School - -
““ o R2 Return from Last Year - -

Enter Code Lookup Table

Change the ListOrder to permanently modify the sort order.

MNamespsace: K12 Name: Enter Code Locked: N
[0 Use Code as the State Code

All values reported to state will be used from the lookup code and not evaluate to the State Code unless the State Code is non-blank for a given value

L]
mm

New to District

@ Lookup Values o+ Ada

Re-Enter - -
Previously In School - -

Return from Last Year - -

Enter Code Lookup Table
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Lookup Table Definitions

* Indicates there are specific entries required for these lookup tables. Click the lookup table name to be redirected to
a these specific entries.

A Indicates there might be state-specific entries required for these lookup tables. Reference your state reporting guide
for these values.

Lookup Table Purpose m Tab Section Field

Designates the type of room System > Setup > School
used for the section Room

Lookup Table Purpose Screen Tab Section Field

K12.Attendanceinfo

K12

Room Type Room Room Room Type

Customizes the types of Attendance > Setup >
weeks for each district District Calendar

Lookup Table Purpose Screen Tab Section Field

K12.Courseinfo

Week Type Advanced options Special Week Setup Week Type

Denotes the type of course

Academic Type A (Ex. Honors, Non-Academic) Course > District Course Course Course Info Academic Type
Secondary course subject
types used for courses that Course
AltID Type A offer credit for additional Course > District Course Alternate Codes Alt Type
graduation requirements (Ex. Year Override
Course Subject Areas, State)
Apportionment Category ;itdeiggry used for state Course > District Course Course Other Provider Information Apportionment Category
Used for courses that offer Course
College Subject Area post-secondary creditin Course > District Course : Course Subject Areas College Area 1-5
specified subjects Year Override
Determines the test group
Course Discipline » type the course uses for Course > District Course Course Verified Credit 1-2 Course Discipline
verified credit tests
. Term duration for the entire - .
Course Duration course Course > District Course Course Course Info Course Duration
Specific course type/medium
Course Type » (Ex. Distance Learning, Course > District Course Course Other Provider Information Course Type

Virtual)
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Purpose

Screen

Section Field

K12.Courseln

Department

Funding Source

Instructional Level »

Proficiency Core »

Provider Description

Sced Course Code

Sced Course Level

Sced Subject Area

State Course Code A

Subject Area #

University Subject Area

VocEd Type

Associated school
department

Program funding the course

Instructional type used for
staff (Ex. Honors, Non-
Academic)

Indicates if students can
establish proficiency with the
course

Financial provider for course
content (Ex. Post Secondary
Institution, Comprehensive
Services Act)

Course code used for
National Course
Classification

Course level used for
National Course
Classification

Subject area used for
National Course
Classification

Code used for state reporting
for specific states, such as
Washington

Subject area the course
applies towards

Subject area(s) that apply
specifically towards university

Indicates how the course
applies towards vocational
education

Course > District Course

Course > District Course

Course > District Course

Course > District Course

Course > District Course

Course > District Course

Course > District Course

Course > District Course

Course > District Course

Course > District Course

Course > District Course

Course > District Course

Edupoint Proprietary and Confidential

Course

Course
Year Override

Course

Course

Course

Description

Description

Description

Year Override

Course
Year Override
Course
Year Override

Course

Course Info Department

Other Provider Information Funding SourceFunding

Qualifies for Alt State Funding Source

Other Information Instructional Level

Other Provider Information Proficiency Core

Other Provider Information Provider Description

National Course

Classification Course Code

National Course

Classification e e

National Course Subject Area

Classification

StateCourseCode State Course Code
Course Subject Areas Subject Areas 1-5
Course Subject Areas University Area 1-5

Other Provider Information Voc Ed Type
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Lookup Table Purpose

Section Field

K12.MassSchedulelnfo

Used to group specific
students together to keep
them in the same group for
schedule requests (Ex. ELL,
SPED)

User Balance

Lookup Table Purpose

K12.Schedulelnfo

Indicates if the course is for

Defined Class Type students with disabilities

Indicates if the section
content is provided by or
affiliated with a third party

Indicates specific strategy
with teaching content

Instructional Content

Instructional Strategy

Indicates how and where the
section is taught (Ex.
Classroom, Online)

InstructionalMethod

Indicates the staffrole in the
section (Ex. Assisting
Teacher, Lead Team
Teacher)

Staff Responsibility #

Indicates the type of team

Team Teaching teaching for a section

Code assigned to each
school term for reporting or
tracking purposes

Term Codes ?

Mass Scheduling >
Schedule Request

Screen

Schedule > Section

Schedule > Section

Schedule > Section

Schedule > Section

Schedule > Section

Schedule > Section

Mass Scheduling > Setup
> School Setup

Schedule > Section

Options

Tab

Current Students
Additional Staff

Current Students

Current Students

Current Students

Current Students

Additional Staff

Additional Staff

Basic Info

Current Students

Scheduling Options

Section

State Reporting
Additional Staff

Section Info

Section Info

Section Info

Staff Contributions
Additional Staff
Teaching Options

Term Definition detail

Section Info

Balance Code

Defined Class Type

Instructional Content

Instructional Strategy

Instructional Method

Responsibility

Team Teaching

Term Code
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Scheduling Setup

Class Periods

Each class day consists of period units; therefore, all schools must define the class periods. For
example, while an elementary school might only have one period for the entire day, a high school
would have a period for each class.

1. Make sure the current focus points to a school and not the district.

2. Navigate to Synergy SIS > Mass Scheduling > Setup > School Setup.

School Setup NG IR
Menu~- | o Save | *Undo
School Name: Hope High School School Year: 2016-2017
Basic Info Options SIS Data Options Labels TeacherVUE Mobile Apps
@ Period Definition

Start Period End Period Homeroom Period Homeroom Meeting Day
0 9 2 -

School Setup Screen

3. Enterthe Start Period and the End Period. For example, if the school has six periods, the
start period might be 7 and the end period might be 6.

4. Enterthe Homeroom Period if the students are assigned a homeroom. Otherwise, leave
this field blank.

5. Selectthe Homeroom Meeting Day if the homeroom only meets once a week.

See Meeting Days and Period Rotation for more information on
assigning meeting days.

6. Selectthe School Type.
7. Selectthe School Attendance Type.
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8. Select how the school takes attendance in Attendance Entry Method for Teachers and
Class Attendance. This field only affects how teachers take attendance. This selection does
not affect state reporting or attendance calculations.

« By Section means the teacher posts attendance once for the section. Only the first
period of the blocked section has attendance posted to it.

« By Bell Period allows the teacher to post attendance for each bell period scheduled for
the section. The teacher has to select each bell period and post attendance separately.
Each bell period for the section has the attendance posted to it as inputted by the
teacher.

« By Section— Fill All allows the teacher to post attendance once for the multi-period
section. The attendance posts to each scheduled period of the section.
9. Selectthe School Attendance Reason Type:
o Regularis for schools that record absences.

« Positive is for schools that record a present reason for each student in addition to an
absent or tardy reason. Only select this option if your school is marked as a positive
attendance school type.

10. Select Grade Attendance Calculated for a school using period attendance:

« By Section calculates attendance based on section. The section containing the
attendance events must match the student's currently enrolled section.

« By Grading Definition accumulates attendance by verifying the sections that contain
attendance events against any student's currently enrolled section. If a student
switches to a different section mid-year, when you run the Update Attendance process,
the student's report card reflects the attendance for both sections.

11. Setthe Calendar Type to Regular.

See the Synergy SIS — Attendance Administrator Guide for night
|| : :
and summer school information.

12. Click Save.

[ E You must make these changes for each school in the district. ]
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Term Definition

Terms define when classes start and end for the school year. A single term can have multiple grade
reporting periods that signify a milestone in the class, such as a midterm grade. Each school must
define terms for every school year.

1. Navigate to Synergy SIS > Mass Scheduling > Setup > School Setup.
2. Click Add in the Term Definition section.
3. Enterthe Term Number, Term Name, and Term End Date.

The Term Begin Date automatically calculates based on the
school calendar.

4. Click Show Detail to add term codes to each term.

School Setup CCOa -0

Menuw | o + Save || *Undo

School Name: Hope High School School Year: 2018-2019
Basic Info Options SIS Data Options Labels TeacherVUE Mobile Apps

® Period Definition

Start Period End Period Homeroom Period Homeroom Meeting Day Bell Sched Override
0 9 1 - -
® Type Information

® Grade Selection ® Grading Options ® Roll Over Defaults

@ Grade Level Max Enrollments + Add Iy Show Detail

R N T T S
n- 1 Fall 07/02/2018 12/31/2018 & 81, YR
n 2 Spring 01/01/2019 07/05/2019 & $2, YR
School Setup Screen
5. Click Add in the Term Codes section.
@ Term Definition + Add | W Hide Detail
O Term Number Term Name Term End Date
Number ~ IE Fall 11/24/2017 @@

10 @ Term Codes .

2 P
=] e e T = O 5

[
BB

School Setup Screen, Term Definition Detail
6. Enterthe Term Code Number, which should match the Term Number selected.
7. Selectthe Term Code.

Edupoint Proprietary and Confidential



Schedule and Course Guide
Chapter 2: Scheduling Setup

8. Enter the Start Date and End Date. These fields calculate Schedule Based FTE when terms

overlap.
( N\
Make sure that each of your terms has a different Start Date and
End Date. If any of your terms have the same start or end dates,
E Synergy SIS will generate warnings on certain attendance screens.
See Term Definition Warning. The only exception is if your school
L uses hybrid grading periods. )
9. Click Save.
s Schools can customize term codes using the Lookup Table
==t! Definition screen. See District Course Setup for more information.

Term Definition Warning

Schools with multiple terms defined with the same start and end dates in the Term Definition section
receive the warning: “Two or more terms have the same date range. To resolve this issue, go to the
Term Definition section in School Setup.” This warning displays on the following screens:

Period Attendance Daily Attendance

Class Period Attendance Class Daily Attendance

Course Attendance Student, (Enroliment tab), FTE Calc
button

Student Classes, (Schedule Based FTE = TeacherVUE Attendance (if selecting the

tab) option to use the new data loaders)

You can assign term definitions at Synergy SIS > Mass Scheduling > Setup > School Setup.

Incorrect Term Definitions

Term Term Begin Term End Current Term
Number Date Date Codes
1 Semester 1 7/5/2016 1/10/2017 S1,Q1,Q2
2 Semester 2 1/11/2017 5/25/2017 S2,Q3,Q4

You can access attendance screens with incorrect term definitions defined, but as long as the term
definitions are incorrect, the warning message displays on the screens mentioned above.

¥ Period Attendance
Menu + <€ Q » L] + Save | *Undo

Student Name: AAA, cindy School: Hope High Scheel Status: Active Homeroom:

Calendar Days of Activity Totals History Attendance Letters Concurrent Attendance Summary
Last Name First Name Middle Name  Suffix Perm ID Grade
ABMA cindy 997031 10 -

Hope High School for Year 2016
-Two or more schedule terms have the same date range. To resolve this issue, go to the Term Definition Grid in School Setup.

03/10/2017 | Go To Date Go To Current Date Previous 15 Days Next 15 Days Days To Show |15

[T Do Mot Show Special Attendance Codes (N/S, N/E, Wy

Period Attendance Screen

31
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Setting up Correct Term Definitions

Correct your term setup to ensure that date ranges are unique. In the previous example, S1, Q1,
and Q2 refer to the exact same date range as S2, Q3, and Q4. Depending on the school’s needs, the
correct setup might look like one of the following sections:

Example 1:
Term Term Term Begin Term End Current Term
Number Name Date Date Codes
1 ' Semester1 | 7/5/2016 | 1/10/2017 | S1
2 Semester2  1/11/2017 | 5/25/2017 | S2
Example 2:
Term Term Term Begin Term End Current Term
Number Name Date Date Codes
1 ' Quarter1 | 7/5/2016 | 10/5/2016 | S1,Q1
2 ' Quarter2 =~ 10/6/2016 | 1/10/2017 S1,Q2
3 | Quarter3 | 1112017 | 342017 | $2,Q3
4 | Quarter 4 | 3/5/2017 | 5/25/2017 | S2,Q4
Example 3:
Term Term Term Begin Term End Current Term
Number Name Date Date Codes
1 . Term1 | 7/52016 | 10/5/2016 | YR,S1,Q1
2 - Term2 | 10/6/2016 = 1/10/2017 = YR,S1,Q2
3 | Term 3 | 1/11/2017 | 3/4/2017 | YR, S2,Q3
4 | Term 4 | 3/5/2017 | 5/25/2017 | YR, S2, Q4
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Bell Schedule Definition

After defining the number of periods, schools must configure a start and stop time for each period on
the Bell Schedule Definition screen. Bell Schedules aid in calculating the absence amount submitted
to the state for period attendance schools.

Creating Bell Schedules

Schools can configure multiple bell schedules, but schools can have only one default schedule. You
can enter times for each period manually or fill times automatically using the Bell Creation Assistant.

1. Navigate to Synergy SIS > Schedule > Setup > Bell Schedule Definition.
2. Click Add to open the Bell Schedule Definition (Add) screen.

Bell Schedule Definition

X Close

Code* Bell Schedule Name*

Bell Schedule Definition (Add) Screen

3. Entera Code and Bell Schedule Name for the schedule. For example, the default schedule
might use a Code of DBS and a Bell Schedule Name of Default Bell Schedule.

Bell Schedule Definition

* Close

Code Bell Schedule Name
DBS Default Bell Schedule

Bell Schedule Definition (Add) Screen

4. Click Save.

The new schedule displays with a line for each period defined in the

E School Setup screen. You can enter the times for each period
manually or Synergy SIS can fill it in automatically using the Bell
Schedule Creation Assistant.
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5. Clickthe E' in the Bell Schedule Creation Assistant section to open the Bell Schedule
Creation Assistant. This option automatically fills in the schedule.

a. Enterthe Start time of first period (non-military time), Total minutes per period,
and Passing time in-between periods.

b. Click Create Bell Schedule to automatically fill in the schedule.

¥ Bell Schedule Definition ‘

Menu~ € Q¥ & ¢ Save  *Undo m Delete

Code: 1 Bell Schedule Name: Default School: Hope High Schoel School Year: 2016-2017
Bell Schedule

Q
Q

Code Bell Schedule Name
1 Default

@ Bell Schedule Creation Assistant

Note: This will generate a bell schedule for all periods based on your input. After you build the bell schedule, you can edit the schedule in the Bell
Schedule Definition group box.

§:00 AM ® start time of first period
55 Total minutes per period
5 Passing time in-between periods

Create Bell Schedule

Bell Schedule Definition Screen

6. Once the schedule displays, you can edit the numbers directly in the fields provided. You can
also delete a period from the schedule by clicking the X in the Delete column. Set the
following additional options, if needed:

o Minute Override — Overrides the bell period amount from the Total column.

» Override Reason — Allows you to add text explaining the reason for a Minute
Override.

« Non-Instructional — Removes the bell period amount from any minute calculations on
reports and state extracts that use the Bell Schedule.

@ Bell Schedule Definition

[Line Dsiete Perioa| Start Tme | Stop Tme _ Total Passing Time Minute override | Overrds Reason | Non-nstructions! |
5

“ b 4 7 1:20 PM 2:05 PM 045 o
n b4 8 210 PM 2:55 PM 045 5

10 B4 9 3200 PM 345 PM 0:45

X o 7:30 AM 8:15 AM 0:45 ]
2  FaE 8:05 AM 9:05 AM 100 0 ]

B X 2 9:00 AM 955 AM 055 5 ]
“ X 3 10:00 AM 10:45 AM 045 5 o
R X 4 10:50 AM 11:35 AM 0:45 5 ]
n X 5 11:40 AM 12:25 PM 045 5 ]
A X - 12:30 PM 1:15 PM 045 5 ]

]

]

o

Instructional Minutes for Fullday

Bell Schedule Definition Screen

7. Click Save.
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Each Period in the Bell Schedule Definition must have a start and stop

time.

schedule one for a given day.

You can define multiple bell schedules at a school but you can only

Overriding Bell Schedules

You can create bell schedules based on grade levels and/or houses. When you apply the specific

bell schedule, it overrides the regular bell schedule.

1. Navigate to Synergy SIS > Mass Scheduling > Setup > School Setup.

2. SelectaBell Sched Override.

o Enforce Bell Schedule Filtering — Periods removed from a bell schedule are not
considered as meeting and are not used in any calculations, such as minutes and

attendance.

« Grade Level (with Bell Schedule Filtering) — Uses specific bell schedule for identified

grade levels.

« House (with Bell Schedule Filtering) — Uses specific bell schedule for identified Houses.

o None (Default) — Uses regular bell schedule calculations, which includes all periods on

the bell schedule even if the class does not meet.

School Setup

Menu = ol

School Name: Hope High Schoeol School Year: 2017-2018 Summer

Basic Info Options SIS Data Options Labels

® Period Definition

TeacherVVUE

Mobile Apps

Start Period End Period Homeroom Period Homeroom Meeting Day|

® Type Information

School Attendance Type Attenda

+ | Daily Attendance -

School Type

1 4 1 v

By Sedi

Grade Attendance Calculated Concurrent Enroliment Type

Bell Sched Override

-

Enforce Bell Schedule Filtering
Grade Level (with Bell Schedule Filtering)

House (with Bell Schedule Filtering)
None (Default)

School Setup Screen

3. Click Save.

35
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Enforce Bell Schedule Filtering

In this example, the student is reported as attending 4 periods in the day and blank periods are
excluded from calculations. No changes occur in Bell Schedule Definition.

@ Bell Schedule Definition
[Line | Delete | Period | Sarifme | SwpTme | Tow | PassngTme
- 1 1 6:45 AM ©@  B44AM © 159 5
2 B9 2 e} e}
3 B9 3 849 AM 10:40 AM 151 5
n P 4 © ©
5 B9 5 10:45 AM 1:30 PM 2:45 5
K x s © ©
i X 7 1:35 PM ©® 230PM ® 055

Bell Schedule Definition Screen

Setting Grade Level Bell Schedule

Once you override the bell schedule, Synergy SIS uses the selected bell schedule to calculate
minutes/hours for all 12th grade students. Schedule Based FTE also displays the bell schedule in
the FTE Segment Detail.

1. Navigate to Synergy SIS > Schedule > Setup > Bell Schedule Definition.

« You can apply an existing bell schedule to a specific grade level, or you can create and
apply a new bell schedule to the grade level using the Grade Level Bell Schedule
section that displays below the regular bell schedule.

« The Grade Level Bell Schedule section only displays for those bell schedules that exist
in the school year calendar. If a bell schedule is not used in the calendar, the Grade
Level Bell Schedule section does not display because no overrides are possible.

* Bell Sche<dube Dofiniton -k
SR R [+ 5 |
ot I Dot ot Hame Rageter Bal Sokel Sovusl Depaiee Mgk Skl Taw DI

o et e tne

@ b Sohuhie Duinnan.

£l
P
I
=
u @
[
]
E]
E

ot Lo B Snaciis.

Bell Schedule Definition Screen
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2. Selecta bell schedule in the Override Bell Schedule column to apply a Grade Level Bell
Schedule override.

Fobe R Bk i N Bopees Pl b (i b gl B e L1 B0

[ [N ——

- I

x
'y
X
x
=
x
x
'y
X

[ ap—

Bell Schedule Definition Screen

3. Click Save.

Setting House Bell Schedule

Once you override the bell schedule, Synergy SIS uses the selected bell schedule to calculate
minutes/hours for all house students. Schedule Based FTE also displays the bell schedule in the
FTE Segment Detail.

1. Navigate to Synergy SIS > Schedule > Setup > Bell Schedule Definition.

« You can apply an existing bell schedule to a specific house level, or you can create and
apply a new bell schedule to the house level using the House Level Bell Schedule
section that displays below the regular bell schedule.

« The House Level Bell Schedule section only displays for those bell schedules that exist
in the school year calendar. If a bell schedule is not used in the calendar, the House
Level Bell Schedule section does not display because no overrides are possible.

* Ball Schisdulo Dedindticn SE-1- 30

Coe ITUL il e N el Pl b et [ g Mgl it Vo 7112000

a]

[ - - - - -
o

Bell Schedule Definition Screen
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2. Select a bell schedule in the Override Bell Schedule column to apply a House Level Bell
Schedule override.

" Ball Schedula Dafinition + 50 3|
M- 4 Q3 OB - =

ok AT i e . et Bl e i i igh T e 3000 3800

T P Babaskie Vs

[ Eagaan P bt

PEEL

kR ®oR KN KK
E
L= T = = I = = = = =
SEL A
"'zeci

D0 000000
']

Bell Schedule Definition Screen

3. Click Save.

None (Default)

In this example, the student is reported as attending 7 periods in the day and blank periods are
included in calculations.

@® Bell Schedule Definition
[ne | Dmete | peoa | somtme | SopTme | om | PassngTime
p 4 1 6:45 AM (¢] &44 AM (o] 1:59 5
2 B 2 c] c]
3 b4 3 8:49 AM ® 10:40 AM ® 1:51 5
4 B9 4 c] o
] b4 5 10:45 AM (0] 1:30 PM ® 2:45 5
| s B s ) )
7 b4 7 1:35 PM (c] 230 PM (o] 0:55

Bell Schedule Definition Screen
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Adding a District Calendar

1. Navigate to Synergy SIS > System > Setup > District Setup.

District Setup

Menu ~ ol « Save | *Undo

District Setup

Options System Grade Setup

@ Current System Year

Current Year
2018-2019 -

Base Year
2006

Organization Year Tree

2006
2007
2008
2009
2010
2011
2012
2013
2014
2015
2016
2017
2018
2019
2020
2021

LA R AR B EE AR AR LR R R

@ Staff Years

Last Staff Year Increment Date

TeacherVUE

Labels

@ Year Permissions

Auto-Sequence

Previous Year(s) Permission

Update

Increment Staff Years

c
3

Reports Waivers Mobile Apps Concurrent Options Accessibility Color Themes

® Summer School

Current Year Permission
Update -

Summer School Year
2017

Next Year(s) Permission
Update -

Summer School Type
S: Summer -

Actions...

District Setup Screen

2. Select the year for your calendar under the Organization Year Tree section.

3. Select Add Extension to <<year>> from the Actions... menu. The Add Year Extensions

screen opens.

District Setup
Menu~ | | & | | & Save | 4 Undo
District Setup
Options System Grade Setup
@ Current System Year
Current Year Base Year
2018-2019 |~ |2006
Organization Year Tree
b 2006
b 2007 District Setup
b 2008 @ Year-Type Specific Setup
b 2009
p 2010
b 2011 District Tracks
p 2012
b 2013 District Attendance Code

District Discipline Code

n District Course

p 2015

p 2017
[ 20 D\slnchmups
p 2019
b 2020 “D\sln:l'rratks
b 2021

© staff Years

Last Staff Year Increment Date

TeacherVUE

Labels

@ Year Permissions

Auto-Sequence

Previous Year(s) Permission

Update

Increment Staff Years

Setup Screens

Q
8

Reports Waivers Mobile Apps Concurrent Options Accessibility Color Themes

® summer School

Current Year Permission
Update -~

Summer School Year
2017

Next Year(s) Permission
Update -

Summer School Type
S: summer -

Add Extension to ' 2015

Delete ' 2015'

District Setup Screen
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Select the type of extension to add from the Year Extensions field (Regular, Night, or

Summer).

Select Link Year with all organizations to add this school year to all schools in the
organization tree. Otherwise, you need to link each school to this year manually.

Year Extensions  Link Year with all organizations
Regular -

you will have to manually link this year with any organizations you want associated with it.

( )
A If setting up an extension that is not in use at all schools, such as
summer or night school, do not select this option. )
To add this extension to an individual school, see the Advanced
Calendar Options in the Synergy SIS — Attendance Administrator
Guide.
. /
Add Year Extensions « 00

If checked, all current organizations will have this year associated with them. If left unchecked,

Add Year Extensions Screen

QOrganization Year Tree

b 2006
» 2007
p 2008
p 2009
» 2010
» 2011
p 2012
p 2013
b 2014
b 2015
b 2016
p 2017
p 2018
p 2019
b 2020
» 2021

District Setup

®

Year-Type Specific Setup

District Tracks

District Attendance Code
District Discipline Code
District Course

District Groups

o

District Tracks

@ staff Years

Last Staff Year Increment Date i@ Increment Staff Years

6. Click Save.
District Setup « CUEG-0
Menu~ = o
District Setup
Options System Grade Setup TeacherVUE Labels Auto-Sequence Reports Waivers Mobile Apps Concurrent Options Accessibility Color Themes
@ Current System Year @ Year Permissions @ summer school
Current Year Base Year Previous Year(s) Permission Current Year Permission Next Year(s) Permission Summer School Year Summer School Type
20182019 |~ | 2006 Update - Update ~ Update - 2017 S: Summer -

Actions...

Setup Screens

District Setup Screen

. You can create multiple extensions for each year. For example, you
—| can use the process above to create a separate calendar for a
summer school or night school program.
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Defining a District Calendar

After you create the extension for the year, you can define the district calendar. The dates defined at
the district set the boundaries for the school calendars. Create the district calendar so that the
earliest date from any school defines the initial date of the district calendar and the latest date from
any school sets the last date of the district calendar.

1. Navigate to Synergy SIS > Attendance > Setup > District Calendar.

Q
Q
al
a4
-]

District Calendar .

Menu~ | o

School Year: 2018-2019 Calendar Type: Regular
District Calendar Report Periods Advanced Options

@ District Calendar Type Options ® District Calendar Options
Calendar Type Sun Mon Tue Wed
Regular - O
O

Calendar

| Sunday | Monday | Tuesday | Wednesday | Thursday |  Fridy | Saturday |
Month/Year

E | Day | ype  Day | Type  Day | Type | Day | Type  Day | Type  Day | Type  Day | Type |
&3 4 5 6 7 8

Sep—201ﬂ
2

- 9 10 11 12 13 14 15
16 17 18 19 20 21 22
n 23 24 25 26 27 28 29
.

ﬂo:t-zuwa 1 2 3 4 5 6

District Calendar Screen

2. Select the days of the week when the district holds classes by selecting the fields under each
day of the week.

3. Click Create Calendar.
4. Select Regular as the Calendar Type.

Collect Year Dates Z0¢
School Year: 2016-2017

The default calendar has not been generated. Please enter in
the start and end dates of the calendar you would like to create.

Calendar Type
Regular ~

Calendar Start Day ~ Calendar End Day
& =

Collect Year Dates Screen

5. Enter the beginning date in Calendar Start Day and the last day of the calendar in Calendar
End Day.

6. Click Save.
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7. Enter district-wide holidays and other non-school days in the calendar.
8. Selectthe Type of day off.

r

All days off in the district calendar also show in all of the school
calendars so only select days off that are common to all schools in
the district. The options available are Holiday, Vacation, Staff

Development, Non-School Day, or Other. You can also mark days
as Emergency Closure Day (Approved) or (Unapproved) or
Supplemental. See Supplemental Instruction Setup in the
Synergy SIS — Attendance Administrator Guide for more

information.
. W,

Defining Periods

Use the Report Periods tab of the District Calendar to define periods for attendance reports. You
only use these periods for the reports so they can match the grading periods, the terms, or whatever
other intervals are helpful such as 40" and 100t" day.

1. Navigate to Synergy SIS > Attendance > Setup > District Calendar.
2. Selectthe Report Periods tab.
3. Click Add to create a blank line.

District Calendar «ceE-0

Menu~ ol

School Year: 2018-2019 Calendar Type: Regular

District Calendar Report Periods Advanced Options

@ District Report Periods -I- Add

Default Dates
= st & | End 3

District Calendar Screen, Report Periods Tab

4. Enter the Order the period should display in.
5. Enter a descriptive Name.
6. Enter the Start and End dates.
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7. Click Add to add another report period and continue until you enter all report periods.

A The dates for each report period cannot overlap.

District Calendar

Menu~= | ol « Save || * Undo

School Year: 2018-2018 Calendar Type: Regular

District Calendar Report Periods Advanced Options

District Report Periods =+ Add

(=] K
= - E
NN -

40th Day
100th Day

End of Year

Default Dates
o L sat 3 | End 3

08/03/2018 10M15/2018

01/14/2019

[
10/18/2018 B
[

011772019 05/27/2019

District Calendar Screen, Report Periods Tab

8. Click Save.

Setting up a Holiday Week

1. Navigate to Synergy SIS > Attendance > Setup > District Calendar.

2. Selectthe Advanced Options tab.
3. Click Add for a new line.

District Calendar

Menu~ o « Save | * Undc

School Year: 2018-2019 Calendar Type: Regular

Report Periods Advanced Options
@ Special Week Setup

District Calendar

n Week Date Week Type Exclude from State Reports

District Calendar Screen, Advanced Options Tab

Enter the beginning date of the week in the Week Date field.

5. Enterthe Week Type.

You can customize the types of weeks for each district using the

Week Type lookup table.

Click Add to add another week, if needed.
Select X to delete a week, if needed.
Click Save.

© © N o

Select Exclude From State Reports to exclude this week from the state upload.
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Adding Instructional Hours

You can determine how many instructional minutes are offered at each school based on a
combination of the Bell Schedule Definition and Period Rotation Definition selected and the number
of days in the School Calendar.

1. Navigate to Synergy SIS > Attendance > Setup > District Calendar.
2. Selectthe Advanced Options tab.
3. Enter the Instructional Hours for each Grade Level.

District Calendar i L&

Menu - [} " Save = ndo

[
Q
al
[ 2]

School Year: 2018-2019 Calendar Type: Regular

District Calendar Report Pericds Advanced Options

B Special Week Setup +

. - - Exclude from State -
A K -

@ State Required Instructional Hours

Y - T T
1 L& 100

nK 200

Hm 200

nuz 400

Hus 500

-

District Calendar Screen, Advanced Options Tab

4. Click Save.
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School Calendar Setup

After defining the district calendar and creating the bell schedules for your school, you must setup a
school-specific calendar for each of the schools in the district. Each day can have only one bell

schedule assigned to it.

There are two ways to assign bell schedules to schools. You can either use the Create Calendar
functionality or select options directly on the School Calendar screen.

Before adding or editing a record, confirm the current focus points to a
school and not the district.

Option 1: Using Create Calendar

1. Navigate to Synergy SIS > Attendance > Setup > School Calendar.
2. Click Create Calendar to open the Create School Calendar screen.

School Calendar e -0

Menu + o « Save + Undo Create Calendar

School Name: Hope High School School Year: 2018-2019 Calendar Type: Regular
School Calendar School Report Periods Advanced Options

@ Bell Default @ valid School Days
Default Bell Schedule Set Bell Default Sun Mon Tue Wed Thur Fri Sat
1: Default - O O

[0 use Supplemental Calendar
School Calendar

 Tuesday | Wenesday |
Line Month/Year
.-m-ﬁmmm-mmﬁm-ﬁmmm-ﬁmmm-mm

1 1

Sep - 2018 1

10 1 11 1 12 1 13 1 14 1
17 1 18 1 19 1 20 1 21 1
- 24 1 25 1 26 1 27 1 28 1
n 3 1 4 1 3 1

Oct- 2018 1 1 2 1

School Calendar Screen
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3. Select Use District Calendar to apply the district calendar to the school calendar.

Synergy SIS uses the Calendar Type and Start Date and End Date for the District
Calendar display.

Create School Calendar -0e
School Name: Hope High School

*® Close

If you would like to get the District calendar then select "Use District Calendar”
checkbox and click OK. You can create your own independent calendar by entering
the start and end dates of the calendar you would like to create.

@ District Calendar
If the 'Use District Calendar' check box is disabled the district calendar has not
been created for the school's calendar type.

Calendar Type
Regular -

Start Date End Date
09/03/2018 |@@ 07/30/2010 &

[ use District Calendar

Start Date End Date
=]
@ Bell Default

Default Bell Schedule 1: Default hd

@® Rotation Default
O NoFill O Fill Rotating Days Skipping Over Holidays

O Fill Rotating Days Holidays Count As Rotation Day

@ valid Days of Week

Sun Mon Tue Wed Thur Fri Sat
O O

Create School Calendar Screen

If the dates and type do not display, the district calendar does not
exist for the school's calendar type.
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4. Selectthe Start Date and End Date to create a school calendar with different dates than the
district calendar.

Create School Calendar 00
School Name: Hope High School

% Close

If you would like to get the District calendar then select "Use District Calendar”
checkbox and click OK_ You can create your own independent calendar by entering
the start and end dates of the calendar you would like to create.

@ District Calendar
If the 'Use District Calendar check box is disabled the district calendar has not
been created for the school's calendar type.

Calendar Type

Regular -

Start Date End Date
09/03/2018 @@ 07/30/2019 &
[ use District Calendar

Start Date End Date
B

@ Bell Default

Default Bell Schedule 1: Default -

@ Rotation Default
O No Fil O Fill Rotating Days Skipping Over Holidays

O Fill Rotating Days Holidays Count As Rotation Day

@ valid Days of Week

Sun Mon Tue Wed Thur Fri Sat

Create School Calendar Screen

5. Select the Default Bell Schedule.

[
See Assigning Rotation Default for information on Rotation Default.
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6. Click Save. Once you create the calendar, the default bell schedule assigns to every day of

the school calendar.

School Calendar
Menu ~ o « Save
School Calendar

® Bell Default

Default Bell Schedule
1: Default

[0 use Supplemental Calendar
School Calendar

= Undo

School Report Periods

Create Calendar

School Name: Hope High School School Year: 2018-2019 Calendar Type: Regular

Advanced Options

@ Valid School Days

Sun Mon Sat

Set Bell Default 0 “ “ v % % 0

T esaay | wewnesaay | mursam | rnom
Emmmﬁmmmﬁmmmmmmﬁmmm

Sep- 2018 5 1 6 1 |7

10 1 M 1 |12 1 |13 1 |14 1

17 1 18 1 19 1 20 1 21 1

24 1 25 1 26 1 27 1 28 1

Oct- 2018 1 12 1 3 1 4 1 5 1
School Calendar Screen

If some days do not follow the default bell schedule, you can define
another bell schedule in the Bell Schedule Definition screen. See
Bell Schedule Definition for further instructions.

7. Select the special bell schedule in the Bell field.

School Calendar
Menu~ | ol « Save
School Calendar

@ Bell Default

Default Bell Schedule
1: Default

O use supplemental Calendar
School Calendar

Oct- 2018

 Undo

School Report Periods

I ——

Create Calendar

School Name: Hope High Schoel School Year: 2018-2019 Calendar Type: Regular

Advanced ODIIOHS
@ valid School Days

Sun Mon

Set Bell Default O = 2 = = = O

Wodnesday | Turcsay | Fray |
Rot| Bell |Day|Type|Rot| Bell @m@m@m

8. Click Save.

Sep 2018 4 |] 1 1 |7

10 1 11 13 1 14 1
0: Distributed Learning

17 1 18 1: Default 20 1 21 1
2 Early Dismissal

24 1 25 27 1 |28 1

1 1 2 1 3 1 4 1 5 1

School Calendar Screen
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9. Select the Type of non-school day specific to the school and different from the district
calendar. The options are Holiday, Vacation, Staff Development, Non-School Day, Other,
Emergency Closure Day (Approved) or (Unapproved), or Supplemental.

See Supplemental Instruction Attendance in the Synergy SIS —

L-J Attendance Administrator Guide for more information about

supplemental days.

Menu = ol

School Name: Hop

@ Bell Default

Default Bell Sched
1: Default

School Calendar

School Calendar <z

School Calendar School Report Periods Advanced Options

[ use Supplemental Calendar

| Monday | Tuesday | Wednesday | Thursday |  Friday |
m-mmm-mmm-mmm-mmm-mm

« Save * Undo Create Calendar

e High School School Year: 2018-2019 Calendar Type: Regular

@ Valid School Days

- Set Bell Default sun  Mon  Tue Wed Thur Fri  Sat
O -

- Sep - 2018 1 4 1 |6 1|7
10 1 11 1 14 1
Hol: Holiday
17 1 18 |Vac: Vacation 1 21 1
_ | sta: starr Development
n = T 5 |on Non-School Day i 2 1
- oct- 2018 1 1 |2 |Om:Otner 1 5 1
Ema: Emergency Closure Day (Approved)
“ 8 1 9 |Emu: Emergency Closure Day (Unapproved) 1 12 1
School Calendar Screen
10. Click Save.
( A
A You must repeat these steps to create a school calendar for every
school in the district.
\. J
\

Once you create the initial calendars for the district and the schools,
you can create calendars for subsequent years by copying these
initial calendars. You do this through the New Year Rollover
process. See the Synergy SIS — New Year Rollover Process Guide
for more information about this process.

J
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Option 2: Selecting Options on the School Calendar Screen

1. Navigate to Synergy SIS > Attendance > Setup > School Calendar.

2. Selectthe Default Bell Schedule.
3. Click Set Bell Default. This updates all days in the calendar with this schedule.

Pl

School Calendar

Menu~ ok « Save | *yUndo | | Create Calendar

School Mame: Hope High Schoel School Year: 2016-2017 Calendar Type: Regular

School Calendar School Report Periods Advanced Options
@ Bell Default @® Rotation Default
Defaull Bell Schedule © No Fill @ Fill Rolating Days Skipping Over Holidays
1: Default -
© Fill Rotating Days Holidays Count As Rotation Day
Set Bell Default
Customize the Rotation default by date and type

@ Supplemental Bell Default

Default Supplemental Bell Schedule

=

Set Bell Default

[F1 use Supplemental Calendar

«

&

Set Rotation Default

o

School Calendar Screen

4. Selectthe Default Supplemental Bell Schedule.
5. Click Set Bell Default.

Select Use Supplemental Calendar to change the School
Calendar.

School Calendar

Menu~ o « Save | *+yUndo | | Create Calendar

School Mame: Hope High Schoel School Year: 2016-2017 Calendar Type: Regular

School Calendar School Report Periods Advanced Options

(® Bell Default @ Rotation Default
Default Bell Schedule © No Fill @ Fill Rotating Days Skipping Over Holidays
1. Default -

) Fill Rotating Days Holidays Count As Rotation Day

Set Bell Default
Customize the Rotation default by date and type

@ Supplemental Bell Default

Default Supplemental Bell Schedule

-

Set Bell Default

Set Rotation Default

|| Use Supplemental Calendar

School Calendar Screen
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6. Select the Bell column for a specific day in the School Calendar section to manually adjust the
bell schedule.

School Calendar
Munth.erar MoKy, Wednesday n
Day _Type |Rot BellDay Rot _Bell Day Type | Rot _Bell Day Type | Rot | Bell Day Type |
JUI - 2016 4 A 5 B 1 6 A 1 T
i 11 B A 1 13 B 1 14
n 17 18 A B 1 20 A 1 21
24 25 B A 1 27 B 1 28
31
Aug - 2016 1 A 1 2 B 1 3 A 1 a
v 8 B 1 9 A 1 10 B 1 11
“ 14 15 A 1 16 B 1 17 A 1 18
n 21 22 B 1 23 A 1 24 B 1 25
28 29 A 1 30 B 1 31 A 1
Sep - 2016 P
n A 5 B 1 = A 1 7 B 1 A

School Calendar Screen

7. Click Save.
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Defining School Report Periods

The School Report Periods tab allows you to define periods for attendance reports. These
periods only apply to these reports so they can match the grading periods, the terms, or other helpful
intervals, such as 40th and 100th day. As with the calendar, the school report periods can use those
defined at the district or override the periods at the school level.

1. Navigate to Synergy SIS > Attendance > Setup > School Calendar.

2. Selectthe School Report Periods tab. You cannot change the Order or Name of the
district report periods or add or delete report periods at the school level. However, you can
change the dates.

School Calendar e -0

Menu - ok « Save + Undo Create Calendar

School Name: Hope High School School Year: 2018-2019 Calendar Type: Regular

School Calendar I School Report Periods I Advanced Options

@® School Reporting Period

1 40th Day 09/03/2018 B | 10152018 ]
2 100th Day 10/18/2018 ] 01/14/2019 = O
= O

3 End of Year 01/17/2019 B 05/27/2019

Load District School Weeks

@ School Week Setup + Add
AT et on e o s ors

@ State Reporting Periods Wy Show Detail

School D f
Line |Reporting Period Start Date End Date NonAttendance Days o8 2ys of
Days Enroliment

Need Data 09/03/2018 1212172018

09/03/2018 04/12/2019 160 160

09/03/2018 07/30/2019 3 237 237

School Calendar Screen, School Report Periods Tab
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3. Enter the start date in the DateStart field and the end date in the DateEnd field to change the
dates for the school report periods.

A The dates for each report period cannot overlap.

School Calendar

Menu~ | ol ' Save

School Calendar

@® School Reporting Period

Load District School Weeks

@ School Week Setup

@ State Reporting Periods

Need Data

. !

= Undo

School Name: Hope High Schoeol School Year: 2018-2019 Calendar Type: Regular
School Report Periods

[Line | Order _
- 1 40th Day

2 100th Day
3 End of Year

=+ Add

09/03/2018

School D f
Line [Reporting Period Start Date End Date NonAttendance Days Shes 2ys O
Days Enroliment

2 09/03/2018

3 09/03/2018

Create Calendar

Advanced Opfions

DateStart DateEnd Override
09/03/2018 B 10/15/2018 B O
10/18/2018 B 01/14/2019 ] O
01/M17/2019 B 05/27/2019 ] ]

Exclude From State Reports

Iy Show Detail

1212172018
04/12/2019 160 160
07/30/2019 3 237 237

School Calendar Screen, School Report Periods Tab

4. Select Override next to the periods you modified.

5. Click Save.
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Loading a Week

You can mark an entire week as a holiday, such as Winter Break or Spring Break, for a school or
district.

1. Navigate to Synergy SIS > Attendance > Setup > School Calendar.
2. Clickthe School Report Periods tab.

School Calendar « e -e

Menu - ok " Save + Undo Create Calendar

School Name: Hope High School School Year: 2018-2019 Calendar Type: Regular

School Calendar I School Report Periods I Advanced Options

@® School Reporting Period

40th Day 00/03/2018 B | 10152018 ]
100th Day 10/18/2018 ] 01/14/2019 = O
End of Year 01/17/2019 B 05272019 ] O

Load District School Weeks

@ School Week Setup + Add
n“ Week Type Exclude From State Reports

@ State Reporting Periods Wy Show Detail

School D f
Line |Reporting Period Start Date End Date Holidays NonAttendance Days e 2ys of
Days Enroliment

Need Data 09/03/2018 1212172018

09/03/2018 04/12/2019 160 160

09/03/2018 07/30/2019 3 237 237

School Calendar Screen, School Report Periods Tab
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3. Click Load District School Weeks to display the district weeks configured in the School
Week Setup area.

School Calendar 28T -0

Menu = L] " Save + Undo Create Calendar

School Mame: Hope High School School Year: 2018-2019 Calendar Type: Regular

School Calendar | School Report Periods | Advanced Options

@ School Reporting Period

n 1 40th Day 09/03/2018 B 101512018 B
- 2 100th Day 10/18/2018 B | 01142019 B O

05/27/2019 B O

3 End of Year 01/17/2019

|Load District School Weeks |

® School Week Setup
: Exclude From
- Week Type State Reports

1 12/2312018 ] Winter Break hd O

[® sState Reporting Periods I Show Detail

Days of
Line |Reporting Period Start Date End Date Holidays NonAttendance Days o
Days Enroliment

Need Data 09/03/2018 12/21/2018
2 09/03/2018 04/12/2019 160 160

3 09/03/2018 07/30/2019 3 237 237

School Calendar Screen, School Report Periods Tab
Select X to delete a district week that does not apply to the school, if needed.
Click Add in the School Week Setup section to add a week off for the school, if needed.
Enter the beginning date of the week in the Date field.
Selectthe Week Type.

N o g &

You can customize the types of weeks for each district using the
Week Type lookup table.

8. Select Exclude From State Reports to exclude this week from the state upload.
9. Click Add to add another week, if needed.
10. Select X to delete a week, if needed.
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11. Click Save.

For California schools and districts, Synergy SIS also outlines the

a P1, P2, and P3 reporting periods the state uses. This information is
in the State Reporting Periods section at the bottom of the School
Report Periods tab of the School Calendar screen.

School Calendar 2T -0

Menu = L) + Save + Undo Create Calendar

School Name: Hope High School School Year: 2018-2019 Calendar Type: Regular

School Calendar | School Report Periods | Advanced Options

@ School Reporting Period

1 40th Day 09/03/2018 5 10/15/2018 ]
2 100th Day 10/18/2018 = 01/14/2019 =] O
3 B End of Year 01/17/2019 B 052712019 B O

Load District School Weeks

® School Week Setup + Add

Exclude From
-— C State REPD"S

1 2/23/2018 Winter Break

® State Reporting Periods

School Days of

Line Reporting Period Start Date End Date Holidays NonAttendance Days

Days Enroliment
i Need Data 09/03/2018 12/21/2018 80 80
2 p 09/03/2018 04/12/2019 160 160
3 K 09/03/2018 07/30/2019 3] 237 237

School Calendar Screen, School Report Periods Tab

For each reporting period, Synergy SIS calculates the Start Date

E and End Date of the period. It also counts the number of Holidays
and other Non-Attendance Days in the period. Finally, it tabulates
the number of School Days and Days of Enroliment.
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12. Click Show Detail to see the detail of each period by week, if needed.

@ State Reporting Periods Wy Hide Detail
Reportlng ® Analysis -
Llne Perlod
Exclude
i L=t DEE o Week Ty School | NonAttendance From Days of
2 pe Days Days State | Enroliment
Reports
3 00/02/2018 5
1 09/09/2018 5 5
1 09/16/2018 5 5
1 09/23/2018 g g
2 09/30/2018 5 5
n 2 10/07/2018 g 5
2 10/14/2018 5 5

School Calendar Screen, School Report Periods Tab, State Reporting Periods Detail

Synergy SIS tabulates this information for each week. Select
Exclude from State Reporting to remove any of these weeks
from the state upload.

Adding a Custom Holiday

1. Navigate to Synergy SIS > Attendance > Setup > School Calendar.
2. Selectthe Advanced Options tab.
3. Click Add to add a new line.

School Calendar .

Menu - L] «" Save || * Undo Create Calendar

0
Q
o
‘
[}

School Name: Hope High School School Year: 2018-2019 Calendar Type: Regular

School Calendar School Report Periods Advanced Options
@ Grade Level Calendar Override

School Calendar Screen, Advanced Options Tab

4. Selectthe Grade affected by this custom holiday.
5. Enter the date of the custom holiday in Cal Date.
6. Select the type of non-school day in Holiday.

« Click Add again and follow the steps above to add another non-school day for a grade,
if needed.

« Select X to delete a day, if needed.

7. Click Save.
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Reviewing Instructional Hours and Adding Hour Deviations

1. Navigate to Synergy SIS > Attendance > Setup > School Calendar.

2. Select the Instructional Hours tab.

3. Review the Total Instructional Hours section.

Grade — Displays the grade levels selected in School Setup.

House — Only available if House (with Bell Schedule Filtering) is the selected Bell
Schedule Override on the School Setup screen. Instructional Minutes display per
House.

Instructional Hours — Sum of the minutes derived based on a combination of the Bell
Schedule Definition and Period Rotation Definition selected and the number of days in
the School Calendar using the following equation:

Total minutes from the Bell Schedule * the number of days it is used in the calendar/ 60
minutes

You must set the Exclude Passing Minutes in Schedule
—| Based FTE selection to No on the Schedule Based FTE
Setup — District screen.

Instructional Hours Deviation — Manual entry option to adjust the Total Reported
Instructional Hours. You can enter a'-' (minus) to subtract hours or simply enter hours
to add.

Total Reported Instructional Hours — Sum of Instructional Hours and
Instructional Hours Deviation columns.

State Required Instructional Hours — Displays the Instructional Hours entered from
the District Calendar.

Difference in Hours — Displays the difference between the Total Reported
Instructional Hours and the State Required Instructional Hours columns. If the
difference in hours is greater than or equal to the required hours, the field is green,
otherwise, the field is red.

-0

A

School Calendar

Menu - [} Create Calendar

School Mame: Hope High School School Year: 2018-2019 Calendar Type: Regular

School Calendar School Report Periods Advanced Options Instructional Hours

@ Total Instructional Hours

1 B 1801.97 8.00 180997 0.00 180997

nw 16801.87 0.00 16801 .87 0.00 1801 97

1 1801.97 0.00 1801.97 0.00 1801.97

- 12 158573 0.00 1685.72 0.00 159573

School Calendar Screen, Instructional Hours Tab

4. Click Save.
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Updating the Attendance Calendar for an Emergency Closure Day

This process updates the Attendance Calendar when the school or district calendar changes to an
emergency closure day, and updates the Attendance Calendar to move attendance to the next valid
day for both daily and period attendance schools.

1. Navigate to Synergy SIS > Attendance > Setup > School Calendar.
2. Change the day to an approved school closure day.

School Calendar i ®lali] [cleRl-lo@
Menu- || || ssue | #Unco || Creste Calencar
School Name: Hope High School School Year: 20182019 Calendsr Typs: Regular
School Calendar | School Report Periods  Advanced d Opfions  Instructionsl Ho
School Calendar
Month/Year T
Day 7| TypeT| BeIIY SelnDy T | DayT| FneY BeIIY SehDy T | DayT| F;pev BeIIY sany T Der FmeY BeIIY SehDy ol M= Bell" SchiDy T
Nov - 2018 1 naefined v
1z 1 undefined ~ 12 1 undefined ~ 14 1 undefined ~ 18 1 undefined = 1€ 1 undefined
ﬂ 19 1 undefined ~ 20 Ema undefined 21 1 undefined v 22 1 undefined = 23 1 undefined ~
n 1 undefined v 27 1 undefined v 28 Ema undefined 29 = undefined 0 1 i ©
Ebe c- 2018 2 1 undefined » 4 1 undefined ~ |5 1 undefined v © 1 undsfined ~ 7 1 undefined ~
ﬂ 10 1 undefined ~ 11 1 undefined ~ mundefmed 13 1 undefined ~ 14 1 undefined ~
7 hal undsfined 18 1 undefined ~ |19 1 undefined v 20 1 undefined ~ 21 1 undefined ~
n 24 1 undefined v 25 1 undefined ~ |28 1 undefined v 27 1 undefined ~ 28 1 undefined ~

3. Click Save. The Attendance Calendar Update screen opens.

4. Selectthe Attendance Reasons for Move Absence Reasons. This step is required. The
reasons selected here are the only ones that will move to the next valid day on the Attendance
Calendar.

5. Click Update School.

Attendance Calendar Update

Update School Close Window

Changes Made
Aftendancs records sxist in the system for ths days below. Pleass sslect the changss you would like pushed to
Adams Elementary. or select Close Window to not make any updates to this schools record
@ Modifications

o Crange T s T L Orgua e T e e ]

121202018 Ema

@ Move Absence Reasons.

Meve the following reason codes to the next valid school day for each student.
Absence Reasons 0 = &

Immuniz Home Susp [J Lice Inschl Sus Iss

ler Positive Other MNurse Late
Appealed [ Sweep Psychologi [ example Detention
Exc Tardy [ Pager Inschoolsy [ Exc Tardy liness
Message [ Doctor App [J C-Pax Office

Health Late Bus Sweep Exc Tardy
T

AltLm Ct [ Counseling [ Bussspend Unerified

Attendance Calendar Update Screen
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Verifying the Attendance Calendar Update

You can ensure the Attendance Calendar update was successful by viewing the Attendance
Calendar on the Daily Attendance or Period Attendance screen.

7 Daily Attendance
Meu- A€ Q¥ A&

Student Neme: Abdulbari, Kathy A. School: Adams Elementary Status: Active Homeroom:

Colender | DeysofActiviy  Totals  History  DaiyEntry  Atiendance Letters
Lost Name: First Name Middie Name Sufix Pemn ID Grade Gender  EGFIID
Abdulari Katny Abdusermie 135578 = «| [Femais| +

Show Full Year Date | & |GoToDate <= Previous Month| | Next Montn >

(N/I) Not Meeting in Bell Schedule  (N/D) Not defined in Period Rotstion
Daily Aftendanee Calendar

[ Tuesday Wednesday
Month Year T v All Day Attendance 1 | Attendance 2 v All Day Attendance 1 | Attendance 2 v All Day Attendance 1 | Attendance 2 v il
o Reason V| ValueJ 7| Reason 7| Reason T o Reason 7| Value CJ7|  Reason 7| Reason T = Reason 7| Value [JT| Reason 7| Reason T o Reason
L) 20 pal n

- Nov-2018
De-2018 3 I 4 Ema Ema Ema Ema 5 Sus 100 Sus Sus I &
= n «1

Daily Attendance Screen

You can view the students affected by the update by viewing the Attendance Calendar Student
Attendance Update file in the Job Q Admin Viewer.

Student: Abbott, Bily - Sis Number: 123456
Attendance Day becoming a holiday is 12/12/2818
Code 1 0SS

Code 1 amount 1.G@

Period: 2 abs code: 055 arrival time: departure time: note:
Period: 4 abs code: 055 arrival time: departure time: note:
Period: & abs code: 055 arrival time: departure time: note:
Period: 8 abs code: 055 arrival time: departure time: note:
Period: 18 abs code: N/5 arrival time: departure time: note:

Attempting to move data to 12/13/2013
Successfully moved attendance to 12/132/20818

Student: Aaron, lan - 5is Number: 234567
Attendance Day becoming & holiday is 12/12/2818
Code 1 0SS

Code 1 amount 1.8@

Period: 2 abs code: 055 arrival time: departure time: note:
Period: 4 abs code: 055 arrival time: departure time: note:
Period: & abs code: 055 arrival time: departure time: note:
Period: § abs code: 055 arrival time: departure time: note:
Period: 1@ abs code: N/S arrival time: departure time: note:

Attempting to move data to 12/13/2018
Successfully moved attendance to 12/13/2018

Attendance Calendar Student Attendance Update Output

If the next calendar day is a holiday or weekend, the attendance update
moves to the day after the holiday or weekend. This is only true for period
.,  attendance schools if all the same codes are applied to all periods for the
attendance updates.

If the change of day is done from the District Calendar, all schools in that
district update.
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Rules Logic for Moving Attendance

The following describes the rules logic for moving attendance for once daily, twice daily, and period
attendance schools.

Once Daily School

Does the attendance code for the date that was changed in the calendar match one of the codes that
should be moved?

If yes

« Search for a day to move the attendance to using Once Daily Rules below.

« Was a day found to move attendance to?
If yes

« Log attendance for the date that was changed in the calendar in the "Update" log.
« Move attendance to the new day.

If no

« Log attendance for the date that was changed in the calendar in the "Non-update" log.
Do not move attendance.

If no

« Log attendance for the date that was changed in the calendar in the "Non-update" log. Do not
move attendance.

Once Daily Rules
Is there an attendance code?
If yes
» Does that code match one of the codes that should be moved?
If yes
» Look at the next valid attendance day for this student. If that day is valid, return it.
If no

« Nodayfound, attendance cannot be moved.

If no

« Thisis avalid day that attendance can move to.
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Twice Daily School

Do both of the attendance codes for the date that was changed in the calendar match one of the
codes that should be moved?

If yes

» Search for a day to move the attendance to using Twice Daily Rules below.

« Was a day found to move attendance to?
If yes

« Log attendance for the date that was changed in the calendar in the "Update" log.

« Move attendance to the new day. (Code1/Amount1 moves to Code1/Amount1 on the
new day, Code2/Amount2 moves to Code2/Amount2 on the new day)

If no

« Log attendance for the date that was changed in the calendar in the "Non-update" log.
Do not move attendance.

If no

« Log attendance for the date that was changed in the calendar in the "Non-update" log. Do not
move attendance.

Twice Daily Rules
Is there an attendance code in AM or PM?
If yes
« Do both attendance codes match one of the codes that should be moved?
If yes
» Look at the next valid attendance day for this student. If that day is valid, return it.
If no

« Nodayfound, attendance cannot be moved.

If no

« Thisis a valid day that attendance can move to.
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Period Attendance School

Is there an attendance code in every period for the date that was changed in the calendar for this
student? AND

Do all of the attendance codes for the date that was changed in the calendar match? AND
Does that code match one of the codes that should be moved?

If yes

« Search for a day to move the attendance to using Period Rules below.
« Was a day found to move attendance to?

If yes

« Log attendance for the date that was changed in the calendar in the "Update" log.

« Move attendance to the new day. (All periods are filled with the code that was in the
periods on the newly created holiday. The AM code moves straight across if it matches
a code that should be moved.)

If no

« Log attendance for the date that was changed in the calendar in the "Non-update" log.
Do not move attendance.

If no

«» Log attendance for the date that was changed in the calendar in the "Non-update" log. Do not
move attendance.

Period Rules

Are there any period attendance codes?

If yes

o Do all of the attendance codes match? AND
« Is that code one of the codes that should be moved?

If yes
« Look at the next valid attendance day for this student. If that day is valid, return it.

If no
« Nodayfound, attendance cannot be moved.
If no

« Thisis a valid day that attendance can be moved to.
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School Scheduling Options

The School Scheduling Options screen contains options for running the scheduling course requests
for full sections, generating section IDs, adding meeting days, and selecting pathways.

|

See Meeting Days and Period Rotation for more information on creating
Meeting Days.

1. Navigate to Synergy SIS > Mass Scheduling > Setup > School Scheduling Options.

2. Selectthe Class Size Limit option. This is the process the system uses when reviewing
course requests for a section that reached the class size limit.

Add Student, no Message — Adds the student to the section without giving a warning
message.

Add Student, with Message — Adds the student but includes a warning message that
the section has reached the class size limit.

Don't add student — Skips scheduling the student into the section.

Require Password — Only adds the student to the section if you enter the correct
password.

3. Enter the Section Override Password if using the Require Password option.
4. Enter the Section ID Width. This is the character limit for a section ID.

5. Select the Auto Sequence option. This determines the section ID creation process when
running the Master Schedule Builder process.

Manual — Manually add section IDs after running Master Schedule Builder.

Period and Counter— Section IDs begin with the period number, followed by a
sequential number based on section creation order.

Course and Period — Section IDs begin with the Course ID, followed by the section
period number. Choose this option only if the school never offers two sections of a
course in the same period.

Counter— The system creates section IDs with a sequential number based on creation
order.

Course and Period and Counter— Section |Ds contain the Course ID, period number,
and sequential creation number.

Course and Counter — Section IDs match the same number as the one generated by
Master Schedule Builder.

Course and Manual — The system generates a Course ID, the user manually creates a
section ID, and the system attaches the two.

L-J See the Synergy SIS — Master Schedule Builder Guide for
more information on Master Schedule Builder.
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Select Track Class Deletions for Add/Drop Report to keep deleted sections on the
Student Classes Deleted screen and any applicable reports.

Select Enable Section ID Validation Warnings to display a warning when a manually
entered section ID goes over width requirements.

Select Do Not Fill Section ID Gaps to prevent the system from filling gaps between existing
sections and instead create sequential section IDs from the highest section number. For
example, a school has the following sections created: 1001, 1002, and 2001. If selected, the
next Section ID automatically assigned to a created section is 2002.

O This is useful for schools that change Section ID format and wish to
=  keep previous sections on file for record-keeping purposes.

Select Only Create Grade Records For Homeroom Section if your school issues grades
through homeroom teachers while still tracking participation in other courses. Elementary
schools primarily use this option.

|| See the Synergy SIS — Grading and Course History Administrator
Guide for more information about grading.

Select Enable View of Student's Team/House/Counselor to view this information on the
Section and Schedule Section screens, as well as the STU408 — Class List report.

See Houses and Teams Overview for more information on Houses
and Teams.
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11. Select Enable View of Course Duration to display the course duration value for a course in

the Student Requests and
Schedule Request screen

Alternates for Electives sections on the Requests tab on the
and in the Selected Course Requests and Selected Alternate

Course Requests sections on the Course Request screen in ParentVUE and StudentVUE.

Menu ~ ol

School Name: Hope Hig

& Options

Class Size Limit

School Scheduling Options

Section Options Course Request and Walk-In Options House/TeamyExclusion Pathways

h School School Year: 2020-2021

Section 1D Width

Allow Owerride of Pathw

Section Override Passw

the following checkbox

[J Enable House Cat

[ Enable View of Cou

[ Track Class Deletions for Add/Drop Report

Creation of "Grade" records can be limited to just the Homerocom Section by checking

[ Only Create Grade Records For Homeroom Section.
[ Enable View of Student’'s Team
[ Enable View of Student's House

[ Enable View of Student's Counselor
[0 Enable Period Rotation Schedule Pattern

ays Restriction in Class Auto Sequence

ord [ Enable Section D Validation Warnings
[ Do Not Fill Section 1D Gaps

Sgory

rse Duration

12. Click Save.

School Scheduling Options Screen

Meeting Days and Period Rotation

Adding Meeting Days

Some schools offer classes on di
periods to fit scheduling needs.

Navigate to Synergy SIS

fferent days or different periods. Use Meeting Days to rotate

> Mass Scheduling > Setup > School Scheduling Options.

2. Click Add in the Meeting Days section. A new row displays. Do this for each day in the period

rotation. For example, if th

ere are four days in the rotation, enter four meeting days.

3. Enter the Order number for the day.

Enter a Code to identify th

e day.

5. Enter a Description for each day.

® Meeting Days
oo
1

=N N

- S
MWF Mon Wed Fri
TR Tue Thur

6. Click Save.

School Scheduling Options Screen
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Deleting Meeting Days

You can delete Meeting Days for a future school year on the School Scheduling Options screen that
have linked sections on the Schedule Section screen. An error message displays if you try to delete
a Meeting Day on the School Scheduling Options screen for a linked section in the Meeting Days
section on the Section screen and Homeroom Meeting Days on the School Setup Screen.

1. Navigate to Synergy SIS > Mass Scheduling > Setup > School Scheduling Options.
2. Click Delete Meeting Day for the meeting Code to delete.

School Scheduling Options : € a =B RAE ceF e
Menu ~ =
School Name: Hope High School School Year: 2018-2019
Section Options Course Request and Walk-In Options House/Team/Exclusion Pathways
® Options @ Include In Grading Option
Class Size Limit Section ID Width When the include grade option or minimum class enrollment days
Don't add student - 4 are blank, the district default will be used (Grade Option "Always')

If Always or blank is selected then the Minimum Class Enrollment

Allow Override of Pathways Restriction in Class Auto Sequence )
Days field is disregarded. If evaluate is selected, then the student

Require Password % Course and Period and Counter i must have been enrolled in the course for at least the number of
Section Override Password ¥ Enable Section ID Validation Warnings days indicated in the Minimum Class Enroliment Days textbox
........ ) Do Not Fill Section ID Gaps below to have a grade in the course.

@ Track Class Deletions for Add/Drop Include Grade Option

~ Report Evaluate active classes against Minimum Days Enrolled
Creation of "Grade" records can be limited to just the Homeroom Section Thresheld
by checking the following checkbox Minimum Class Enroliment Days

10

[ Only Create Grade Records For Homeroom Section
() Enable View of Student's Team
¥ Enable View of Student’s House
¥ Enable House Category
[ Enable View of Student's Counselor
[ Enable Period Rotation Schedule Pattern

® Meeting Days + Add

N

MWF Delete Meeting Day

2 TTh Delete Meeting Day

3 Test Testing Delete Meeting Day
4 4 S Saturday Delete Meeting Day

School Scheduling Options Screen
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The following error messages display when a meeting day cannot be
deleted on the School Scheduling Options screen as:

« The Meeting Code is linked to the Meeting Days on the Section
screen.

A Error

The Meeting Day being removed is currently tied to Section(s) via Meeting Day

tab on Section screen. Remove all links to Meeting Day from Section(s) before
deleting.

Error Message

« The Meeting Code is linked to Homeroom Meeting Days on the
School Setup screen.

A Error

The Meeting Day being removed is currently tied to School Setup - Homeroom

Meeting Day. In School Setup choose a different Meeting Day or clear the value
before deleting.

Error Message

A confirmation message displays before deleting the meeting day if the

meeting day is used only on the Schedule Sections screen. Click Yes to
delete the selected meeting day.

Schedule Section Confirmation

The Meeting Day being deleted currently has records

linked to Schedule Section. If the Meeting day deletion is

allowed to proceed then the associated links will be

deleted from the Schedule Section table.

Do you wish to proceed?

Yes | No
Schedule Section Confirmation Window

. J
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District Setup Options

Use the District Setup screen to ensure that rotation periods stay in the section if any changes are
made on the Period Rotation Definition screen.
Navigate to Synergy SIS > System > Setup > District Setup.
2. Selectthe System tab.

Select Do not clear rotation periods when increasing number of days in the cycle

and Do not clear rotation periods when decreasing number of days in the cycle in the
Other Options section.

District Setup

Menu~ || o || o Save | *yUndo

District Setup

Options Grade Setup TeacherVUE Labels Auto-Sequence Reports

Walvers Mobile Apps Concurrent Options
Accessibility Color Themes

Class Attendance Signature Text

Parent Filtering
Enable Parent Filtering -

Do not allow same parent to be added to a student with multiple relationships
[C] Display Student Test ID

I Do not clear rotation periods when increasing number of days in the cycle Do not clear rotation periods when decreasing number of days in the l:yl:lel
[0 Organizations that are direct children of the district are sub-districts

Prevent users from viewing or editing invalid daily attendance

District Setup Screen, System Tab
4. Click Save.
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Period Rotation Definition

Use the Period Rotation Definition screen to configure periods for all meeting days.
1. Navigate to Synergy SIS > Schedule > Setup > Period Rotation Definition.

2. Enterthe Number of Days in Cycle. For example, if school periods change every other day,
there are two days in the cycle. If periods change every day except for the fifth day, there are
four days in the cycle.

Period Rotation Definition
Menu~ o « Save | *+yUndo

€U &w= ceio

e

School: Hepe High School School Year: 2016-2017

Rotation Days Rotation Periods

INumDer of Days in Cycle 2 I Restore Defaults

@ Rotation Definition

e |_oaycoas | Scneaue Goae

MWF: Mon Wed Fri 2 Day A

1 A
B TR: Tue Thur - Day B

Period Rotation Definition Screen

3. Click Save. The Rotation Definition section fills automatically with a Day Code for each day in
the cycle.

4. Assign the meeting days created in the School Scheduling Options screen to each day in the
cycle by selecting it from the Schedule Code.

5. Click Save.

6. Selectthe Rotation Periods tab. You can manually edit either default distribution to adjust
the rotation. Clicking either Set Rotating Default or Set Non-Rotating Default populates
the Period Definition section.

« Click Set Rotating Default to set up a rotating schedule in which each period is ata
different time every day in the cycle.

0
a
%)
o

¥ Period Rotation Definition ‘

Menu~ || o | & Save 4 Undo

School- Adams Elementary School Year: 2015-2016
Rotation Days | Rotation Periods I
Set Rotating Defaultl Set Non-Rotating Default

@ Period Definition

ine | _reos | ooaw  omem  omow | owom |

L R

o

-~

L ~ o o -~ @ M = (=]
(=] o~ L] o LN R ) -
- [T -] -~ L] [ R R 2] [X]
(X - o @ -~ L N B (1]

w©

Period Rotation Definition Screen, Rotation Periods Tab
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« Click Set Non-Rotating Default to set a non-rotating schedule where each period is
at the same time every day in the cycle.

Q
Q
%)
o

7 Period Rotation Definition ‘
Menu~ || ¥k || & Save | *Undo

School: Adams Elementary School Year. 2015-2016

Rotation Days Rotation Periods
Set Rotating Default | | Set Mon-Rotating Default

@ Period Definition

3

'y
'S
=~
»
»

@
®
@®
@®
@®

o
L
o
o
o

Period Rotation Definition Screen, Rotation Periods Tab

7. Click Save.

Assigning Rotation Default

After updating the Period Rotation Definition screen, assign rotation days to specific calendar dates
in the School Calendar.

1. Navigate to Synergy SIS > Attendance > Setup > School Calendar.

2. Select Fill Rotating Days Skipping Over Holidays or Fill Rotating Days Holidays
Count as Rotation Day in the Rotation Default section to automatically assign rotation.

School Calendar e e

Menu~ | o + Save | *yUndo Create Calendar

School Name: Hope High Scheel School Year: 2016-2017 Calendar Type: Regular
School Calendar School Report Periods Advanced Options

@® Bell Default ® Rotation Default

Default Bell Schedule
1: Default -

@ No Fill @ Fill Rotating Days Skipping Over Holidays Set Rotation Default

@ Fill Rotating Days Holidays Count As Rotation Day
Set Bell Default

Customize the Rotation default by date and type

@ Supplemental Bell Default

Default Supplemental Bell Schedule

-

Set Bell Default

O use Supplemental Calendar

School Calendar Screen
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3. Click Customize the Rotation default by date and type to set a different rotation for part
of the year. The Set Default Rotation Calendar screen opens.

a. Selectthe Start Date and Rotation Code to begin the rotation.
b. Select the Rotation Default option.

Set Default Rotation Calendar ce

By setting the start date, the rotation will begin from the start date to the end of the calendar. This gives you the capability to make an
update mid-year without affecting the beginning of the school calendar.

Start Date Rotation Code Rotation Default

|. = T @ NoFil

@ Fill Rotating Days Skipping Over Holidays

© Fill Rotating Days Holidays Count As Rotation Day

Set Default Rotation Calendar Screen
c. Click Save.

4. Manually change the rotating day by clicking in the Rot column and selecting the Day Code.

School Calendar

: — Monay | uesay | Weanesay | mursay
M 5ay| type | Rot  men |Day| Type | Rot | Ben |pay Type | Rot | Bei Day Type | Rot | Ben
Aug-2014 25 Hol 26 1 27 1 28 1

Sep-2014 1 2 I 1 3 1 4 1 5 }
8 1 € 1 11 1 12
n 15 1 16 A Day A 1 18 1 19

B Day B
22 1 23 1 25 1 26
n 29 1 30 1

School Calendar Screen

=

5. Click Save.

Assigning Periods to Sections

1. Navigate to Synergy SIS > Schedule > Section.
2. Locate the section to modify.
3. Selectthe Meeting Days tab.

[$]
Q
o
[}

¥ Section )
Menu~ | € | Q | ¥ | | Save | ™yUndo | < Add X Delete

Section ID: 0001 Course Title: Life Science School Year: 2014-2015

Current Students Student Enroliment History Meeting Days Additional Staff Staff History

Section ID Course ID Course Title  Staff Name Room Name
ooo1 §C422 Life Science | | Tofft, Robert| | 120

® Meeting Days

Cycle Codes
2 I
4 4 4

4 4 4

Section Screen, Meeting Days Tab

Edupoint Proprietary and Confidential



Schedule and Course Guide

Chapter 2: Scheduling Setup 3

4. Enter the Period Begin and End for each Meeting Day in the Cycle Codes section.

[\
You must assign periods to each section in the rotation.

5. Click Save.

Allowing Schedule Overlap

You can enable sections to overlap for the same period for students within the District Setup and
School Setup screens.

District Level Validation

1. Navigate to Synergy SIS > System > Setup > District Setup.
2. Selectthe System tab.

3. Select one of the following under Validate Student Classes in the Other Options section:

« Do Not Validate Student Classes — Ignores schedule overlap
o Show Error and Do Not Allow Data to be Saved if Student Classes Overlap
o Show Warning and Allow Data to be Saved if Student Classes Overlap

District Setup £ F{I L m o= 2O
Menu~ || # |« Save | *3Undo
District Setup

Options Grade Setup ~ TeacherVUE  Labels  Auto-Sequence  Reports  Waivers  Mobile Apps

Concurrent Options
® Other Options

Discipline Type

Accessibility

Color Themes

Incident Violation Display District Group History Filter

Incident - Entire Violation - -
Student Notification Badge Number Update Type [CI Allow Enroliment in Multiple GATE Programs
Icon -

[C] Disable Unique State Number

Genesis update of badge number | ~
Adult ID Update Type

4. Click Save.

Section Locking Options

Section Periods Options
Override Periods in Meeting Days Tab And Do Not Display Warning Message | ~

Allow Negative Seat Totals Auto Generate -
Enable Announcement Dismissal Fee Total Type

Include fees for all organizations and all
years

Enable histerical tracking of staff in sections

Do Not Lock Section, Do Not Display Warning Message | ~

Auto Assign District Staff To Schools

Validate Student Classes

Show Warning and Allow Data to be Saved if Student Classes Overlap -

District Setup Screen, System Tab

%

After enabling district-level validation, each school in the district that
does not follow the same validation must use their own settings.
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School Level Validation

1. Navigate to Synergy SIS > Mass Scheduling > Setup > School Setup.

2. Select one of the following under Validate Student Classes in the Other Info section:

« Do Not Validate Student Classes— Ignores schedule overlap

o Show Error and Do Not Allow Data to be Saved if Student Classes Overlap

« Show Warning and Allow Data to be Saved if Student Classes Overlap

School Setup

Menu - | o ' Save | *yUndo

Basic Info Options SIS Data Options

@ other Info

Labels

School Name: Adams Elementary School Year: 2016-2017

TeacherVUE Mobile Apps

[E] Exclude from State Reporting
[C] Report Sub Schools

Validate Student Classes
Do Not Validate Student Classes -

[C] Enable College Credit
Enable Subject Area Override

-

Enable College Area Override

Enable University Area Override

[I Charter

[T] Make classes action on student inactivate mandatory
[T Is Separate School

Improvement Status

School Hours Per Week  Special Ed "Bell to Bell" Hours Per Week

Scheduling Options
Homeroom and Associated Course Enroliments

Default Locker Combination

- -

3. Click Save.

School Setup Screen
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Enabling Historical Staff Tracking

Schools assign each section of a course to a staff member. Before assigning staff to sections,
schools must add all staff members to their respective schools and assign departments to staff to

allow for grouping and reporting.

|

See the Synergy SIS — System Administrator Guide for more information
on adding and updating staff assignments.

Enable historical tracking of staff assignment to a course allows the system to keep a record of which
staff members have taught a particular course.

1. Navigate to Synergy SIS > System > Setup > District Setup.

2. Selectthe System tab.

3. Select Enable historical tracking of staff in sections in the Other Options section.

Student Notification

lcon -

[T] Disable Unique State Number
Allow Negative Seat Totals
Enable Announcement Dismissal

o o = - —
District Setup P A YRR
Menu - o « Save | *yUndo
District Setup
Cptions Grade Setup TeacherVUE Labels Auto-Sequence Reports Waivers Mobile Apps
Concurrent Options Accessibility Color Themes
@ Other Options
Discipline Type Incident Violation Display District Group History Filter
Incident - Entire Violation - -

Badge Number Update Type

Genesis update of badge number | ~
Adult ID Update Type

Auto Generate -

[T] Allow Enroliment in Multiple GATE Programs

Fee Tolal Type

Include fees for all organizations and all
years

I Enable historical trackinH of staff in sections |

4. Click Save.

District Setup Screen, System Tab
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Restricting Section Modifications

You can restrict a user’s ability to delete student section enroliments using one of three methods:
prohibiting any change, prohibiting changes during specific times of the day, or prohibiting changes

after a certain number of days.

1. Navigate to Synergy SIS > System > Setup > District Setup.

2. Selectthe System tab.
3. Choose one of the following options:

« Select Disable ability to add, drop, and transfer students to prohibit any
modification to student schedules for the current term.

Selecting this option overrides any settings in the Disable

Add, Drop, and Transfer section.

District Setup

Menu~ o

District Setup

Options Grade Setup

Concurrent Options Accessibility

TeacherVUE
Color Themes

Labels

@ Disable Add, Drop, and Transfer

ID Disable ability to add. drop, and fransfer students. (overrides grid Delow)l

Enter a begin and end time during which users will not be able to add, drop,
or transfer students

@ Disable Add. Drop. and Transfer

Day of 5 Disabled Time Period
- ~oegn | ena

Auto-Sequence

Reports Waivers Mobile Apps

Disable the ability to delete student section enrollment
on

or after day of the current term.

[ consider Holidays in the days of enrollment count.

Message shown when the ability to delete student
section enrollment is disabled.

District Setup Screen, System Tab

Edupoint Proprietary and Confidential




Schedule and Course Guide 77
Chapter 2: Scheduling Setup

« Enter the Begin and End time period for each Day of the Week to lock modification in
the Disable Add, Drop, and Transfer section.

@ Disable Add, Drop, and Transfer

or transfer students

@ Disable Add, Drop, and Transfer

o o + \ (=]
District Setup ATLSSuLL® CecHo
Menu~ || o | |  Save | * Undo
District Setup
Options System Grade Setup TeacherVUE Labels Auto-Sequence Reports Waivers Mobile Apps
Concurrent Options Accessibility Color Themes

Disable ability to add. drop. and transfer students_(overrides grid below)

Enter a begin and end time during which users will not be able to add, drop,

Disable the ability to delete student section enroliment
on

or after day of the current term.

Disabled Time Period Consider Holidays in the days of enroliment count.

Begin End

Message shown when the ability to delete student
section enroliment is disabled.

District Setup Screen, System Tab
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« Enter a numeric value of up to three digits for Disable the ability to delete student
section enrollment on or after day _ of the current term. If left blank or the field
contains 0, the option remains disabled.

a. Select Consider Holidays in the days of enroliment count to include school
holidays in the day count.

b. Enter the Message shown when the ability to delete student section
enroliment is disabled.

€

[<H

@ cume

District Setup ATS S

Menu~ | ok « Save | *Undo

District Setup

Options System Grade Setup TeacherVUE Labels Auto-Sequence Reports Waivers Mobile Apps
Concurrent Options Accessibility Color Themes

@® Disable Add, Drop, and Transfer

[[] Disable ability to add, drop. and transfer students.(overrides grid below) Disable the ability to delete student section enrollment

Enter a begin and end time during which users will not be able to add, drop. on

or transfer students or after day of the current term.

@® Disable Add, Drop, and Transfer

Disabled Time Period [T Consider Holidays in the days of enrollment count.
Line Day of Week =
~Begn  End |

nsunaa Message shown when the ability to delete student
Y section enrollment is disabled.
I\,ﬂc»nuag,r

Tuesd ay

District Setup Screen, System Tab

4. Click Save.
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Setting Course Display Options

The Course ID Print Width field allows you to customize the length of the Course ID as it displays in
any reports. You can also set the Short Course Title to display instead of the full course title for any
reports and screens that use a course name. The Short Course Title also displays on Course History

records.

B

If there is no Short Course Title entered for the course on the District
Course screen, reports and screens use the full Course Title.

|

1. Navigate to Synergy SIS > System > Setup > District Setup.
2. Selectthe System tab.
3. Enterthe Course ID Print Width in the Course Options section as a numerical value.
4. Select Use Course Short Title.
District Setup » AL uREEOILELGACRG Y Comg-e
Menu~ | o
District Setup
Options Grade Setup TeacherVUE Labels Auto-Sequence Reporis Waivers Mobile Apps
Concurrent Options Accessibility Color Themes
@ Course Options
Course ID Print Width
[[] Use Course Short Title
@ Explain Use Course Short Title
District Setup Screen, System Tab
5. Click Save.
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Managing District Courses

The District Course screen lists all courses taught within the district. These records are not school-
year specific. The Section screen captures individual classes held each year for each course.

Adding a District Course

1. Navigate to Synergy SIS > Course > District Course or Synergy SIS > Schedule >
District Course.

2. Click Add. The District Course (Add) screen opens.

( )
You can also duplicate an existing course by selecting Duplicate
Course from the Menu. This only copies the data on the Course tab.
You must manually enter information from additional tabs after

saving the course.

v District Course
0 Menu - < Q » o

Edit Course Data 5

Update School Course Fees Pre/C

Duplicate Course

View Audit Detail For District Course

District Course Screen
\_ J

3. EnteraCourse ID. This code is alphanumeric and limited to 20 characters.

4. Enterthe Course Title. You can also enter the Course Short Title if your school uses this
label.

See Setting Course Display Options for more information on the
Course Short Title.

5. Select Mandatory to assign the course automatically to all schools in the district. If a course is
not mandatory, schools must opt-in to the course.

Use the Inactive option to remove a course listing. You cannot
delete a course after it displays on the Student Course History
screen.
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6. Select Always Show in Course History Add if the course should display even if marked
inactive.

District Course

i &9
* Close

Course

Course 1D Course Title Course Short Title iardat 1 Inact
andato nactive

ENGOS English 9th Grade English 9 y

[T] Always Show In Course History Addl

@ Course Info

Course Duration
Q3: Quarter 3

Department College Prep  Credit Max Credit

~| | EN: English - [} 3.000 3.000

Post Secondary Credit Override

0.000
Course History Type

Quality Points  Alpha Numeric Setting (Default to Alpha)
O

Teacher Aide

Academic Type

[C] Extended Day
[I] College Approved

[C] Distance Learning Course
[F] Pass/Fail Only

[F1 Online Course
[C] Dual Credit [T] Allow School Course Title Override

[C] Jobs for American Graduates Program

District Course (Add) Screen
7. Selectthe Course Duration.

8. Select the Department.

9. Enter the Credit and Max Credit offered for the course.

District Course

‘. %9
¥ Close

Course

Course ID Course Title Course Short Title
ENGO0S

Mandato Inactive
English 9th Grade English @ = v O
[T Always Show In Course History Add

@ Course Info

Course Duration Department College Prep  |Credit Max Credit Post Secondary Credit Override
Q3 Quarter 3 ~| | EN: English - B 3.000 3.000 0.000
Course History Type  Quality Points  Alpha Numeric Sefting (Default to Alpha)

B

Academic Type Teacher Aide [[] Extended Day

[F] College Approved

[Tl Distance Learning Course
[[] Pass/Fail Only

[C] Online Course
[[] Dual Credit [T] Allow School Course Title Override

[7] Jobs for American Graduates Program

District Course Add Screen

10. Selectthe Duplicate Request option under Scheduling Options to determine how the course
handles duplicate course requests.

The Duplicate Course Request setting on the School Scheduling

Options screen in the Mass Scheduling module overrides this
selection.

11. Selectthe Schedule Priority used for Mass Scheduling.

Edupoint Proprietary and Confidential



Schedule and Course Guide 83
Chapter 3: Courses and Rooms Setup

12. Enter information for the ParentVUE Options to control access to course requests.

See the Synergy SIS — ParentVUE and StudentVUE Administrator
Guide for more information about ParentVUE and StudentVUE
course requests.

@ Scheduling Oplions

Duplicate Request

Schedule Priority

Optimum Size

Maximum Size

School Name
&

@ Status
Year Start

Year End

@ ParentVUE Oplions

Grade Range Low Grade Range High Schedule Priority

[T] Do not show in online course requests (PVUE/SVUE)

13. Selectthe Grade Low and Grade High.

District Course Add Screen

14. Selectthe Subject Area under Course Subject Areas to identify how the course meets
graduation requirements. You can select multiple subject areas.

15. Find and select a child course in the Merge Course field to link to a parent course when
reporting repeated course attempts on the CHS403 - Repeat Course report if needed. This
allows the report to include the merged course in the final count of the parent course, and is
useful when course numbers update within school course catalogs.

L-J See the Synergy SIS — Course History User Guide for more
information on the CHS403 — Repeat Course report.

@ course Restrictions

Merge Course
g

[] Technical Course
Technical Provider

[£] Exclude From State Reporting

[[] Exclude From Attendance Letters

[[] Exclude From Eligibility Course Count
[T Exclude From Eligibility Course Count Multiplier

Gender Grade Low Grade High Subject Area 1
-~ | 09 - M - Science Required | ~
Subject Area 2
@ other Information Science Elective | ~
Old SIS Course ID Category Code Instructional Level NCLB Core Subject Area 3
SC492 2603 - ~ | | Nota core academic class under NCLB | ~ T

@ Course Subject Areas

Subject Area 4
Subject Area 5

College Area 1

College Area 2

District Course Add Screen
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16. Enter Verified Credit information by choosing the Course Discipline from the list.
17. Click the link under Test Group to link the course to a group.

-

@ Verified Credit 1
Technical Provider Course Level CTE Credits Req. CTE Total Duration (Hours) Perkins Funded
- - (& Course Discipline Test Group

- &
CTE Gender Type CTE Course Credit Equivalency ID CTE Credit Equivalency

- - -

@ verified Credit 2

Course Discipline Test Group

- &

@ Alternate Codes + Add

R T S T S

District Course Add Screen

18. Click Add in the Alternate Codes section to add a row to the section. Alternate codes specify if
the system should include or exclude a course in graduation requirement calculations. The
Order determines the order to process the Alt Types for GPA calculation.

After adding an Alternate Code to any course, you must assign an
A alternate code to every other course included in graduation
requirement calculations, including previously existing courses.

© Verified Credit 1
Technical Provider Course Level CTE Credits Req. CTE Total Duration (Hours) ~ Perkins Funded
- = B Course Discipline Test Group

- &
CTE Gender Type CTE Course Credit Equivalency ID CTE Credit Equivalency

@ Verified Credit 2

Course Discipline Test Group

- &

@ Alternate Codes

ERET e s o

District Course Add Screen

19. Select any additional course options.

See the Synergy SIS — Grading and Course History Administrator
Guide for more information on subject areas, school graduation
requirements, and configuring verfied credit.

20. Click Save.
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Editing Course Data

You can edit most course information directly on the District Course screen. Follow the steps below
to edit data in the top row of the screen.

1. Navigate to Synergy SIS > Course > District Course or Synergy SIS > Schedule >
District Course.

2. Select Edit Course Data from the Menu.

¥ District Course
Menu - < Q > =

|Edit Course Data |

Update School Course Fees
Duplicate Course

View Audit Detail For District Course

District Course Screen, Menu

3. Make any necessary changes to the top row of data.

¥ District Course

Menu= || € | Q. » & Save ™ Undo m

Course ID: HIS201 Course Title: Western Civilization

Course Description Year Qverride Pre/Corequisite Schools Teaching Associated Courses Standards Opt In Options Course Fees
Course 1D Course Title Course Short Title Vandat nacti A ShowIn © History Add
HIS201 Western Civilization W Civ andatory nactive ways owin ourse History
District Course Screen
4. Click Save.
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Adding Equivalent Courses to a Merged Course

1. Navigate to Synergy SIS > Course > District Course or Synergy SIS > Schedule >
District Course.

2. Selectthe Equivalencies tab.

Click Chooser to locate the Course ID or Course Title.

¥ District Course LM CoE -0
Course |D: 00AM Course Title: Kind Am
Course Description Year Override Pre/Corequisite Schools Teaching Associated Courses Standards Opt In Options Course Fees I Equivalencies
Course 1D Course Title Course Short Title X 5
3
00AM Kind Am Kind Am Mandatory Inactive Always Show In Course History Add
® Course Equivalencies .
e camo T e 7|
u- Q0PM $ Kind Pm $
District Course Screen, Equivalencies Tab
4. Click Save.
'

You cannot add Course Equivalencies to a course that is already an
equivalent of another course. You must clear the Merge Course field
in the Other Information section of the Course.

v District Course

<lals =& [ + A |

Course ID: 00AM Course Titie: Kind Am
Course

Course ID
00AM

@ Course Restrictions.

Menu ~

Descripion  YearOveride  PreiCorequisie  Schools Teaching  Associaled Courses  Slandards  OptinOptions  CourseFees  Equivalencies

Course Title
Kind Am

Course Short Title

\and Am Mandatory

Inactive Abways Show In Course Histery Add

Gender Grade Low Grade High

- K - 0z

@ Other Information

0id SIS Course ID Category Code Instructional Level NCLB Core

00AM 261 - ~| | Nota core academic class under NCLB

Ierge Course

District Course Screen
.

Year Overrides

In order to comply with graduation and state requirements, schools can create subject areas,

technical course indications, or additional course attributes that are valid for certain years only.

1. Navigate to Synergy SIS > Course > District Course or Synergy SIS > Schedule >

District Course.

Selectthe Year Override tab.

Click Add in the Course Subject Areas section to add a new row.
a. Enterthe Start and End.

b. Selectthe Subject Area, College Area, and/or University Area.
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4. Click Add in the Alternate Codes section to add a new row.

a. Enterthe Start and End.
b. Selectthe Alt Type and enter the Alt Code.

5. Click Add in the Qualifies for Alt State Funding section to add a new row.
a. Enterthe Year Start and Year End.
b. Selectthe Funding Source.
6. Click Add in the Technical Course section to add a new row.
a. Enterthe Year Start and Year End.
7. Click Add in the Course Content Area section to add a new row.
a. Enterthe Start Year and End Year.
b. Selectthe Code.
¥ District Course L€ &m= CTEEO
Menu- € Q¥ & | Save | *™Undo
Course ID: 5C482 Course Title: Bioloegy
Course Description Pre/Corequisite Schools Teaching Associated Courses Standards
Opl In Optlons Course Fees
Course ID Course Title Course Short Title
e Biology Biology ] Mandatory [ | Inactive
|| Aways Show In Course History Add
@ Course Subject Areas
mmmmmmm-mmmm-mmmm
@ Alternate Codes .
R T S S T S
@ Qualfies for Alt State Funding
Cx e s S e 6 rmsore +
@ Technical Course .
R T = S
® Course Content Area .
R S
District Course Screen, Year Override Tab
8. Click Save.
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Pre/Corequisites

You can add prerequisite and corequisite course information on the District Course screen. You can
also add prerequisite course groups if a course requires more than one prerequisite class.

Prerequisites and prerequisite course groups function with OR logic. For
example, a student is eligible for enroliment in Algebra | by passing the
Pre-Algebra course or fulfilling the Core prerequisite group requirement.

1. Navigate to Synergy SIS > Course > District Course or Synergy SIS > Schedule >
District Course.

Select the Pre/Corequisite tab.

3. Click Add in the Corequisite or Prerequisite sections to select individual courses or click
Chooser to select multiple courses.

v District Course L€ TS ww SCEo

Menu~ € Q  » L PAEVCHIR TG 4+ Add | X Delete

Course |D: 5C492 Course Title: Biology

Course Description Year Override Pre/Corequisite Schools Teaching Associated Courses Standards

i

Op‘ In OpthnS Course Fees
Course ID Course Title Course Short Title D Mandat D | i
andator nactive
sCa02 Biology Biology v

[ Aways Show In Course History Add

@ Corequisites +Add | Chooser
A T E— core e :
n LABO1 & Biology Lab

@ Prerequisite [+75 " Chooser | ¥ show Detail |

Tk e oomen S comeme o mn
nn SC09 8 Science 9 - Any creditable mark -

@® Prerequisite Group + Add | Chooser

K arup e :

® Prerequisite Group Help

Satisfying any one of the prerequisite groups will satisfy the requirement.

District Course Screen, Pre/Corequisite Tab
4. Select a Prerequisite course and click Show Detail.
5. Selectthe Valid Marks for Pre-Requisite. If left blank, the course uses any creditable mark.
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Select Include course history that does not earn credit if the course does not award
credit, but still counts towards prerequisite requirements.

@ Prerequisite 4 Add  Chooser | Wy Hide Detail

mm Prerequisite Course: - Science 8

SC09
L Valid Marks for Pre-Requisite O < &

Fa+ Fla Ela Os+ Fs EB-
COc+Oc Oc-Op+OpOb-
OF Owr@d O1 O20s3
{4 Oo HOs ON

[0 Include course history that does not earn credit

Note: Selection can only be made if a Valid Mark is selected.

District Course Screen, Pre/Corequisite Tab, Prerequisite Detail

Click Save.

Adding Prerequisite Groups

1.

5.

Navigate to Synergy SIS > Course > District Course or Synergy SIS > Schedule >
District Course.

Click Add on the Prerequisite Group section. The Prerequisite Course Group screen opens.

You can also access the Prerequisite Course Group screen from
==t/ the Course module.

Enter the Group Name.

Select the Logic Type. This logic type applies to all courses within the Prerequisite Course
Group.

Prerequisite Course Group

Group Name Logic Type

-

And
Or

Prerequisite Course Group Screen

Click Save. The Prerequisite Course Group screen closes.
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6. Click Add to add a single course to the group or Chooser to add multiple courses.

7 Prerequisite Course Group |z

Menu~ € Q¥ L] « Save | *Undo

Courses

[
o

Group Name Logic Type
HS Sp2 or =
@ Prerequisite | +4Acd  Chooser = Wy Show Detail |

(X | comen _  comeme S W
“ Sp1 Span 1 - Any creditable mark -
“ MS 1S Intro to Span C.B.A

Prerequisite Course Group Screen

7. Select a course and click Show Detail.
8. Selectthe Valid Marks for Pre-Requisite. If left blank, the course uses any creditable mark.

9. SelectInclude course history that does not earn credit if the course does not award
credit but still counts towards prerequisite requirements.

¥ Prerequisite Course Group (e
Menu~ | € Q ¥ o DAETCHIR NI = Add | % Delete
Courses
Group Name Logic Type
HS Sp2 or |~
@ Prerequisite 4+ Add | Chooser WY Hide Detail
m Prerequisite Course: - Intro to Span
sp1 Valid Marks for Pre-Requisite O +
2 MSIS Oa+ Ma Oa-Op+ MeOb-
Oc+¥Mec Oc-Op+OpED-
OF OwrD 01 OzO03
04 Oo Os Ow
Include course history that does not earn credit
Note: Selection can only be made if a Valid Mark is selected.

Prerequisite Course Group Screen, Prerequisite Detail

10. Click Save.
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Schools Teaching

The Schools Teaching tab of the District Course screen is read-only and displays all schools that
offer the course.

¥ District Course ceETo

menu~ || € | Q » | «save  +Undo [E NI IR Y

Course ID: HIS201 Course Title: Western Civilization

Course Description Year Override Pre/Corequisite Schools Teaching Associated Courses Standards Opt In Options

Course Fees

Course ID Course Title Course Short Title

G e — prm— Mandatory Inactive Always Show In Course History Add

@ Schools that teach this course
I
- Hope High School

Kennedy High School
King High School

District Course Screen, Schools Teaching Tab

Standards

The Standards tab of the District Course screen allows schools to align standards to courses.
Select standards by Standards Type, Grade, and Subject. You can weigh specific standards for the
course higher than others and flag them as included in report cards.

1. Navigate to Synergy SIS > Course > District Course or Synergy SIS > Schedule >
District Course.

Select the Standards tab.
Click Chooser.
Enter search criteria to display a list of standards.

ok~ w D

Double-click a standard or hold the Shift key to select multiple standards and click Add
Selected Rows.

Click Select.
SelectInclude in Report Card and enter the Weight if required.

o

¥ District Course
Menu~ | € Q> L + Add | X Delete

Course |ID: §C492 Course Title: Biolegy
Course Description ‘Year Override Pre/Corequisite Schools Teaching Associated Courses Standards Opt In Options Course Fees

Course ID Course Title Course Short Title
Mandatol Inactive Always Show In Course History Add
sc402 Biology Biology g ¥ Y
@ standards -
nm Standard % Include In Report Card 5| Weight % Year Start%
- $.615.00-12 Students know the general structures and functions of DNA, RNA sl
n $.622.00-12 Students know biodiversity is the sum total of different kinds of on ]
n $.637.00-12 Evolution is the result of genetic changes that occur in constantly sl

District Course Screen, Standards Tab

8. Click Save.
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National and State Course Classification

Enter information for course alignment to national and state standards on the District Course
screen.

N o o s~ D=

10.
11.
12.
13.

|| Refer to your state reporting guide to determine if specific values are

required for reporting purposes.

Navigate to Synergy SIS > Course > District Course.

Select the Description tab.

Select the Subject Area under National Course Classification.

Selectthe Course Level.

Select the Course Code.

Enter the Sequence number of the course.
Enter the Available Credit.

v District Course

Course |ID: 5C492 Course Title: Biclogy

Opt In Options Course Fees
Course ID Course Title Course Short Title
SC492 Biology Biology

Always Show In Course History Add

Short Description

Description
Biology

Extended Info

Menu~ € Q P & | Save | *Undo m % Delete

Course Year Override Pre/Corequisite Schools Teaching

E LA T

Associated Courses

Mandatory

Inactive

Standards

@ national Course Classification

Subject Area Course Level

Course Code

Sequence Available Credit

District Course Screen, Description Tab

Select the Subject Area under State Course Classification.

Select the Course Record Type.
Select the Course Content Area.
Select any applicable Course Levels.
Enter the Standard Addressed.

Select Grad Requirement Indicator if the course is part of graduation requirements.
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14. Select End of Course Indicator and End of Course Assessment if this is the last course
in a series.

15. Select IB Indicator if the course meets International Baccalaureate qualifications.
16. Select AP Indicator if the course is for Advanced Placement.
17. Enterthe AP Code, IB Code, and CIP Code if necessary.

18. Select AICE Indicator if the course qualifies as an American Institute for Creative Education
course.

19. Select IGCSE if the course qualifies as an International General Certificate of Secondary
Education course.

20. Select the College information if the course is a college-level course, including College
Course Title and College Course Credits.

@ state Course Classification

Subject Area Course Record Type Course Content Area

- - -

Course Level

[7] B: Basic or remedial course

[C] G: General or regular course

[T] E: Enriched or advanced course

[0 H: Honors course

[7] D: Dual/concurrent enroliment course

[T] A- Articulation agreement course

[T C: Industry/occupational certification course
[T] X: Mot applicable

[CI N: No credit

Standard Addressed
[[] Grad Requirement Indicator

End Of Course Assessment
[C] End Of Course Indicator
[[] 1B Indicator [[] AP Indicator [C] SOL Indicator
AP Code |B Code CIP Code
[C] AICE Indicator [C] IGCSE Indicator
College Code College Course Code College Course Title College Course Credits State Course Code Depariment Code

Class Indicator PosiSecondary Institution

District Course Screen, Description Tab

21. Enter any necessary information for the Civil Rights Data Collection section.
22. Click Chooser to find and select the CTE Programs associated with the course.

@ civil Rights Data Collection

CRDC Subject Area CRDC Course Code
@ Block Scheduling

Course Designation Code O «~ &

@ CTE Programs Chooser

6 el e o me < o e cunr

District Course Screen, Description Tab

23. Click Save.
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School Course Opt-In

Schools must first opt-in to teach District Courses in order to have them available in the School
Courses screen. This also allows you to create sections for scheduling.

Opt In Options

Use the Opt In Options tab on the District Course screen to select the type of schools allowed to
opt-in to the course. You can include or exclude individual schools.

Navigate to Synergy SIS > Course > District Course.

Select the Opt In Options tab.

Select all School Types Allowed to Opt In for this Course.

Click Chooser in the Opt In Types section to select individual schools.

o kw0 Dd =

Select the Include/Exclude option.

v District Course « cEFTO

Menu- | € | Q | » &  Ssave  *Undo m

Course ID: HIS201 Course Title: Western Civilization

Course Description YYear Override Pre/Corequisite Schools Teaching Associated Courses standards Opt In Options

Course Fees

Course ID Course Title Course Short Title

e e —— ED Mandatory Inactive Always Show In Course History Add

@ School Types
School Types Allowed to Opt In for this Course O + &

[C] Elementary School [#] High School [[] Middle School [[] Special School

@ Opt In Types Choaoser

“m School Name = Include J Exclude =
n Continuation High School

N

Exclude -

Exclude
Include

District Course Screen, Opt In Options Tab
6. Click Save.
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School Course Opt-In

Each school must opt-in to a course to offer it. Schools automatically offer any course marked
mandatory by the district.

1. Ensure that the school in focus is correct.

Admin User (Show Active Only)

@ SX Qg[?y 2020-2021 Hope High School

RELEELTS # Lok Signowt Support >

Synergy Home Screen

2. Navigate to Synergy SIS > Course > School Course Opt-In or Synergy SIS >
Schedule > School Course Opt-In.

3. Select the search criteria to find courses, such as the Subject Area, Course ID, Course
Short Title, etc.

Click Search.
5. Select Opt In on the row to enable the course for the school.

School Course Opt-In

Menu~ || Remove Unused Opt-In Courses L] + Save | *yUndo

School Name: Hope High School School Year: 2016-2017
Course Opt In

Subject Area Course ID Course Short Title Course Title Short Description
- Search

® Search Results

| courselD | Course Short Title Course Title Short Description

Subject Area

Science Required LABO1 Biology Lab
Science Required PP46 Biology Biology
Science Required PP79 Science Science
] Science Reqguired SCo3C1 Science Science
] Science Reguired sSCo3c2 Science Science

School Course Opt-In Screen

6. Click Save.
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Remove Unused Opt-In Courses

At the end of the year, you can remove courses from displaying in the list if they have no scheduled
students.

This process removes the Opt In option for any selected courses for the
school and school year in focus.

1. Click Remove Unused Opt-In Courses.
v School Course Opt-In «ccEe
Menu - I Remove Unused Opi-In Courses I & | #save | +Undo
School Name: Hope High Schoel School Year: 2015-2016
Course Optin
Subject Area Course ID Course Short Title Course Title Short Description
- ESear:ha
© search Results
[ine omn | swmecm | coumen | comesnenmie  counems  swonpescrpuen |
n B ‘World History Geography cecss21 Corres Wid St Corres Wid St |
n ] World History Geography ccss22 Corres Wid St 2 Corres Wid St 2
School Course Opt-In Screen

2. Click Yes to confirm removal.

Confirm

The following process will remove 392 opt-in courses in Hope High School for the school year 2015. Are you sure you want to continue?
Press YES to continue or NO to cancel

Confirmation Message
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Managing School Courses

The School Course screen in the Course module lists all courses opted-in to at the school for the
specified school year. The majority of the screen is read-only, but you can change the class size in

the Scheduling Options section.
1. Navigate to Synergy SIS > Course > School Course.

2. Locate the course to modify.
3. Setthe Optimum Size and Maximum Size for sections of the course.

97

SC492

@ Scheduling Options

Biology

v School Course « ¥ e
Menu~ € Q¥ & | Save | *Undo
School Course Description School Course Fees
Course ID Course Title Course Short Title Course Duration Credit

Biology

Optimum Size

Maximum Size

S2

~| |0.500

@ Current Section List Iy Show Detail

"Line_section 1D & st Name __ Term Gods & Room Number & Begin Perod & End Parios & Totalstudents Opan sexts
52 5 5 20 a8

0005 Tofft, Robert 150

| B

4. Click Save.

Tofft, Robert 52 120 6 6 23 5

Worsnop, William 52 124 2 2 22 6

School Course Screen

Add Linked Courses

Course linking creates a relationship between two courses. For example, you can create a link
between alab course and a lecture course or between a prerequisite and another course.

E You can only link courses opted-in to at the school.

1. Navigate to Synergy SIS > Course > School Course.
2. Click Add in the Linked Courses section.
3. Enter the search criteria to locate the course(s) to link.
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¥ School Course CCce%e
Menu- | € | Q| » | & ¢save  +Undo
School Course Description School Course Fees

Course ID Course Title Course Short Title Course Duration Credit

8C492 Biology Biology 82 ~ 0500
@ Scheduling Options

Optimum Size Maximum Size
@ Current Section List Iy Show Detail
@ Linked Courses
ER T R o e :
“ 1 RS Biology Lab
School Course Screen

5. Click Save.

Managing School Rooms

Schools assign course sections to rooms to determine schedule availability and class size. You must
configure school rooms before creating the school schedule.

1. Navigate to Synergy SIS > System > Setup > School Room.

2. Click Add to add a new line.
3. Enterthe Room Name.
4. Enterthe Class Size. This is the total number of students that can attend a class.
5. Enterthe current School Year.
6. Selectthe Department and Room Type if applicable.
You can also use Department and Room Type information for
ClassBoard and Master Schedule Builder. See ClassBoard
Overview for more information on ClassBoard.
7 School Room I
Menu~ | ¥ | « Save | * Undo
School: Hope High School School Year: 2014-2015
Room
® Room
R
“n 101 28 2014 -~ -
“ 102 23 2014 -~ -
“ 103 30 2014 -~ -
“n 104 32 2014 -~ -
106 22 2014 -~ -
School Room Screen
7. Click Save.
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The College Credit option allows staff to indicate students that receive post-secondary credit for a
course in reports. You can set college credit at either the section level or student level.

Enabling College Credit

1. Navigate to Synergy SIS > System > Setup > School Setup.

2. Select Enable College Credit in the Other Info section.

School Setup

Menu~ | o + Save

* Undo

School Name: Hope High School School Year: 2016-2017

Basic Info Options SIS Data Options Labels

@ Other Info

[T Exclude from State Reporting
[Z] Report Sub Schools
Enable Subject Area Override

Enable College Area Override

TeacherVUE Mobile Apps

Validate Student Classes

-

School Hours Per Week  Special Ed "Bell to Bell" Hours Per Week

Scheduling Options
Traditional Schedule Tracking (Default) -

3. Click Save.

School Setup Screen

Setting College Credit for Sections

1. Navigate to Synergy SIS > Schedule > Section.

2. Locate the section to modify.

3. Select R: Receiving or E: Eligible in the College Credit field in the Students section.

¥ Section
¢ Q » &

Menu -

Current Students Student Enroliment History

nn Acevedo, Andrew

CAEUCIIR ML 4= Add | X Delete

Section ID° 000001469 Course Tifle: Am Govt School Year: 2016-2017

Meeting Days

Adams, Ronald | & | | 216 &

Section ID Course ID Course Title Staff Name
000001469 55851 |& | | Am Govt
@ students

Resolved
RaoeJEmmcm

CCELe

Additional Staff Staff History

Room Mame

Chooser

. College

Leave Date % # Teacher Aide 3

Credit

3. Click Save.

886630 Hispanic 01/27/2017 i@ i - ] =
n. Arvanitas, Christina T. 892706 Vnie 12 07/05/2016 @& =] - ] ]
Section Screen
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Setting College Credit for Students

Navigate to Synergy SIS > Student > Student.
Locate the student to modify.
Select the Classes tab.

L=

Select R: Receiving or E: Eligible in the College Credit field in the Class Schedule section.

Attendance Code’ Tdy ~ Period- 0 (7:00 AM - 3:30 PM) Room 216 Section ID° 1077 Course Title: Am Govt Staff Name' Jackson, Kathy (1069)
- Tardy

@ Class Schedule + Add

PEﬂDdS
Line Term Code Course Title Enter Date
= ~m

Chooser | Actions =

Leave Date

¥ Student n gL -e
Meu~ A [ ¢ Q|3 (& vsae wund BETAEE ® A
Student Name: Abbott, Billy C. School: Hope High Schoel Homeroom: 403 Teacher: Andrews, M.

Demographics ~ Parent/Guardian  Otherinfo  Emergency  Enrolment  Enroliment History Documents  Contact Log

Notes
Last Name First Name Middle Name  Suffix ~ PermID State ID Grade Gender Language Spoken at Home
Abbott Billy C 905483 0001341311 12 - |Male ~  English -
@ Current Class

0077 5561 Am Govt 09 12  07/04/2017 & 11/24/2017 &
0 0o s 0840 SC49 Science 10 121 09 12 11/24/2017 & 1172412017 @
0 0 82 1077 5851 Am Gowvt 216 09 12 113012017 & 01/09/2018 @
1 1 51 0106 ARS4 Beg Jewelry 403 10 12 07/04/2017 & 1212212017 @

Oooo

Student Screen, Classes Tab

5. Click Save.
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You can create a history of State Course Codes for a course on the Year Override tab of the District
Course screen. You can choose to enter the codes manually or select the codes from a dropdown

field associated with a lookup table.

Showing State Course Codes as a Lookup Value

1. Navigate to Synergy SIS > System > Setup > District Setup.

2. Selectthe System tab.

3. Select Show State Course Code As Lookup in the Course Options section.

Menu~ | o

District Setup
Options Grade Setup TeacherVUE Labels  Auto-Sequence Reports
Concurrent Options Accessibility Color Themes

@ Course Options

Course 1D Print Width

[Z] Use Course Short Title
@ Explain Use Course Short Title

Enable Subject Area Override
Enable College Area Override
Enable University Area Override

[Tl Use Course Title Override

© Explain Use Course Title Override

[T] show Course History Mark As Lookup
[£] Copy Serving School from Section to District/Non-District School on Course History
| Show State Course Cede As Lookup |

[C] Allow Multiple AP Codes On District Course

District Setup CLehnee )

S CES -0

District Setup Screen, System Tab
4. Click Save.
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Adding State Course Codes

Navigate to Synergy SIS > Course > District Course.
Locate the course to modify.

Select the Year Override tab.

Click Add in the Sate Course Code section.

Enter the Year Start.

Enter or select the State Course Code.

7. Click Save.

IR

The following example displays the State Course Code field as a manual entry field.

v District Course CLESueRTLE S0

Menu~ € Q » & + Add || % Delete

Course ID: $C492 Course Title: Biology

Course Description Pre/Corequisite Schools Teaching Associaled Courses Standards Opt In Options

Course Fees

Course ID Course Title Course Short Title

SCa92 T Biology [l Mandatory [ Inactive [ | Always Show In Course History Add

® Course Subject Areas + Add

s $| eno & 1 82808/ ss[s8 1824 35 4sls 18 2834 a0

@ Attemate Codes + Add

® Qualifies for Alt State Funding + Add
@ Technical Course + Add
® Course Content Area + Add

® stateCourseCode + Add

m Year Start Year End = State Course Code =
IR - = B
L

District Course Screen, Year Override Tab
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The following example displays the State Course Code field as a lookup value.

o7 = ;

v DiStriCt Course Audio/Video Technology and Film-Other m -& e |'l'| % % E E se e -9
Menu = <€ Q > o Audio/Video Technology and Film-Workplace Experien =

Audio/Visual Production

Course ID: $C492 Course Title: E Automotive Body Repair and Refinishing-Comprehensi

Course Description Automotive Body Repair and Refinishing-General Associated Courses standards Opt In Options
Course Fees Automotive Detailing and Reconditioning
Automotive Detailing and Reconditioning
Course ID Course Titlg " ) ]
ac40o Biology Automotive Mechanics-Comprehensive dandatory [ Inactive [ | Always Show In Course History Add

Automotive Mechanics-Comprehensive
Automotive Service
© Course SubjectAreas | H atomotive Service

Aviation
Balto-Slavic Language Conversation and Culture
© Alternate Codes +Add Balto-Slavic Language Field Experience
Balto-Slavic Language for Native Speakers
nm Balto-Slavic Language |
Balto-Slavic Language I

; | Balto-Slavic Language Il
@ Qualfies for Alt State Fundin )
Balto-Slavic Language IV

m \/+| Balto-Slavic Language V

Balto-Slavic Language-Other
Balto-Slavic Literature

S04 asls s 18233 sas]53

Alt Code =

Funding Source

@ Technical Course + Add
Banking

Banking and Finance

@ Course Content A Barbering
urse ntent Area
Barge and Boat Operation

Basic Math

BASIC Programming
© Stale Course Code | 444 i ayils (Title 1)

n Basic Skills (Title ) ate Course Code
Bible History
- 2017 Bible History Biology f
Biblical Literature
Biology i

Year End

District Course Screen, Year Override Tab
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Assigning Teacher Aides
Schools use one of two methods in assigning teacher aides to courses. You can create a single

Teacher Aide course and assign all aides to the course or assign students to existing sections and
flag them as teacher aides.

Creating a Teacher Aide Course

If schools allow students to be teacher aides, creating a generic Teacher Aide course prevents the
creation of duplicate sections for each course with a teacher aide. This course also records
participation for the student’s grading record and course history.

1. Navigate to Synergy SIS > Course > District Course.
a. Click Add. The District Course (Add) screen opens.
b. Enter the appropriate course information.
c. Select Teacher Aide.

District Course
Course
Course ID Course Title* Course Short Title
Enter [ Mandatory [J Inactive [J Always Show In Course History Add
@ Course Info
Course Duration” Department* College Prep ~ Credit* Max Credit* Post Secondary Credit Override Course History Type  Quality Points
= = O
Alpha Numeric Setting (Default to Alpha)
(m]
Academic Type O Teacher Aide [ Extended Day
- [J College Approved [ Distance Learning Course
[ Pass/Fail Only O Online Course
[J Dual Credit O Allow School Course Title Override
0 Tite | [ Jobs for American Graduates Program
O Credit Recovery [ Postsecondary Articulated Course
Dual Language Instruction Type Language OT Instruction
District Course (Add) Screen

2. Opt-in to the course using the School Course Opt-In screen.

E See School Course Opt-In for more information.
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3. Navigate to Synergy SIS > Mass Scheduling > Setup > School Setup.

a. Select the created course by clicking the *5? icon in the Generic Teacher Aide Course

section.
b. Selectthe Credit Given.

« Fixed Credit Value — Awards a fixed credit amount. Enter the amount under

Credit.

105

o From Section Credit— Awards the same amount of credit assigned to the section

that the student participates as a teacher’s aide for.

Only select this option if you add teacher aides to

existing sections, not when creating a separate course

for teacher aides.

« Percent of Section Credit— Awards a percentage of the section credit. Enter the

percent amount in the Percent field.

School Setup
Menu~ « Save | *Undo
School Mame: Hope High School School Year. 2016-2017
Basic Info Options SIS Data Options Labels TeacherVUE Mobile Apps
@ Generic Teacher Aide Course

Course ID  Course Title Credit Given Credit
TAQ99 | & | Teacher Aide & |Fixed Credit Value ~ 0.00

[l

U4 O

School Setup Screen
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4. Navigate to Synergy SIS > Schedule > Section.
a. Create a section under the Teacher Aide course.

b. Click Chooser in the Students section to find and select students to add to the section.
c. Click Save.

The Course ID and Course Name display as the generic teacher aide course within the
Student Classes, Student Grades, and Student Course History screens.

This is only for teacher aides for courses. You must create separate
courses for other types of aides, such as office aides, that are not
associated with another course.

7 Student Classes &0
Menu - L ' Save | *Undo

Student Name: Aguado, Karen C. School: Hope High School Status: Active Homeroom: 209

Current Classes Class Enrollment History Schedule Based FTE
Last Name First Name Middle Name  Suffix Perm ID Grade
Aguado Karen Cervantes 135319 12 -

© Drop Class, Filter and Override Options

@ current Class Schedule + Add | Chooser

Fenod Overri
Meetm L ave|

Line, Term Course Title g Enter Date College Credit | Subje:

@ M Area

1048 MA302 Geometry MWFTR P-14 07/05/2016

]
o 0 S 0048 MA30 Geometry MWFTR P14 00 09 07/05:2016 & - A
3 U 1 s2 1991 NC402 Pers Rel Time MWFTR SEM 10 12 07/05/2016 @ - ]
n1 1 S1 0991 NC401 Pers Rel Time MWFTR SEM 10 12 07/05/2016 & - ]
_51 1 82 6007  TA900 | TeacherAide  MWFTR 09 12 | 04102017 BB - [a]
Student Classes Screen
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Adding Teacher Aides to Sections

107

You can also add a student as a teacher aide to existing sections without using a separate course.
1.

Navigate to Synergy SIS > Schedule > Section.

2. Locate the section to modify.

3. Enter the Max seats under the Teacher Aide Seats section.

v Section cuLe

Menu- € Q » L] « Save | *yUndo

Section ID: 000000123 Course Title: Academic Decath School Year: 2016-2017
Current Students Student Enroliment History Meeting Days Additional Staff Staff History

Section ID Course ID Course Title Staff Name Room Name
000000123 ADSEW & | |Academic Decath | | Arthur A Andrea | & 3
@ Section Info @ sStudent Seat Totals
Begin Period End Period Term Code ]  Prohibit assigning additional students once the Max is reached,
2 ~||2 ~| |82 - regardiess of class size limit rules in School Scheduling Options.
Attendance Option Grading Option Attendance Type  Male Female  Totals Max Open Seats
Include in Attendance |~ | Include in Grading ~ Regular - A2 2 15 19 4

Supplemental Funding Category

-

@ Teacher Aide Seats

Instructional Minutes Override

[0 Using Elementary Minutes Total Maix Open Seats
[} 1 1
Section Record Type
Section Screen

4. Click Chooser in the Students section to locate a student acting as a teacher aide.

5. Select Teacher Aide. This removes the student from the section seat totals.

@ Students

| Chooser |

Resclved College . .

ine Student Name Enter Date Leave Date + Teacher Aide ¥ Audi
n._m Race/Ethnicity ¥ m-- credit ~ 7|

n. Abbott, Billy C 905483 Hispanic 01/26/2017 & &
n. (Abbott, Bobby C_) 169523 White 10 03/22/2017 & & - ]
n (Acosla, Eugene A) 873021 Hispanic 12 1/18/2016 @ & - ]
nn Adams, Albert L 880844 White 1 021712017 i@ =] - 0
n Adams, Howard T. 873085 White 12 11M8/2016 & & - 0
Section Screen
6. Click Save.
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Class Options

Concurrent Classes

You can set up the option to view all classes for concurrently enrolled students within the District
Setup screen. Concurrent School Data allows Synergy SIS to display a second, read-only class
section for the concurrent school on the Classes tab of the Student screen and on the Student
Classes screen of the Schedule module. STU202 — Student Schedule report also prints this
information.

7 Student n P

Menu~ € Q> L_ BRI NG 4 Add | X Delete

Student Name: Abbott, Billy C. School Hope High School Homeroom:  Teacher Arthur A., A.
Demographics ~ ParentGuardian  Otnerinfo  Emergency  Enrollment  Enroliment History Documents  Contact Log

Q
G
S e

Notes Protected Information
Last Name First Name Middle Name ~ Suffix ~ Perm D Grade
Abbott Billy Cc 005483 12 -

@ Drop Class and Filter Options

@ Class Schedule + Add | Chooser 5

@ Filter Options

(@ Class Schedule For Kennedy High School

o e T e oo S o

1300  AR34  Adv Photo Benitez, Steven 415 10 12  01/30/2017 1 30 29
9 e & 0010 EN101  Comm Coll En101 Swartz, Kimberly COUN 11 12 10/03/2016 8 50 42

Student Screen, Classes Tab

5 e}
v Student Classes ¢ zele
Menu~ || € | Q | » 4 save | *+Undo @®
Student Name: Abbott, Billy C. School: Hope High School Status: Active Homeroom:
Current Classes Class Enrolment History Schedule Based FTE

Last Name First Name Middle Name  Suffix ~ Perm ID Grade

Abbott Billy C 905483 12 -
@ Drop Class, Filter and Override Options
@ Current Class Schedule + Add | Chooser

@ Filter Options

@ Class Schedule For Kennedy High School

Pen S Enter |Leave|
lne Term Code Course Title Teacher Aide

1300 AR34  Adv Photo Benitez, Steven 415 10 12 01/30/2017 1 30 29
ng 9 3 0010 EN101 Comm Coll En101 Swartz, Kimberly COUN 11 12 10/03/2016 8 50 42
Student Classes Screen

Navigate to Synergy SIS > System > Setup > District Setup.

Select the Concurrent Options tab.

Select Yesfor Concurrent School Data in the Viewing Options section.
Select Yesfor Show Concurrent Attendance.

A ow DN =
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5. Select Yesfor Show Concurrent Classes.

~ e

District Setup «Ceme
Menu~ | o + Save | % Undo

District Setup
Options System Grade Setup TeachervUE Labels Auto-Sequence Reports Waivers Mobile Apps Concurrent Options

Accessibility Color Themes

@ Viewing Options

Home School Data Concurrent School Data
Yes - | Yes -

@ Display Options

Show Concurrent Attendance
Yes -
Show Concurrent Classes

Yes -

T7] Display Additional Warning Message on Concurrent Student Enroliment

District Setup Screen, Concurrent Options Tab

6. Click Save.

Audit Classes

Schools can allow students to take a class without receiving course credit or having a grade count
towards their GPA. After enabling auditing, an indicator displays if a student has an audited class on
the Student Classes, Student, Student Course History, and Section screens. The class displays as
audited in all reports and transcripts.

1. Navigate to Synergy SIS > System > Setup > District Setup.

2. Selectthe System tab.

3. Select Allow student classes to be flagged as audited in the the Audit Class Options
section.

4. Enter the Audit Symbol used on reports to distinguish audited classes. This can be a
maximum of four characters.

5. Selectthe Show Audit Symbol After location to determine where the audit symbol displays.

District Setup e e
Menu ~ L] + Save | *yUndo

District Setup
Options Grade Setup  TeacherVUE  Labels  Auto-Sequence  Reports  Waivers  Mobile Apps
Concurrent Options Accessibility Color Themes
@ Audit Class Options
Allow student classes to be flagged as audited
The following options determine how audited classes should be displayed in reports:

Audit Symbol Show Audit Symbol After
* Course ID -

District Setup Screen, System Tab

6. Click Save.
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Class Size Limit Override

Schools configure the maximum number of seats in a class through the Mass Scheduling module or
when creating sections. Schools can extend these limits when necessary, such as when counselors
add students to a class before withdrawing other students during schedule configuration.

The below settings apply to the entire district. To enable class size limit
==l overrides at the school level, see School Scheduling Options.

1. Navigate to Synergy SIS > System > Setup > District Setup.

2. Selectthe System tab.
3. Select Allow Negative Seat Totals in the the Other Options section.

District Setup

Menuv | o | | Save | *Undo

District Setup

Options Grade Setup TeacherVUE Labels Auto-Sequence Reports Waivers Mobile Apps

Concurrent Options Accessibility Color Themes

@ Other Options
District Group History Filter

Discipline Type Incident Violation Display
Incident - Entire Violation - -
Student Notification Badge Number Update Type [C] Allow Enroliment in Multiple GATE Programs
lcon - Genesis update of badge number -
[”] Disable Unigue State Number Adult ID Update Type
I Allow Negative Seat Totals I Auto Generate v
Enable Announcement Dismissal Fee Total Type
Include fees for all organizations and all
years
District Setup Screen, System Tab
4. Click Save.
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User/User Group Class Size Limit Overrides

You can allow specific users or user groups to override class size limits, such as registrars.
1. Navigate to Synergy SIS > System > User > User or User Groups.
2. Selectthe Security Settings tab.

3. Selectthe Allow Override of Max Students in Class option under the Scheduling section.

« Add Student, No Message — No warning message displays when adding students to a
full class.

« Add Student, with Message — A warning displays when adding students to a full class.
« Don’t Add Student —You cannot add students to a full class.

« Require Password—You must enter a password to proceed with adding a student.

See School Scheduling Options for instructions on setting the
==l override password.

¥ User .

Menu~ € Q ¥ L] PEEVCHIR NG 4 Add | % Delete

User Name: Adams, Ronald

Demographics Organizations User Groups Navigation Menu Security Seftings Focus Spell Check POV

0
Q
Be
)

Last Name First Name Middle Name Disabled User Type u
s User

Adams Ronald Staff i
@ Discipline @ Conference

Discipline Security Discipline Organization Security Conference Visitation
@ Impersonation @ Student Enroliment History

[C] Cannot be Impersonated Student Enroliment Organization Security
@ Health Options Student Enroliment Year Security
Display Health Comments T
Display Documents @ Needs / Programs

Needs / Programs Security

-

@ Scheduling @ Special Education

IA\Iow Override of Max Students in Class Require Password - I Exempt From Student Team

=

User Screen, Security Settings Tab

4. Click Save.
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Section Lock

The system locks sections by default once a term starts. You can disable this feature on the District
Setup screen.

Edupoint does not recommend disabling section locking. Disabling this
feature may damage section data and produce duplications or errors
when running the Update Grades and Update Course History processes.

1. Navigate to Synergy SIS > System > Setup > District Setup.
2. Selectthe System tab.
3. Selectthe Section Locking Options in the Other Options section.

Lock Section—No changes allowed. This is the default option.

Do Not Lock Section, Do Not Display Warning Message — Sections not locked and no
warning displays when making changes

Lock Course ID after Section is Created — After creating a section, the Course ID is
locked for any existing sections of a course and all future sections. This also locks the
Course ID on the District Course screen.

Lock Section When Grades Taken — Locks sections after grades are updated for that
section and grading period. The following key elements are locked down on section
data for any student in a section that has Update Grade processed while this option is
selected: Section ID, Term Code, Course ID/Title, Begin Period, End Period, and
Meeting Days.

Do Not Lock Section, Display Warning Message — Sections do not lock, but a warning
displays before saving changes.

District Setup «ceEe
Menu~ | d | | & Save | * Undo
District Setup
Options Grade Setup TeacherVUE Labels Auto-Sequence Reports Waivers Mobile Apps
Concurrent Options Accessibility Color Themes
@ Other Options E
Discipline Type Incident Violation Display District Group History Filter
Incident - Entire Violation - -
Student Nofification Badge Number Update Type [T1 Allow Enrollment in Multiple GATE Programs
lcon - Genesis update of badge number | L
[7] Disable Unigue State Number Adult ID Update Type
Allow Negative Seat Totals Auto Generate -
Enable Announcement Dismissal Fee Total Type
Include fees for all organizations and all
years
Enable historical tracking of staff in sections
Section Locking Options
Do Not Lock Section, Do Not Display Warning Message | ~

District Setup Screen, System Tab

4. Click Save.
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Meeting Day Lock

Synergy allows you to override a section’s meeting days when updating the beginning and ending
periods for a section.

1. Navigate to Synergy SIS > System > Setup > District Setup.
2. Selectthe System tab.

3. Selectthe Section Periods Options in the Other Options section.

« Override Periods in Meeting Days Tab and Do Not Display Warning Message — Allows
you to update period information without displaying a warning.

« Override Periods in Meeting Days Tab and Display Warning Message — Allows you to
update period information, but a warning displays.

« Do Not Override Periods in Meeting Days Tab — Does not allow period modification.

District Setup e

~

Menu~ | | M | |+ Save | *Undo

District Setup

Options Grade Setup TeacherVUE Labels Auto-Sequence Reports Waivers Mobile Apps
Concurrent Options Accessibility Color Themes

@ Other Options

Discipline Type Incident Violation Display District Group History Filter

Incident - Entire Violation - -
Student Notification Badge Number Update Type [T] Allow Enroliment in Multiple GATE Programs

Icon - Genesis update of badge number | =

[T] Disable Unique State Number Adult ID Update Type

Allow Negative Seat Totals Auto Generate -

Enable Announcement Dismissal Fee Total Type

Include fees for all organizations and all
years

Enable historical tracking of staff in sections

Section Locking Options
Do Not Lock Section, Do Mot Display Warning Message

Section Periods Options
Override Periods in Meeting Days Tab And Do Not Display Warning Message |«

District Setup Screen, System Tab
4. Click Save.
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Managing Course Groups

Use Course Groups to group sets of courses together for organization purposes. This allows you to
identify scheduling conflicts for the course group on the OSM801 — Course Request Conflict Matrix
report.

1. Navigate to Synergy SIS > Course > Course Group.
2. Click Add to open the Course Group (Add) screen.
3. Enter the Name of the new group.

Course Group

Name

Course Group (Add) Screen
4. Click Save.
5. Click Chooser to find and select school courses for the group.

¥ Course Group e

Menu~ | € | Q| ¥ | & | «Save | *Undo

School Mame: Hope High School School Year: 2014-2015
Courses Description

Name
9th Grade Core

@ Group Courses
i, S R L EEE—
n 1 Dl Algebra |

n PO oo World Hisigeog

nEMS1 Fund Eng |

n 4 [BeIH Life Science

Course Group Screen

6. Click Save.
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Course Wheels

Course Wheels define sets of courses to schedule during the same year. For example, if Algebra Il is
a required course for sophomores, the wheel includes both the first and second semester courses.
Schools also configure wheels to schedule a group of electives for all students of a specific grade.
You can assign sections to course wheels through either the mass scheduling or manual scheduling

process.

Creating Wheel Definitions

1. Navigate to Synergy SIS > Scheduling > Setup > Wheel Definition or Synergy SIS >
Mass Scheduling > Setup > Wheel Definition.

2. Click Add to open the Wheel Definition (Add) screen.
3. Enterthe Wheel ID and a description for the Name.

Wheel Definition

Wheel ID Name
GRD9 Grade 9 Electives

Wheel Definition Add Screen

4. Click Save.
5. Click Chooser in the Course Grid to find and select courses for the wheel.
7 Wheel Definition @ e
Menu~ € Q¥ L]  Save | *y Undo m
School: Hope High School School Year: 2016-2017
Courses DE!SCI’IptIDH
Wheel ID Name
GRD9 Grade 9 Electives
® Course Grid
(% e e e
“ ARB3 Beg Drawing
n 2 CB11 Computer Apps
“ EN73 Speech
“n F343 Food Science |

Wheel Definition Screen

6. Click Save.
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Mass Scheduling Course Wheels

The Option Set Wheel screen defines sections assigned to courses in each wheel definition. This
screen only applies to the associated Option Set.

E See Overview of Option Sets for more information on option sets.

1. Navigate to Synergy SIS > Mass Scheduling > Schedule Control.
2. Open the option set.

[$]
Q
]
2]

Schedule Control «
Menu~ | ok + Save | * Undo

School- Hope High Schoel Year 2016-2017
Scheduling Option Sets

Create/Copy Option Set

Checked Out
Option Set Name -
To Total ¥ |Scheduled ¥ Date/Ti

I3
Scheduler User, Admin 1.37% 2764 38 04/05/2017

@ Option Sets

Scheduler - User, Admin
Scheduler - User, Admin  99.23% 2742 2721

Copy of last year's schedule Master Schedule Builder + User, Admin % 2750 002/01/2017

Schedule Control Screen

3. Select Open Option Set Wheel under Quick Links.
v Schedule Option Set | g

School: Hope High School

Menuv | € | Q| » | | save mUndo [RAVEEES

Run Name: 2016-2017 Schedule Run In Progress: No

Options Fill Open Periods

Currently Checked Qut To

Check I
User, Admin een
@ Last Schedule Run @ Current Stats
Date/Time Total Scheduled Rejected Optimized % Total Time Total Scheduled Rejected %
04/05/2017 12:36:48 | @ 2764 38 2726 0 | 1.37% | 00:00:38 2764 38 2726| | 1.37%
@ Basic Information ® Quick Links

Run Name | 2016-2017 Open Student Schedule

i

Schedule Now
Allow unchecked out users to edit sections

s

Open Schedule

Run Description
Section

Open School Options

Term to Reschedule: If blank, scheduling entire year Open Option Set Wheel

Open ClassBoard

alle)]o-

Schedule Option Set Screen

4. Locate the definition to modify.
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5. Click Add to add a row.

7 Option Set Wheel < cee

Run Name: 2016-2017
Menu~ € Q| > | & sSave | ®Undo

Wheel ID: GRD8 Name: Grade 8 Electives School: Hope High School Year 2016-2017

Options
Wheel ID MName
GRD9 Grade 9 Electives
® Option Grid Iy Show Detail

n Option Name

.

Option Set Wheel Screen
6. Enter an Option Name used to define the courses.
7. Click Save.

8. Click Show Detail. The courses associated with the wheel display.

7 Option Set Wheel < cee

Run Mame: 2016-2017
Menuw € Q| P | L] + Save | *Undo

Wheel ID: GRD8 Name: Grade 8 Electives School: Hope High School Year: 2016-2017

Options
Wheel ID Name
GRD9 Grade 9 Electives
® option Grid + Add

Option Name
Peroa

Period 2

- Period 3

Option Set Wheel Screen
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9. Clickthe i'-"? under Section ID to find and select sections.

T Option Set Wheel | Ced
Run Name: 2016-2017
Menu~ € Q¥ & | | «Save | *Undo
Wheel ID: GRD9 Name: Grade 9 Electives School: Hope High School Year: 2016-2017
Options
Wheel ID MName
GRD9 Grade 9 Electives
@ Option Grid + Add | WY Hide Detail
COERUELE Run Name: 2016-2017
1 Period 1 Option Detail
=2 Period 2 ® Option Section Grid
=8 Period 3 Course Title Section ID
ARB3 Beg Drawing &
A CB11 Computer Apps &
3 IEE Speech &
n FS43 Food Science | &
Option Set Wheel Screen, Option Grid Detail
10. Click Save.

Manual Scheduling Course Wheels

This process associates sections with the courses defined in a wheel.

-_—

Navigate to Synergy SIS > Schedule > Setup > Walk-In Scheduling Wheel Def.

2. Locate the wheel to modify.

3. Click Add to add a new line.

4. Enter the Option Name. You can define multiple sets of sections as options for each wheel.

v Walk-In Scheduling Wheel Def < ze

Menu~ € Q| » o Save  ®Undo

K

Wheel ID: GRD® Name: Grade 9 Electives School: Hope High Scheol Year: 2018-2017

Options
Wheel ID Name
GRD9 Grade 9 Electives
® Option Grid + Add | Wy Show Detail

ERRN -

Walk-In Wheel Scheduling Wheel Def Screen
5. Click Save.
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6. Click Show Detail. The courses associated in the wheel display.

7. Click the *E? under Section ID to find and select sections.

v Walk-In Scheduling Wheel Def ACLEene L& CcR

=l
Menu= € Q 3 & | | save || 4 Undc

Wheel ID: GRD9 Name: Grade 9 Electives School: Hope High Scheel Year: 2017-2018

Options
Wheel ID Name
GRD9 Grade 9 Electives

@® Option Grid +Add | WY Hide Detail |
m Option Name Option Detail

i [FErEE ® Option Section Grid
(ne  Cowsed | CouseName | SectonD
1 MU71 Chorus | Beg &
PA ARG3 Beg Drawing &
MU29 Beg Guitar &
“ ARS54 Beg Jewelry g
[ AR32 Beg Photo &
n CB10 Comp Foundation &
Walk-in Scheduling Wheel Def Screen, Option Grid Detail
8. Click Save.
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Houses and Teams Overview

Schools use houses and teams to assign groups of students to the same sections or to keep sections
assigned to the same teacher or period. Houses group students together so that you can schedule
them into the same sections. Common houses for students include ROTC members, sports team
members, and students with AP academic schedules. Teams assign sections to the same teacher,
room, or period throughout the academic year. For example, you can use teams to keep a Biology
class and a Biology Lab class together with the same teacher and classroom throughout the school
year.

House and Team Assignment

Houses and teams remain consistent throughout the school year and must retain the same number
of sections and seats.

You can mass assign students through the Mass Assign House and Team screen in the Mass
Scheduling module. The Schedule Request and Walk In Schedule screens within the same module
assign individual students to houses or teams. After assigning students, staff can assign course
requests to students in bulk using these groups.

[ You must assign all sections flagged for a house to members of the same ]
house.

Option sets contain rules for processing house and team assignments. The system assigns students
to a team based on availability and schedules any unassigned students into the first team available
for their schedule. If the system rejects an assignment, check the following:

« The seat count max total is not even for all sections within a team, or you have scheduled all
available spaces within a section.

» Sections are not evenly distributed, you have not defined teams correctly, or you have not
defined teams evenly by teacher, room, or period.

Synergy SIS allows students scheduled in one section for a team only if
other sections are unavailable for the course within the team, or if you did
not create sections evenly for all courses within the team.

Creating Houses and Teams

Schools define houses and teams within the School Scheduling Options screen.

Creating a House

1. Navigate to Synergy SIS > Mass Scheduling > Setup > School Scheduling Options or
Synergy SIS > System > Setup > School Scheduling Options.

2. Selectthe House/Team/Exclusion tab.
3. Click Add on the House Codes section to add a new row.
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4. Enter a Code to designate the house.
5. Enter aDescription.

School Scheduling Options ‘

Menu~- | | M | | o Save | 4y Undo

[§)
G
7]
)

School Name: Hope High School School Year: 2016-2017
Section Options Course Request and Walk-In Options

@ Term Exclusion Codes #add || @ House Codes

DO E T T
“ AVID

ELL

House A

House B

SPED

School Scheduling Options Screen, House/Team/Exclusion Tab

6. Click Save.

Creating a Team

Click Add on the Team Codes section to add a new row.
Enter a Code to designate the team.
Enter a Description.

El

Select the Option for the team:

o Keep Same Period

« Keep Same Period and Teacher
o Keep Same Room

« Keep Same Teacher

5. Click Save.

® Team Codes

R R

Team A Keep Same Teacher

“ B Team B Keep Same Teacher -
“ C Team C Keep Same Teacher -
“n D Team D Keep Same Period and Teacher -

School Scheduling Options Screen, House/Team/Exclusion Tab

Selecting Pathways for Scheduling
You can assign more than one house or team when Mass Scheduling or scheduling Sections. This
feature provides more flexibility when scheduling for learning communities.

1. Navigate to Synergy SIS > Mass Scheduling > Setup > School Scheduling Options.
2. Selectthe Pathways Tab.
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3. Click Add in the Pathways House Codes section.
a. Entera Code and Description.
b. Click Save.

4. Click Add in the Pathways Team Codes section.

a. Enter a Code and Description.
b. Click Save.

School Scheduling Optlons

Schedule and Course Guide
Chapter 4: Houses and Teams

Menu - -  Save = Un

School Mame: Hope High School Scheel Year: 2018-2019
Section Options

Courze Reguest and Walk-In Opfions House/Team/Exclusion Pathways
Use Pathways when Scheduling Sections

| ves

B Pathways House Codes

ﬂ_ o

@ Pathways Team Codes o+ Add

EER
- NURSE Nursing

£y

Bames

Swim

4]
[
]

Ll
)

- Line Pathway Team
Description +T Description
-- ACTG Accounting

School Scheduling Options Screen, Pathways Tab
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5. Select Yesin the Use Pathways when Scheduling Section. This option adds:

The Schedule Pathways House and Schedule Pathways Team fields to the
Options tab on the student's Schedule Request screen.

=

Menu- 4 Q ¥ &

Student Name: %) Abbott, Billy €. School: Hope High School Status: Active Homercom: ANNX

Schedule Request

Requests  Restrictions Teacher Course Recommendation  Graduation Requirements

Last Name First Name Middle Name Suffix Perm 1D Grade Gender Locked In Validated
Abbott Billy c 905483 12 v | | Male ~//No v |No |~
@ scheduling Options ® ParentVUE Information

Low Period High Period chedule House ‘Schedule Team Locked In ParentVUE Locked In Date

= = = = No | ~| 12/07/2018 10:50:00 -]
Schedule Pathways House Schedule Pathways Team Validated ParentVUE Validated Date
Accounting ~ Bames v No ~ | 12/07/2018 10:50:00 &
EXEMPUHOUSE  EXEmpT TEam  Balance Code Seat Weight
~| 150

Schedule Request Screen, Options Tab

The Pathways tab on the Section screen:

¥

menu- | [ ¢ [ > || & [+ Add |

Section 100 Course Title:  School Year
Section ID Course ID Course Title Staff Name Room Name

Pathways House Option Pathway House

Pathways Team Option Pathway Team

Section % i g

Curmrent Students Student Enroliment Histor Meeting Days Additional Staff Siaff Histol Schedule b

& &

D

Accounting Finance & Nursing

- Barnes [J Swi

im

Section Screen, Pathways Tab

6. Selectthe Section Options tab.

7. Selectan option in Allow Override of Pathways Restriction in Class.

Add Student, no Message — Pathways House and Team restrictions are overriden.
Synergy adds a student with a restriction to the section and no restriction warning
message displays.

Add Student, with Message — Pathways House and Team restrictions are overriden.
Synergy adds a student with a restriction to the section, but a restriction warning
message displays.

Don't add Student — Pathways House and Team restrictions are not overriden.
Synergy does not add a student with a restriction to the section.

Require Password — Y ou can override the Pathways House and Team restrictions by
entering the override password for a student that has a restriction. An error message
displays saying the password does not match and the student cannot be added to the
section if an incorrect password is entered.
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8. Enter Section Override Password, if needed.

Schedule and Course Guide
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School Scheduling Options

Menu + i

School Name: Hope High School School Year: 2018-2019

Section Options Course Request and Walk-In Options

® Options
Class Size Limit

Add Student, with Message

-

Allow Overnde of Fathways Restriction in Class
Require Password

Section Override Password

rerennan

House/Team/Exclusion

Pathways

Section ID Width
4

Auto Sequence
Counter

-

) Enable Section ID Validation Warnings
[ Do Not Fill Section 1D Gaps

9. Click Save.

School Scheduling Options Screen

The Allow Override of Pathways Restriction in Class field is
also available on the Security Settings tab on the User and User

7 User , < cea-0
Meu= € Q| » | o X Delete
User Mame: Aldrich, Heidi
Demographics Organizations User Groups Mavigation Menu Security Settings Focus Spell Check PO Access
Last Mame First Mame Middle Mame Disabled User Typs
Aldrich Heidi Staft | - |0 Es User
@ Scheduling ® Special Education
Allow Override of Max Students in Class - Exempt From Student Team
I Allow Override of Pathways Restriction In Class{| - s
f Systemwide Case Manager
@ Other Add Student, no Message =
Add Student, with Message
g
Show BO On Mousover Den't add student @ Tests to Administer Default
Mavigation | Standard - Require Password Update ds J—
TeacherVUE Administrator ~ | Admin'§ - - -
HealthVUE User ~ | SEVUE User ~ CounselVUE User =
KioskVUE User bl
User Screen, Security Settings Tab
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Assigning Houses and Teams

Individually Assigning Houses and Teams

The Schedule Request and Walk In Schedule screens create house and team assignments for
students.

Schedule Request

Navigate to Synergy SIS > Mass Scheduling > Schedule Request.
Locate the student to modify.
Select the Options tab.

El

Select the house to assign under Schedule House and Schedule Pathways House if
needed.

5. Select the team to assign under Schedule Pathways Team and Schedule Pathways
House if needed.

Select Exempt House or Exempt Team to instead remove house
or team assignment during the student’s scheduling process.

v Schedule Request
Menu ~ < Q » L]

Student Name: ®) Abbott, Billy C. School: Hope High School Status: Active Homeroom: ANNX

Requests  Restrictions Teacher Course Recommendation  Graduation Requirements

Last Name First Name Middle Name Suffix Perm 1D Grade Gender Locked In Validated
Abbott Billy c 902483 12 ~ | Male v/ |No |~||No |~
@® Scheduling Options @ ParentVUE Information

Low Period High Period chedule House Schedule Team Locked In- ParentVUE Locked In Date

— = = = No | ~| | 12/07/2018 10:50:00 [
Schedule Pathways House Schedule Pathways Team Validated ParentVUE Validated Date
Accounting ~| |Bames = No ~| | 12/07/2018 10:50:00 (=]
EXEMPL FoUSE EXCMpT 1eam  Dalance Code Seat Weight

~ 1150

Schedule Request Screen, Options Tab
6. Click Save.
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Walk In Schedule

1. Navigate to Synergy SIS > Mass Scheduling > Walk In Schedule or Synergy SIS >
Schedule > Walk In Schedule.

2. Locate the student to modify.
Select the Request tab.

4. Selectthe house to assign under Schedule House and Schedule Pathways House if
needed.

5. Select the team to assign under Schedule Pathways Team and Schedule Pathways
Team if needed.

Select Student Exempt From House Restriction or Student
—) Exempt From Team Restriction to instead remove house or
team assignment during the student’s scheduling process.

v Walk In Schedule AR
Menus 2 £ Q¥ o Print Schedule <= Not Scheduled Not Scheduled >>
Student Name: %) Abbott, Billy C. School: Hope High School Status: Active Room Name: 104 Schedule Status: Rejected ® 9% o&
Quick Placement Analysis Schedule Graduation Requirements
Last Name First Name Middle Name Perm ID Suffix Grade
Abbott Billy Cameron 905483 10 -
Gender
Schedule
Male

* Denotes alternate courses that were scheduled in lieu of the requested course
** Denotes Sections associated with a Wheel course request

Info Legend

P]- Class Does Not Apply to Graduation Requirement
R - Student has taken course

E - Student has taken equivalent course

P - Student received a passing mark

F - Student received a failing mark

@ Scheduling Options

Low Period High Period Schedule House Schedule Team  Seat Weight
- ~| |ELL - -

Student Exempt From House Restriction Student Exempt From Team Restriction

Walk In Schedule Screen, Request Tab

6. Click Save.
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Mass Assigning Houses and Teams

..  Period Restrictions prevent the mass assignment process from
—| scheduling students during certain periods. See Defining Period
Restrictions for more information.

1. Navigate to Synergy SIS > Mass Scheduling > Mass Assign House And Team or
Synergy SIS > Schedule > Mass Assign House And Team.

2. Selectthe House or Team and Pathways House or Pathways Team to assign. Schools
must process each house and team assignment separately.

3. Select Modify Only If Blank next to the house or team selection to only update unassigned
students.

4. Selectthe Grade Filter option.
« Keep the default option Not Used to assign students without grade filters.
« Select Exclude or Include and select specific grades.

5. Select the Gender if needed.
6. Click Chooser to find and select students for processing.

|
Q
[
»

Mass Assign House And Team

Menu~ Assign

School: Hope High School School Year: 2020-2021

Options Additional Filters

® House and Team @ Period Restrictions @ Pathways House And Team

House Modify Only If Blank Low Period Modify Only If Blank Pathways House  Modify Only If Blank
- a - (m] - (m]

Team Maodify Only If Blank High Period Modify Only If Blank Pathways Team  Modify Only If Blank
= a = [m] = (m]

© Grade Filter ® Gender Filter
OExclude Olnclude @ NotUsed Grade O < & Gender

Do d10 0110312

O Students Chooser

Mass Assign House And Team Screen
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7. Selectthe Additional Filters tab for further options.

Click Add on the Condition section. A new row displays.
Select the Property used to filter assignments.
Selectthe Not and Operator option as required.

a o T o

Enter the Value to be compared for the filter.

Mass Assign House And Team woe i coi’k-e

Menu~ || Assign

School: Hope High School School Year. 2020-2021

Options Additional Filters

@ Conditions + Add

I R S

Birth Year (Student) - Greater Than - 2016

Mass Assign House And Team Screen, Additional Filters Tab

8. Click Assign.

Assigning Houses and Teams to Sections

Before assigning Houses and Teams to sections, you must perform the
first run of the Option Set used for the schedule. See Running the
Scheduler for more information.

1. Navigate to Synergy SIS > Mass Scheduling > Schedule Control.
2. Open the option set.

_—
Schedule Control « ceEe
Menu~ | & | | ¢ Save *Undo
School: Hope High Schoel Year: 2016-2017
Scheduling Option Sets
Create/Copy Option Set
@ Option Sets
Line Option Set Name Checked Oul

Total & |Scheduled | Date/Ti
..2016—201? E Scheduler - User, Admin 1.37% 38 04/05/2017
..ALG Blank Scheduler - User, Admin
. =8 Backup Copy Scheduler - User, Admin 99.23% 2742 2721
=~ Copy of last year's schedule g Master Schedule Builder - User, Admin % 2750 002/01/2017

Schedule Control Screen
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4. Select Open Schedule Section under Quick Links.

7 Schedule Option Set

School: Hope High School

Menu~ € Q¥ L] + Save | *Undo

Run Name: 2016-2017 Schedule Run In Progress: No

| zmd

Options Fill Open Periods

Currently Checked Out To

User, Admin checkin

@ Last Schedule Run @ Current Stats

Date/Time Total Scheduled Rejected Optimized % Total Time Total Scheduled Rejected %
04/05/2017 12:36:48 & 2764 36 2726 0| 1.37% | 00:00:38 2764 38 2726| | 1.37T%

@ Basic Information @ Quick Links
Run Mame  2016-2017 % Open Student Schedule
Schedule Now

[F] Allow unchecked out users to edit sections
Run Description Open Schedule

[Py
7
#E

Section

Open School Options

Term fo Reschedule: If blank, scheduling entire year

&

Open Option Set Wheel

Open ClassBoard

Schedule Option Set Screen
5. Locate the section to modify.

6. Selectthe House and/or Team under the Restrictions section.

7 Schedule Section

Run Name: 2016-2017

Menu- | € Q¥ L] + Save | *Undo

Section ID: 6008 Course Title: Biclogy Run Name: 2016-2017

Current Students Meeting Days
Section 1D MSB Section ID Course D Course Title Staff Name Room Name
£008 SC402 | & | | Biology & &

B Section Info B Staff Contributions B Student Seat Totals

@ Teacher Aide Totals

B Restrictions @ Staff Contributions

Grade Range Low Grade Range High Gender Restriction Credit House Team Responsibility
09 ~| |09 - ~ | 0.500 - - -
Term Exclusion Amount

[C] Mo Term Override [T] Exclude From Mass Scheduling

Schedule Section Screen

7. Click Save.
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Assigning Pathways Houses and Pathways Teams to Sections

Select the Pathways tab.
Locate the section to modify.

o kw0 bd =

Navigate to Synergy SIS > Schedule > Section.

Select the Pathways House and/or Pathways Team.
Select the Pathways House Option and the Pathways Teams Option.

« Do Not Use — Scheduler ignores Pathway House selection while scheduling students in

this section.

« Exclude — Scheduler excludes Pathway House selection while scheduline students in

this section.

« Include — Scheduler includes Pathway House selection while scheduling students in

this section.

¥ Section
Menu~ < Q  » o

Section ID: 0002 Course Title: Life Science Scheol Year: 2018-2019

Current Students Student Enrollment History

Additional Staft Stafr History Schedule Matrix Pathways

Section ID Course ID  Course Title Room Name

0002 SC422 | § | | Life Science

Pathways House Option Pathway House
Include ~ @ Accounting [ Finance

Pathways Team Option Pathway Team

Include v # Barnes L Swim

120 &

6. Click Save.

Section Screen, Pathways Tab
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Mass Assigning Houses and Teams to Sections and Counselors

You can mass assign a house and team by Section or by Counselors on the Mass Assign House
and Team screen.

Navigate to Synergy SIS > Mass Scheduling > Mass Assign House And Team or
Synergy SIS > Schedule > Mass Assign House And Team.

1.

Select the House or Team to assign.
Select Modify Only If Blank next to House to only update the students not assigned to a
house if necessary.

Select Modify Only If Blank next to Team to only update the students not assigned to a
team if necessary.

Click Chooser in Sections to locate sections for processing. The added sections display the

currently assigned House and Team for that section if any.
Click Chooser in the Counselors section to locate counselors for processing.

c r arae
Mass Assigh House And Team ' € o= EBAE: cef-o
Menu - Assign
School: Hope High School School Year: 2018-2019
Options Additional Filters
® House and Team @ Period Restrictions @ Pathways House And Team
House Maodify Only If Blank Low Period Modify Only If Blank Pathways House  Modify Only If Blank
House A - ] - ] - (]
Team Modify Only If Blank High Period Modify Only If Blank Pathways Team Modify Only If Blank
| Team A - O - - =
@ Grade Filter @ Gender Filter

J Exclude © Include ® NotUsed Grade O = & Gender

Oe010011 012

@ Students Chooser

B Sections
T S T S T N

® Counselors

e w1

Mass Assign House And Team Screen

7. Click Assign to:

Update the mass assign house and team for all the students in the selected Section ID.

Assign the house and team depending on the school's focus for students, whether
Active only, Inactive only, or both Active and Inactive students.

Create alog file with the reviewed and updated student names.

NAME: Acunia, Kenneth 0., Grade: 28@, GENDER: M, 55Y: 31F6F5A4-BBC5-4E48-BF2E-ABEVAL@AD27@, Records Updated: True
MAME: Adams, Billy A., Grade: 218, GENDER: M, 55Y: FF318C53-E9B81-482A-A734-(449@85147726, Records Updated: False
NAME: Clooney, George, Grade: 228, GENDER: M, SS5Y: 7F773BF9-FE%A-4GAF-9599-DFB@9B179CD2, Records Updated: True

Log File
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Course Requests Overview

You can add course requests for students using one of three methods.
« Mass Assign Course Requests assigns requests in bulk based on student demographic data.
« Schedule Request assigns individual requests to students.
« ParentVUE and StudentVUE allow parents and students to make specific course requests.

Use mass assignment if you require a majority of students to take a core set of courses. It also
assigns a set of courses to a group of students based on grade, gender, house, or team. The mass
assignment process can also remove any discontinued or changed course offerings from groups.

Individual course requests allow students to choose between required or elective courses and allow
for easier customization on an individual student basis.

If schools use the ParentVUE and StudentVUE software, students and parents can enter elective
choices themselves. This can increase data accuracy and reduce staff workload.

Mass Assigning Course Requests

Adding New Course Request Groups

Navigate to Synergy SIS > Mass Scheduling > Mass Assign Course Requests.
Click Add to open the Mass Assign Course Requests (Add) screen.
Enter the Name for the group of courses.

oo D=

SelectInclude in Quick Assign Groups to allow the course request group to also display
on the Schedule Request, Schedule Student, and Walk In Schedule screens.

5. Select Allow Duplicate Course Requests if necessary.

Synergy SIS bases duplicate course requests on the courses
E currently assigned to the student. You can assign duplicate

requests to students if the course in question is not an existing

request. Log notes describe any duplicates assigned.

Mass Assign Course Requests

Name

10th Grade Regular Ct

Include In Quick Assign Groups
[T Allow Duplicate Course Requests

Mass Assign Course Requests (Add) Screen

6. Click Save.
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Click Chooser on the Courses to Add section to find and select courses.

You can also click Chooser on the Courses to Find and Replace
section to remove existing course requests at the same time.

Select a Preferred Term to schedule the course for if necessary.

Select Lock StudentVUE to have the course display as Locked in StudentVUE on the
Schedule Request screen.

This option also locks the course from removal within StudentVUE
or ParentVUE.

Select Pre-Req Not Required to disable prerequisite enforcement when scheduling.

Mass Assign

Name

@ Courses To Add

10th Grade Regular Cc¢

Include In Quick Assign Groups

¥ Mass Assign Course Requests
Menu ~ < Q > L] + Save | *mUndo Replace Courses

Name: 10th Grade Regular Core

Selected Students

Allow Duplicate Course Requests

Lit Explor

Am Govt

Biology

Alt Geom 2nd Sm

Prin Eng |

(% |Line Cowse D Gourse Tite | Preferrea

e xe
Chooser ” @ Courses To Find and Replace
Chooser
-

B ] nm Course Title
B B u AG29 Expl Agric

O O

O O

O O

Click Save.

Mass Assign Course Requests Screen
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Selecting Filter Options

Filter options provide criteria for assigning courses to students. All selected filters are cumulative,
and students must match all criteria entered to be assigned. Options are blank or display Not Used
by default.

If you select Exclude or Include for afilter, you must select at least one
option. Other screens that use the Quick Assign Groups function do not
use these filters.

1. Navigate to Synergy SIS > Mass Scheduling > Mass Assign Course Requests.
2. Select the Gender option.
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3. Selectto Exclude or Include the filtering options as needed.

Filter Options
@ Gender

Gender

@ Grade

Exclude ® Include Not used
Grade 0 + ®

# o7 D os 0o9

@ House

Exclude Include @ Not Used

House O < &

@ Team

Exclude Include @ Not Used
Team O + &

O Black [ Blue

O Team 6

@ ELL status

Exclude Include @ Not Used

ELL Level O + &

[ English [ Initially Identified as Fluent
Only (EQ) English Proficient (I-FEP)
@ Gate Status
Exclude Include @ Not Used
Gate Code
[ Giftedness
@ Sstudent Group
Exclude Include  ® Not Used

Student Group

@ special Ed Student Services

Exclude Include ® Not Used

Special Ed Student Services

[ Other Health Impairment

[0 Moderate Mental Retardation

D Preschool - Moderate Delay

[ Hearing Impairment

[ Mild Mental Retardation

[0 Specific Learning Disability

[0 Preschool - Speech/Language Delay
[ Traumatic Brain Injury

(] Orthopedic Impairment

D House 1 [0 House 2 [ House 3 [J House 4

) Green [ Orange [ Red
O Team 1 0 Team 2 [0 Team 3 O Team 4 [ Team 5

[0 Advanced Placement [ Quick Group [ Government

] Multiple Disabilities - Severe Sensory Impairment

[ Reclassified
O Early O Early Fluent English [ To Be
(") Beginning Intermediate [ Intermediate Advanced [ Advanced Proficient (R-FEP) Determined

[0 Autism

(") Preschool - Severe Delay

[0 Emotional Disability (private school)
) Multiple Disabilities

[0 speech/Language Impairment

[CJ Emotional Disability

[T visual Impairment

[0 Severe Mental Retardation

4. Click Save.

Mass Assign Course Requests Screen
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Selecting Students and Student Groups

Select the Selected Students tab to choose students to assign.
. Click Chooser to find and select students.
3. Click Add in the Student Condition Filter section.

The selections in the Student Condition Filter section apply as an

And condition to the settings on the Mass Assign tab.

Select a Property Name, Operator, and Value.

5. Click Chooser in the Student Groups section to select the student groups.

v Mass Assign Course Requests

« Save = Undo m % Delete Replace Courses

Name: 11th Grade Partial
Mass Assign | Selected Students | Other Info

Name
11th Grade Partial

“ Include In Quick Assign Groups
Allow Duplicate Course Requests

® Selected Students Chooser

Menu + < Q ‘:| = ! % by et ? =] A+ ...:. :

Y T S N S R

MNOTE: The selections in the Student Condition Filter grid are treated like an 'and’ condition to the results of the Mass Assign tab.

Student Condition Filter + Add

o B B T B R T
@ Student Groups

% -~ | Line Code T Description T

Mass Assign Course Requests Screen, Selected Students Tab

6. Click Save.
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7. Selectthe Other Info tab to enter a Description of the course request group if necessary.

7 Mass Assign Course Requests £ €G58 W
Menu = < Q » L] PCETCIIR NG 4 Add | % Delete Replace Courses
Mame: 10th Grade Regular Core
Mass Assign Selected Students Other Info
Name
10th Grade Regular Ct
Include In Quick Assign Groups
Allow Duphcale Course Requesls

Description

i 2O HR e

Mass Assign Course Requests Screen, Other Info Tab

8. Return to the Selected Students tab.

9. Click Save.
10. Click Replace Courses to run the course assignment.

¥ Mass Assign Course Requests
Menu~ | € | Q  » | & Save . Undo Replace Courses

Name: 10th Grade Regular Core
Mass Assign Selected Students Other Info
Name
10th Grade Regular Ct

Include In Quick Assign Groups
Allow Duplicate Course Requests

Mass Assign Course Requests Screen

139
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Individually Assigning Course Requests

Three screens assign course requests to students: Schedule Request, Schedule Student, and Walk

In Schedule. Options available for course assignment depend on configuration settings inside the

School Scheduling Options screen.

( )
See Student Course Request Options for more information on
configuration settings.

E You cannot preschedule students using the Schedule Request screen.
Prescheduled students have sections manually assigned as a course

L request and are exempt from the Mass Scheduling process. )

Schedule Request

1. Navigate to Synergy SIS > Mass Scheduling > Schedule Request.
2. Select Add By Group if using a Quick Assign Group.
3. Click Chooser in the Student Requests section to find and locate courses.

You can create Quick Assign Groups during the Mass Assign
—| Course Requests process. See Mass Assigning Course Requests
for more information.

7 Schedule Request «zefe
Menu~ | € Q| ¥ & | | Save | ™Undo ®
Student Name: Acevedo, Andrew School: Hope High School Status: Active Homeroom: 401
Requests Restrictions Options Teacher Course Recommendation
Last Name First Name Middle Name  Sufiix ~ Perm ID Grade Locked In Validated
Acevedo Andrew 886630 11 = No >~ |No | =
@ Quick Add
IAdd By Group - I
@ Student Requests a
. Alternate . o - -
Line| Course Title Preferred Term — Pre-Req Not Required/Corequisite Not Required lLocked in StudentVUE

Schedule Request Screen

4. Selectthe Preferred Term if allowing students a term choice.

5. Selectthe Term Override to allow a student to attend a class in a different term than the one

indicated in the master schedule.

6. Selectthe Repeat Tag to indicate the reason for the student to repeat the course if
applicable.

7. Selecta Teacher by clicking the (-‘? if allowing students to choose a teacher preference.

8. Select the Alternate Course preferred by clicking the (-‘? .
9. Select Pre-Req Not Required to disable prerequisite enforcement.
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Select Corequisite Not Required to disable the corequisite requirement.

Select Locked to lock the course request from modification in Schedule Request and Walk-In
Schedule.

Select Locked in StudentVUE to lock the course request from modification in
ParentVUE/StudentVUE.

7 Schedule Request « CEEe
Menuv | € Q| > | M| sae  .Undo @
Student Name: Acevedo, Andrew School- Hope High School Status: Active Homeroom: 401

Requests | Restrictions Options Teacher Course Recommendation
Last Name First Name Middle Name  Suffix Perm ID Grade Locked In Validated
Acevedo Andrew 866630 1 v/ |[Ne |~v]||Noe [~
@ Quick Add

Add By Group -

© Student Requests Chaoser

D N e e e s s S e
nn ADBBW | Academic Decath

n. ARS8 Adv Jewelry A4 - -
n. AR64 Int Drav wing v - -

Schedule Request Screen

@
&

(=] =]
] ]

@
>

%
Y
O
O

13. Click Chooser in the Alternates for Electives section to find and select alternate courses.

14. Enter the Preferred Priority as a numerical value to control the order for scheduling courses.

® Alternates for Electives |
“ 1 ARG3 Beg Drawing

“ 2 MuT1 Chorus | Beg

n 3 AR32 Beg Photo

Schedule Request Screen

15. Click Save.

Student and Teacher Restrictions

The Restrictions tab allows you to prohibit scheduling specific students or teachers with an
individual student. Synergy SIS does not process any course requests that result in sections
containing students or teachers specified.

1.

Select the Restrictions tab.

2. Click Chooser on the Student Restrictions section to find and select a student.
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3. Click Chooser on the Teacher Restrictions section to find and select a teacher.

7 Schedule Request

Menuv € QP & | Save | ™ Undo

Student Name: Acevedo, Andrew School: Hope High Schoel Status: Active Homeroom: 401

Requests Options Teacher Course Recommendation

Last Name First Name Middle Name  Suffix Perm 1D Grade Locked In Validated
Acevedo Andrew 886630 11 ~||No |~| | No |~

(based on individual releationships) will not be placed in the same class.

The following grid indicates teachers that will NOT be scheduled with the current student

@ Teacher Restrictions

@ ©®

The following grid is used to select students who will NOT be allowed to be placed in the same classes as the current students. The list will ensure each student

@ Studeni Resirictions
£ e

e e ]

Schedule Request Screen, Restrictions Tab

4. Click Save.

Teacher Course Recommendation

Teachers add course requests for students using the Teacher Course Recommendation tab.

1. Selectthe Teacher Course Recommendation tab.

2. Click Add.
3. Selectthe Course ID or Course Title by clicking the 'L"?
4. Selectthe Date of Recommend.
5. Select Staff Name by clicking the & .
¥ Schedule Request e -9
Menu~ | B (| € Q| % | & | «Save | ®Undo
Student Name: %) Abbott, Billy €. School: Hope High School Status: Active Homeroom: 104 @ " o&
Requests Restrictions Options | Teacher Course Recommendation Graduation Requirements
Last Name First Name Middle Name Suffix
Abbott Billy Cameron
Perm ID Grade Gender Locked In Validated
905483 10 ~ | Male | |No * No |«
@ Teacher Course Recommendation
Move to Course Course Date Of
%ol o YT OGRS R SV oo Y| semem Y comnY
u Move to Request EN23W & Sr Honors Lit & 08/20/2019 =] Simmons, Bill &
Schedule Request, Teacher Course Recommendation Tab
6. Click Save.
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Moving to Student Course Request

Use the Move to Request option to move a teacher recommended course into a student course
request.

v Schedule Request HIt =l
Menu~ 3 <€ Q » o + Save || *yUndo
Student Name: %) Abbott, Billy C. School: Hope High School Siaius: Active Homeroom: 104 @ o 0&
Requests Restrictions Options I Teacher Course Recommendation Graduation Requirements
Last Name First Name Middle Name Suffix Perm ID Grade
Abbott Billy Cameron 905483 10 -

Gender Locked In Validated
Male ~|/No |~=||No |~

® Teacher Course Recommendation + Add

e oo e T T o ¥ o s ¥ ot aconmans - ¥ me T _commant 7
“- Move to Request PP70 & English 10 & 08/20/2019 =] Adams, Mark &

Schedule Request, Teacher Course Recommendation Tab

« A success message displays when the course is moved to the student course request.

_— © Success
= S ic nch | &
= S & Quick Launcn | £ Course PP70 moved to Requests

Schedule Request L —

enu> = < Q » A + Save | %y Undo

tudent Name: %) Abbott, Billy C. School: Hope High School Staius: Active Homeroom: 104 @ " o &
Requests Restrictions Options Teacher Course Recommendation Graduation Requirements

ast Name First Name Middle Name Suffix Perm ID Grade

Abbott Billy Cameron 905483 10 -

Fender Locked In Validated
Male ~| |No '~ [No ~

Teacher Course Recommendation =+ Add

Schedule Request Screen, Teacher Course Recommendation Tab

« Theteacher recommended course displays on the Requests tab of the Schedule Request
screen and the course is Locked in StudentVUE by default.

T Schedule Request BIEETE!
Menuv | 3 1 ¢ Q| | & vsae $Undo
Student Name: %) Abbott, Billy C. School: Hope High $chool Status: Active Homercom: 104 @ E's ﬁ
Restrictions ~ Options  Teacher Course Recommendation  Graduation Requirements
Last Name First Name Middle Name Suffix Perm ID Grade Gender Locked In Validated
Abbott Billy Cameron 905483 10 ~ Male ~ No ~ No ~

@ Student Requests  Chooser

Pre-Req ‘Corequisite
. Course Term Term Repeat. Alternate
! = s
Required Required
_—
o’ B a | s

Locked in T
StudentVUE
L

@
@

PAB6 Int Acting -

nn P PE761 Weight Tm Boys - - - K El =] o o =]

nn m PE762 Weight Tm Boys - - - & K (=] =] o =]

nn w |ep70 English 10 - - - & $ 5] 5] 5] v
L —

Schedule Request Screen
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Schedule Student

1. Navigate to Synergy SIS > Mass Scheduling > Schedule Control.
2. Open the option set.

—

Schedule Control ccoRKe
Menu~ | ¥ | |« Save | *Undo

School: Hope High Schoel Year: 2016-2017

Scheduling Option Sets
Create/Copy Option Set
@ Option Sets
Checked Out
Line Option Set Name

II p ' o ¢ =
n2016—201? ) Scheduler - User, Admin 1.37% 2764 38 04/05/2017
ALG Blank o Scheduler - User, Admin

Backup Copy ) Scheduler - User, Admin 99.23% 2742 2721

Copy of last year's schedule g Master Schedule Builder = User, Admin % 2750 002/01/2017

| s s—

Schedule Control Screen

4. Select Open Student Schedule under Quick Links. The Schedule Student screen displays.

@ Quick Links

@ Open Student Schedule

:2.{ Open Schedule Allow unchecked out users to edit sections

Section

Open School Options
Open Option Set Wheel

Open ClassBoard

Schedule Option Set Screen

5. Selectthe Add By Group if using a Quick Assign Group.

You can create Quick Assign Groups during the Mass Assign
Course Requests process. See Mass Assigning Course Requests
for more information.
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6. Click Chooser in the Course Requests section to find and locate courses.

The Sched Priority column autopopulates based on the Schedule
Priority setting on the District Course screen.

7 Schedule Student

Run Name: 2016-2017

Menu~ | € Q| ¥ L + Save | *™yUndo | | <<Conflict | | Conflict >> @®

Student Name: Acevedo, Andrew School: Hope High School Status: Active Homeroom: 401 Run Name: 2016-2017 Schedule Status: Rejected
Requests Analysis Schedule

Last Name First Name Middle Name  Suffix Perm ID Grade Sehedul
Acevedo Andrew 886630 " - chedule
@ Quick Add

@ Class Size Limit Password

I Add By Group - I Max Class Size Qverride Password

@ cCourse Requests Chonser

Li Ci Titl Te Overrid A"emate Coli=E Pre-Ri ite Not R ed | Pl heduled Secti
ine ourse Title lerm 'erride re-| uisite Nof uir rescl ul on
o[ eReseNee

Schedule Student Screen

7. Selectthe Preferred Term if allowing students a term choice.

8. Selectthe Term Override to allow a student to attend a class in a different term than the one
indicated in the master schedule.

9. Selectthe Preferred Staff by clicking the '5? if allowing students to choose a teacher
preference.
10. Select the Alternate Course preferred by clicking the '5?
11. Select Pre-Requisite Not Required to disable prerequisite enforcement.
12. Select Corequisite Not Required to disable the corequisite requirement.

v Schedule Student

Run Name: 2016-2017

Menu~ | € Q| > | || «Ssave  *Undo | <<Confict | = Conflict >> @

Student Name: Acevedo, Andrew School: Hope High School Status: Active Homeroom: 401 Run Name: 2016-2017 Schedule Status: Rejected

Requests Analysis Schedule
Last Name First Name Middle Name Suffix Perm ID Grade
Schedule
Acevedo Andrew 886630 " -
® Quick Add @ class Size Limit Password
Add By Group

- Max Class Size Override Password

@ Course Requests Chooser

Alternate
Prelerred Prescheduled
Line| Course Title |Sched Priority Preferred Term | Term Override Course  |Pre-Requisite Not Required Corequisite Not Required o
a ] * X

ADEGV\ Academic Decath = Elective (Low)

n. ARS8 Adv Jewelry Elective (Low) - -
n ARG4 Int Drawing Elective (Low) - -

Schedule Student Screen

@

a a = X
a a &b A

)
® 9 9

@

13. Click Chooser in the Alternates for Electives section to find and select alternate courses.
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14. Enter the Preferred Priority as a numerical value to control the order for scheduling courses.

(@ Alternates for Electives .T E
“- ARE3 Beg Drawing

“- 2 MuT1 Chorus | Beg

n 3 AR32 Beg Photo

Schedule Student Screen

15. Click Save.

Walk In Schedule — Request

Navigate to Synergy SIS > Mass Scheduling > Walk In Schedule or Synergy SIS >
Schedule > Walk In Schedule.

Select the Request tab.
Selectthe Add By Group if using a Quick Assign Group.

You can create Quick Assign Groups during the Mass Assign
Course Requests process. See Mass Assigning Course Requests
for more information.

Click Chooser in the Course Request section to find and locate courses.

T Walk In Schedule
¢ Q|| &| wsae | ®uno

cem -

Menu~ @ 2 Print Schedule << Not Scheduled Not Scheduled >>

Student Name: Zuniga, Kathleen School: Hope High School Status: Active Room Name:  Schedule Siatus

Quick Placement Analysis

Last Name First Name
Zuniga Kathleen

Schedule Graduation Requirements

Middle Name Perm ID Suffix Grade

997014 1

Gender
Schedule
~ Female ~

@ Filter 1@ Select the terms to schedule

Schedule Status

Filter Term To Schedule | Current Term Forward | ~

Term Start ~ | Term End

® Quick Add

@ Drop and Enter date for class changes Add By Group

Lock all courses | | Un-Lock all courses | | Delete Non-Scheduled Course Request(s)

@ Graduation Requirement Options

® course Requesl

Pre-Req
L=l Title Term ovemide || staft | °°"“ L)
Required

Choo er

Prescheduled
.

Walk In Schedule Screen, Request Tab

Select Locked to lock the course request from modification in Schedule Request and Walk-In
Schedule.

Select the Preferred Term if allowing students a term choice.

Select the Term Override to allow a student to attend a class in a different term than the one
indicated in the master schedule.

Select the Repeat Tag to indicate the reason for the student to repeat the course if
applicable.
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9. Select the Preferred Staff by clicking the & if allowing students to choose a teacher
preference.

10. Select the Alternate Course preferred by clicking the & .

11. Select Pre-Req Not Required to disable prerequisite enforcement.
7 Walk In Schedule s -
Menu~ 2/ € Q » & Print Schedule << Not Scheduled Not Scheduled >>
Student Name: Zuniga, Kathleen School: Hope High School Status: Active Room Name: Schedule Status:

Quick Placement Request Analysis Schedule Graduation Requirements
Last Name First Name Middle Name Perm ID Suffix Grade Gender
Zuniga Kathleen 997014 1 e o | —
@ Filter @ Select the terms to schedule
orm Start 2 Term End l — Schedule Slﬁtui Term To Schedule Current Term Forward | v
@ Quick Add

[C] Drop and Enter date for class changes Add By Group

Lock all courses | | Un-Lock all courses | | Delete Non-Scheduled Course Request(s)

@ Graduation Requirement Options

@ Course Request

Course Plﬂened meened mﬂ“ SoUES Prescheduled

Not Scheduled
ﬂﬂ d

‘Chooser

5] EN40 Shakespeare - - & g g =] Erl P

Walk In Schedule Screen, Request Tab
12. Click Save.

{ N
Click Lock all courses or Un-lock all courses to mass lock or unlock
course requests for the student.

¥ Walk In Schedule EIRlEA
Menuw 2 ¢ Q » & Print Schedule << Not Scheduled Not Scheduled >>
Student Name: Zuniga, Kathleen School: Hope High School Status: Active Room Name: Schedule Status:
Quick Placement Request | Analysis Schedule Graduation Requirements
Zuniga Kathleen 997014 1 ~| [Female| +| | Schedule
'_T @ Filter @ Select the terms 1o schedule
Term Start © TermEnd 2| (Fiter| Schedule Status Term To Schedule | Current Term Forward |+
® Quick Add
© Drop and Enter date for class changes Add By Group
Walk In Schedule Screen, Request Tab
. J

Using the Schedule Status Screen

1. Navigate to Synergy SIS > Schedule > Schedule Status.

« Drop Date — This defaults to the current day minus one day. This is the Drop Date for
any student scheduled using this screen. @

The Schedule Status screen shows the cumulative results from the
Schedule Status option on the Walk In Schedule screen. The
summary cards display the Schedule Status options Not Scheduled
and Rejected and can be used as filters.
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« Enter Date — This defaults to the current day. This is the Enter Date for any student

scheduled using this screen. @

o Term To Schedule — Determines which sections to add for any student scheduled

using this screen ©

o Not Scheduled — Total number of students included in the scheduling run who are not

scheduled or are rejected @

« Schedule Reject — Total number of students with class conflicts that need to (and can)

be resolved ®

« Graph — Number of students with each status by grade level ®

« Percentage Scheduled — [Number of Total students - (Not Scheduled + Schedule

Reject / number of Total students)] * 100 @
o Schedule All Students Below — Schedules all students showing on that list ©

» Schedule — Schedules that student only ©

Schedule Status HRE =Y

Menuw o

Status

@ Options
Drop Date o Enter Dalo Term To Scnedu\o

04/12/2020 & | 04/14/2020 & |Current Term Forward =

O, o,

@ Not Scheduled @ Schedule Reject

M Nots uled
B Schedule Reject

o0.00%

Scheduled

@ Student Schedule Status Schedule All Students Below 8

Sueiname T ore ST Comser 7| sorasamp =T scaue T

- Abbott, Billy C. 10 Wilson, Rob 04/10/2020 09:18:37 Schedule
. Abnemethy, Anne E. 10 McGrew, Tom 04/03/2020 12:07:20 Schedule
n . Samberg, Andy 09 Schedule
- . Samberg, AndyFAKE 09 Schedule
“ . Test, Nolan 10 Schedule
“ . Test, Sedona 09 Schedule
. TEST, SVUE 1 Schedule
n . Testing, KN 09 Schedule
n . Thomas, Robb 09 Schedule
Schedule Status Screen
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The Graduation Requirement Options section displays on the Requests tab of the Schedule
Request screen and the Quick Placement tab of the Walk In Schedule screen.

The Student Requests section on the Requests tab of the Schedule Request screen and the
Course Request section on the Requests tab of the Walk In Schedule screen indicate if a class

does not apply to a graduation requirement.

The Graduation Requirements tab on the Schedule Request screen and the Walk In Schedule
screen contains the student course requests and the Graduation Requirement Options section.

Showing the Graduation Requirement Indicators

1. Navigate to Synergy SIS > System > Setup > School Setup.

2. Select an option for Graduation Requirement Indicator Display in the Other Info section.

« Do not show — Does not display the indicators on the Student Classes screen, the
Classes tab on the Student screen, and the Schedule Request and Walk In Schedule

screen.

« Show on request and student class views (Default) or blank — Displays the indicators on
the Student Classes screen, the Classes tab on the Student screen, and the Schedule
Request and Walk In Schedule screens.

« Show on request views only — Displays the indicators on the Schedule Request and

Walk In Schedule screens only.

School Setup

Menu ~ i

@ Policy Code
Policy Code O -~ @
[ Needs Values

@ Other Info
[ Exclude from State Reporting
[ rReport Sub Schools
[ Enable College Credit
Enable Subject Area Override

Enable College Area Override

Enable University Area Override

[ Charter

[ Is Separate School
Improvement Status

School Name: Hope High School School Year: 2018-2019

Basic Info | Options SIS Data Options  Labels TeacherVUE Mobile Apps

[ Make classes action on student inactivate mandatory

Validate Student Classes
Do Not Validate Student Classes -

School Hours Per Week  Special Ed "Bell to Bell" Hours Per Week

Scheduling Options
Traditional Schedule Tracking (Default) -

Use Student Seat Weight
Graduation Requirement Indicator Display

Do not show
Show on request and student class views (Default)
Show on request views only

3. Click Save.

School Setup Screen
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Applying Graduation Requirements

1. Navigate to Synergy SIS > Mass Scheduling > Schedule Request or
Synergy SIS > Mass Scheduling > Walk In Schedule.

2. Locate the student.

3. Select the options in the Graduation Requirement Options section to use in the graduation
requirement calculation.

« Graduation Requirement — Select the option to indicate Required courses in the
Course Credit Requirement(s) section on the Graduation Requirements tab.

« Add Work in Progress — Select an option to populate the In Progress column in the
Course Credit requirement(s) section on the Graduation Requirements tab.

o Get Graduation Requirement Definition From The Student's Diploma Type —
Select this option if using Diploma Type on the Other Info tab of the Student screen to
define graduation requirements for the student that display on the Graduation

Requirements tab.
The Get Graduation Requirements From the Student's
Diploma Type option takes precedence if all options are selected.

4. Select Apply Requirement.

7 Schedule Request € i ceE-e
Menu~ | B £ Q » L]
Student Name: Compton, Joshua B. Schocl: Hope High School Ststus: Active Homeroom: P-22 (L]
Requests Restrictions Options Teacher Course Recommendation Graduation Requirements
Last Mame First Name Middle Name Suffix Perm ID
Compton Joshua Buckley 916538
Grade Gender Locked In Validated
10 ~| |Male | |No |~||No |~

@ Graduation Reguirement Options
Graduation Requirement Add Work In Progress
High School
Get Graduation Reguirements From The Student’s Diploma Type
¥ Apply Requirement

Schedule Request Screen

Edupoint Proprietary and Confidential



Schedule and Course Guide

Chapter 5: Course Requests 151

~\

An Info Legend displays at the bottom of the Student Requests section. It describes
the codes used in the Info columns.

7 Schedule Request ' & o [cleE|-e
Menu~ | R 4 Q 3 = « Save || * Undo

Student Nams: % Abbott, Billy C. School: Hope High School Status: Active Homercom: ANNX 5] H ! 5] o &

Requests Restrictions Options Teacher Course Recommendation Graduation Requirements

Last Name First Mame Middle Name Suffix Perm ID
Abbott Billy C 905483

Grade Gender Locked In “alidated
12 - | | Male *| [No |=||No | =

© Graduation Requirement Options

® Quick Add

@ Student Requestz Choosar

® Alternates for Electives =+ Add | Chooser

Infio Legend

- Class Does Mot Apply to Graduation Requirement
- Student has taken course

- Student has taken equivalent course

- Student received a passing mark

- Student received a failing mark

mUmJJ—!

Schedule Request Screen
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« The Info columns display the student's progress in the Student Requests section.

« The first column displays when the class does not apply to graduation requirements
and Apply Requirement is selected.

« The second column indicates if the student took the course.
« R —Student has taken the course.
o E—Student has taken an equivalent course.

« The third column indicates if the student passed the course.
o P—Student received a passing mark.
« F—Studentreceived a failing mark.

7 Schedule Request

Menu~ @ 2 £ QO ¥ = v Save || *% Undo

Student Mame: %) Abbott, Billy C. School: Hope High School Status: Active Homerocom: ANNX

Reguesis Restricticns Options Teacher Course Recommendation Graduation Requirements
Last Mame First Mame Middle Mame Suffix
Abbott Billy C

Locked In “Jalidated
Mo - |No |-

® Graduation Reguirement Options

Graduation Reguirement Add Work In Progress
High School - -

¥ Get Graduation Requirements From The Student's Diploma Type
# Apply Requirement

@ Quick Add

@ Student Requests Chooser

. Preferred Term Repeat
- L4 -

Animal Sci

FE PJAGH Landscape D&mi | - - -
p R PlARSY Beg Jewelry o - -
PR Flars4 Beg Jewelry - - .
ARSS Adv Jewelry - - -
P E F|ARE4 Int Drawing v v L
ARBOW Ap Studio Art - - -

Schedule Request Screen
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7 Walk In Schedule

@ Graduation Requirement Options

Graduation Requirement Add Work In Progress
[ @et Graduation Reguirements From The Student's Diploma Type
¥ Apply Requirement

@ Manually Schedule Student

Section

HH
R

Code

Menu- 3 < Q 2> (] Print Schedule << Mol Scheduled Not Scheduled >>
Student Mams: Acosta, John A, School: Hope High School Status: Active Room Mame: @ @ o a &
Quick Placement Request Analysis Schedule Graduation Requirements

Last Name First Mame Middle Name Suffix Perm ID Grade

Arcosta John Alvarez 150265 11 hd
Gender [

Male C ule
@ Options

Quick Add (by Secfion ID or Course ID) Acd Drop Date Enter Date Term To Schedule Section Override Password

01/20/2019 B | 01r21/2019 & | Current Term Forward | =

Schedule Period

Meeting
Day

-n g CO15C - Corr Drugsisoc Spring
-n g R |P EM212 - Inter Esl(Lang) 52 Spring
) o L
g MA312 - Alf Geom 2nd Sm 52 Spring
n 4 B NC902 - Yearbook 52 Spring -
nﬂ g R |P | PES0T - AA Giris Sp YR Sprng
Walk In Schedule Screen

5. Selectthe Graduation Requirements tab.

« The same selections made on the Requests tab display in the Graduation
Requirements Options section.

« The Course Credit Requirement(s) display.

7 Schedule Request
< a > &
Student Name: Acosta, John A. School: Hope High School Status: Active Homeroom: 106

Requests Restrictions Options  Teacher Course Recommendation | Graduation Requirements

Last Name First Name Middle Name Suffix Perm ID Grade Gender Locked In Validated
Acosta John Awvarez 150265 1 - Male '~ No ~No -
® Graduation Requirement Options

Graduation Requirement  Add Work In Progress
University Requirements +| (Student Schedule |+

[ Get Graduation Requirements From The Student's Diploma Type
Apply Requirement

©®  Course Credit Requirement(s)

Menu~ | 3 « Save | ®Undo

Credits
Required Y Completed Y In Progress v Requested
0000 1.000 0000
0000 0000 0.000
0000 0500 1,000
0000 0500 0.000
0000 0,000 0.000
0500 0000 0000
11.000 4000 2,000
11.500 6000 3000

Legend
[J- Meets Requirements
[T Does Not Meet Requirements.

2.000

1500

1500

2.000

0.500

0.000

6.500

Schedule Request Screen, Graduation Requirements Tab
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7 Walk In Schedule
Menu- 2 € Q > &

~ Student Schedule |~

ent
©  Course Credit Requirement(s)

BN

- History

n English

“ Mathematics

n Lab Science

“ Foreign Language
Arts

Electives
“ Total
Legend

Legend
[[]- Meets Requirements
[CJ- Does Not Meet Requirements.

John Alvarez

2000
2000
3000
2.000
2.000
1.000
3.000

15.000

< Not Scheduled | | Not Scheduled >>

Perm ID Grade
150265 1

0.000
0000
0000
0.000
0.000
0500
11.000

11.500

Gender

) Male || | Scheduie

Credits

1.000

Requested

Remaining

Mass Assigning Course Requests by Current Course

Walk In Schedule Screen, Graduation Requirements Tab

The Mass Assign Course Requests By Current Course screen allows a school to input course
requests based on courses students are currently taking. For example, to assign Spanish 2 as a
course request in next year’s focus to all students currently taking Spanish 1.

1. Navigate to Synergy SIS > Mass Scheduling > Mass Assign Course Requests By

Current Course.

2. Click Add. The Mass Assign Course Requests By Current Course (Add) screen opens.

Enter the Name for the process.

MName

[TEST

Mass Assign Course Requests By Current Course

X Close

4. Click Save.

5. Click Chooser on the Selected Students section to find and select students.

Mass Assign Course Request By Current Course (Add) Screen

s

\.

The Section ID or Course ID is required to search for a student.

. Leaving the Year blank defaults the search to the current year setup
on the District Setup screen.

The search results include only the students enrolled in the focus
year (typically next year's focus).

~

6. Click Save.
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Click Chooser on the Courses to Add section to find and select courses.

[
Enter the Course ID and/or Title or click Find to locate courses.

Click Save.

Select Lock StudentVUE to lock the course in StudentVUE on the Schedule Request

screen if necessary.

Select Pre-Req Not Required to disable prerequisite enforcement when scheduling if

necessary.

Select Allow Duplicate Course Requests if necessary.

Allow Duplicate Course Requests adds the same course

requests to the same students again with each run.

Menu- [ €Q[ > &

Mass Assign
Name

TEST

Allow Duplicate Course Requests
@ Selected Students | Chooser

E% Allen, Melissa
“ Barela, Lois M
“ Gonover, Mildred L
“n Dewitt, Rachel E
n Ellenberger, Gary R
n“ Fakava, Paula
n Fenn, Kathryn
n“ Funkhouser, Thomas L.
nn Garza, Ryan J
nn Giyeat, George
m Hartman, Cynthia D.

12

v Mass Assign Course Requests By Current Course

NOTE: Course requests will be created for the 2018-2019 school year.

® Course ToAdd Choos
TN COE
RN

990220
908925
873621
889246
927874
168359
886205
889251
886535
134084

902614

er

Beg Jewelry

Q

Q

G o Come e 8ok S+ Pt it s

Mass Assign Course Request By Current Course Screen

12. Click Assign to run the process. The process also generates a log file.

Mass Assign Course Requests By Current Course

Definition Name: TEST

811ow Duplicate Requests: False

Gilyeat, George 134884
Fenn, Kathryn 886285
Wilson, Gregory T.
Hartman, Cynthiz D.
Sowards, Scott C.
Ellenberger, Gary R.
Reynolds, Anthony T.
Dewitt, Rachel E.
Garza, Ryan J. 886535
Starks, Justin B.
Howard, Kathleen K.
Meyer, Randy R. 938952
Conover, Mildred L.
McDowell, Arthur F.
Barsla, Lois M. 988925
Fakava, Paula M.
Ress, Roger
Allen, Melissa
Mohammed, Denise
Schlechty, Paula
Funkhouser, Thomas L.

594823
agaz22e

AR54 - Beg Jewelry

ARS4 - Beg Jewelry
982287 ARS4 - Beg
982614 ARS4 - Beg
886072 ARS4 - Beg
927874 ARS4 - Beg
886687 ARS4 - Beg
283246 ARS4 - Beg
ARS4 - Beg Jewslry
378343 ARS4 - Beg
967644  ARS4 - Beg
ARS4 - Beg Jewelry
873621 ARS4 - Beg
252913 ARS4 - Beg
ARS4 - Beg Jewelry
168358 ARS4 - Beg

ARS4 - Beg Jewelry
ARS4 - Beg Jewelry
128735 ARS4 - Beg
383654 ARS4 - Beg
889251 ARS4 - Beg

Toctal Reguests Added: 28
Total Time: @3:00:04.8456

- Added

- Added

Jewelry -
Jewelry -
Jewelry -
Jewelry -
Jewelry -
Jewelry -
- Added

Jewelry -
Jewelry -
- Added

Jewelry -
Jewelry -
- Skipped
Jewelry -
- Added

- Added

Jewelry -
Jewelry -
Jewelry -

Added
Added
Added
Added
Added
Added

Added
Added

Added
Added
(Request Exists)
Added

Added
Added
Added

Mass Assign Course Request By Current Course Log File

155
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ParentVUE and StudentVUE Course Requests

Parents and students enter course requests on the Course Request page of the ParentVUE and

StudentVUE software.

Home Btreams My Account

Good morning, Billy Abbott, 5/21/2008

Attendance

Class Schedule

Course History

Course Request

Discipline

Fee

Grade Book

Health

Report Card

Student Info

| Billy
Messages .
Hope High School (949-555-1212), 2007-2008 School Year Counselor: Joe Diaz J
Calendar

Thank you for using our online course request system. Course requests are now being accepted for the Fall semester. The last date to make
a request is September 1. Requests will be processed on a first-come, first-serve basis, and your final schedule will be distributed on
September 3. To finalize your selection, don't forget to lock in your requests!

Selected Course Requests

Click here to change course requests

Lock Course Requests

Ln Department Course Title Course 1D Elective | College | Credit Term Comment
Prep Qverride

1 (BE) Accounting | BE47 0.50

2 (BE) Bus Cons Law BE39 0.50

3 (CB) Comp Foundation CB10 0.50 Taken: 5/2003 (F)
4 (FS) Cc-Persnl Dev. FS32C 0.50 Taken: 7/2003 (A)
5 (MU) Full Conc Orch MUS1 Yes 0.50

6 (PE) Adv Wt Boys PET82 Yes 0.50

Total Credit 3.00

Alternate Elective Requests (in preference order) - Select at least 1 alternate

Ln | Department | Course Title | Course ID Elective College Prep  Credit Term Comment
Override
1 (AR) Int Phato AR33 Yes 0.50
2 [AM) Automotive  AM10 0.50
Tech

Click here to change course requasts

ParentVUE/StudentVUE Course Request Screen

Lock Course Requests

Schools can limit requests to a certain course type or limit the amount of course requests users can
make. Schools can also restrict course requests to a certain date range. This section details security
settings for ParentVUE and StudentVUE course requests.

See the Synergy SIS — ParentVUE & StudentVUE Administrator Guide
for more information on the course request function.

L]
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District Course Request Settings

1. Navigate to Synergy SIS > System > ParentVUE > ParentVUE and StudentVUE

Configuration.

Select the Course Request option under both the Parent Active Modules and Student Active
Modules sections.

3. Selectthe Course Request Edit Option: Editable or Read-Only.
ParentVUE and StudentVUE Configuration

Menu~ o + Save | *%Undo

0
Q
%
(2]

PVUE Configuration

Activation Key Configuration Contact / Privacy
Acknowledgements

Contact Course Requests Email Languages

@ Parent Active Modules @ Student Active Modules
Attendance
Course Request
Course Reguest Edit Option
Editable -

Attendance
Course Request

Course Reguest Edit Option
Editable A

[¥] Current Schedule
Discipline

[¥] Current Schedule
Discipline

ParentVUE And StudentVUE Configuration Screen

4. Click Save.

School Course Request Settings

1. Navigate to Synergy SIS > System > ParentVUE > ParentVUE and StudentVUE
School Configuration.
2. Review the Disabled Parent Modules and Disabled Student Modules to ensure Course
Request is not selected.
ParentVUE and StudentVUE School Configuration CCcoke
Menu~ | ol  Save | * Undo m
School Name: Hope High Schoel School Year: 2016-2017
PVUE Configuration Course Requests Options
@ Disabled Parent Modules @ Disabled Student Modules
[ Attendance [ Attendance
I [ Course Request [ Course Request |
[ Current Schedule ] Current Schedule
[T] Discipline [C] Discipline
ParentVUE And StudentVUE School Configuration Screen
3. Click Save.
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Hide Lock Course Request

Schools allowing students to return to the course request process after adding classes should

enable the Hide Lock Course Request Setting.
1.
Configuration.

2. Selectthe Course Requests tab.

Select Hide Lock Course Request Button under Additional Options.

Navigate to Synergy SIS > System > Setup > ParentVUE and StudentVUE

ParentVUE and StudentVUE Configuration

Menu~ | o | o Save |+ Undo

PVUE Configuration Activation Key Configuration Contact/ Privacy Contact Course Requests Email
Acknowledgements
@ Course Request Details

Request School Year Open Request Window — Close Request Window

2016-8 - 12/01/2016 = 05/31/2017 =]
Greeting

selection web site! Please review the course requests
selected below. Make all desired changes and when

Welcome fo the Sample District's online course request =

Search Page Message
TEST

Minimum Selection Type Minimum Class Count  Minimum Credit
Course Request Count | ~ 1 3.00

Maximum Requesis
]

@ Additional Options

Alternate Minimum Alternate Maximum

Prereq Required to Select Request
O

Hide Lock Course Request Button
]

@ Minimum Credit and Minimum Class Count could be mandatory depending on the value selected in the Selection Type drop down

Languages

Q

b

Q
5
o

ParentVUE And StudentVUE Configuration Screen, Course Requests Tab
4. Click Save.

Edupoint Proprietary and Confidential



Schedule and Course Guide
Chapter 5: Course Requests

159

Transferring Students with Course Requests and Scheduled
Classes

A student's transfer from one home school to another within the same district and current school
year also transfers the course requests or scheduled courses.

( )
The Schedule Requests from Previous School section displays on the
Requests tab of the Schedule Request screen when requests are
transferred. This section is read-only and cannot be edited. This section
only displays at the most recent home school where the student is active.

The student's courses do not transfer if Drop Classes on Inactivation is
E selected when a student is inactivated.

Concurrent course requests and classes do not transfer.
A no-show student's class schedules or course requests do not transfer.

When a student rejoins the same home school, the class schedule and
course requests retain or drop depending on the option selected at
inactivation, but they do not transfer to the Schedule Requests from

L Previous School section. )

1. Verify the following sections have at least one line entry before transferring a student:

« The Student Requests section and in the Alternative for Electives section on the
Schedule Request screen.

« The Course Request section on the Request tab of the Walk In Schedule screen.
« The Course Request section on the Classes tab of the Student screen.

2. Inactivate the student from the current school.
3. Transfer the student to the new school.
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4. Navigate to Synergy SIS > Mass Scheduling > Schedule Request.

4 )
You must refresh the screen using the Synergy refresh button
rather than the browser refresh button.

Courses not offered at the school highlight in yellow and do not
transfer.

Only the class schedule transfers when a student has both class
schedule and course requests made.

E Courses do not transfer from class schedule when:

« Thereis a Leave Date associated with the course that is
before the Enter Date at the new school.

« A semester was completed before the Enter Date at the new
school even though these courses do not have explicit Leave
Dates.

« The Enter Date is after the enrollment date at the new

school.
\. J

5. Select the courses to transfer.

[ @ Hold down the CTRL key to select multiple courses. J

6. Click Transfer to Current School.

An error message displays when the courses selected for transfer are not
available at the transferred school.
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When the transferring courses are available at the transferred school, the selected courses transfer:

« From the Schedule Requests from Previous School section to the Schedule Requests section

« From the Alternates for Electives from Previous School section to the Alternates for Electives

section

7 Schedule Request ST -0
venus | 2| ¢ Q[> (& vsae | Sun

Student Name: Ackley, Brian R. School: Franklin High School Status: Active Homeroom: @®
Requests | Resticlions  Oplons _ Teacher Course Recommendalion  Graduation Requirements

Last tiame Frst Name Vidde Name sumx PemiD Grade Gender  Lockea n Valatea

Ackey Bran R 912048 1 s (<o~ (N0 |-

@  Student Requests.

Pre-Req Not Corequisite Not
une | mo ¥| cousem T Course Tiie T Temovemde T| Repeatlg T Atemaiecouse T et T edusel® ¥\ locked T| LockedinStudentuE T
1 AG51 Landscape D&m | - - g o [w] [u] [m]
KRN ene2 Wora Lt - - 0 o o o [
@ Alternates for Electives 4 Add | Chooser

P - Student received a pas

| > [
| o G

jaGs1

| s Gk

[

Chooser

Info Legend

- Giass Doss Not Apply to Graduation Requrement
R - Student has taken course

£ Student has aken equvalent course

ssing mark

£ Student received a falng mark
©® Schedule Requests from Previous School I
Transfer to Current School

©  schedule Requests fom Previous School

[ Course ID
1 B

©®  Attemates for Electives from Previous School

egens
L5 Gourses nthe schecuie Reaquests fom Previous Schoas roup b are ot oferedat i shool

v Gourse e o

T cousseTwe T RepeatTag  T| Pre-ReqNotRequired | Gorequisite NotRequired 7| Locked T LockedinstudentvUE 1]

9th Eng-Corr
Web Page Design
World Lit
Landscape Dam |
Fund Eng

Preferrea Priority [ Course ID Y Course Tite v

Schedule Request Screen

Course request selections can be modified after transferring the
courses to the current year's request list.

The Request tab on the Walk In Schedule screen displays the Schedule Requests from Previous
Schools section. The Alternates for Course Requests section is not available on this screen.

* Walk In Schedule BREEEARD)
Menu» A < a » - v - Print Schedule << Not Scheduled Not Scheduled >>

Siudent Name: Ackley, Brian R. School Frankiin High School Staius Active Room Narme @®
Quik Placement Anaysis Schedule | Graouaton Requrements

LastName First Name Micgle Name sumx Pem 1D Grage Gender

Ackiey Brian R 913948 12 < Maie || Schedue

© Fiter © Seiect the tems 1o schedule

O Gra n Rex
Alternate Course
IO R =S e e L T e T

s
L] 2 AGS1 & & L x
LB cB20 s 8 @ x
- 4 EN32 g 8§ * x

= |5 | o o . x

6 Fail
7 Spring

* Denotes aftemate courses that were scheduled in leu of the requested course

** Dendtes Sections associated Wit a Wheel course request

Info Legend

[P Class Does Mot Apply to Graguation Requirement

R - Student has taken course

E - Student has taken equivalent course:

P - Stugent received a passing mark

F - Stugen received a failng mark

© scheduiing Options

LowPeiod  HMgNPeod  Schedule House Schedue Team

Student Exempt From House Restriction [ Student Exempt From Team Restriction
© schedule Requests From Previous School
Transter 1o Curtent S¢hool
©  Scheduke Requests fiom Previous Schools
Line CourseD T Course Title v Repeat Tag | Pre-Req Not Required T Corequisite Net Required T Locked T Locked in StudentvUE v
1 e B
cB20
s = B
4 [=d
5 ) Fund Eng Il “
eng
[ Courses in the Sceauie Requests from Previous Schools group box are not ofered at his school

O Quick Ada

Walk In Schedule Screen, Request Tab
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Defining Period Restrictions
Schools restrict scheduling for certain students during certain periods. For example, students

participating in a work-study program require a free afternoon schedule. Schools apply period
restrictions to houses and teams or to individual students.

Setting House and Team Period Restrictions

1. Navigate to Synergy SIS > Mass Scheduling > Mass Assign House And Team or
Synergy SIS > Schedule > Mass Assign House and Team.

Select the House or Team. Schools must process each House and Team separately.
Selectthe Low Period. This is the earliest period students can attend.
Selectthe High Period. This is the latest period students can attend.

Select Modify Only If Blank next to each period to update only the students with no existing
period restrictions.

o w0

[ E See Mass Assigning Houses and Teams for further information. ]

6. Enter any additional options.

Mass Assign House And Team £V &= Ceheo
Menu~ || Assign
School: Hope High School School Year: 2016-2017
Options Additional Filters
@ House and Team @ Period Restrictions
House Modify Only If Blank Low Period Modify Only If Blank
- ] - 0
Team Modify Only If Blank High Period Modify Only If Blank
- B - ]
@ Grade Filter @ Gender Filter
@ Exclude @ Include @ NotUsed Grade( = & Gender
Co7DosDo9 D10 =
A1 @12

Mass Assign House And Team Screen

7. Click Assign.
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Setting Individual Restrictions in Schedule Request

o bk~ w0 b

6.

Navigate to Synergy SIS > Mass Scheduling > Schedule Request or
Synergy SIS > Schedule > Walk In Schedule.

Locate the student to modify.

Select the Options tab.

Selectthe Low Period. This is the earliest period the student can attend.
Selectthe High Period. This is the latest period the student can attend.

Menu~ € Q¥ L] + Save | *yUndo

Student Name: Ahlstrom, Jack M. School: Hope High Scheol Status: Active Homeroom:

Requesis Restrictions Options Teacher Course Recommendation

Last Name First Name: Middle Name  Suffix Perm ID Grade Locked In Validated
Ahlstrom Jack M 888112 11 ~ |No ~| No |~
@ Scheduling Options @ ParentVUE Information
Low Period High Period Locked In ParentVUE Locked In Date
- - No |« =]
Schedule House Validated ParentVUE Validated Date
- No - ]

Schedule Team

-

Exempt House Exempt Team
0 8

Balance Code

¥ Schedule Request GG

Q

Q

|

Schedule Request Screen, Options Tab
Click Save.
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Setting Individual Restrictions in Walk In Schedule

1. Navigate to Synergy SIS > Mass Scheduling > Walk In Schedule or Synergy SIS >

Schedule > Walk In Schedule.

2. Locate the student to modify.
3. Selectthe Request tab.
4. Selectthe Low Period as the earliest period the student can attend.
5. Selectthe High Period as the latest period students can attend.
v Walk In Schedule A B
Menuv || € Q| > | | o | | «Save | ™yUndo | Print Schedule << Not Scheduled | | Not Scheduled >>
Student Name: Ahlstrom, Jack M. School: Hope High School Status: Active Room Name:
Quick Placement Analysis Schedule
Last Name First Name Middle Name ~ Suffix ~ Perm ID Grade L
Anistrom Jack M 886112 11 Sehedule
@ Select the terms to schedule ® Quick Add
Term To Schedule Add By Group
All Terms - -
Lock all courses | | Un-Lock all courses | | Delete Non-Scheduled Course Request(s)
@ Course Request Chooser
* Denotes altenate courses that were scheduled in lieu of the requested course.
** Denotes Sections associated with a Wheel course request
@ Scheduling Options
Low Period High Period Schedule House Schedule Team
Walk In Schedule, Request Tab
6. Click Save.
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Term Exclusion Codes

Team Exclusion Codes allow for only one course within a group of courses to be taken in a term. For
example, a school may allow students to take only one Art course per term, so schools assign the
same Term Exclusion Code to all Art classes. Assign term exclusion codes to sections through either
the mass scheduling or manual scheduling process.

Adding Term Exclusion Codes

1. Navigate to Synergy SIS > Mass Scheduling > Setup > School Setup Options.
2. Selectthe House/Team/Exclusion tab.
3. Click Add within the Team Exclusion Codes section.
4. EnteraCode and Description.
School Scheduling Options «zeFe
Menu~ o + Save | ™ Undo
School Name: Hope High School School Year: 2016-2017
Section Optlons Course RE!QUE!SI and Walk-In Optlons I HousefTeam/Exclusion I
® Term Exclusion Codes . ® House Codes + Add .
(% tne cow o omcrpior [ % ne | cose & oesrn &)
“n ART Art Elective AVID
ELL
House A
House B
SPED
School Scheduling Options Screen, House/Team/Exclusion Tab
5. Click Save.
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Assigning Term Exclusion Codes in Mass Scheduling

Create sections for specific option sets within the Schedule Section screen, then assign term

exclusions to them.

E See Overview of Option Sets for more information on option sets.

1. Navigate to Synergy SIS > Mass Scheduling > Schedule Control.

2. Open the option set.

Schedule Control

Menu~ | ok | |« Save | *yUndo

School: Hope High School Year 2016-2017

Scheduling Option Sets

Create/Copy Option Set

@ Option Sets

I

Option Set Name

[ @]
[
i
[ o]

Checked Qut
To Total 4 |Scheduled % | Date/Ti

I+
nzme-zm? Scheduler ~  User, Admin 137% 2764 38 04/05/2017
ALG Blank Scheduler ~  User, Admin
Backup Copy Scheduler ~  User Admin  9923% 2742 2721
Copy of last year's schedule Master Schedule Builder User, Admin % 2750 002/01/2017
| s s—
Schedule Control Screen
4. Select Open Schedule Section under Quick Links.

T Schedule Option Set | cmd
School: Hope High School

Menu~ | € Q¥ L] « Save | *™Undo
Run Mame: 2016-2017 Schedule Run In Progress: No

Options | Fill Open Periods

Currently Checked Out To J—

User, Admin ek

@ Last Schedule Run @ Current Stats

Run Name | 2016-2017
Schedule Now

Run Description

Term to Reschedule: If blank, scheduling entire year

-

Date/Time Total Scheduled Rejected Optimized % Total Time Total Scheduled Rejected %
04/05/2017 123648 & 2764 38 2726 0| 1.37% 00:00:38 2764 38 2726 | | 1.37%
@ Basic Information @ Quick Links

Open Student Schedule

Allow unchecked out users to edit sections

Ty

.‘%

oee

Open Schedule
Section

Open School Options

Open Option Set Wheel

Open ClassBoard

&
@

Schedule Option Set Screen
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6. Selectthe Term Exclusion under the Restrictions section.

v Schedule Section
Run Name: 2016-2017

¢ al» &

Menu

Section |D: 8008 Course Title: Biology Run Name: 2018-2017

Instructional Minutes Override Instructional Method

Cooperative Learning
B

Course Quality Points Quality Points Override

Cooperative Learning Mins

Serving Disfrict Serving School Institution Type

@ Restrictions

Grade Range Low Grade Range High Gender Resfriction Credit

09 ~| |09 - ~| 0.500

Term Exclusion

o

[C] No Term Override [C] Exclude From Mass Scheduling

o VEEVCHIR GG 4 Add | X Delete

Current Students Meeting Days
Section ID MSB Section ID Course ID  Course Title Staff Name Room Name
5008 5C4902 | &/ | Biology & &
@ Section Info @ staff Contributions @ Student Seat
Totals
Period Begin Period End Term Code Responsibility
6 ~ |6 -| |51 - -
@ Teacher Aide
Attendance Option Grading Option Instructional Strategy Amount Totals

[7] Using Elementary Minutes

College Credit

-

® staff Contributions

House Team

Responsibility

Amount

Schedule Section Screen

7. Click Save.
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Assigning Term Exclusion Codes in Manual Scheduling

Add term exclusion codes when creating sections or to existing sections.

See Managing Sections for more information creating sections for manual

scheduling.

1.

2. Locate the section to modify.

Navigate to Synergy SIS > Schedule > Section.

3. Selectthe Term Exclusion under the Restrictions section.

¥ Schedule Section

Run Name: 2016-2017

Section ID: 8008 Course Title: Biology Run Name: 2016-2017
Current Students Meeting Days

Section ID MSB Section ID

6008 SC492 | &
@ section Info

Period Begin Period End Term Code

6 - |6 - 51 -

Attendance Option Grading Option

- -

Instructional Minutes Override Instructional Method
[C] Using El

Cooperative Learning  Cooperative Learning Mins
a

Course Quality Points Quality Points Override

Serving District Serving School Institution Type

- -

@ Restrictions

Grade Range Low Grade Range High Gender Restriction Credit

09 ~ |08 - - 0.500

Term Exclusion

-

[7] No Term Override [] Exclude From Mass Scheduling

Menus € Q » & NEEVCRIENIGEE 4+ Add | X Delete

Biology &

Instructional Strategy

=

lementary Minutes

House

College Credit

Course ID  Course Title Staff Name Room Name

8

Team

Responsibility

Amount

@ staff Contributions @ Student Seat

-

Totals

® Teacher Aide
Totals

@ staff Contributions

Responsibility

Amount

Schedule Section Screen

4. Click Save.
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Overview of Option Sets

Option sets are test schedules used to determine schedule balance between student requests and
courses offered. You can create blank option sets or create a copy of a previous year’s schedule.
Each option set displays in the Schedule Control screen alphabetically by Option Set Name, along
with testing results for each option set.

This manual only discusses Scheduler type option sets. See the
Synergy SIS — Master Schedule Builder Guide for more information about
the Master Schedule Builder schedule type.

¥ Schedule Control m L M ccRe
Menu~ | ok || o Save | *Undo

School: Hope High School Year: 2014-2015

Scheduling Option Sets

Create/Copy Option Set
@ Option Sets
Current Stats Latest Run
Line Option Set a Checked Out| Student Results
Name o To % |Total & Scheduled % |Date/Time %
= = ¥ | Total # | Scheduled % |Rejected 2| %
2backup B scheduler - User, Admin 7.32% 2745 201 ::’:‘1"::15 2745 201 2544 7.32% 00:00:51
09/21/2015
ua backup TB% scheduler - User, Admin 7.32% 2745 201 B 2745 201 2544 7.32%  00:00:52
M abackup [ scheduler - User, Admin 7.32% 2745 201 022015 prss 201 2544 7.32%  00:00:52
L) 17:01:28
" 5pbackup [F scheduler - User, Admin 7.32% 2745 201 ::{ﬁ:ﬁ:ﬁ 2745 201 2544 7.32% 00:00:51
BackUp 09/21/2015 .
H o =, Scheduler - User, Admin 7.32% 27456 201 164509 2745 201 2544 7.32%  00:00:53
Deme Run 09/30/2014
IH 1-BIL u:!a‘ Master Schedule Builder ~ Wilson, Rob  91.77% 2745 2519 229318 2745 2519 226 91.77% 00:29:31

Schedule Control Screen

o Checked Out To — User currently editing the option set
« Current Stats — Lists the latest statistics of Percentage scheduled, Total students, and

Scheduled students. These statistics update after making changes to individual schedule
information, such as confirming prescheduled students.

« Latest Run - Lists the results from the latest test run of the option set. This includes the

Date/Time of the run, Total/Scheduled/Rejected students, the Percentage scheduled, and
the total Run Time of the test process.
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Creating an Option Set

Navigate to Synergy SIS > Mass Scheduling > Schedule Control.
Click Create/Copy Option Set.

Enter a Name and Description for the option set.

Select Scheduler for Schedule Type.

o kw0 bd =

Selecta Copy Option.

o Copy last year’s schedule — Copies a previous year’s master schedule. Enter the Year
from the list and select Include Sections without Teachers and/or Rooms, if
necessary.

Add New Option Set

Add Close

® Option Set Basic Info

Name Schedule Type
Scheduler -

Description

@ Create Options

Copy Option Year
Copy last year's schedule ~ | 2014-2015 -

[T Include Sections without Teachers and/or Rooms

Add New Option Set Screen

« Copy existing Option Set— Copies any option set in Schedule Control. Select the Year
and Scheduling Option Set.

o SelectInclude Sections without Teachers and/or Rooms, if necessary.
« Select Copy Student Results, if necessary.

@ Create Options

Copy Option Year Scheduling Option Set

Copy existing Option Set v M M
[C] Include Sections without Teachers and/or Rooms

[C] Copy Student Results

Add New Option Set Screen

o Blank—Used primarily by schools new to Synergy SIS or schools that completely
overhaul their scheduling options.
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o Copy current master schedule — Used primarily to readjust schedules mid-year.
Choose the Select Term to Schedule and Preschedule Current Student Classes
options from the list.

Using the Copy current master schedule option affects

A existing course requests. The system removes all existing
course requests and replaces these with course requests
based on student's current schedules.

@ cCreate Options

Copy Option Select Term to Schedule Preschedule Current Student Classes
Copy current master schedule | = - -

WARNING: Using this option will affect existing course requests. All existing course requests will be
removed and replaced with course requests based on student's current schedules.

This option is most often used for mid year re-scheduling and not during the process of setting up the new year
scheduling. Typically the Copy Option 'Copy Last year's schedule' is used during new year scheduling. Please verify
before adding this new option set.

Add New Option Set Screen

6. Click Add when finished. The Job Status window displays and notifies the user once the
option set finishes.

Job Details:

Job Detail

09/24/2015 12:43:22 Sched-Create Add new scheduling Option Set

Status

In progress:
@, i orog

Job Details Screen
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Only one user can edit an option set at a time. This prevents multiple users from working in the same
option set and overwriting updates. Users can still view information in checked out option sets.
Check out option sets on the Schedule Control screen. You can check out multiple option sets at the

same time.

4

erasing your changes.

Edupoint recommends that you keep option sets checked out until you
complete all changes. Checking out option sets prevents others from

1. Navigate to Synergy SIS > Mass Scheduling > Schedule Control.

2. Select the Zato open the Scheduler option set.

Schedule Control

Menu~ | | ik | | Save | Undo

School: Hope High School Year 2016-2017
Scheduling Option Sets
Create/Copy Option Set

@ Option Sets

Option Set Name

Scheduler
Scheduler

Scheduler

nﬁackup Copy
jn(:opy of last year's schedule

sl sl &l &

Master Schedule Builder =

Checked Out
To Total # | Scheduled 3 Date/Time =

1.37% 2764 38 04/05/2017 12:36:48

- User, Admin

hd User, Admin

- User, Admin 89.23% 2742 2721

User, Admin % 2750 002/01/2017 10:29:58

Schedule Control Screen

3. Click Check Out. Your username displays in Currently Checked Out To.

Schedule Option Set
< a > -

Menu =

Options

Currently Checked Out To
Check Out

@ Last Schedule Run

Fill Open Periods

+ Save | = Undo [ 4NEEE

Run Name: 2 backup Schedule Run In Progress: No

Schedule Option Set Screen

4. Selectthe Allow unchecked out users to edit sections under Quick Links to permit other
users to modify sections using the Schedule Section screen if checked out. Users cannot edit

any other option set information.
5. Click Save.

6. Click Check In to unlock the option set after making changes.
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Quick Links

The Quick Links section offers links to various screens that assist with the scheduling process.

Changes made through these screens only affect the data within the option set.

Open Student Schedule — Allows you to view and modify student course requests. This

screen provides the same functionality as the Schedule Request screen.

Open Schedule Section — Allows you to create and modify sections. This screen provides

the same functionality as the Section screen.

Open School Options — Allows you to edit the School Scheduling Options.

Open Option Set Wheel — Allows you to add sections to course wheels.

Open ClassBoard — Opens the ClassBoard screen.

[ E See ClassBoard Overview for more information on ClassBoard. ]

® Quick Links

Open Student Schedule

Open Schedule [C] Allow unchecked out users to edit sections

Section

Open School Options

Open Option Set Wheel

Open ClassBoard

Schedule Option Set
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Mass Scheduling Processing Options

The School Scheduling Options screen contains rules and settings for the Mass Scheduling and
Master Schedule Builder processes. This controls how the system handles prescheduled students
when scheduled course requests already exist.

1. Navigate to Synergy SIS > Mass Scheduling > Setup > School Scheduling Options.
2. Selectthe Course Request and Walk-In Options tab.

School Scheduling Options e e

Menu~ o « Save | * Undo

School Name: Hope High School School Year: 2016-2017

Section Options | Course Request and Walk-In Options | House/Team/Exclusion

@ Course Request / Walk-n Scheduling Options
@ Enforce the following rules @ Balance Options
[T] Use Teacher Preferences - Course Request Sequence -
Corequisite Option | | ~ Balance Option -
Prerequisite Option -
[T Allow Alternale Course @ Mass Scheduling Options
[0 Use Room Seat Limit When a student is added to a Section and a Course Request exists but is already being used.
] check Term Override Perform the following action
[ Check Term Preference - Prompt with error (default) -

[F] Check Student Restrictions

[F] Check Teacher Restrictions
House Option Match Sections with Houses |
Team Option -

Duplicate Course
Request

Max time to spend per student (in seconds; default value
is .1 second)

School Scheduling Options Screen, Course Request And Walk-In Options Tab

3. Select the Mass Scheduling Options.

« When a student is added to a Section and a Course Request exists but is
already being used. Perform the following action:

« Prompt with error (default) — Asks for confirmation before scheduling.

o Use existing Course Request — Uses the existing course request for the student
for the section.

o Create New Course Request— Creates a new course request for the student
while keeping the existing request.

® Mass Scheduling Options

When a student is added to a Section and a Course Request exists but is already being
used. Perform the following action

Prompt with error (default) -

School Scheduling Options Screen, Course Request And Walk-In Options Tab

4. Click Save.
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Analyzing Course Requests

After entering all student course requests, schools review course request totals to see which options
accommodate the majority of students. For example, schools can cancel classes with low enrollment
or add additional sections for courses with high interest.

1. Navigate to Synergy SIS > Mass Scheduling > Course Request Analysis.
2. Enter the analysis criteria.

View courses by Department, Course ID, or Course Title.
b. You can also analyze courses by their PVUE Locked and PVUE Verified values.

c. Enteranumberinthe Less Than Requests field to view courses with a low request
total.

Course Request Analysis
Menu~ o + Save | *yUndo

I
3
a
-

4
©

Analysis Repeats

Department Course ID Course Title PVUE Locked PVUE Verified Less Than Requests
- - - Filter

Current student filter is: *Active Only'. Use focus menu to change active/inactive filter settings

® Course Reqguest Analysis

Totals

Course Request Analysis Screen

3. Click Filter to display a list of courses. Each course lists the number of requests by grade
level, gender, and the number of times a student requests the class as an alternate.

Course Request Analysis « CCcEe
Menu~ | Mk | Save 4y Undo

Analysis
Department Course ID Course Title PVUE Locked PVUE Verified Less Than Reguests
- - - Filter

Current student filter is: ‘Active and Inactive'. Use focus menu to change activefinactive filter settings

@ Course Request Analysis

o [ e [ e [ w1 [ s | |
Male Female Male Female Male|Female Male Female Male Female Male Female Male Female| All Course|
nsc SC33 - Earth Science 2 1 1 3 1 4
SC S§C332 - Earth Science 50 33 46 26 8 10 104 69173
SC 5C42 - Life Science 1 1 1
nsc §C422 - Life Science 39 14 6 [ 1 3 4B 23 69
| ==

Course Request Analysis Screen

4. Selectthe Course name to screen the students that requested the course. The School
Course Detail screen opens.

5. Totransfer all student requests from this course to another course:

a. Clickthe :E? next to Destination Course.
b. Find and select a substitute course.
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c. Click Transfer to move all students.

School Course Detail

< ced
Menu- | o + Save | *yUndo

Primary Course Request Alternate Course Request

Department Course ID Course Title
sC SC49 Science 10

@ Re-assign Request

@ Additional Course Request Filter Options

Destination Course Traner Course One Course Two Course Three it
ransfer iiter
5C492 & g g &
® Note

@ Students
n 2,3 4|5 6 7 8,9 10
-- Abbott, Billy C 905483
-- Abbott, Bobby C ) 168523 10

School Course Detail Screen

6. Tofilter the Students section by displaying overlapping course requests:

a. Clickthe & next to each Course under Additional Course Request Filter Options
b. Click Filter.

Courses selected under Additional Course Request Filter
Options filter as an AND condition. Students displayed
requested all of the specified courses with the original course.

School Course Detail

« Cee
Menu~ ol + Save | *Undo

Primary Course Request Alternate Course Request

Department Course ID Course Title
SC S5C49 Science 10

@ Re-assign Request

@ Additional Course Request Filter Options
Destination Course

S— Course One Course Two Course Three -
ransfer iter
el gs51 | & EN32 | & &
® Nole
@ Students
i Acevedo, Andrew 886630 "

School Course Detail Screen
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7. Selectthe Alternate Course Request tab to view students who requested the course as an
alternate. You can delete or transfer these students.

School Course Detail . coed

[

Menu~ o + Save | *yUndo

Primary Course Request | Alternate Course Request |

Department Course ID Course Title
AG AG31 Animal Sci

@ Re-assign Request

Destination Course

Transfer
8

@ Students

@ Global Students
-- AAA, Cindy 997031
-- Acosta, John A 150265 1

School Course Detail Screen, Alternate Course Request Tab

8. Click Save.

To review additional course request data to analyze course

E offerings, see the OSM409 — Student Course Request Verification
Listing, OSM601 — Course Request Totals, and OSM602 — Student
Request Exception reports.
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Creating Sections

Schools must add all sections for all courses prior to running the option set. Each Option Set uses a

different list of sections.

Edupoint recommends that you add sections to only the first Option Set
0 created each year and copy this set for any additional schedules to reduce
data entry.

1.

Navigate to Synergy SIS > Mass Scheduling > Schedule Control.

2. Open the option set.

Schedule Control ‘
Menu~ | o  Save | Undo

Q
G
&l
)

School: Hope High Schoel Year 2016-2017

Scheduling Option Sets

Create/Copy Option Set

Checked Out
Option Set Name selea -
To Total ¥ [Scheduled ¥ Date/Ti

I3
Scheduler hd User, Admin 1.37% 2764 38 04/05/2017

@ Option Sets

1 2016-2017

ALG Blank
Backup Copy

Scheduler - User, Admin

Scheduler - User, Admin 9923% 2742 2721

Copy of last year's schedule ¥z Master Schedule Builder = User, Admin % 2750 002/01/2017
R —————

Schedule Control Screen

4. Select Schedule Section under Quick Links.

@ Quick Links

% Open Student Schedule

?:;: Open Schedule Allow unchecked out users fo edit sections

Section

Open School Options

Open Option Set Wheel

Open ClassBoard

Schedule Option Set Screen

179

Copyright 2009-2020 Edupoint Educational Systems, LLC



Schedule and Course Guide

180 Chapter 6: Mass Scheduling

5. Click Add. The Schedule Section screen opens.

If the Section ID automatically generates, leave this field blank.
Otherwise, enter a unique Section ID. The Mass Scheduling
process does not use the MSB Section ID.

6. Selectthe '-.‘-?under Course ID to locate the course. The Course Title populates
automatically.

7. Selectthe '-5? under Staff Name to find and select the teacher staff member.

8. Selectthe '-‘-? under Room Name to find and select the school room.
9. Selectthe Period Begin and Period End.
10. Selectthe Term Code.
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Enter the Max number of students for the section under Student Seat Totals.

Period Begin*  Period End* Term Code*

Attendance Option Grading Option
Instructional Strategy
Instructional Minutes Override Instructional Method

College Credit
[T] Using Elementary Minutes

@ staff
Contributions

@ student Seat Totals

O Prohibit assigning additional students once the Max is reached,
regardless of class size limit rules in School Scheduling Options.

Responsibility

-

Male Female Total

Amount

Max Class Size Override Password

@ Teacher Aide Totals

Total Max

Open Seats

p
Prohibit assigning additional students once the Max is reached,
regardless of class size limit rules in School Scheduling Options
overrides any other configuration of blocking for the specific section.
The following message displays when you attempt to add another student with
the section at the max student count.
« The section number displays on the error message to help identify which
section reached the max student count.
I, « The student row number displays on the error message to help identify
= which student was over the max student count.
A Error
Unable to add student. The section ('AD709-14") prohibits assigning additional
students once the max is reached.
(row: 21)
Class Size Limit Error Message
. J
Schedule Section | ke
*® Close
Current Students Meeting Days
Section ID MSB Section ID Course ID* Course Title Staff Name Room Name
& & &
@ Section Info

Max? Open Seats

Schedule Section Screen
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12. Selectthe Serving School to include the school name in the Student Course History record
for the class.

@ Section Info @ staff ® Student Seat Totals
) Contributions

Period Begin*  Period End* Term Code® [T prohibit assigning additional students once the Max is reached,

- - - Responsibility regardiess of class size limit rules in School Scheduling Options.
Attendance Option Grading Option T Male Female  Total Max* Open Seals

- - Amount
Instructional Strategy Max Class Size Override Password
-
Instructional Minutes Override Instructional Method @ Teacher Aide Totals
-
§ Total Max
College Credit

Open Seats
[0 Using Elementary Minutes

-
Cooperative Learning

o

Course Quality Points Quality Points Override

Cooperative Learning Mins,

Serving District{ Serving Schoolf Institution Type

- -

Schedule Section Add Screen
13. Enter any additional section information.
14. Click Save.

Running the Scheduler

The Schedule Option Set screen contains variables and rules to apply to the option set data, which
you review by running test schedules with student request and course data. The Last Schedule Run
and Current Stats fields display schedule results and are read-only.

7 Schedule Option Set

« cMe
School: Hope High School

5
Menu~ | € QP L «Save | ®uUndo [EIEEE

Run Name: 2018-2017 Schedule Run In Progress: No

Options Fill Open Periods
Currently Checked Out To
Check In
User, Admin
@ Last Schedule Run @ Current Stats
Date/Time Total Scheduled Rejected Optimized %  Total Time Total Scheduled Rejected %
04/05/2017 12:36:48 & 2764 38 2726 0 1.37% 00:00:38 2764 38 2726 | 1.3T%

Schedule Option Set Screen
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1. Navigate to Synergy SIS > Mass Scheduling > Schedule Control.
2. Open the option set.

—
Schedule Control «zeRe
Menu~ | | ok | ¢ Save | *%Undo
School- Hope High School Year 2016-2017
Scheduling Option Sets
Create/Copy Option Set
@ Option Sets .
Checked Out
Line Option Set Name - =
To Total ¥ |Scheduled ¥ Date/Ti
nn201&2017 = Scheduler - User, Admin 1.37% 2764 38 04/05/2017
nALG Blank Scheduler - User, Admin
nBa{:kup Copy Scheduler - User, Admin 9923% 2742 2721
nncopy of last year's schedule Eﬂ‘ Master Schedule Builder User, Admin % 2750 002/01/2017
| e

Schedule Control Screen
3. Modify the Run Name if needed. This changes the name of the option set in Schedule
Control.
Enter a Run Description.

5. Selectthe Term to Reschedule from the list if using a copy of the current master schedule. If
not, this field is disabled.

6. Select the scheduling rules to apply under the Enforce the follow rules section.

« Use Teacher Preferences — Reviews the teacher/staff preference chosen for the
student's course request during the scheduling process.

o Must Have — Only schedules the request if the system can meet the student's
preference. The variable becomes a high priority.

o Try— Attempts to schedule the request with the student's preference. If
unavailable, the system chooses another section that meets other requirements
with higher priorities.
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« Corequisite Option— Enforces corequisite requirements defined on the District
Course screen.

o Full Enforcement (Checks CHS) — Uses student course history to check if the
student took the corequisite course previously. If so, the system schedules the
course request.

« Enforce Requested — Requires the student to also request any corequisites
along with the original course request, or it does not schedule the course. If the
student requests both courses, the system schedules them in the same term.

« Schedule Requested — Schedules any corequisite courses in the same term
along with the course request.

« No Enforcement — Default option. Disregards all corequisites during scheduling.
« Prerequisite Option — Defines prerequisites listed in the District Course screen.

« Full Enforcement (Checks CHS) — Uses student course history to verify that
students complete prerequisites.

o No Enforcement — Default option. Disregards all prerequisites during scheduling.

« Schedule Requests in Prereq Order— Schedules any prerequisite courses
required for the student in the first term of the schedule. Schools use this option
when creating schedules for a year or if student grades have not yet posted.

« Allow Alternate Course — Schedules alternate course requests if a student's primary
course request is unavailable.

« Allow Global Alternate Courses — Schedules any global alternate coursesif a
student's primary course request is unavailable. Enabled by default.

« Use Room Seat Limit — Limits the number of students assigned to a section based on
room capacity instead of the seat limit assigned to the section. Schools rarely use this
option, as section class size allows more flexibility in scheduling.

o Check Term Override — Attempts to honor term overrides chosen for a course
request.

o Check Term Preference — Reviews the term preference chosen for a student's
course request during the scheduling process.

» Must Have — Only schedules the request if the system can meet the student's
preference. The variable becomes a high priority.

o Try—Attempts to schedule the request with the student's preference. If
unavailable, the system chooses another section that meets other requirements
with higher priorities.
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o Check Student Restrictions and Check Teacher Restrictions — Verifies if
scheduling conflicts with any restrictions in place for a student or teacher on the
Schedule Request screen.

[
See Schedule Request for more information.

@ Enforce the following rules

[] Use Teacher Preferences -
Corequisite Option -
Prerequisite
Option

[ Allow Alternate Course

Allow Global Alternate Courses

[[] Use Room Seat Limit

[[] Check Term Override

[[] Check Term Preference -

[[] Check Student Restrictions
[7] Check Teacher Restrictions

House Option | No House Enforcement -

Team Option | No Team Enforcement -
Duplicate

Course Request

Exceed max class size for CORE classes by
this %

Exceed max class size for ELECTIVE classes
by this %

Exceed max class size for OTHER classes by
this %

Special Run

Option

Max time to spend per student (in seconds; default
value is .1 second)

Schedule Option Set Screen
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« House Option — Chooses how the Scheduler processes house assignments.

» Automatic House Enforcement — Students manually assigned to houses remain
with their house through the scheduling process.

« The system only schedules course requests if they match sections within
the house. If they do not match within a house, it ignores them.

« The system schedules students with no house assignments into any
section, regardless of the house affiliated with the section.

« Match Sections with Houses — Schedules students assigned to a house into
sections designated for that house. If the section is not part of a house, the
system schedules any studentinto it.

« Students manually assigned to a house retain their assignment.
« The system schedules unassigned students into the first house available
for their schedule.

» No House Enforcement — Ignores house assignment for students and sections
during the walk-in scheduling process.

o Team Option — Chooses how the Scheduler processes team assignments.

» Enforce Team Assignments — Students manually assigned to teams remain with
their team throughout the scheduling process. If the section is not part of a team,
the system schedules any student into it.

« The system only schedules students assigned to a team into sections
designated for the team.

« The system schedules unassigned students into the first team available for
their schedule.

« No Team Enforcement — Ignores team assignment for students and sections
during the walk-in process.

« Duplicate Course Request — Determines how the scheduling process handles
duplicate requests.

« Reject all duplicates — The system rejects all duplicate course requests.

« Schedule all of the duplicates — The system schedules all duplicate course
requests.

« Schedule one of the duplicates — The system only schedules the duplicate
request that best fits the student's schedule.

This option overrides any duplicate course setting on the
individual District Course screens.

« Exceed max class size for CORE/ELECTIVE/OTHER classes by this % — Allows
Core, Elective, and Other class types to exceeded sizes by a percentage amount.
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« Special Run Option — Sets a specific run option for the scheduler.

« Ignore max class size — Schedules sections without using class size restrictions.
Edupoint recommends using this option for the first few test runs of an option set.
This allows you to discover more serious scheduling conflicts.

« Perform schedule optimization — Used to remove previously scheduled students
from a section so that a seat opens for a student with a scheduling conflict. While
this option can fix many scheduling issues, the process is time consuming.

This process does not attempt to resolve an
incompatible schedule issue.

« Max time to spend per student — Maximum amount of time the scheduling process
attempts different options per student.

Only change this setting if a scheduling conflict indicates that a
A student was not scheduled due to a timeout. You should only
increase the number in .025 increments.

@ Enforce the following rules

[[] Use Teacher Preferences -
Corequisite Option -
Prereguisite
Option

[] Allow Alternate Course

Allow Global Alternate Courses

[[] Use Room Seat Limit

[[] Check Term Owverride

[[] Check Term Preference -

[ Check Student Restrictions
[T Check Teacher Restrictions

House Cption Mo House Enforcement -
Team Option | No Team Enforcement -
Duplicate

Course Request

Exceed max class size for CORE classes by

this %

Exceed max class size for ELECTIVE classes

by this %

Exceed max class size for OTHER classes by
this %

Special Run

Option

Max time to spend per student (in seconds; default
value is .1 second)

Schedule Option Set Screen
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7. Select the Balance Options.

« Grade Order — Allows the system to process student priority by grade: High Grade to
Low Grade, Low Grade to High Grade, or Not Used.

« Sequence By — Variables which assign the scheduling order: Alpha A to Z, Alpha Z to
A, Difficulty and Random. The system determines Difficulty by the number of available
sections to the number of periods offered for the course.

o Course Request Sequence — Determines the order the system processes course
requests.

« By Course Request Priority and By Difficulty — Schedules course requests first
by Schedule Priority (Core or Elective) and then overall difficulty.

« By Difficulty — Schedules courses by overall difficulty, determined by the number
of available course sections versus the number of available periods.

For the best scheduling results, Edupoint recommends
0 that schools select By Difficulty for the Course
Request Sequence option.

« Balance Option — Attempts to keep a demographic balance when scheduling
students. Available options are Balance Property, Ethnicity, Gender, Gender and
Balance Property, Gender and Ethnicity, and Total Students.

« Balance Property consists of a custom set of values, such as ELL or SPED. You
can assign students a Balance Code on the Schedule Request screen in the
Mass Scheduling module.

o Thelookup table K12.MassSchedulelnfo.UserBalance contains the codes

used for this property.
[ See Lookup Table Definitions for more information on lookup ]
tables.

(@ Balance and Sequence Options
Grade Order Low Grade to High Grade | = Sequence By | Difficulty -
Course Request Sequence -

Balance Option Total Students -

Schedule Option Set Screen
8. Select the rules to apply under Exclude the following students.

o Selectthe Grade Levels, Houses, or Teams to exclude.
« Select Lock Schedule for Skipped Students to retain their schedule information.

A If left blank, the system removes schedules from excluded
students.
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o SelectDo Not Process Fully Scheduled Students to save processing time.

® Exclude the following students

Do Mot Process the Following Grade Levels 0 +* &
107 108 E109 10 E 11 E112

Do Mot Process the Following Houses O +* &

[F] AVID [E] ELL [F] HSA [] HSB [C] SPED

Do Mot Process the Following Teams O +* &

COa@BOC

O Lock Schedule for Skipped Students - NOTE: If this is not checked and

grade levels (above) are selected to be skipped, the skipped student's
class assignments will be cleared

[F] Do Mot Process Fully Scheduled Students

Schedule Option Set Screen

9. Click Schedule Now in the Basic Info section to run the option set with the selected variables
and data.

® Basic Information

Run Name 2016-2017

Schedule Now

Run Description

Term to Reschedule: If blank, scheduling entire year

-

Schedule Option Set Screen

The Job Status screen displays a message once the scheduler finishes. Depending on the options
selected and the information entered, it might take some time to complete.
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Clear All Results and Debug

The Clear All Results section contains the option to Clear all schedule results from previous runs.

This does not clear any prescheduled students.

@ Clear All Results

Clear all schedule results
student result, copy this Option Set to a new option set.

@ Debug

Verbose Messages

]

NOTE: This will clear all current student scheduled results in this option set. All prescheduled sections are preserved. If you want to start with a blank

Schedule Option Set Screen

The Debug section contains the Verbose Messages option, which provides more detailed error

messages for schedule processing logs.

Fill Open Periods

The Fill Open Periods tab allows the system to schedule the same course for all students during a
selected period. Schools use this function to schedule study halls or homeroom courses.

Select the Fill Open Periods tab.
Selecta term.

Select the period range.
Click Save.

Click Fill Open Periods.

o gk w N =

Click the '-‘-?to find a select a course. The Course ID and Course Title automatically populate.

A You cannot reverse this process.

T Schedule Option Set

School Hope High Scheol

Menu + < Qa » L] + Save  *Undo [RAVSEE

Run Name: 2016-2017 Schedule Run In Progress: No

Options Fill Open Periods

Currently Checked Out To

Check In
User, Admin -

@ Options
Fill all Student open periods for the term:
Spring -
with the following course:
NCS501 Study Hall Study Hall| &
in the following period range:

6 ~ - |8

Fill Open Periods

Schedule Option Set Screen, Fill Open Periods Tab
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Mass Assigning Sections

The Mass Assigning Sections screen allows schools to make global changes to schedules within an
Option Set. This process does not change the section assignments in the final student schedule.

Mass Assign Sections processes sections in one of three ways:

« Add/Keep — The process adds sections to all students that match the criteria specified. You
can choose to keep existing sections or course requests or preschedule students into the
section.

» Replace — The process removes the specific section listed under Find and Replace and
replaces it with the section listed under Sections to Add.

« Remove — The process assigns the section listed under Sections to Add, but keeps the
specified section listed under Find and Replace. You can also remove course requests for the
section.

Creating Mass Assignments

Navigate to Synergy SIS > Mass Scheduling > Mass Assign Sections.
Click Add.

Enter a Name.

Choose the Option Set to apply changes to from the list.

Click Save.

o kw0 bd =

¥ Mass Assign Sections ‘
Menu ~ < Q » ol + Save * Undo Assign Sections

Mass Assign Student Selection

0
e}
brd
]

Name Option Set
Sci 10 to Bio 2016-2017 -

The following will ook for all students who are enrolled in the Sections To Find and Replace and will add/replace/remove them with the Sections To
Add

@ Sections To Add + Add | Chooser @ Sections To Find and Replace 4 Add | Chooser
[ e secionio & couse1o ¢ course e #Jl % | une | secion 0 & Gourse 0 & Gouse e & fn &
@ Options

Course Reguests -

Prescheduled -

@ Student Filters

Gender hd

Grade
o7 [Clog [Cog 10 C 11 C12

Mass Assign Sections Screen

6. To Add sections:

a. Click Add or Chooser to find and select sections under the Sections to Add section.
b. Leave the Sections to Find and Replace section empty.
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7. ToReplace sections:

Click Add or Chooser to find and select sections under the Sections to Add section.

Click Add or Chooser to find and select sections under the Sections to Find and
Replace section.

Select the Action under Sections to Find and Replace.

« Keep —Keeps existing sections of the course assigned to the specified students.

« Remove Course Request— Removes the course request from the specified
students.

« Replace Section — Removes existing sections of the course from the specified
students and replaces them with the new section.

8. To Remove sections:

a.

Click Add or Chooser to find and select sections under the Sections to Find and
Replace section.

Select Remove Course Requestfor Action.
Leave the Sections to Add section empty.
v Mass Assign Sections  cEiLe

Menu~ <€ Q & | ssave | ®Undo SN IR IVEEEE | Assign Sections

Mass Assign Student Selection
Name Option Set
5ci 10 to Bio 2016-2017 -

The following will look for all students who are enrolled in the Sections To Find and Replace and will add/replace/remove them with the Sections To
Add

@ sections To Add .. @ sections To Find and Replace
Course Course ) 0
Action
nﬂﬂﬂ nﬂﬂﬂ Title ¥ =
“- 6008 SC492 Biology “- 6009 SC49 Science 10 Replace Section -

Mass Assign Sections Screen

9. Select Only replace sections if a student has matching requests for Course Requests if
needed. If left blank, the process adds sections regardless of a student's course request
information.

10. Select Preschedule students into the section(s) for Prescheduled if needed.

11. Select a Gender to filter requests to this type.

12. Selecta Grade to filter request to this type.

@ Options
Course Requests -

Prescheduled -

@® Sstudent Filters

Gender hd

Grade
[Flo7 [Flos Eo9 @10 [E11 112

Mass Assign Sections Screen
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13. Select the Student Selection tab to assign the section to specific students.
14. Click Add or Chooser to find and select students.

Menu -

MWame

v Mass Assign Sections - € o= KR AR c/elg-e

€ Q > = o Save || ¥ Undo m P Rl | Assign Sections
Mazs Assign Student Selection

Change Jewelry to Photo Masgs Scheduling Trial Run #1 -

@ Selected Students

E
1

Option Set

e remm T e v
10

Aaron, Mary E. 997097

15. Click Save.

Mass Assign Sections Screen, Student Selection Tab

16. Click Assign Students to process the definition. A message with results displays once

completed.

v Mass Assign Sections

Menu - < Q » L]  Save | *yUndo [ECJEGLENER IVETEN | Assign Sections

Mass Assign Student Selection
Name Option Set
Sci10 to Bio 2016-2017 -

Mass Assign Sections Screen

Synergy

Assign Completel

Total students reviewed: 1511
Total students modified: 7
Total Time: 00:00:34_ 4294305

Synergy Message
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Manual Scheduling Options

The School Scheduling Options screen contains rules for scheduling students using the Walk In
Schedule screen.

1. Navigate to Synergy SIS > Mass Scheduling > Setup > School Scheduling Options.
2. Selectthe Course Request and Walk-In Options tab.

School Scheduling Options «ceme

Menu~ « Save | * Undo

School Name:” Hope High School School Year: 2016-2017

section Options | Course Request and Walk-n Options | House/Team/Exclusion

se Request / Walk-In Scheduling Options

@ Enforce the following rules @ Balance Options

[C] Use Teacher Preferences - Course Request Sequence

Corequisite Option v Balance Option -
Prerequisite Option -

[ Allow Alternate Course ©® Mass Scheduling Options

[7] Use Room Seat Limit When a student is added to a Section and a Course Request exists but is already being used
[0 Check Term Override Perform the following action
[F] Check Term Preference - Prompt with error (default) -
[[ Check Student Restrictions
[0 Check Teacher Restrictions

House Option Match Sections with Houses -

Team Option -

Duplicate Course
Request

Max time to spend per student (in seconds; default value
is 1 second)

School Scheduling Options Screen, Course Request And Walk-In Options Tab

3. Select the scheduling rules to apply in the Enforce the following rules section.

« Use Teacher Preferences — Reviews the teacher/staff preference chosen for the
student's course request during the scheduling process.

o Must Have — Only schedules the request if the system can meet the student's
preference. The variable becomes a high priority.

« Try— Attempts to schedule the request with the student's preference. If

unavailable, the system chooses another section that meets other requirements
with higher priorities.

« Corequisite Option — Enforces corequisite requirements defined on the District
Course screen.

o 1/Full Enforcement (Checks CHS) — Uses student course history to check if the

student took the corequisite course previously. If so, the system schedules the
course request.

« 2/Enforce Requested — Requires the student to also request any corequisites
along with the original course request or it does not schedule the course. If the
student requests both courses, the system schedules them in the same term.

o 3/Schedule Requested — Schedules any corequisite courses in the same term
along with the course request.

o 4/No Enforcement— Default option. Disregards all corequisites during
scheduling.
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« Prerequisite Option — Defines prerequisites listed in the District Course screen.

» Full Enforcement (Checks CHS) — Uses student course history to verify that
students complete prerequisites.

« No Enforcement — Default option. Disregards all prerequisites during scheduling.

« Schedule Requests in Prereq Order— Schedules any prerequisite courses
required for the student in the first term of the schedule. Schools use this option
when creating schedules for a year or if student grades have not yet posted.

« Allow Alternate Course — Schedules alternate course requests if a student's primary
course request is unavailable.

o Use Room Seat Limit — Limits the number of students assigned to a section based on
room capacity instead of the seat limit assigned to the section. Schools rarely use this
option, as section class size allows more flexibility in scheduling.

o Check Term Override — Attempts to honor term overrides chosen for a course
request.

@ Enforce the following rules

[ Use Teacher Preferences -
Corequisite Option | | -
Prerequisite Option -
[T Allow Alternate Course

[[] Use Room Seat Limit
] Check Term Override

[[] Check Term Preference d

[[] Check Student Restrictions
[] Check Teacher Restrictions

House Option  Match Sections with Houses -
Team Option v

Duplicate Course
Request

-

Max time to spend per student (in seconds; default value
is .1 second)

School Scheduling Options Screen, Course Request And Walk-In Options Tab

o Check Term Preference — Reviews the term preference chosen for a student's
course request during the scheduling process.

» Must Have — Only schedules the request if the system can meet the student's
preference. The variable becomes a high priority.

« Try— Attempts to schedule the request with the student's preference. If
unavailable, the system chooses another section that meets other requirements
with higher priorities.
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« Check Student Restrictions/Check Teacher Restrictions — Verifies if scheduling
conflicts with any restrictions in place for a student on the Schedule Request screen.

[ E See Schedule Request for more information. ]

« House Option — Chooses how the Scheduler processes house assignments.

« Automatic House Enforcement — Students manually assigned to houses remain
with their house through the scheduling process.

« The system only schedules course requests if they match sections within
the house. If they do not match within a house, itignores them.

« The system schedules students with no house assignments into any
section, regardless of the house affiliated with the section.

« Match Sections with Houses — Schedules students assigned to a house into
sections designated for that house. If the section is not part of a house, the
system schedules any student into it.

« Students manually assigned to a house retain their assignment.
« The system schedules unassigned students into the first house available
for their schedule.

« No House Enforcement — Ignores house assignment for students and sections
during the walk-in scheduling process.

o Team Option — Chooses how the Scheduler processes team assignments. The field
under Enforce the following rules should be set to one of the following:

» Enforce Team Assignments — Students manually assigned to teams remain with
their team throughout the scheduling process. If the section is not part of a team,
the system schedules any student into it.

« The system only schedules students assigned to a team into sections
designated for the team.

» The system schedules unassigned students into the first team available for
their schedule.

« No Team Enforcement — Ignores team assignment for students and sections
during the walk-in process.

Copyright 2009-2020 Edupoint Educational Systems, LLC



198 Schedule and Course Guide
Chapter 7: Manual Scheduling

« Duplicate Course Request — Determines how the scheduling process handles
duplicate requests.

« Reject all duplicates — The system rejects all duplicate course requests.

« Schedule all of the duplicates — The system schedules all duplicate course
requests.

o Schedule one of the duplicates — The system only schedules the duplicate
request that best fits the student's schedule.

This option overrides any duplicate course setting on
the individual District Course screens.

« Max time to spend per student — Maximum amount of time the scheduling process
attempts different options per student.

Only change this setting if a scheduling conflict indicates that a
A student was not scheduled due to a timeout. You should only
increase the number in .025 increments.

@ Enforce the following rules

[C] Use Teacher Preferences -
Corequisite Option | | ~
Prerequisite Option -
[C] Allow Alternate Course

[[] Use Room Seat Limit
[C] Check Term Override

[C] Check Term Preference -

[ Check Student Restrictions
[C] Check Teacher Restrictions

House Option  Match Sections with Houses -
Team Option -

Duplicate Course
Request

-

Max time to spend per student (in seconds; default value
is .1 second)

School Scheduling Options Screen, Course Request And Walk-In Options Tab
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4. Selectthe Balance Options.

« Course Request Sequence — Determines the order the system processes course
requests.

« By Course Request Priority and By Difficulty — Schedules course requests first
by Schedule Priority (Core or Elective) and then by overall difficulty.

« By Difficulty — Schedules courses by overall difficulty, determined by the number
of available course sections versus the number of available periods.

« Balance Option — Attempts to keep a demographic balance when scheduling
students. Available options are Balance Property, Ethnicity, Gender, Gender and
Balance Property, Gender and Ethnicity, and Total Students.

« Balance Property consists of a custom set of values, such as ELL or SPED. You
can assign students a Balance Code on the Schedule Request screen in the
Mass Scheduling module.

« The lookup table K12.MassSchedulelnfo.UserBalance contains the codes

used for this property.
[ See Lookup Table Definitions for more information on lookup ]
tables.

@ Balance Options

Course Request Sequence -

Balance Option -

School Scheduling Options Screen, Course Request And Walk-In Options Tab

5. Click Save.
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Managing Sections

If manually scheduling students, add all sections for your school using the Section screen in the
Schedule module.

Before deleting a section, you must first delete all students in the Current
Students and Student Enrollment History tab and all staff under the
Additional Staff tab.

Adding Sections

Screens within the Schedule module modify student schedules after the Mass Scheduling
processes completes. For smaller districts, staff use the module to schedule students manually. You
must create sections before the scheduling process begins.

1. Navigate to Synergy SIS > Schedule > Section.

2. Click Add to open the Section (Add) screen.

If the Section ID does not automatically generate, enter a unique
Section ID. Otherwise, leave the generated value. The Mass
Scheduling process does not use the MSB Section ID.
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Students and Meeting Days tabs automatically.

You can also duplicate an existing course by selecting Duplicate
Section from the Menu. This only copies the data on the Current

¥ Section

Edit Section Data Reports

Synchronize Section Tolals STU408 - Class Student
Synchronize All Section Totals

Synchronize Section Meeting Day Periods

Synchronize Staff History

Synchronize Gradebook Class

View Audit Detail For Section

Open Data Warehouse. ..

Open District Vendor...

A

2
1

O Section Screen

section to the duplicate section if necessary.

Click Load Additional Staff From Duplicated Section on the
Additional Staff tab to copy additional staff data from the original

@ Teaching Options @ TeacherVUE Security

Primary EL Language Team Teaching Ell Indicator

|Lnad Additional Staff From Duplicated Section |

®  Aaditional Staff  Chooser

Add Section R
Section ID: 0102
Current Students Additional Staff
Section ID Course ID Course Title Staff Name Room Name
1234 0300 | &| 3/4 Grade | Carroll, Natalie | & |0002 &

Primary Staff Grades Additional Staff Grades Additional Staff Grade Book

T cowwwens | reseneneseeumy | exauae

Defined
staff] Badge I i staft staft o From
Type Num Language " | Contribution (Contribution Attendance ;:o: State
Responsibility| Amount Reporting|

Add Section Screen

the course.

You must manually enter information from additional tabs after saving

Select the é‘under Course ID to find and select the course. The Course Title populates

automatically.

Select the L@under Staff Name to find and select the teacher staff member.

Select the é‘ under Room Name to find and select the school room.
Select the Begin Period and End Period.
Select the Term Code.

J

201
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8. Enter the Max number of students for the section under Student Seat Totals.

4 A
Prohibit assigning additional students once the Max is
reached, regardless of class size limit rules in School
Scheduling Options overrides any other configuration of blocking
for the specific section.

The following message displays when you attempt to add another
student with the section at the max student count.
« The section number displays on the error message to help
identify which section reached the max student count.
E « The student row number displays on the error message to
help identify which student was over the max student count.
A Error
Unable to add student. The section ('AD709-14") prohibits assigning additional
students once the max is reached.
(row: 21)
Class Size Limit Error Message
\. J
Section | &
*® Close
Current Students r-,lee:mg 36};’8

Section ID Course ID* Course Title Staff Name Room Name

zzzzzz 9 9 ‘9

@ Section Info (@ Student Seat Tolals

Begin Period*  End Period* Term Code* [ Prohibit assigning additional students once the Max is reached,
- - v regardless of class size limit rules in School Scheduling OptiOHS.

Attendance Type Supplemental Funding Category

-

Section Record Type

Attendance Option Grading Option Male Female  Totals Max* Open Seats

- -

Max Class Size Override Password

-

Instructional Minutes Qverride

[C] Using Elementary Minutes @ Teacher Aide Seats
Total Maix Open Seats

-

Section (Add) Screen
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9. Selectthe Serving School to include the school name in the Student Course History record

for the class.
@ Section Info
Begin Period®  End Period* Term Code*
Attendance Option Grading Option AM PM Attendance Type Supplemental Funding Category

Instructional Minutes Override Section Record Type

=

Instructional Strategy Instructional Method Instructional Content Category Code Override
[C] Distance Learning [l Independent Study

- - -

College Credit Online Course Override State Course Qverride Alternative Learning Override
&
- - & -

Course Quality Points Quality Points Override

Serving District [Serving School |nstlut0n Type

Instructional Unit ID Local Master Schd 1D

Cooperative Learning  Cooperative Learning Mins
O

Section Add Screen

10. Selectthe Grade Range Low and Grade Range High in the Restrictions section to define
any grade limitations.

These fields are required if your school uses Daily Attendance or

Period Attendance.
@ Restrictions @ staff Contributions @ TeacherVUE Security
Grade Range Low Grade Range High |Gender Resfriction Credit Responsibility Primary Staff
- - ~| | 0.500 Absent Teacher of Attendance
House Team Record -
i - Amount Additional Staif
Aftendance
Term Exclusion
[C] Mo Term Override  [] Exclude From Mass Scheduling -
Section Add Screen
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11.

Enter a Default Enter Date in the Section Options section if needed.

4 )
If the Default Enter Date is left blank before clicking Chooser, the
Enter Date defaults to the current date.

If the Default Enter Date contains a date before clicking Chooser,
E the Enter Date for all students in the section becomes the Default
Enter Date.

If the section is a Semester 2 class and the Default Enter Date is
before the start of Semester 2, the Enter Date updates to the first

L day of Semester 2 when saved. )

@ Section Options

Default Enter Date To apply an Enter Date that is not the current date, enter a “Default Enter Date”. This date will apply to students added
B using the “Chooser.” Enter Dates, regardless of entry method, will be validated by Synergy™ scheduling and enroliment
rules.

Section (Add) Screen

12. Enter any additional section information.
13. Click Save.

Re-Enroll Removed Students

The Student Enrollment tab displays a list of students withdrawn from the section. You can re-
enroll removed students from this tab if the section is still active.

1.

Select the Student Enroliment History tab.

2. Clearthe Leave Date for the student in the Dropped Students section.

[§]
Q
o
5]

¥ Section .

Menu~ € Q> & ssave  =Undo [IE NG EE JEEE

Section |D: 000001469 Course Title: Am Govt School Year: 2016-2017

Additional Staff Staff History

Current Students I Student Enrollment History I Meeting Days

Course ID  Course Title Staff Name Room Name
S5851 & | Am Govt Adams, Ronald & | 216 &

A
Leave Date Teacher Aide % (Audit Class 3 E

Section ID
000001469

@ Dropped Students

-Addmgtun Paula M §71686 12 07/05/2016 & 07/05/2016 &
n. Coursen, Alice L.} 164706 12 07/05/2016 & 07/05/2016 & O O -

Section Screen, Student Enroliment History Tab

3. Click Save.
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Add additional staff to the section for individuals with specific class roles.

1. Selectthe Additional Staff tab.
2. Click Chooser to find and select staff to add.
3. Selectthe Class Role if required.

¥ Section

< Q » &

Menu -

Section ID: 0000014689 Course Title: Am Govt School Year: 2018-2017

Current Students Student Enrollment History Meeting Days
Section ID Course ID Course Title Staff Name
000001469 33851 & |Am Govt| |Adams, Ronald &

@ Teaching Options
Primary EL Language Team Teaching

-

Ell Indicator

@ Adaitional Staff

a Badge ,

Class Role &

Teacher -

Num ~

1005

nn Atwood S., Sharon Teacher

CE-EVCIR NG + Add | % Delete

0
&
Lo

Additional Staff Staff History

Room Name

216 | &

@ TeacherVUE Security
Primary Staff Grades Additional Staff Grades

- -

Additional Staff Grade Book

-

Choozer Yy Show Detail

Start Date % End Date EL Language = .

-
-
03/16/2017 &=

Section Screen,

4. Click Save.

Synchronize Section Totals

Additional Staff Tab

After updating data under Student Seat Totals or Teacher Aide Seats, you must synchronize these

new values.

1.
Details screen displays with the progress.

Select Synchronize Section Totals or Synchronize All Section Totals from the Menu. The Job

¥ Section

Edit Section Data

+ Save | *Undo d

Reports

Synchronize Section Totals

Synchronize All Section Totals

STU408 - Class Student

Duplicate Section
Synchronize Staff History

Synchronize Gradebook Class

Synchronize Section Meeting Day Periods

Section Screen, Menu
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2. Click OK on the Synchronization Complete message.

Synergy

Synchronization Complete.

Synergy Message

Synchronize Section Meeting Day Periods

After updating information on the Meeting Days tab, you must synchronize the staff history.

1. Select Synchronize Section Meeting Day Periods from the Menu.

¥ Section

< Q| & | «sae *uUndo m
Edit Section Data Reports
Synchronize Section Totals STU408 - Class Student

Synchronize All Section Totals

Synchronize Section Meeting Day Periods |

Duplicate Section
Synchronize Staff History

Synchronize Gradebook Class

Section Screen, Menu

2. Selectthe Synchronize Option.

Synchronize Section Meeting Day Periods

Synchronize Section Meeting Day Period Options

Synchronize

Synchronize Option -

Synchronize Section Meeting Day Periods Screen
3. Click Synchronize. The Job Details screen displays with the progress.
4. Click OK on the Synchronization Complete message.
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Synchronize Staff History

After updating staff information, you must run the Synchronize Staff History option from the menu.

1. Select Synchronize Staff History from the Menu.

T Section

¢ Q| &  «sae *Undo [iE SN
Edit Section Data Reports
Synchronize Section Totals STU408 - Class Student

Synchronize All Section Totals
Synchronize Section Meeting Day Periods

Duplicate Section

I Synchronize Staff History I

Synchronize Gradebook Class

Section Screen, Menu

2. Select Synchronize all sections across the entire district if needed.

Synchronize Staff History

Synchronize Staff History Options

Synchronize will create historical staff records based on the primary staff associated for each section within the current focus.

Synchronize

£ Synchronize all sections across the entire district

Synchronize Staff History Screen
3. Click Synchronize. The Job Details screen displays with the progress.
4. Click OK on the Synchronization Complete message.
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Assigning Additional Staff

Synergy SIS allows you to assign additional staff (such as a substitute teacher) to a section by start
and end date and by start and end time. TeacherVUE allows the additional staff member to view the
appropriate sections in TeacherVUE for the date range of their assignment. The substitute teacher
has access to the teacher's assignments but the district determines the level of access and security.

1. Navigate to Synergy SIS > Schedule > Assign Additional Staff.
Assign Additional Staff | Sdie -0
Menu ~ ol Assign Additional Staff Clear

Options
@ 1. Find Staff Person Sections For Assignment Dates

Staff Name Gender Type Badge Num Birth Date
&

Start Date End Date

=
[l Do Not Filter Sections By Assignment Dates

Refresh Section List

@ 2. Select Additional Staff

Staff Name Gender Type Badge Num Birth Date
&

@ 3. Select Additional Staff Attributes

Class Role EL Language

TVUE Attendance TVUE Grades

TVUE Grade Book

Staff Contribution Responsibility Staff Contribution Amount

-

[0 Exclude From State Reporting

Line
Title

@ 4 Select Sections Assignments.

Course
ID And

o

Assign Additional Staff Screen

2. Select the teacher who needs the substitute in the 1. Find Staff Person Sections For

Assignment Dates section.

a. Click the Staff Name field. The Find: Staff screen opens.

b. Select the teacher on the Find: Staff screen. Once selected, the Find: Staff screen
closes and the teacher's sections display in the 4. Select Sections Assignments section.

3. Enterthe Start Date and End Date for the additional staff member's assignment. Only the

Start Date is required.

@ 1. Find Staff Person Sections For Assignment Dates

Staff Name
Andrews, Mark | &
Start Date

08/06/2018

Gender Type

Male Teacher| | 1002

End Date
09/28/2018

[l Do Not Filter Sections By Assignment Dates

e

e

Refresh Section List

Badge Num Birth Date

11/19/1972

Assign Additional Staff Screen

Edupoint Proprietary and Confidential



Schedule and Course Guide 09
Chapter 7: Manual Scheduling

4. Select the additional staff member in the 2. Select Additional Staff section.

a. Click the Staff Name field. The Find: Staff screen opens.

b. Select the staff member on the Find: Staff screen. Once selected, the Find: Staff screen
closes and the additional staff information populates all the fields in this section.

@® 2. select Additional Staff

Staff Name
Aderson, Gordon | & | | Male Teacher| | 1000 11/17/1972

Gender Type Badge Num Birth Date

Open User View

Assign Additional Staff Screen

N\

Synergy SIS displays a message under the Staff Name if the
staff member selected does not have a TeacherVUE user
account. You must create an account for them in Synergy SIS
if you want the additional staff member to have access to the

primary teacher's TeacherVUE account.

J

5. Select any attributes for the additional staff in the 3. Select Additional Staff Attributes section.

a. Select whether to give the additional staff member access to view or enter attendance
and grades using TeacherVUE through TVUE Attendance, TVUE Grades, and
TVUE Grade Book as needed.

[ E These fields obey Grade Book security settings. ]

Class Role
Substitute

Update -

@ 3. select Additional Staff Attributes

TVUE Attendance TVUE Grades TVUE Grade Book

Staff Contribution Responsibility Staff Contribution Amount

[l Exclude From State Reporting

EL Language

- -

Update + Post Grades |-

-

Assign Additional Staff Screen

6. Select the sections the additional staff member is assigned to in the 4. Select Sections

Assignments section.

7. Click Assign Additional Staff. Synergy SIS displays a notification indicating that the
selected additional staff member was added to the number of selected sections.
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Assigning Multiple Students to Sections

Schedule multiple students at a time using the Assign Students to Sections and Class Assignment
screens.

Assign Students to Sections

1. Navigate to Synergy SIS > Schedule > Assign Students to Sections.

2. Clickthe u@ next to Section ID to find and select a section to add.
3. Enter the Start Date for the section.

A message displays indicating the Validate Student Classes option

a set on the School Setup screen, which applies to any overlapping or
duplicate sections. See Allowing Schedule Overlap for more
information.

Assign Students To Sections ‘

Menu - L] Clear

§
c
'y
©

Organization Name: Hope High Scheol School Year: 2016-2017
By Student By Section
@ Section

Section ID Course ID Course Title Staff Name Tofal Students Max Students Open Seats

@ Assignment Options

Start Date
Process

@ Students Chooser

Assign Students To Sections Screen
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4. Click Chooser in the Students section to find and select students to assign.

Assign Students To Sections « 2o
Menu~ & | Clear

Organization Name: Hope High School School Year: 2016-2017

By Student By Section

@ Section

Section 1D Course ID Course Title Staff Name  Total Students Max Students Open Seats

1656 & | MA402 | |Aigebrall  Vogl, Randy| |30 32 2

@ Assignment Options

Start Date

25012217 Validate Student Classes in School Setup s se o: Do Not Valdate Student Casses’

Process

© Students
R T S

Assign Students To Sections Screen

5. Click Process. A confirmation message displays once the process completes.

Assign Students To Sections « ZdicO

Menu~ = & | Clear

Organization Name: Hope High Scheel School Year: 2016-2017
By Student By Section

@ section
Section ID Course ID Course Title Staff Name  Total Studenis Max Students Open Seats
1656 & |MA402 | | Algebrall | Vogl, Randy 30 32 2

® Assignment Options
Start Date
75707 & Vallate Student Classes in School Setup Is set o5 Do Not Valdate Student Classes’

@ students Chooser ‘

Y ™ S TS S S
-n Cannon, Sean Q. 968281

2 Carlson, Aaron D. 586943 "

-“ Carlson, Judy J. 204921 10

Assign Students To Sections Screen
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Replacing Section Assignments

Copy students from one section to another or assign students to sections with specific IDs using the

By Section tab.

1. Selectthe By Section tab.

2. Selectthe Student Action to determine how to process students.
3.
4

Enter the Date to withdraw students and the Date to enroll students.

Use one of two methods to move students:

a. Select Use Section Pattern Match option to move or copy student class enroliment

from one section pattern to another.

i. Enterthe pattern to match in Section From.
ii. Enterthe pattern to match in Section To.

-
A question mark (?) functions as a random character.

For example, entering 77???in Section From and

a 2????in Section To moves students in all sections
starting with 1 to corresponding sections starting with 2.
Students in section 11111 move to section 21111, and
soon.

Assign Students To Sections

Menu~ B Clear

Organization Name: Hope High Schoel School Year: 2016-2017

By Student

@ Help Message

@ Specific Section Transfer/Section Pattern Maich

Use Section Pattern Match

From Section Pattern To Section Pattern
192997 29977

Process

Copy (Copies students from section to section) | - 07/31/2017 ] 08/01/2017

Q

Student Action Date to withdraw students Date to enroll students

Q

Assign Students To Section Screen, By Section Tab
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b. Leave Use Section Pattern Match blank to transfer specific sections.

i. Enter the Section From.
ii. Enter the Number of Students to Move. If left blank, the process moves all
students until the destination section is full.

iii. Enterthe Section To.

Assign Students To Sections < zed
Menu~ | B clear
Organization Name™ Hope High Schoel School Year 2016-2017
By Student
@ Help Message
Student Action Date to withdraw students Date to enroll students
07/31/2017 B 08/01/2017 ]

Copy (Copies students from section to section) | =
@ Specific Section Transfer/Section Pattern Match

[C] use Section Pattern Match
If "Number of Students to Move" field is left blank, all the students from the source section will be moved to the destination section until the maximum

student seat limit is reached for the destination section.

Section From Number of Students to Move Section To
1148 5 ENG101
Process

Assign Students To Section, By Section Tab

Click Process to make the new assignments.
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Class Assignment

Assign sections in bulk to groups of students using the Class Assignment screen.
1. Navigate to Synergy SIS > Schedule > Class Assignment.

Enter the Grade, Last Name, First Name, and/or Gender in the Required Fields and
Student Filters section.

Select Unassigned Only to keep assigned students in existing sections.
4. Click Filter Students. The Students section displays the results.

Class Assignment

Menu= | o Clear All

Organization Name: Hope High School School Year: 2020-2021
Mass Assignment

(® Required Fields and Student Filters

Grade OJ ~+ ¥

Ooe D10 011 012

Last Name First Name Gender

Unassigned Only
O

Filter Students

Class Assignment Screen
5. Enterthe Grade, Last Name, First Name, and/or Enter Date in the Teacher Filters section.

6. Click Filter Sections. The Classes section displays the total students assigned to the section,
divided by grade if the grade option is blank.

(2 Teacher Filters
Grade O «~

Oog 10 O11 D12

Last Name First Mame EnterDate

08/06/2020 &
Filter Sections

Class Assignment Screen

7. Select Add next to the students to assign.
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8. Click Add next to the section to move students to.

Class Assighment
Menu~ | o Clear Al

[ ]
[
#
]

QOrganization Name: Hope High School School Year: 2016-2017

Mass Assignment

@ Required Fields and Student Filters @ Teacher Filters
Grade Q) ~ Grade 0 +~ &
o7 Dos Toe D10 &1 H12 o7 Dos Do D10 @11 H12
Last Name First Name Gender Last Name First Name EnterDate
- Webster 04/25/2017 @

Unassigned Only

Filter Sections

Filter Students

@ students

@ Classes

mmmmmmmm

Student

Add | (Unassigned)

None 5 2 1332840 109

Adams, Billy A. 88931411 M

Webster, B P-08 27 27
Beltran, Christopher

15738411 M Websler, B P08 25 1 26

Chudy, Tina L. 88721311 F Webster, M 226 126 2 29

Class Assignment Screen
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Assigning Individual Students to Sections

Schools assign classes to individual students using the Student Classes screen and the Classes tab
of the Student screen. You can also add students to a section through the Section screen.

Student Classes Screen

1. Navigate to Synergy SIS > Schedule > Student Classes.
2. Locate the student to modify.
3. Click Add to add a single class or click Chooser to find and select multiple classes.
4. Enter any section options as needed.
v Student Classes o0
Menu- | € Q¥ o « Save | *yUndo @®
Student Name: Acevedo, Andrew School: HDpE High Schooel Status: Active Homeroom: 401
Current Classes Class Enroliment History Schedule Based FTE
!_ast Name . First Name Middle Name  Suffix Perm ID Grade
|Acevedo | [Aandrew 886630 11 -
@ Current Class
The last scheduled class for this student has ended:
Period: & Section: 0736 Course Title: Academic Decath Staff Name: Canaday C., Curt Room Name: 307A
@ DI’Op Class, Filter and Override Options
@ current Class Schedule +Add Chooser
Period
m.Mﬁ S Hm
0036 5551 Am Gowt 216 090 11 11/25/2016 @
1 g2 0006 ARS8 Adv Jewelry M 403 11 12 01/27/12017 &
.2 2 (82 1202 ARG4 Int Drawing MT 401 10 12 04/06/2017 @@
Student Classes Screen
5. Click Save.
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When printing the STU202 — Student Schedule report from the Menu on
the Student Classes screen, only the current term displays. To change this
setting:

1. Navigate to Synergy SIS > System > User > User Password
and Preferences.

2. Selectthe Report Preferences tab.

3. Select Full Schedule When Printed From Menu under the
Student Schedule section.

4. Click Save.

User Password and Preferences
Menu~ | o « Save | *yUndo

User Name: User, Admin

Password Preferences I Report Preferences I

® Student Profile

[C] Suppress Photo

[C] Hide Health Conditions

[C] Hide Parent Info

[C] Hide Emergency Info

[C] Hide Physician Info

[Tl Hide Signature Info

[T] Include Health Condition History
[Z] Show Homeroom Teacher

® Student Schedule

[Tl Hide All Personal Info

[7] Hide Perm ID
| [©1 Full Schedule When Printed From Menu |
Sort Options

=

User Password And Preferences Screen, Report Preferences Tab
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Student

Navigate to Synergy SIS > Student > Student.

Locate the student to modify.

Select the Classes tab.

Click Add to add a single section or Chooser to find and select multiple sections.

o kw0 bd =

Enter any section options.

¥ Student n ‘

Student Name: Abbott, Billy €. School: Hope High School Homeroom: 403 Teacher: Andrews, M.

Demographics Parent/Guardian Other Info Emergency Enroliment Enroliment History Documents Contact Log
Notes

%]
Q
e
4
]

Last Name First Name Middle Name  Suffix ~ Perm ID State ID Grade Gender
Abbott Billy C 905483 0001341311 | |12 ~| |Male @~

Language Spoken at Home
English -

@ Current Class

Attendance Code: Period: 0 (7:00 AM - 3:30 PM) Room: 216 Section ID: 1077 Course Title- Am Govt Staif Name: Jackson, Kathy (1069)
Tdy - Tardy

@ Class Schedule + Add | Chooser | Actions -

Penods Ruom
Line Term Code Course Title Enter Date Leave Date College Credit
T

0077 8551 Am Govt 07/04/2017 @ 11/24/2017 @&
o s 0840 SC49 Science 10 121 09 12 11242017 & 11/24/2017 & -
0 82 1077 8551 Am Govt 216 09 12  11/30/2017 @& 01/09/2018 & =
1 &1 0106 ARS4 Beg Jewelry 403 10 12 07/04/2017 & 12/22/12017 & -
1 82 1116 EN46 Prin Eng Il 231 12 12 11/30/2017 @& & -

Student Screen, Classes Tab

6. Click Save.
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to add.

0

Q

1. Navigate to Synergy SIS > Schedule > Section.
2. Locate the section to modify.
3. Click Chooser to find and select students

v Section

Menu- | € Q| > oM

« Save | +yUndo (S LN I SETEG]

Section |D: 000001489 Course Title: Am Govt School Year. 20168-2017

Current Students Student Enroliment History Meeting Days Additional Staff Staff History
Section ID Course ID Course Title Staff Name Room Name
000001469 $551|& |Am Govt Adams, Ronald | & | | 216 &
@ Students Chunser

Ri lved c Il
Line Student Name SO Enter Date Leave Date e ege # |Teacher Aide 3
RacelEthmclty

Acevedo, Andrew 886630 Hispanic 01/27/2017 &
n. Arvanitas, Christina T, 8o2796 \Wnite 12 07/05/2016 & =] - O
n Bailly, George 87472 Wnite 12 07/05/2016 & =] - O
Brady, Kenneth P 874026 Wnite 12 07/05/2016 & & - i
Section Screen

4. Enter any options for the student.
5. Click Save.

Adding Enter Dates to Existin

g Sections

You can use the Mass Change Enter Date process to change the Enter Date for all students in an

existing section.
1.
2. Locate the section to modify.
3. Select Mass Change Enter Date from the

Navigate to Synergy SIS > Schedule >

Section.

Menu.

v Section

Menu -

Edit Section Data

Rl

< Q

Synchronize Section Totals

Duplicate Section
Synchronize Staff History

Synchronize Gradebook Cl

Synchronize All Section Totals

Synchronize Section Meeting Day Periods

>

« Save || *%Undc ﬁ

Reports

STU408 - Class Student

ass

Mass Change Enter Daies

Open Data Warehouse. ..

Wiew Audit Detail For Section

Section Screen
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4. Enter the Default Enter Date.
5. Click Apply Default Enter Date.

Mass Change Enter Date

Menu - Apply Default Enter Date Cancel

To update Enter Dates for several students, select various students by holding the Shift button while highlighting
students by line. Enter a 'Default Enter Date' and select 'Apply Default Enter Date'. Enter Dates for highlighted
students will be updated.

To update Enter Dates for ALL students. Enter a 'Default Enter Date' and select 'Apply Default Enter Date'. The Default

Enter Date will apply to ALL students.

Enter Dates will be validated by Synergy™ scheduling and enrollment rules.

Default Enter Date
&=

@ Studenis

Line Student Name Enter Date Leave | Teacher
Date | Aide
- Aaron, lan 120442 Male 07/0412017

wi - Alejandrez, Willie JR 992706 Male 03 07/04/2017

Antonio Gonzalez, James D. 105613 Male 03 082812017

! Bahena, Joshua 120454 Male 03 07/04/2017

Mass Change Enter Date Screen

The Default Enter Date applies to all students in the section.

Hold the Shift key to highlight specific students within the section to
a set the Default Enter Date as the Enter Date for those students
only.

If the section is a Semester 2 class and the Default Enter Date is
before the start of Semester 2, the Enter Date updates to the first
day of Semester 2 when saved.
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Assigning Tracks

Multi-track schools allow different school calendars for specific students. Each track represents a
separate school calendar. Schools can use tracks to reconcile limited space within school facilities.

See the Synergy SIS — Attendance Administrator Guide for more
information on creating and configuring tracks.

L]

Schools assign each student to a specific track through the enroliment process, and can only assign
one track per enroliment. Administrators enter student enroliments through the Student screen.

7 Student =
< Qa3

See the Synergy SIS — Student Management Administrator Guide and
Synergy SIS — Student Management User Guide for more information on
the student enroliment process.

Q0
Q

o

@ O

Menu -

+ Save | *yUndo m % Delete

Student Name: Acevedo, Andrew School: Hope High Scheel Homeroom: 401 Teacher: Gunn, G.

Demographics Parent/Guardian Other Info Emergency Enroliment Enroliment History Classes Documents
Contact Log Notes Protected Information TR Test Tab
Last Name First Name Middle Mame ~ Suffix ~ Perm ID Grade Track
Acevedo Andrew 886630 1 - -
Student Screen

After creating tracks, assign each class section to a specific track. This is done through the Section
screen or assigned automatically using Mass Assigning Tracks.

Manually Assigning Tracks

1.
2. Locate the section to modify.
3. Select Edit Section Data from the Menu.

Navigate to Synergy SIS > Schedule > Section.

¥ Section
< Q » o | | Save | *Undo

| Edit section Data

I Reports

Synchronize Section Totals

Synchronize All Section Totals

Duplicate Section
Synchronize Staff History
Synchronize Gradebook Class

View Audit Detail For Section

Synchronize Section Meeting Day Periods

S5TU408 - Class Student

Section Screen
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4. Selectthe Track.

v Section
Menu~ € Q¥ L] + Save | * Undo m

Section ID: 000001469 Course Title: Am Govt School Year: 2016-2017

Current Students Student Enroliment History Meeting Days Additional Staff Staff History
Section ID Course ID  Course Title Staff Name Room Name | Track
000001469 5551 | & | | Am Govt Adams, Ronald | & | | 216 Ky -

Section Screen

5. Click Save.

Mass Assigning Tracks

Assign or update tracks in bulk using the Mass Assign Track screen. The Mass Assign Track
process updates the student's track based on the period and term code specified. The period
defaults to the homeroom period.

The homeroom or other section for the specified period must have a track
==l assigned in order for this process to complete.

1. Navigate to Synergy SIS > Schedule > Mass Assign Track.
2. Selectthe Period and Term Code in each student’s schedule where you assign tracks.
3. Click Update Track.

Mass Assign Track i &M : [cle[=]-d

Menu ~ Update Track

Organization Name: Hope High School FullYearverbose: 2020-2021

The process executed by this view will update the student's track based on a period of the day and term code. By selecting the Period and the
Term Code you are specifying the section that will be evaluated in the student schedule that will be used to determine what the student track
should be. The Period drop down defaults to the homeroom period as specified in School Setup. You must enter the Period and Term Code.

@ Select a Period and Term to Update Tracks

Period Term Code
1 » |Quarter 3 -

Mass Assign Track Screen
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Elementary Scheduling

Elementary scheduling requires additional setup based on the option selected within the School
Setup screen for assigning and tracking homerooms and linked courses.

Schools must create sections for the homeroom class itself as well as
other courses not taught by the homeroom teacher, such as Physical
Education.

Homeroom Setup

223

. Navigate to Synergy SIS > System > Setup > School Setup.
2. Enter the Homeroom Period.

School Setup
Menu - | ol « Save || * Undc
School Mame: Adams Elementary School Year: 2016-2017
Basic Info Options SIS Data Options Labels TeacherVUE Mobile Apps

(® Period Definition

Start Period End Period] Homeroom Period Homeroom Meeting Day

1 5 1 -

School Setup Screen

3. Select one of the following under Scheduling Options in the Other Info section:

« Traditional Schedule Tracking (Default) — Schools associate one section for each
course/period that a teacher instructs. You can enroll students in sections manually or
through mass scheduling.

Homeroom and Associated Course Enrollments — Schools associate courses that a
homeroom teacher instructs together. Schools create sections for the homeroom and

any classes not assigned to a homeroom teacher. You can enroll students in schedules
manually or through mass scheduling. Generated extracts and reports show enroliment

records for both sections and homeroom courses.
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« Linked Sections — Schools associate one section for each course/period that a teacher
instructs and adds the homeroom teacher name as a Linked Staff Member on the
Section screen. You can enroll students in homeroom sections, which automatically
enrolls them into all linked sections.

You can enable the Enforce Linked Section Gender and
Grade Restrictions option after selecting Linked Sections if
required.

School Setup «cea

Menu~ | ok | Save *Undo

School Name: Adams Elementary School Year: 2016-2017

Basic Info Options SIS Data Options Labels TeacherVUE Mobile Apps
© Other Info
[C] Exclude from State Reporting Validate Student Classes
[T Report Sub Schools -
[l Enable College Credit School Hours Per Week  Special Ed "Bell to Bell" Hours Per Week

Enable Subject Area Override

Scheduling Options
Enable College Area Override Homeroom and Associated Course Enroliments | =

-

Enable University Area Override
[C] Charter
[C] Make classes action on student inactivate mandatory
[C] Is Separate School
Improvement Status Default Locker Combination

School Setup Screen

4. Click Save.

Configuring Homerooms and Associated Courses

These options only take effect if the school uses Homeroom and Associated Course Enrollments as
the Scheduling Option.

1. Navigate to Synergy SIS > Course > District Course.
2. Create or locate the homeroom course.
3. Selectthe Associated Courses tab.
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4. Click Chooser to find and select courses taught by the homeroom teacher. Generated
reports display this teacher as the instructor for these courses.

Menu +

Course

Course
0400

¥ District Course Nt ]

Course Description Year Override Pre/Corequisite Schools Teaching Associated Courses Standards Opt In Options

Course Fees

Ahways Show In Course History Add

@ corses

T cov e B
1

cla 5| & vsae | num

ID: 0400 Course Title: 4th Grade

ID Course Title Course Short Title

4th Grade 4th Grade Wandatory | Inactve

ENGO4 English 4th Grade
2 MAO4 Math 4th Grade
ESCO04 Science 4th Grade
“ HS04 History 4th Grade

District Course Screen, Associated Courses Tab

5. Click Save.

Configuring Linked Sections

225

These options o

nly take effect if the school uses Linked Sections as the Scheduling Option.

r

\.

N\
When using Linked Sections, the Exclude From Link Section Process
option displays on the Section screen. If selected, homeroom enrollment
does not automatically include the selected section.

@ Restrictions

Grade Range Low Grade Range High Gender Restriction Credit
K ~ 06 - ~ | 1.000
House Team

- -

Term Exclusion
[ Mo Term Override  [C] Exclude From Mass Scheduling

ID Exclude From Link Section Processl

Section Screen

1. Navigate

to Synergy SIS > Schedule > Section.

2. Create sections for the homeroom course.

Homeroom sections must use the same Period as the defined
Homeroom Period on the School Setup screen.

3. Create sections for additional subject courses.
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4. Click the & next to the Linked Staff Name to find and select the homeroom teacher for any
section for additional subjects. Leave this blank if the primary teacher of the section is the
homeroom teacher.

7 Section ccge
Menu = L] « Save || +yUndo

Section ID- 0402 Course Title: Math 4th Grade School Year: 2016-2017
Current Students Student Enrollment History Additional Staff Staff History

Section 1D Course ID  Course Title Staff Name Room NamejLinked Staff Name | Track
0402 MAOD4 | & | Math 4th Grade | |Berriz, Cynthia | & & ||| Cordova, Angie | & -

Section Screen

5. Click Save. Once saved, linked sections create records for each student with the same
enrollment date as the homeroom record.

v Student Classes & e
Menu + o + Save | *yUndo

Student Name: Alvarado, Ruby M. School: Adams Elementary Status: Active Homeroom: 0038

Current Classes Class Enrollment History Schedule Based FTE
Last Name First Name Middle Name  Suffix Perm ID Grade Track
Alvarado Ruby Marie 119675 04 - -

@ Current Class

The last scheduled class for this student has ended:
Period: 4 Section: 0404 Course Title: English 4th Grade Staff Name: Borgen, Jessica Room Name:

® Drop Class, Filter and Override Options

@ current Class Schedule + 4dd | Chooser
Course Title Teacher
1 1 YR 0438 0400 4th Grade Cordova, Angie 0038 04 04 04/26/2017 &
2 2 YR 0402 MAD4 Math 4th Grade Berriz, Cynthia K 06 04/26/2017 &
3 & 3 YR 0403 ESC04 Science 4th Grade Martinez, Alberto 0008 K 06 04/26/2017 &
4 4 YR 0404 ENGO4 English 4th Grade Borgen, Jessica K 06 04/26/2017 &
Student Classes Screen
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Updating Homeroom Information

One Time Process Per School

The Update Homeroom Data process checks student schedules for the homeroom course in the
current term and makes any necessary updates. Run the process after making any changes to the
homeroom or scheduling options on the School Setup screen or the homeroom course or section.

1. Navigate to Synergy SIS > System > Setup > School Setup.
2. Select Update Homeroom Data from the Menu. The Job Detail screen opens.

School Setup e
& | save | *Undo
View Audit Detail For School Setup =~ Processes Workflows

Update Homeroom Data Mass Scheduling Preparation

Clear Homeroom Data

School Setup Screen

3. Click OK on the confirmation message.

Synergy

Homeroom update complete! 866 total students updated.

Synergy Confirmation Message

Copyright 2009-2020 Edupoint Educational Systems, LLC



298 Schedule and Course Guide
Chapter 7: Manual Scheduling

Multiple Schools or Recurring Process

The Schedule Homeroom Data Process screen allows the Update Homeroom process to run for

multiple schools or the entire district. This process also allows scheduling Update Homeroom as a
recurring job in Synergy.

1. Navigate to Synergy SIS > System > Setup > Schedule Homeroom Data Process.

Schedule Homeroom Data Process

Menu~ | Schedule Processing of Homeroom Data

Process Options

@ Organizations

Organization List O + &

[ Adams Elementary [ Bilingual Magnet School (1 Central Enroliment [ Continuation High School [J Eisenhower Middle School [J Grant Elementary

[0 Hope High School [ Jefferson Elementary [ Kennedy High School [ King High School [ Lincoln Elementary [ Roosevelt Middle School
[0 STEM Magnet School [J Truman Middle School  []Washington Elementary

@ Operation Type

@® Update Homeroom Data O Clear Homeroom Data

@ Schedule Job

Schedule Task

Schedule Homeroom Data Process

2. Selecta school or schools to process in the Organization List.

4 )
When focused to the district level or any organization level (for
example, high schools, middle schools, elementary schools, or

E special schools), each school displays in the list. Select one school
or multiple schools. If left blank, the process runs for all schools in

L the Organization List. )

3. Select which process to run in the Operation Type section.

« Update Homeroom Data — Removes existing homeroom data for students and
replaces it with updated data. This is the default option.

« Clear Homeroom Data — Removes existing homeroom data without replacing it.
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4. Selectthe appropriate Schedule Task. This is the frequency the report runs. You can set
reports to run Once, Daily, Weekly, or Monthly.

« Once - No additional options display.

« Daily— Select the following options:

Start Time — Enter the time of day for the report to run.

Start Date — Enter the date to start running the process.

Stop Date — Enter the date to stop running the process. For example, the date of

the end of the school year.

Enter the number of days between the running of each process. For example,
enter 7to run the process every day or enter 7 to run the process once per week.

Process Options

@® Organizations

Organization List O ~ &

@ Operation Type

® Update Homeroom Data

Schedule Homeroom Data Process

Menu - Schedule Processing of Homeroom Data

[JAdams Elementary [ Bilingual Magnet School (] Central Enroliment [ Continuation High School
Hope High School []lefferson Elementary [ Kennedy High School [JKing High School
[JSTEM Magnet School (] Truman Middle School [ Washington Elementary

O Clear Homeroom Data

@ Schedule Job

Schedule Task  Start Time
Daily - |9:00 AM

@ Schedule Task Daily

Every 7

Start Date Stop Date
© | |03/02/2018 @ 06/24/2018 &

Day(s)

Schedule Homeroom Data Process
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o Weekly — Enter the Start Time, Start Date, and Stop Date. Select the following

options:

« Enter the number of weeks between the running of each process. For example,
enter 7to run the process every week or enter 4 to run the process once every

four weeks.

« Select the days of the week you want the process to run. The following example
displays the process running every week on Monday, Wednesday, and Friday.

Schedule Homeroom Data Process

Menu ~ Schedule Processing of Homeroom Data

Process Options

@ Organizations

Organization List O < &
[JAdams Elementary [ Bilingual Magnet School (] Central Enroliment [ Continuation High School
Hope High Scheol [JJefferson Elementary [ Kennedy High School [ King High School
[JSTEM Magnet School [] Truman Middle School  [] Washington Elementary

@ Operation Type

® Update Homeroom Data O Clear Homeroom Data

@ Schedule Job

Schedule Task  Start Time Start Date Stop Date
Weekly ~ (900AM @| 03/02/2018 @ | 06/24/2018 B

@ Schedule Task Weekly

Every 1 Week(s) on: Monday [ saturday
[ Tuesday [J Sunday
Wednesday
[ Thursday
Friday

Schedule Homeroom Data Process
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« Monthly— Enter the Start Time, Start Date, and Stop Date. Select the following

options:

« Select whento run the process on a Day of the month, such as 1 for the 1st or
20 for the 20th. You can also select a specific weekday, such as the First Monday
of the month. You can also select which months to run the process for. The
following example displays the process running the 3rd week of the month on
Wednesday from March to June.

Menu -

Process Options

@ organizations

Organization List O + &

@ Operation Type

® Update Homeroom Data

Schedule Homeroom Data Process

Schedule Processing of Homeroom Data

[Jadams Elementary [ Bilingual Magnet School (] Central Enroliment
Hope High School []Jefferson Elementary [ Kennedy High School
[0 STEM Magnet School [ Truman Middle School ] Washington Elementary

[ Continuation High School
[ King High School

O Clear Homeroom Data

@ Schedule Job

Schedule Task
Monthly

Start Time
9:00 AM

=

@ Schedule Task Monthly

O Day

-

3

-

® The
Wednesday | ~

Start Date Stop Date
©® |03/02/2018 @ 06/24/2018 @@

of the month(s) [ January [ July
[J February  [J August
March O september

of the month(s) )
April O oOctober
May [J Movember
June O December

Schedule Homeroom Data Process

The drop-downs display 7-31, 1-5, and the days of the

week.

5. Click Schedule Processing of Homeroom Data.
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Setting Virtual Schools

You can schedule students into a virtual school through mass scheduling and scheduling processes.
This enables you to link sections of the same course between the virtual school and the home school
so both schools update when the student adds or drops the class.

4 )
Both schools must be set up for concurrency on the School Setup screen
as follows:

o The home school must be set to either Full Concurrent - Able to
send and receive concurrent students or Exit Concurrent - Able to
send concurrent students only for the Concurrent Enrollment

E Type.

« The virtual school must be set to either Full Concurrent - Able to
send and receive concurrent students or Entry Concurrent - Able to
receive concurrent students only for the Concurrent Enrollment
Type.

Both schools must be opted in to the district course on the School Course
Opt-In screen.

J
1. Navigate to Synergy SIS > Course > District Course.
a. Locate the course to make virtual.
b. Selectthe virtual school where the course is taught in the School Name.
c. Click Save.
v District Course
weni- [ ¢ a 3| &
Course ID: CCEN46 Course Title: Corr Eng 1l
Course Description ‘ear Override Pre/Corequisite Schools Teaching Associated Courses Standards Opt In Options Course Fees Equivalencies
Course ID Course Title: Course Short Title:
CCEN46 CorrEng il CorrEng i Mandatory Inactive Always Show In Course History Add
@ course Info
Course Duration Department College Prep  Credit Max Credit Post Secondary Credit Override Course History Type
52: Semester 2 ~ CCEN - D 0.500 0.500
Academic Type [ Teacher Aide [ Extended Day
Regular - [ coliege Approved [ pistance Learning Course
[] Pass/Fail Only [ Online Course
[ Dual Credit [ Allow Scheol Course Title Override
[ Title 1 [] Jobs for American Graduates Program
[ Credit Recovery
Dual Language Instruction Type Language Of Instruction
@ Scheduling Options @ ParentVUE Options
Duplicate Request Schedule Priority @ status Grade Range Low Grade Range High Schedule Priori
=) |Core (High) ear Start Year End = =
Optimum Size Maximum Size -

District Course Screen
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2. Navigate to Synergy SIS > Schedule > Section.

a. Create a section for the course.

( )
There must be a section at both the home school and the
virtual school. )
b. Focus to the home school.
( )
Both schools must be out of mass scheduling or not have used
L mass scheduling for the linking process to function properly.

c. Select the virtual school's section in the Primary Section to link the home school's
section to it.

Menu~» 2

Instructional Strate:

College Credit Dua

7 Section

Section ID: CCEN46-001 Course Title: Corr Eng Il School Year: 2019-2020

Current Students Student Enroliment History Meeting Days Additional Staff Staff History Schedule Matrix Pathways

Section ID Course ID Course Title Staff Name Room Name

CCEN45-001 CCEN4E & |CorrEngll g &
© Section Info B Studg
Begin Period End Period Term Code |:| A

1 - 1 - YR |- q
Attendance Option Grading Option Aftendance Type Supplemental Funding Category @ Siud

= z z z Male

Instructional Minutes Override  Staff Minutes Override Section Record Type

|:| Using Elementary Minutes
Open
gy Instructional Method Instructional Content Category Code Override
|:| Distance Learning |:| Independent Study 25

| Credit Credit Recovery

Online Course Override State Course Override Alternative Learning Override O Teac
= 8 =
Course Quality Peints Quality Points Override © Grad
Grade H
Serving District Serving School Insttution Type
Primary Section Instructional Unit ID Local Master Schd ID B State

Kennedy High School 1-1 883388 (YR) -

O

Cooperative Learning  Cooperative Learning Mins ‘Work Based Learning Code

Section Screen

i,

Any students enrolled in this section must be concurrently enrolled in both

schools.

All students enrolled in this section display in both sections at both

schools.

233
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Schedule Matrix

The Schedule Matrix tab shows how the selected section contributes to student FTE. It displays all
the section information and the section schedule breakdown by Term, Days in Term, Hours
Scheduled, and the Average Minutes per Meeting that are in your Bell Schedule for that period.
It also displays the period, bell periods, minutes, days in calendar, and the total minutes the section
meets per meeting day.

7 Section Ak s cle(g-e
Menu~ | 2 < a » ] o Save || *Undo mm

Section ID: PP02-0502 Course Title: English Literature School Year: 2018-2019
Current Students Student Enroliment History Additional Staff Staff History Schedule Matrix

Section ID Course D Course Title Staff Name Room Name Track
PP0OZ-0502 PFOZ & | English Literature & & -

B Section Information

Term Days In Term Hours Schedule Avg Minutes per Meeting
52 168 140 50.00
Period Rotation Calendar
Period Rotation Definition School Calendar

B Section Schedule Breakdown

- Rotation Code Bell Code Schedule . - -
o '“d R e (eEE
1 5 5 50 168 3400

Default Rotation - 1

Section Screen, Schedule Matrix Tab
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Prescheduling Students

Prescheduling reserves seats for students in specific sections. You preschedule students within the
Schedule Student or Schedule Section screens inside an Option Set or in the Walk In Schedule
screen.

The Mass Scheduling process does not reassign prescheduled students.
You must update prescheduled students manually.

Schedule Student

1. Navigate to Synergy SIS > Mass Scheduling > Schedule Control.
2. Open the option set.

Schedule Control  zcoEe
Menu~ o « Save | *yUndo

School- Hope High Schoel Year 2016-2017

Scheduling Option Sets

Create/Copy Option Set

Checked Out
Option Set Name ceeest 0
To Total 3 Scheduled & Date/Ti

@ Option Sets

I+
n201&201? F‘ Scheduler - User, Admin 1.37% 2764 38 04/05/2017
2 Ea‘ Scheduler - User, Admin
3 E‘ Scheduler - User, Admin  99.23% 2742 2721
ncopyoflaslyearsschedule E&‘ Master Schedule Builder = User, Admin % 2750 002/01/2017
-

Schedule Control Screen

4. Select Open Student Schedule under Quick Links.

@ Quick Links

@ Open Student Schedule

E:'-I Open Schedule Allow unchecked out users to edit sections

Section

Open School Options
Cpen Option Set Wheel

Open ClassBoard

Schedule Control Screen

5. Locate the student to preschedule.
6. Click Chooser in the Course Requests section to find and select courses.
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7. Click the +in the Prescheduled Section column next to a course. The Schedule Section
screen opens.

T Schedule Student R

Run Name: 2018-2017

Menu- € Q| ¥ ‘ L] ¥ Save | +Undo | << Conflict Conflict >»

Student Name: Abbott, Paulette School: Hope High Scheool Status: Active Homeroom: 402 Run Name: 2016-2017 Schedule Status: Scheduled
Requests Analysis Schedule

Last Name First Name Middle Name Suffix Perm 1D Grade Sehedul
Abbott Paulette 097053 09 chedue
@ Quick Add @ Class Size Limit Password
Add By Group - Max Class Size Qverride Password
Course R fs
® couse gues ]

Alternate
Preferred Prescheduled
Line Course Title | e Pre-Requisite Not Required Corequisite Not Required| ' oo oot <
Staff Section
o s
&

Agm Animal Sci

- AR42 Int Stain Glass
- EN33  PrinEngl

O
]

&
&
&

O
]

D % B B
o
o

O
O

Schedule Student Screen
8. Select a section to add.
9. Click Select Section.

Schedule Section

Menu - = Select Section Close

Course ID: 8C49 Course Title: Science 10

Section

@ Choose Section

Perlods Restrictions
Line Te Gender |Grade|Grade
Begin Team
Restriction| Low | High
6009

Schedule Section Screen

10. Click Save.
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Schedule Section

1. Navigate to Synergy SIS > Mass Scheduling > Schedule Control.
2. Open the option set.

Schedule Control =)
Menu~ o + Save | *Undo

§
]
]

School: Hope High Schoel Year: 2016-2017
Scheduling Option Sets

Create/Copy Option Set

@ Option Sets

Line Option Set Name CHEEKEAIOUE . "

To Total % |Scheduled & Date/Ti
n2016—201? g | Scheduler - User, Admin 1.37% 2764 38 04/05/2017
ALG Blank g | Scheduler - User, Admin
Backup Copy & | Scheduler - User, Admin 99.23% 2742 2721
Copy of last year's schedule g Master Schedule Builder = User, Admin % 2750 002/01/2017
L Sme—

Schedule Control Screen

4. Select Open Schedule Section under Quick Links.

@ Quick Links

ﬁ Open Student Schedule

3 Open Schedule Allow unchecked out users to edit sections

Section

o |
.

Open School Options

Open Option Set Wheel

Open ClassBoard

8 @ &

Schedule Control Screen

5. Locate the section to preschedule.
6. Click Chooser in the Students section to find and select students.
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7. Select Pre-Schedule in each row for the students to preschedule.

7 Schedule Section
Run Name: 2016-2017

Menu- || € Q| ¥ & save muUndo [EESGEEE EES

Section ID: 6008 Course Title: Biology Run Name: 2016-2017

Current Students Meeting Days
Section ID MSB Section ID Course ID  Course Title Staff Name Room Name Track
6008 SC492 | & | | Biology & &

® Section Info | @ Staff Contributions | @ Student Seat Totals

@ Teacher Aide Totals

B Restrictions @ Staff Contributions

@ Students
R T
- Akin, Andrea E. 002875 Female 10
-- Centner, Jason .. 904114 Male 10
-- Chavira, Henry E. 966307 Male 10
-- Diaz. Anthony L. JR 148500 Male 10

Term Override

Pre-Schedule

« 2 g

Schedule Section Screen

8. Click Save.

Walk In Schedule

239

Navigate to Synergy SIS > Schedule > Walk In Schedule.
Locate the student to preschedule.
Select the Request tab.

L=

screen opens.

Click the + in the Prescheduled Section column next to a course. The Schedule Section

v Walk In Schedule

Menuv | X | € Q| 3| | «Sae  &Undo | PrintSchedule | | <<NotScheduled | | Not Scheduled >>

Student Name: Zor-EI, Kara School: Hope High School Status: Active Room Name: SEM Schedule Status:

Quick Placement Analysis  Schedule  Graduation Requirements

Lock all courses| | Un-Lock all courses| | Delete Non-Scheduled Course Request(s)

® Graduation Requirement Options

@ Course Request  Chooser

Not Scheduled

nn ] 5} ARSE Int Jewelry - - 8§ 8§ 8 8
un ] 5} NC501 Study Hall v v $ $ 8 8
-n Fall

un (] @ s857 Prin&prac Econ v v 8 8 8 8
un P @ ENG Prin Eng I - - $ $ 8§ g
n P ] NC401 Study Hall - - 8 8 8 g
n“ P [ MA42 Trigonometry v v 8 8 & g

Last Name First Name Middle Name Perm ID Suffix Grade Gender
Zor-El Kara 874087 12 v |Female v

Schedule

caurse Preferred Term Preferred m Pre-Req Not .
e

P X
P X

0665 - Prin&prac Econ| gp

0116 - Prin Eng li
0992 - Study Hall

0354 - Trigonometry

&
&
&

COR

Walk In Schedule Screen, Request Tab
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5. Select a section to add.
6. Click Select Section. The Schedule Section screen closes.

Schedule Section

Menu~ | o | Select Section Close

Course |D: SC492 Course Title: Biology
Section

@ Choose Section

0005 Tofft, Robert
000? 120 Tofft, Robert 32 (3 6 M
1032 124 Worsnop, Wiliam 52 2 2 MT

Perlod .
Line Room Meeting
Name c Dde “ Days m

Schedule Section Screen

7. Click Save.

Analyzing Mass Scheduling Course Requests

Modify student course requests from within the option set through the Schedule Student screen.

1. Navigate to Synergy SIS > Mass Scheduling > Schedule Control.

2. Open the option set.

Schedule Control
Menu~ @ o + Save | * Undo

School: Hope High Schoel Year: 2016-2017
Scheduling Option Sets

Create/Copy Option Set

@ Option Sets

l .2016—2{]1]r Scheduler - User, Admin 1.37%
Scheduler - User, Admin
Scheduler A User, Admin ~ 99.23% 2742

Master Schedule Builder User, Admin % 2750

-

Q
G
5
[}

Line Option Set Name Checked OUt
Total % [Scheduled 2| Date/Ti

38 04/05/2017

271

002/01/2017

Schedule Control Screen
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3. Select Open Student Schedule under Quick Links.

® Quick Links

E Open Student Schedule

':ﬂ.ql Open Schedule [ Allow unchecked out users to edit sections

Section

Open School Options
Open Option Set Wheel

Open ClassBoard

Schedule Option Set Screen

4. Locate the student to analyze. You can also click Conflict to scroll through only students that

have conflicting schedules.
5. Click Schedule to manually schedule the student's course requests.

Requests Analysis Schedule

Last Name First Name Middle Name  Suffix Perm D Grade
; Schedule
Abbott Billy C 905483 12 -

Student Name: Abbott, Billy C. School: Hope High Schoeol Status: Active Homeroom: Run Name: 2016-2017 Schedule Status: Rejected

7 Schedule Student | cEe
Run Name: 2016-2017
Menuw | € Q| ¥ o « Save | *yUndo I << Conflict Conflict >» I CICL: FAT T YA

Schedule Student Screen

241
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6. Selectthe Analysis tab to view scheduling results. Each course displays in the Schedule
Analysis section with results showing in the Schedule Period columns.

« A —Available section.
o F—Full section.
« Number—Period scheduled for the student.

Schedule Status: Rejected

Requests Schedule

Last Name First Name Middle Name  Suffix Perm ID Grade
Acevedo Andrew 866630 "
@ Filter ® Quick Add ® Current Stats
Term = Add By Group Total
- 2742
Filter
Rejected
22
@ Schedule Analysis

Not Scheduled

ENO91C

9th Eng-Corr

n ARB4 Int Drawing 0202 31 2 2
- 8551 Am Govt 0469 51 4 4
“ 5C49 Science 10 0725 51 5 5
ADBBEW Academic Decath 0736 YR 6 6

m course .n“E m Penod E"d ﬂ

Schedule

T Schedule Student “CcEe
Run Name: Mass Scheduling Trial Run #1
Menu~ | € Q ¥ L] « Save | *yUndo || << Conflict Conflict > @®

Student Name: Acevedo, Andrew School: Hope High School Status: Active Homeroom: 401 Run Name: Mass Scheduling...

Scheduled

%
99.2%

Schedule Period

~
AAFA4AA
FAAAFSBA

B

2720

Rejection Reason

No Section available

Schedule Student Screen, Analysis Tab
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7. Select the Schedule tab to view all scheduled and unscheduled course requests.

7 Schedule Student

Run Name: Mass Scheduling Trial Run #1

Menu~ || € | Q | » | | Save *Undo | << Conflict | Conflict ==

Schedule Status: Rejected

Requests Ana\yS\S Schedule
Last Name First Name Micdle Name ~ Suffix  Perm D Grade —
Acevedo Andrew 886630 11 chedue
@ Filter
Term
Filter
@ Schedule

Not Scheduled

Student Name: Acevedo, Andrew School: Hope High School Status: Active Homeroom: 401 Run Name: Mass Scheduling...

[Lne |_Gourseid | Gourse e Secton'd| _term _perioq seg | Penoa end Rejecion Reason

I ENOOAC 9th Eng-Corr No Section available
FaII
nARE4 Int Drawing 0202 51 2 2 Gunn, Gwen
8851 Am Govt 0469 s1 4 4 Jackson, Kathy
nscag Science 10 0725 51 5 5 Tofft, Robert
!ADSGW Academic Decath o735 YR 6 6 Canaday C.. Curt

@

Schedule Student Screen, Schedule Tab
8. Click Save after making adjustments.

Analyzing Individual Course Requests

The Analysis tab of the Walk In Schedule screen allows you to view student course requests and

analyze student schedules.

1. Navigate to Synergy SIS > Schedule > Walk In Schedule.
2. Locate the student to analyze.

3. Click Schedule to manually schedule the student's course requests.

v Walk In Schedule

Menu~ | € Q¥ & | | Ssave | *™Undo || Print Schedule << Not Scheduled | | Not Scheduled >>

Student Name: Acevedo, Andrew School: Hope High School Status: Active Room Mame: 401

Quick Placement Request Analysis Schedule
Last Name First Name Middle Name  Suffix ~ Perm 1D Grade
Schedule
Acevedo Andrew 886630 11 -

|

0
Q
@ o

Walk In Schedule Screen, Analysis Tab

243
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4. Selectthe Analysis tab to view scheduling results. Each course displays in the Schedule

Analysis section with results showing in the Schedule Period columns.
« A—Available section.
« F—Full section.
o Number— Period scheduled for the student.

B O e e e

Not Scheduled
o ARG Int Jewelry sz
8] NC501 Study Hall 81
Fall
8] 8857 Pringprac Econ 0665 32 25 7 Rl 0 0 0
o ENd6 Prin Eng lii 016 28 28 0 81 1 1
n 8] NC401 Study Hall 0992 180 189 0 Rl 2 2 F
Hn 0 MA42 Trigonometry 0354 130 22 8 §1 3 3 A

7 Walk In Schedule AR
Me+ 3 ‘Z| Q| | & oSae $Undo | PrintSchedule | | <<NotScheduled | | NotScheduled>>

Student Name: Zor-El, Kara School Hope High Sehool Stafus® Active Room Name: SEM  Schedule Status W

Quick Placement  Request Schedule  Graduation Requirements

Last Name FirstName Middle Name Perm D Suffix Grage Gender S

ZorEl Kara 874087 12 v Femae - CreduE
Term To Schedule | Curent Ter Fomward v
@ Fiter @ QuickAdd @ Drop and Enter date for class changes

Schedule Status o Drop Date Enter Date
Tem Start v TemEnd v |Fiter AUy Giowp i =
v 04/1212020 04/1312020 &
@ Schedule Analysis  Chooser
Schedule riod

A
A A A
A A A
F A A A
AF AT
3 A A A

Walk In Schedule Screen, Analysis Tab

5. Select the Schedule tab to view all scheduled and unscheduled course requests.

¥ Walk In Schedule

Menu - < Q > L] + Save | *yUndo Print Schedule << Not Scheduled Not Scheduled >>

Student Name: Acevedo, Andrew School: Hope High School Status: Active Room Name: 401

Quick Placement Request Analysis Schedule

Last Name First Name Middle Name  Suffix Perm ID Grade

Schedule
Acevedo Andrew 886630 1

Term To Schedule | All Terms -

@ Fiter

Term Start | Fall ~ Term End | Spring v| |Fitter

@ Schedule

PEFIDU

Am Govt 0036 51 0 0 MT Jackson, Kathy
- Fund Eng li 0522 51 5 5 MT Summers, Kim
nADaew Academic Decath 0736 YR 6 6 MT Canaday C., Curt

o

A
@ 0

Walk In Schedule Screen, Schedule Tab
6. Click Save.
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Student Schedule and Request Analysis

The Student Schedule & Request Analysis screen allows you to find any unassigned students or
students missing specific course requests. Create student and course filters to identify which
students or groups lack the proper courses.

Navigate to Synergy SIS > Schedule > Student Schedule & Request Analysis.
Click Add to open the Student Schedule and Request (Add) screen.
Enter a Filter Name.

oo~

Select the Filter Type.

Student Schedule & Request Analysis

X Close

Filter Name* Filter Type

Student Schedule & Request Analysis (Add) Screen
5. Click Save.

6. Select any appropriate student filters.

a. Select Only include students who have counselor and choose the counselor from
the drop-down.

b. Selectthe Grades to process.

v Student Schedule & Request Analysis L

Menu~ € Q ¥ o U&= NG 4 Add | X Delete

Step 1: Student Filter Step 2: Course Filter Step 3: Results

0
[

Al

Filter Name Filter Type
Grade 10 Sci Students missing schedule courses |«

@ Student counselor filter

I [[] Only include students who have counselor - I

@ Students who are in the following selected grades

GradeQ ~ &
Co7 Dos Dog O 10 D11 E12

Student Schedule & Request Analysis Screen
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c. Click Chooser on the grids corresponding to staff, student groups, or students to find
and select options.

@® Or student is in a class taught by the following teachers
I ™
® Or student is a member of any of the following groups

R T — e :
@ Or any students included below
e

Student Schedule & Request Analysis Screen

7. Click Save.
8. Selectthe Step 2: Course Filter tab.
9. Select any appropriate course filters.

a. Selectthe departments to analyze.
b. Click Chooser on the section to find and select specific courses.

c. Select Exclude Selections to instead only display results for students with requests or
courses within the selected filters. If left blank, results for students missing requests or
courses display.

7 Student Schedule & Request Analysis ceHEe

Menu~ € Q  » | ok + Add | X Delete
Step 1: Student Filter | Step 2: Course Filter | Step 3: Results

Filter Name Filter Type
Grade 10 Sci Students missing schedule courses -
® Condition

Exclude Selections

Courses associated with selections made below will be evaluated. If the "Exclude Selections" checkbox is selected only those students who have
requests or classes in the selected courses will show in the results grid. If the "Exclude Selections" checkbox is not selected then students who are
missing requests or classes will be included in the results grid.

® Courses associated with the following departments

Department ) «~ &

Fine Arts Language Math Science Special Education
Agricultural
Art Aerospace Science Science Business Education Computer/Business
Family and Consumer Industrial Military Science/Leadership

English Sciences Technology Army Music/Performing Arts

Physical Education Reading Social Studies Traffic Safety World Languages
East Valley Institute of

Elementary&School Miscellaneous Special Education [ Transfer Credit Technology

English Language

Development American History

® Or any courses included below

Lo otgy Leo

Student Schedule & Request Analysis Screen, Step 2 Course Filter Tab

10. Click Save.
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11. Selectthe Step 3: Results tab.

12. Click Search. Results can take some time to display depending on the size of the analysis.

13.

14.

v Student Schedule & Request Analysis «

Menu~ € Q¥ A& vsae | ®Undo GG IR TN
Step 1: Student Filter Step 2: Course Filter Step 3. Results

£

o

cc¢

Filter Name Filter Type

Grade 10 Sci Students missing schedule courses | ~
@ Search

Search

Student Schedule & Request Analysis, Step 3 Results Tab

Click the 52 under the Request column to open the Schedule Request screen for the
student. This allows you to schedule a course request for the specified course.

Click the 52 under the Walkin Sched column to open the Walk In Schedule screen for the
student. This allows you to schedule a section for the specified course.

@ Query Detail

Results include students who meet the fellowing conditions:
= Students in Grades: 10

Wheo don't have scheduled classes in:
= At least one of the Selected Courses: Biology. Biology Lab

@ Results

n 23 4

Foe | shugenttame | Femip | encer | wakin s
I AAA, Cindy 997031 10 E A Missing” Biology, Biclogy Lab

Acevedo.Ashley 901830  Female 10 By = Missing: Biology Lab

Adalr, Diane N. 903912 Female 10 7 & Missing: Biology Lab

Student Schedule & Request Analysis, Step 3 Results Tab
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Dropping Classes

Drop a class from a student's schedule on the Student Classes or Student screen.

Dropping a class removes it from the student's schedule. Deleting a class
removes it from the student's records, though the class can still appear on
the Add/Drop report for the student. See Tracking Deleted Classes for

more information.

Student Classes Screen

Navigate to Synergy SIS > Schedule > Student Classes.
Locate the student to modify.

Maximize the Drop Class, Filter, and Override Options section.
Select the section(s) to drop in the Current Class section.

o kw0 Dd =

Enter the Leave Date.

v Student Classes

Menu~ € Q| ¥ & | Save | ™ Undo

Student Name: Abbeott, Billy C. School: Hope High Scheel Status: Active Homeroom:

Current Classes Class Enroliment History Schedule Based FTE

Middle Name Track

G

Suffix Perm ID

905483

Grade
12

First Name
Billy

Last Name
Abbott

@ Current Class

The last scheduled class for this student has ended:
Period: 7 Section: 0957 Course Title: 8th Eng-Corr Staff Name: Nunes, Kathy Room Mame: 230

@ Drop Class, Filter and Override Options

Leave Date @ | Drop Selected Classes Display Term

Max Class Size Override Password Filter

-~ Meeting Day M: Mon

=

Student Classes Screen

6. Click Drop Selected Classes.
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Dropped classes remain on the Class Enrollment History tab for record keeping purposes.

¥ Student Classes L ze&e
Menu~ | € | Q| » | | s «Save | *Undo @R A

Student Name: Abbott, Billy €. School: Hope High School Status: Active Homeroom:

Current Classes | Class Enrollment History I Schedule Based FTE

Last Name First Name Middle Name  Suffix Perm ID Grade Track
Abbott Billy C 905483 12 - -

@ Class Schedule History

Period
|ne Course Title Teacher Enter Date Leave Date
T

0077 TA999 Teacher Aide Jackson, Kathy 07/06/2016 09M19/2016

1 YR 100000000 TAS99 Teacher Aide Tofft, Robert 120  09/20/2016 @& 11/25/2016 &
2 51 0206 AR54 Beg Jewelry Sullivan, Joe 403  10/25/2016 & 11/25/2016 &
3 s 0304 AR32 Beg Photo Schubert, Thome 404 | 07/05/2016 & 11/25/2016 &
7 YR 0060 ENSTC Cec-Am. Lit Nunes, Kathy 230 07/05/2016 @@ 00/20/2016 i@
Student Classes Screen, Class Enroliment History Tab
Student Screen

1. Navigate to Synergy SIS > Student > Student.

2. Locate the student to modify.

3. Selectthe Classes tab.

4. Enterthe Leave Date next to the class to drop in the Class Schedule section.

v Student » crL-e

Menu~ @32 <€ Q > & + Save || *3Undo @AM

Student Name: Abbott, Billy C. School: Hope High School Homeroom: 403 Teacher: Andrews, M.
Demographics Parent/Guardian Other Info Emergency Enroliment Enroliment History Documents Contact Log

Notes
Last Name First Name Middle Name  Suffix Perm ID State ID Grade Gender
Abbott Billy Cc 905483 0001341311 12 + | Male -

Language Spoken at Home
English -

@ Current Class

Attendance Code: Period: 0 (7:00 AM - 3:30 PM) Room: 218 Section ID: 1077 Course Title: Am Govt Staff Name: Jackson, Kathy (1069)
Tdy - Tardy

@ Class Schedule 4 add | Chooser | Actions =

Penuds Ruom
Line Term Code Course Title Enter Date Leave Date College Credit
e

51 0077 8551 Am Govt 07/04/2017 11/24/2017 -
o s 0840 SC49 Science 10 121 09 12 | 11/24/2017 @@ 11/24/2017 @ -
0 82 1077 8551 Am Govt 216 09 12 11/30/2017 @& 01/09/2018 & -
1 &1 0106 ARS4 Beq Jewelry 403 10 12 07/04/2017 @& 1212212017 @@ -
1 82 1116 EN46 Prin Eng Il 231 12 12 11/30/2017 & F- 1 hd

Student Screen, Classes Tab

5. Click Save.
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Tracking Deleted Classes

Schools can track classes deleted from student schedules and compare the data to the Add/Drop
Report. Enable this function on the School Scheduling Options screen.

1. Navigate to Synergy SIS > Mass Scheduling > Setup > School Scheduling Options.

2. Select Track Class Deletions for Add/Drop Report.

School Scheduling Options

Menuv | o # Save | *yUndo

3

S EE -0

School Name: Hope High Schoel School Year: 2017-2018

Section Options Course Request and Walk-In Options House/Team/Exclusion
@ Options @ Include In Grading Option
Class Size Limit Section ID Width

When the include grade option or minimum class enroliment days are blank,
Add Student, no Message -~ 4

the district default will be used (Grade Option 'Alvays'). If Always or blank is
Class Sze Limi Password Auto Sequence selected then the Minimum Class Enroliment Days field is disregarded. If
c t evaluate is selected, then the student must have been enrolled in the
ounter - course for at least the number of days indicated in the Minimum Class
Enroliment Days textbox below to have a grade in the course

] Track Class Deletions for Enable Section ID Validation Warnings
Add/Drop Report [C] Do Not Fill Section ID Gaps

Include Grade Option
Creation of "Grade" records can be limited to just the

Evaluate active classes against Minimum Days Enrolled Threshold | =
Homeroom Section by checking the following checkbox:

Minimum Class Enrollment Days

[7] Only Create Grade Records For Homeroom Section. 10

Enable View of Student’s Team
Enable View of Student’s House
Enable View of Student’s Counselor

School Scheduling Options Screen
3. Click Save.

Student Classes Deleted

The Student Classes Deleted screen under the Schedule module displays deleted class
information.

You must enter a Leave Date for the class prior to deleting it from a
student’s schedule in order for it to display on this screen.

7 Student Classes Deleted

Menu~ | € Q ¥ = « Save | *yUndo

Q
'@
B 5

B e

@
@
a -
&
B
C

Student Name: Abbott, Billy C. School: Hope High School Status: Active Homeroom:
Deleted Classes

Last Name First Name Middle Name  Suffix Perm ID Grade
Abbott Billy C 905483 12 -

This view is used to view/edit student class data that has been deleted, but still retained in the system in order to track against the class Add/Drop report. In order for deletions
to be tracked here, the school option 'Track Class Deletions for Add/Drop Report' (School Scheduling Options view) must be enabled.
© Deleted Classes

Penou Term
LLine| Delete Date Leave Date Course Title Teacher
m

10/25/2016

n.G 6 04/25/2017
nz 2 10/25/2016

0206 ARS54 Beg Jewelry Sullivan, Joe

s1 0602 ARG3 Beg Drawing Gunn, Gwen 401

A A
a3 | A

51 0206 ARS54 Beg Jewelry Sullivan, Joe 403

Student Classes Deleted Screen
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ClassBoard Overview
ClassBoard graphically displays schedule information and allows you to easily modify class settings.

After creating option sets, you can run them within ClassBoard to simulate schedule updates.
However, you cannot individually modify student schedules from this application.

Elﬂ:oint

2,719 of 2,742 (99.2 %)

FILE EDIT VIEW Hope High School - First Try ‘ User: admin

& *‘E’i E!| \WTEH Left: Dept/Course Top: Term/Pericd » [EREGE=NEE _

Fall []

= 0 ‘ 1 4

. |
-
Lo 3 2570 Gary

Afjrote I Mhs Rotc 0 of 25

Afjrotc 1
Afjrotc II Wwhs Rotc 0 of 5

Afjrotc 11

Afjrotc ITT Mhs Rotc 0 of 2

Afjrotc IV ‘Wwhs Rotc 0 of 5

Afjrotc IV

Colorgrd/drill Mhs Rotc 1 of 5

Colorgrd/drill
B G G s s G

Animal Sci Mendoza...29 of 38

Expl Agric Sargent 1 of 10

Landscape Dam 1 Mendoza... 2 of 32

L aee ey Gsewn s ouss
"

ClassBoard Screen

ClassBoard Setup

ClassBoard utilizes the Microsoft® Silverlight® viewer. You must have Silverlight installed on your
system before running ClassBoard.

started/install/default.aspx to install Silverlight.

[ See http://www.microsoft.com/getsilverlight/get- ]

Additionally, administrators must define the SSL setting for each site using ClassBoard with the
DBTools utility. Edupoint includes this tool in the Synergy SIS installation.

1. Launch DBTools.
2. Navigate to Databases > Add New Web.Config/Database Access.
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3. Enter new web.config settings for all websites running ClassBoard.

Data Access Name
|<urtitled:>
webConfig.xml Location
[c-"inetpub \wwwroct Wb Contig [
Database Type —— [ Connection Information
¢ Microsoft SQL Server server
IUocaI]
™ Oracle Database
IHevelation
User ID Schema Owner
‘Web Server Options ———————— IHE“' I
[~ Multi-web Site Installation Password
[~ Primary Database in Multi-Web =
Site Installation Confirm Password
\web.Config SSL Setting =
“ ﬂ Extra Database Connection Parameters
SSL Only I
Both Non-55L & S5L
Test Connection ok | cancel | apaly |

DBTools DatabaseConfig Screen

4. Select one of the following under Web.Config SSL Setting: SSL Only, Both Non-SSL and
SSL, or Non-SSL Only.

5. Click OK.

|| See the Synergy SIS — System Administrator Guide for more
information about using DBTools.

Launching ClassBoard

253

1. Navigate to Synergy SIS > Mass Scheduling > Schedule Control.
2. Open the option set.

3
Q
)
o

Schedule Control
Menu~ | o « Save | +yUndo

School: Hope High School Year: 2016-2017
Scheduling Option Sets

Create/Copy Option Set

Checked Out
Option Set Name e -
To Tot Scheduled & Date/Ti

al o
2016-2017 [ Scheduler - User, Admin 1.37% 2764 38 04/05/2017

@ Option Sets

Scheduler - User, Admin

I ALG Blank

.n Backup Copy

Copy of last year's schedule
R —————

Scheduler - User, Admin 99.23% 2742 2721

Master Schedule Builder = User, Admin % 2750 002/01/2017

Schedule Control Screen
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3. Check out the option set.
4 )
s ClassBoard displays in read-only mode if another user has the
==ll option set checked out.

4. Select Open ClassBoard under Quick Links.
4 )
ClassBoard copies the entire schedule from the Option Set to the
local hard drive of the user’s computer. Changes made to the
Option Set do not display in Synergy until you save changes in

A ClassBoard.
Do not open additional screens within the option set while running
ClassBoard, such as Student Schedule or Schedule Section.
ClassBoard overrides any changes made to the Option Set on other

. screens after you save. )

@® Quick Links
@ Open Student Schedule

EEQ'EI Open Schedule [ Allow unchecked out users to edit sections
3l

Section

Open School Options

')
C.) Open Option Set Wheel

Open ClassBoard

Schedule Option Set Screen

ClassBoard Display Options

The School Name and Option Set Name display at the top of the page with the name of the User
editing the option set. The icons under the menu row correspond to Save, Undo, Reschedule,
Preferences, and Schedule Options. The top-left corner of the section displays the number of
students scheduled divided by the number of course requests and the percentage of students
scheduled.

- Kennedy High School - Mid Year Test = User: admin
Edupoint ' - |

E i % *E" m,‘ L= H Left: Dept/Course Top: Term/Pericd ~ EEEES:TEER -

1st Semester [-]

2,252 of 2,253 (100.0 %)

ClassBoard Screen
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On the header row for each department, the total number of spaces in a class displays along with the
total number of students scheduled. For example, the following image shows one seat occupied out
of 118 seats available during Period 3 in the American History department.

Edupoint recommends that schools assign all courses and staff to their
0 respective departments before using ClassBoard, as this is the method
used to sort data.

5 Amercon oter  ewe

Am Govt Myers 0 of 10

Am Govt

Am History 1 Myers 0 of 5 Myers 0 of 5
American Govt Romero 1 of 10

American His II
Basic Math

Consumer Math Sargent 0 of 17 Sargent 0 of 10
Consumer Math

Driver Train Atwood S. 0 of 10

ClassBoard Screen

Viewing Options

You can display ClassBoard sections in a number of different ways. ClassBoard sorts courses by
departments on the left side of the grid and term and period at the top of the grid. To select a different
view, select the option in the View section at the top of the screen.

Kennedy High School - Mid Year Test s User: admin

A=Al Left: Dept/Course Top: Term/Period ~ JS a0 _|
] Left: E

: Dept/Teacher Top: Term/Period
2,252 of 2,253 (100.0 %) Left

: Dept/Teacher Top: Periods/Meeting Days
Left: Dept/Teacher Top: Meeting Days/Periods | 4 |

e Teacher Top: Termy el e T
[ Agricultural Sci Left: Teacher Top: Dept/Course
gricultural Science _
Left: |

— : Dept/Course Top: Term/Period
Animal Sci Waojcik 0 of

Left: Dept/Course Top: Teacher

Expl Sargent 0 . .
BS0r - Left: Dept/Course Top: Periods/Meeting Days

Landscape D&m I Left: Dept/Course Top: Mesting Days/Periods

[£] American History : Term/Period Top: Dept/Course _

Am Govt Left: Room Top: Dept/Course

Am Govt Left: Room Top: Term/Period

Am History I Myers 0 of 5 Myers 0 of 5
American Govt Romero 1 of 10

American His IT
Basic Math

Consumer Math Sargent 0 of 17 Sargent 0 of 10

ClassBoard Screen
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You can also change the view by selecting View Selector in the View menu.

When sorting sections by either Teacher or Room, the top row displays all
sections with no teacher or room assigned.

E du in,t FILE  EDIT Kennddy High School - Mid Year Test & User: admin
J View Selector 3 Left: Dept/Teacher / Top: Term/Pericd -
Rules » Left: Dept/Teacher / Top: Periods/Meeting Days
2,252 of 2,253 (100.0 %) Preferences Left: Dept/Teacher / Top: Meeting Days/Periods
Schedule Options Left: Teacher / Top: Term/Period
Windows 3 Left: Teacher / Top: Dept/Course -

B Aerospace Science
O ural + Left: Dept/Course / Top: Term/Pericd

Agricultural Science
Left: Dept/Course / Top: Teacher

Animal Sci | Woick 00f30

Left: Dept/Course / Top: Periods/Meeting Days
Expl Agric | Sargent00f10

Left: Dept/Course / Top: Meeting Days/Pericds
Landscape D&m I -

e e
American Histol
Ll e Left: Room / Top: Dept/Course

Am Govt .
Left: Room / Top: Term/Period

Am Govt

o History 1 wemoors © wyersoofs

American Govt Romero 1 of 10

American His IT

ClassBoard Screen, View Menu

Click the scroll bars to move the section. A pop-up displays a smaller version of the section for a
visual focus. The view shifts to the highlighted row when you release the mouse button.

Edu i I FILE EDIT VIEW Kennedy High School - Mid Year Test . User: admin
. .
! -5 © % @] o EOETT R e |

31 0f 172 (18.0 %) 1st Semester [-]

[=] Teacher

[-] Science [5] Industrial Technology
Hammond, ] B Language
[=] Social Studies = Math

[=] Special Education Anderson, G

-
w

]
2
H
2
g
g
H
g
:
£
=
g
=<

[=] Special Education

[5] raffic safety [=] Miscellaneous

[=] Transfer credit [5] Music/Performing Arts
Mahoney, 5

2] Physical Education
[Z] Reading

[=] unknown

[=] science
Hammond, 1

[=] Secial Studies

IE‘ Special Education

Mo Teacher Set IE‘ Special Education
[=] Traffic Safety
[=] Transfer Credit

[=] unknown

No Teacher Set

ClassBoard Screen

Maximize or minimize rows and columns by clicking the + or —icons.
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Each section displays as a colored bar in the grid. The bar displays the last name of the teacher and
the number of scheduled students to the number of maximum seats. The Rules define the color

coding for each section.

Myers 14 of 10

Over max seat count

Myers 5 of 5

Full

Romero 1 of 10

Available seats

Myers 0 of 5

Empty

Toggle rules on or off using the Select Rules section at the top.

Wint - FILE

Kennedy High School - Mid Year Test . User: admin

QTR Left: Dept/Teacher Top: Term/Period ~ EEEEGEEEA Empty, Full, Over

-.

31 of 172 (18.0 %)

[5] Teacher

0 son et R R B T

—————
5 v et 1T
. _________________________________________________________________________________________________________________________________SF 1§

1st Semester [-]

ClassBoard Screen

You can also change the rules by selecting Rules under the View menu.

-

Elﬂ:Olh‘t

Kennedy High School - Mid Year Test

‘ User: admin

View Selector 3

sires Thme Tarm/Darind  »

Rules DI v Class empty

2,252 of 2,253 (100.0 %)

E Aerospace Science

[5] Agricultural Science

Preferences v Class full

Schedule Options ¥ Class cver maximum size

J—

Windows 3

ClassBoard Screen, View Menu
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Windows and Docking Panes

You have the option of displaying four docking panes on the ClassBoard screens to view additional

section information. To enable or disable these windows, select Windows under the View menu and
select the windows to modify.

Edu int FILE EDIT Kennedy High School - Mid Year Test & User: admin
J | View Selector » .
surse Top: Term/Period -
Rules 3

2,252 of 2,253 (100.0 %) BEElEences mester [-]
Schedule Options | | |
o — = 4
Windows 3 Section Details -
E Aerospace Science

o e | ©T |

5ttt S o  ewe
Section Students

Animal Sci ‘Wojcik 0 of 30

Section Statistics
Expl Agric Sargent 0 of 10 .

ClassBoard Screen, View Menu
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« Section Details — Displays details of the selected section.

« Click Go To to bring the section into view on the main grid.
« Click Edit to edit section information.

Details > 4 X
|Allen 25 of 40

Details =
Department American History
Teacher Allen, M

Course 0023

Room 120

Section ID Qooooooooooo0n23
Section Info =
Start period 1

End period 1

Term Code 51

Exclude Attendance Include In Attendan
Exclude Grading Include In Grading
Instructional Minute:

Using Elementary Mi

Student Seat Totals =
Max 40

Total 25

Male 12

Female 13

Open Seats 15
Teacher Aide Totals =
Max

Total 0

Open Seats 0

Restrictions =

Grade Range Low 09
Grade Range High 12

Gender Restriction

Credit 60.000
House House A
Team

Term Exclusion
MNo Term Override

Exclude From Mass ¢

ClassBoard Screen, Section Details
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« Section Rules — Displays the color rules for the sections and allows you to turn rules on or

off.
Rules i
Rule Color J Active
lass empty | v
Class full v
Class over maximum size i
1] | L4
| Details | Rules | Statistics |

ClassBoard Screen, Section Rules

« Section Statistics — Displays the total number of requests for the selected section with the
total number of students scheduled.

Class Requests: 14
Class Scheduled: 14

Details | Rules | Statistics

ClassBoard Screen, Section Statistics

» Section Students — Displays all students scheduled into the section.

o You can mark students Teacher Aide or Pre Schedule.

Students - X
e Cardr [ resver s v
12 Male v E
Abernethy, Anne 11 Female J b |
Acevedo, Andrew 12 Male +

Acevedo, Ashley 11 Female J

Acosta, John 12 Male J

Acosta, Billy 10 Male “

Acunia, Kenneth 11 Male o

Adair, Alan 12 Male “

Adair, Dians 11 Female “

Adair, Timothy 12 Male o

Adams, Albert 12 Male o

Aguilar, Michelle 10 Female o 4
Aguilar, Stephen 12 Male + .

ClassBoard Screen, Section Students
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« Change the window display options by clicking the ¥ icon in the top-right corner of the
window.

« Floating — Displays as a small box over the main screen that you can move and resize.

« Dockable — Displays on the right side of the screen and allows you to move and
organize windows as needed.

. Tabbed Document — Displays as tabs in the main section grid.

« Auto hide — Displays as a small box on the right side of the screen and displays on
mouseover. The Pin icon changes a window from Dockable to Auto-Hide.

» Hide — Closes the window completely.

Rules ]2 x
Rule Floating
Class emi s pockable
Class full
Class ove Tabbed document
Auto hide
Hide

| I

ClassBoard Screen, Window Options

ClassBoard Preferences

Select Preferences under the View menu to change display options for the section grid and other
ClassBoard functionality.

« Section — Changes various display options for the sections in the grid.
« Docking Panes — Allows you to enable or disable different windows.
« Functionality — Allows the following:

« Disable drag’n drop — Prevents you from dragging sections to new locations on the
display grid.

« Jump to — Clicking the scroll bar jumps the view to that location instead of scrolling in
that direction.

« Confirm Changes — Asks you to confirm all changes made to sections.

« Real time scroll — Dragging the scrollbars moves the grid instead of only the visual
preview.
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« Setthe Maximum/Minimum visible classes. 0 indicates no maximum or minimum.

Save Cancel

Preferences

Select the data that you want to view inside a section

Section

|_| Course 1D |_| Department

|| Course Title |+ Teacher

| | Room |+| Class size

|| Period |+ Total students enralled

|| Term || Awvailable enrcllments
Docking panes

|+| Section Details |+| Section Rules

|+| Section Statistics || Section Students

Functionality

|| Disable drag'n drop |__| Confirm changes

|| Jump to | | Real time scroll

Maximum visible classes Minimum visible classes

o | o |

ClassBoard Preferences
« Section Rules and Colors — Allows you to modify how sections are color-coded:

« Selectthe Color code sections by option: Enrollment, House, or Team.
« Selectarule and then select a color to modify the existing colors.

Section Rules and Colors
Color code sections by

| Enroliment -

Rules and colors

Rule Color

Class empty
Class full
Class over maximum size

Select color
H EEEEEN

I I I I I I I I Remowve color from rule

Standard colors
Hn EEEEN

ClassBoard Preferences
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Modifying Schedules in ClassBoard

To easily make changes to the schedule, drag and drop sections on the grid to a new period or term.
Moved or edited sections display with a blue outline on the grid.

7

N\
To reverse changes made in ClassBoard, select Undo under the File
menu or click the Undo icon.
a FILE EDIT VIEW
A Edupoint
Reschedule [
426 of 2,253 (63.3 %) Save
ClassBoard Screen, File Menu
\. J

Myers 14 of 10

Myers 4 of 5

Myers 1 of 5
[ Romero 1 of 10 iloflﬂ I

ClassBoard, Moving Sections

Adding Sections

1. Locate the course in the section.
2. Right-click on an empty space in the period column to add a section for.
3. Select Add Class.
4. Enterthe Section ID. You must manually assign Section IDs to new classes within
ClassBoard.
5. Enter any additional section information.
Add a new class (=S s
I Save I Cancel
Section details | Students
ection Course ID Course Title Staff Name Room Name
IFP?S-Raading - H - H -
Section Info Student Seat Totals
Period Begin Period End Term Code Department Male Female Total Max Open Seats
(2 x 2 =l ¥ || American History |2i/
Exclude Attendance Exclude Grading
L | . | Teacher Aide Totals
Instructional Minutes Override [=] Using Elementary Minutes
Total Max Open Seats
L
Grade Range Low  Grade Range High Gender Restriction Credit House Team Term Exclusion
| =1 ]l =J| I il =l b
[=] No Term Override [=] Exclude From Mass Scheduling
ClassBoard, Add Section
6. Click Save.
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Managing Sections

Right-clicking on an existing section allows you to Add Class, Delete Class, View Section Details, or
Open Class Builder. You can also add or delete classes through the Edit menu. ClassBoard
displays the same section details as the Schedule Section screen.

1. Double-click on a section to view details or use the Section Details window.

2. Click Edit to make changes to section data.

0313 Life Sdence =N
Close
Section details | Meeting days | Students
Section ID Course ID Course Title Staff Name Room Name
5C42-Life Science Konvalin, 5 405
Section Info Student Seat Totals
Period Begin Period End Term Code Department Male Female Total Max Open Seats
) 3 YR Science
Exclude Attendance Exclude Grading
Include In Attendance Include In Grading Teacher Aide Totals
Instructional Minutes Override Using Elementary Minutes
I Total Max Open Seats
Restrictions
Grade Range Low  Grade Range High Gender Restriction Credit House Team Term Exclusion
Mo Term Override Exclude From Mass Scheduling

ClassBoard, Section Details

3. Select the Meeting Days tab to view rotation days if your school enabled meeting days.
4. Selectthe Begin and End Period for the section on each meeting day.

Save Cancel
Section details | Meeting days | Students

Bean b sz s

=L b~z =)

ClassBoard, Section Details, Meeting Days Tab
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5. Select the Students tab to view all students scheduled.
6. Click Drop next to a student to remove them from the class.

Save Cancel

l Section details l Meeting days | Students

Name Teacher Aide | Pre Scheduls
Aguado, Bobby 11 Male i
@ Aguilar, Michelle 10 Female o
@ Aguilar, Carclyn 11 Female v
@ Aguilar, Stephen 1z Male i
@ Aguirre, Mary 12 Female i

ClassBoard, Section Details, Students Tab
7. Click Save.

Class Builder

Class Builder allows you to modify student course requests and manually assign students to
sections.

e e R [ besmiment i
Enrolled Students Course Request Section Roster
Student List Department [ Unknown -] Section [ 1_241_SA99:YR / 599
Course [Student Aid ~]

Total Requests: 77 Total Available Seats: 6700 od T e home T avT T a1
1 " Abbort, Bobby v o 2 [ v 2 £
2 " sbemathy, Bruce o n 3 v 2 "
u . Boramson, Sarah o 1 " v 1 3
n " Abrigo, Seore o e 3 v 1 e
1 " Reeueds, Gerald 7 1 3 v 2 "
u . Ackdand, Jean . 2 3 2 "
©» " sckley, Brian o e~ " S 3
2w et ) £ v 2,
« - oo, et . L 3) . ' L3) % "
n . Bcosta, Kathleen ¢ u " v 2 "
2 . Bere Kimberty s 2 " v n 3

Aeuna, Frances 1 " Engssrom, Ancrew v

Adams, Albert 12 F Erickson, Frances v

ClassBoard, Class Builder Layout
1. Right-click on a section and select Class Builder.
« The left window displays all Enrolled Students at the school.

« The Regs column indicates the number of course requests for that student.

Enrolled Students

Student List

12 M Abbott, Billy 10 :]
11 F Abernethy, Anne i

12 M Arevedo, Andrew 9

11 F Acevedo, Ashley 1

10 M Acosta, Billy 1

12 M Aresta, John 5

Class Builder, Enrolled Students
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« The middle window displays all Course Requests for the selected department and
course.

« The Sched column indicates if a student is scheduled for the specified course.
« Change the course through the menu at the top.

Course Request
Department [Math - J

Courss [ Trigonometry x J

Total Requests: 867 Total Available Seats: 420

iz M Abbott, Billy N
1z M Acevedo, Andrew A
12 M Acosta, John ¥
12 M Adazir, Alan ¥
12 M Adair, Timothy ¥
12 M Adams, Albert h
12 M Adams, Martin

iz M Adams, Larry

Class Builder, Course Request
« The right window displays students assigned to the section.

« The PreSched column indicates if a student is prescheduled for the section.
« Change the section using the drop-down menu at the top.

Section Roster
Section | 0443:51 / MA42 M
12 F Aguirre, Mary
iz F Baum, Jane
12 F Brimhzll, Susan
12 F Camnevale, Rebecca
12 M Everatt, Jos
12 M Figueroz, Shawn

Class Builder, Section Roster

2. Click the ELE next to any column to select filtering options.
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Request window.
Enrolled Students Course Request

Student List Department | Math -
Course [Trigcmomatry - ]

Gd T Gen Hame Y BB Y s GT YT Res T = Total Requests: 867 Total Available Seats: 420

11 F Abemethy. Anne 1 12 M Abbatt, Billy v j

12 M Acevedo, Andrew 9 12 M Acevedo, Andrew v

11 F Acevedo, Ashley 1 1z M Acosta, John ¥

10 M Acosta, Billy 1 1z M Adair, Alan v

12 M Acosta, John 9 12 M Adair, Timathy v

11 M Acunia, Kenneth 1 12 M Adams, Albert v

1 F 2dair, Diane 1 12 M 2dams, Martin

12 M Adair, Alan ] % 12 M Adams, Larry

12 M Adair, Timathy kl ‘ 12 M Aqguilar, Stephen ¥

12 M Adamsz, Albert s 12 F Aguirre, Mary ¥

12 M Adams, Martin 8 12 M Ahlstrom, Jack

Roster window.

Enrolled Students To/from Course Request

4. Use the arrows to add and remove students from the Course Request window to the Section

@_ Closing the Class Builder window automatically saves changes.

Course Request

Department | Math

Course [ Trigonometry

Total Requests: 867 Total Available Seats: 420
12 M Abbott, Billy
Acsvedo, Andrew
Acesta, John
Adair, Alan
Adair, Timothy
Adams, Albert
Adams, Martin
Adams, Larry

Aguilar, Stephen

I
m =z =z = =T = = = =

Aguirre, Mary

6rd T Gen Name T 80T ST 67 T Sched T ‘j

< = = = = =

<]

Section Roster
Section | 0443:51 / MA42 =

Gd T Gen Name T 68T T & T rPesched T fiul

12 F

Aguirre, Mary
Baum, Jane
Brimhall, Susan
Camevale, Rebecca
Everett, Joe
Figueroa, Shavmn
Fullagar, Jane
Graene, Michas|
Hardison, Pamels

Hatch, Deborah

B
= m m o=z m =z = T om 7™

Hise, Eugene

Course Request To/from Section Roster
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3. Use the arrows to add and remove students from the Enrolled Students window to the Course
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Finalizing the Schedule

1. Select Schedule Options under the View menu to verify settings. This is the same information
as on the Schedule Option Set screen in Synergy SIS.

| Schedule Options .

Save Cancel

” B 5]

Schedule Options

Enforce The Following Rules Balance and Seguence Options
|| Use Teachar Praferences [ 1r, - Grade Order
l || Check Carequisites { High Grade to Low Grade = ]
Prerequisite Option e
[ No Enforcement - I [Alpha AtoZ - J

|| Allow Alternate Course

Course Requast Sequence
|| Allow Global Alternate Courses Req =

[_] Use Room Seat Limit | By Difficulty ~ |
|| || check Term Override RO —
|| Check Term Preference Try -
| Total Students A

|| Check Student Restrictions

|_| €heck Teacher Restrictions Exclude the following students

House Option Do Mot Process the Following Grade Levels

| Automatic House Enforcement M |U ps [Ike [Jo1 [Joz [Jo3[Jos [Jos [Jo7r [Jos [J1o [J11 [J12 [ 12+|
Team Opticn Do Mot Process the Following Houses

[Autumatic Team Enforcement M I 114 =
Duplicate Course Request || 118 _‘

| Schedule one of the duplicates | [J11c ] |
Exceed max class size for CORE classas by this % | o |_| 1234587890

Exceed max class size for ELECTIVE classes by this % | Do Mot Process the Following Teams

Excesd ma:x class size for OTHER classes by this 3% | g 1 o

Special Run Option Lia

| None v | Lie -1
[Jc

Mss ime to spend per student (in seconds; default value is .1 -

=acond)

|| Lock Schedule for Skippad Students - NOTE: If this is

0.1 not checked and grade levels (above) are selacted to

be skipped, the skipped student's class assignmants
will be cleared
|_| Do Mot Process Fully Scheduled Students

ClassBoard, Schedule Options

2. Select Reschedule under the File menu or click the Reschedule icon.

- FILE EDIT VIEW
Cupoint
Unda

Reschedule

426 of 2,253 (63.3 %) Save .

ClassBoard Screen, File Menu

3. Click OK to confirm the reschedule process.

Are you sure you want to reschedule the entire option set?

[ 0K J[ Cancel

Reschedule Confirmation Window
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4. Select Save under the File menu or click the Save icon to finalize all changes made within
ClassBoard.

FILE EDIT VIEW

Edupoint
Jo | Undo

Reschedule

426 of 2,253 (63.3 %)

ClassBoard Screen, File Menu

5. Close the Job Queue Status window once complete.

- Job Queue Status E@g
I Job Queue Status
| |
Job ID |SAVE_CLASSBDARD |
Description |Sa\re Class Board Data |

Status Complete: Job is now complete

ClassBoard Job Queue Status
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Once you determine the best schedule using Mass Scheduling, run the chosen Option Set for the
final time to copy sections and student schedules to the Schedule module. This is the final step in
master schedule creation for the new school year.

Creating the Final Option Set

Before finalizing the schedule, make a copy of the option set with a name indicating it is the final set

used to create this year's schedule.

8. Click Add.

Select the Year.

N o o s~ D=

Navigate to Synergy SIS > Mass Scheduling > Schedule Control.
Click Create/Copy Option Set.

Enter the Name and Description that indicates it is the master schedule.
Select Copy existing Option Set for the Copy Option.

Select the Scheduling Option Set that contains the optimal schedule.
Select Include Sections without Teachers and/or Rooms and Copy Student Results.

Add New Option Set

@ Option Set Basic Info

2017 Master Schedule

Final schedule for 2016-2017

@® Create Options

Copy existing Option Set 2016-2017 - |2016-2017 =
Include Sections without Teachers and/or Rooms
Copy Student Results

Scheduling Option Set

Add New Option Set Screen
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Creating the Master Schedule

The Update Schedule process deletes all existing sections and student
A schedules prior to creating the master schedule, then assigns students to
new sections.

1. Navigate to Synergy SIS > Mass Scheduling > Update Schedule.
2. Select the Option Set to use for the master schedule from the list.

¥ Update Schedule
Menu ~ o=
Organization Name: Hope High Schoel School Year: 2014-2015

Update Schedules
WARNING: This process will delete all current sections from the current master schedule and student schedules and then copy the selecied option set schedule results fo the current
master schedule and student schedules
Select Option Set to Copy to Current Master Schedule and Student Schedules
2015-2016 Master Schedule Percentage Scheduled: 97.29% Run Date: 08/25/2015 10:55:04 | ~

Initiate Update Schedule Process

Update Schedule Screen
3. Click Initiate Update Schedule Process.

After the Update Schedule process completes, all other changes to a student’s schedule should use
the Walk In Schedule screen in the Schedule module.

-
Edupoint recommends you modify security to remove the Mass

O Scheduling module from the PAD Tree for most users to prevent anyone
=  from making changes to the Mass Scheduling views after finalizing the

schedule.
7
( )
See the Synergy SIS — Security Administrator Guide for more information
| ] > .
L on modifying PAD security. )
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Ending Terms

Schools must enter a leave date for each class in a student’s schedule to indicate the end of
enrollment. Enter a leave date for all scheduled classes through the End Term screen.

1. Navigate to Synergy SIS > Schedule > End Term.
2. Selectthe Term to Process. Select Today to process the current term.
3. Select the Track if applicable.

0
[}
Eu
©

End Term ‘
Process End Term
Options

This process will put the last day of the selected term in every student class record with a corresponding section whose term code indicates (based on
school term) the class ends in the selected Term to Process.

NOTE: The student remains enrolled in the class through the last day of the term

Term To Process Track To Process
Spring - 5 Day Week =

End Term Screen

4. Click Process End Term.

Students remain enrolled in classes until the Term End Date determined
by term definition settings in School Setup.

273
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274
Deleting Course Requests

Clearing non-scheduled course requests from student schedules allows you to view only current
data on the Walk In Schedule screen. This helps to clear irrelevant course data once the schedule is

finalized.
1. Navigate to Synergy SIS > Schedule > Walk In Schedule.
2. Locate the student to modify.
3. Selectthe Request tab.
4. Click Delete Non-Scheduled Course Request(s).

The Course Request section still displays course requests until you
refresh the screen or scroll to another student and back to the

v Walk In Schedule ce -
Menu~ A & Q » & Print Schedule << Not Scheduled Not Scheduled >>
Student Name: Zuniga, Kathleen School: Hope High School Status: Active Room Name:  Schedule Status

Quick Placement Analysis Schedule Graduation Requirements
Last Name First Name Middle Name Perm ID Suffix Grade Gender S

Schedule
Zuniga Kathleen 997014 1 ~| Female ~
© Filter @ Select the terms to schedule
Schedule Status Wi -
Term Start - TermEnd <! [ Firer Term To Schedule Current Term Forward
® Quick Add

Drop and Enter date for class changes

© Drop ! L Add By Group

Lock all courses | | Un-Lock all courses

Delete Non-Scheduled Course Request(s)

@ Graduation Requirement Options

Walk In Schedule Screen, Request Tab
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Handling Walk In Requests

After finalizing the master schedule and creating sections, staff create additional student schedules
through the Walk In Schedule screen. New students enrolled after the start of the year require these
scheduling procedures. You can add classes to a student’s schedule through the Quick Placement
and Request tabs.

Scheduling Course Requests

See Walk In Schedule — Request for more information on adding course
requests.

1. Navigate to Synergy SIS > Mass Scheduling > Walk In Schedule or Synergy SIS >
Schedule > Walk In Schedule.

2. Selectthe Request tab.
Select the Term to Schedule.
4. Click Schedule. The system attempts to schedule the course requests into available sections.

v Walk In Schedule HREI AR
Menu- | 2 ¢ Q 3 & Print Scnedule | | << Not Scheduled | | Not Scheduled >>
Student Name: Zor-El, Kara Scnool: Hope High School Status: Active Room Name: SEM Schedule Status b
Quick Placement Analysis  Schedule  Graduation Requirements
Last Name First Name Middle Name Perm 1D suix Grade Genger [
Zor-El Kara 874087 12 | [Female | - | SeMedue
 Fiter @ Select the terms to schedule
Schedule Status ; =
I = 2 (rer [Term To Scneaule | Current Term Forwara |
© QuickAdd
@ Drop and Enter date for class changes sy Group
Drop Date Enter Date -

04/12/2020 & 04/13/2020 &

Lock all courses | |Un-Lock all courses| | Delete Non-Scheduled Course Requesi(s)

© Graduation Requirement Options

@ Course Request | Chooser

Course Preferred Term mee-md | ARG Pre-Req Not
info V| Locked T — - or o Y e Prescheduled Section V| Gomment T

Not Scheduled
ﬂn P =] ARS6 Int Jewelry g & & =] & X
n“ P =] NC501 Study Hall - - g & $ a8 LERR
[
n“ P i s857 Prin&prac Econ - - g & & =] 0665 - Prin&prac Econ | g 3¢

Walk In Schedule Screen, Request Tab

5. Select the Analysis and Schedule tabs to view scheduling results.
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Quick Placement

The Quick Placement tab offers a simplified version of the walk in scheduling process. The
Manually Schedule Student section offers a visual representation of a student’s schedule and

course requests.

¥ Walk In Schedule «celEe
Menu~ || € | Q | » | & | «Save  *Undo  PprintSchedule | << MotScheduled = Not Scheduled >> @@gzE®a A

Student Name: Abbott, Billy C. School: Hope High School Status: Active Room Name:

Quick Placement Request Analysis Schedule
Last Name First Name Middle Name  Suffix ~ Perm ID Grade
- Schedule
Abbott Billy c 905483 12 -

@ Manually Schedule Student

section | Mesting
vermcodel oy | o | 1 | 2 | 5 s | 5 | & | 7 [s]s]
[v]
|

] |
ADEEW as33 AR3Z EnosiC
spring M a a 000000123 @ 1207 1504 a Nﬁ:TK a a
Arthur A, A Mhs Rotc, M. Schubert, T ;
+q 1 a1 a 4 a
o s £
ADBEW 4533 ARaz Enosic
2 000000123 @ 1207 1504 a 557 @ a
Arthur A, A Jhs Rote, M. Schubert, T LIl
19 1 & E-% 4 a

-
)
o

3 w Q a4 Q Y a4 Y Y Q@

.. R a a a Q a Q Q a (8|9

AD8BW - Academic Decath s2 MT s

Arthur A, A

4
7 YR MT 78
Canaday C., C.
15
Walk In Schedule Screen

The Legend displays information on the colors shown for each class displayed in the section.

Legend
H Current scheduled class
- Course scheduled, class has open seats
.— Course not scheduled, class has open seats
D- Course scheduled, class has no open seats
.- Course not scheduled, class has no open seats
Course Tifle in italics also indicates course is scheduled
* = Course multiple sections for the given time period

Walk In Schedule, Quick Placement Legend
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Scroll to the Display Preferences section to customize the information displayed in the graph.

« Selectthe Show Info option.

« In Cell-Displays selected information directly on the graph.
« Mouse Over— Displays information when hovering over the section item.
« None —Displays no information. Overrides any additional viewing options.

« Selectthe Sort/Group By option.

« Select Show Multiclass Indicator to choose from multiple sections for the selected course

and period if more than one section exists.

- - uE O =
Y@l FET61 - Weight Trn Boys s1 Section: 0831 ction: 0962 -
Max/Open: 36/3 Section: 0963 Max/Open: 36/11
Max/Open: 36/11 B
Section: 0933 Max/Open: 36/10
] ]
Walk In Schedule Screen

« Select any additional data to display for each section.

@ Display Preferences

Isnow Info | In Cell -
[C] Show Class Max Size
[C] Show Totals By Gender
Show Open Seats
[C] Show Room
Show Section ID
Show Teacher
[C] Show Labels
[C] Show Multiclass Indicator

Term and Period | ~ Sort/Group byl

Show Schedule Summary by Term

[T Hide Course Request Details

Walk In Schedule Screen
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The Quick Placement tab has Show Schedule Summary by Term enabled by default. The
Schedule Summary adds rows for each term and meeting day. It also displays currently scheduled
classes.

a If Show Schedule Summary by Term is disabled, you can only select
course requests that display in the section.

1. Navigate to Synergy SIS > Mass Scheduling > Walk In Schedule or Synergy SIS >
Schedule > Walk In Schedule.

2. Clickthe “* in row corresponding to the Schedule Period column and Meeting Day row to
schedule. The Section Availability screen opens and displays all available sections for that

time.
@ Manually Schedule Student .
D = T
Term Code n—““—“-.-ﬂﬂ
[] []
ADEEW AS33 AR32 =1L
M a a 000000123 g 1207 1504 a 857 a a
Arthur A, A, Mhs Rote, M. Schubert, T. LR
1q 1a 1 a “*Q
i (7 i o
e ENOBIC
T a a 000000123 @ 1207 1504 a A a
Arthur A, A Mhs Rotc, M. Schubert, T. ST
19 1a ERY - Q
w a a a a a a a qa 89
R a a a a a a a a 9|8
F a a a a a a a a (%%
Walk In Schedule Screen

3. Select Show only classes with open seats or Show only classes for requested
courses to narrow results.

4. Click Add next to the section to add.

Section Availability

Available Sections

I Show only classes with open seats Show only classes for requested courses I

@ Available Sections

mmﬁ S -ntle = Eﬁm.

- 0004 SC422  Life Science  Toffi, Robert
. Add 0029 14 Robotics Tech 0 30 30 YR
_ﬂ Add 0098 SAB4  StAssistMedia Media Genter, Media Center0 1 1 52

Section Availability Screen
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5. Select the class inside the section to enroll the student.

Schedule and Course Guide
Chapter 10: Finalizing the Schedule

[ [ |
I

n AR54 -
EN46 -
H ENGO -
FS77 -

6. Click Save.

oL DL oy o0 oL
/] /] (/] /] (/]
F MA302 < EN46 @ PAS6 @ PE7T62 @ FST7 A
32 32 30 36 32
Beg Jewelry s2 Spring M-WT-RF
26 26 26
Prin Eng il s2 Spring M-WT-RF
32 28 28 28
Eng (brit) Lit 52 Spring M-WT-RF
= Fl
Prin&prac Econ 52 Spring M-WT-RF ’
32 32
= - = - =
MA302 - Geometry s2 Spring M-WT-RF 4
32 34 32 32 32
H NCS52 - Rt 5th Per s2 Spring M-WT-RF
NC962 - Rt 6th Per 52 Spring M-WT-RF
| I Fl
Walk In Schedule Screen
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Configuring Schedule Based FTE

Schedule Based FTE is a calculation method used that determines the FTE for a student by
analyzing their schedule. There are two screens in Synergy SIS that allow you to define the rules
used for each grade of student. Also, there is a tab that displays the classes used in the calculation.

Schedule Based FTE is disabled by default. You can enable it for any or all grades in the Schedule
Based FTE Setup — District screen and/or modify it individually for a grade level on a per school
basis in the Schedule Based FTE Setup — School screen.

District Setup Option

1. Navigate to Synergy SIS > System > Setup > Schedule Based FTE Setup - District.
2. Selectan option in Exclude Passing Minutes in Schedule Based FTE.

o Yes—Excludes passing minutes from the FTE calculation.

« Noor blank — Includes passing minutes in the FTE calculation.
3. Enterthe Minimum Hours For Course to count in Schedule Based FTE. This field

refers to the total hours for a course for a school year. For example, a typical class meets for
120 hours per year.

é )
The District FTE Thresholds section allows you to overwrite the default
FTE. By default, Synergy SIS calculates and submits FTE as s (i.e. 0.27).

If you add a single line to the District FTE Thresholds section, you must

E define all FTE thresholds for the district. For example, if you only add a
single line with Max FTE set to 0.50, then students receive 0 FTE if they
do not meet the threshold, 0.50 if they meet the threshold, and no student
canearn 1.00 FTE.
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Schedule Based FTE Setup - District  cree

Menu~ | o | ¢ Save | *Undo

@ FTE Options
Exclude Passing Minutes in Schedule Based FTE Minimum Hours For Course to count in Schedule Based FTE

@ District FTE Thresholds + Add .
| % Juel | rEmewd | | wmrE_
“- If Calculated FTE is greater than or equal to 1.00 then final FTE is 1.00
If Calculated FTE is greater than or equal to 0.75 then final FTE is 0.75
If Calculated FTE is greater than or equal to 0.50 then final FTE is 0.50
then final FTE is 0.25

If Calculated FTE is greater than or equal to 0.01

@ Grade Grid Abbreviations

Include SR - FTE Calculations will include sections that are marked as 'Exclude From State Reporting'

Include ATT - FTE Calculations will include sections that are marked as 'Exclude From Attendance”

® FTE Hours By Grade

Hw R Luglc o

Grade PS is using Enroliment Activities to calculate FTE.

PS

Grade K is using Enrollment Activities to calculate FTE.

! Grade 01 is using Enroliment Activities to calculate FTE.
01 O

Schedule Based FTE Setup — District Screen

Example

Below is a setup for quarter FTE thresholds:

Schedule Based FTE Setup - District «ccee

Menu~ | o | Save | *Undo

@ FTE Options
Exclude Passing Minutes in Schedule Based FTE Minimum Hours For Course to count in Schedule Based FTE

@ District FTE Thresholds

If Calculated FTE is greater than or equal to then final FTE is

If Calculated FTE is greater than or equal to 0.75 then final FTE is 0.75
If Calculated FTE is greater than or equal to 0.50 then final FTE is 0.50
If Calculated FTE is greater than or equal to 0.01 then final FTE is 0.25

Schedule Based FTE Setup — District Screen

Students must reach the appropriate threshold to qualify for the
corresponding FTE. For example, If a student has 0.48 FTE, they
submit as 0.25 because they did not meet the threshold of 0.50.
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8. Determine which of the three methods to use to calculate a student’s FTE in the FTE Hours
By Grade section. The FTE Hours By Grade section automatically displays all grades in the
district and the method used to calculate the FTE for the grade.

@ FTE Hours By Grade

HH% L Log'c S

Grade is using Enroliment Activities to calculate FTE.

Grade is using Enrollment Activities to calculate FTE.

Grade is using Enrollment Activities to calculate FTE.

Schedule Based FTE Setup — District Screen

Method 1 — The default method of determining FTE uses the value stored in Enrollment
Activities and displayed on the Student screen. The Setup Description column of the
FTE Hours By Grade section displays Grade XX is using Enrollment Activities to
calculate FTE. for each grade using the default method.

Method 2 — Enter a value in the Minimum Hours for Full FTE field for a grade to
enable Schedule Based FTE for the grade. The Setup Description column of the FTE
Hours By Grade section displays Grade XX is using NNN total hours annually to
calculate Full Time FTE. where NNN is the number of hours entered in the Minimum
Hours for Full FTE field. Then, Synergy SIS calculates the student’s schedule for the
entire year and submits FTE based on the threshold achieved.

Method 3 — Select Use Elementary Logic for a grade to enable Elementary Schedule
Based FTE for the grade. The Setup Description column of the FTE Hours By Grade
section displays Grade XX is using Elementary Logic to calculate FTE. Synergy SIS
examines the student’s schedule for the FTE calculation based on the AM PM setting of
their sections. If the student only has a section flagged for AM or PM, they earn 0.5
FTE, but if they have a section marked for Both (or blank) they earn 1 FTE.

9. Define which sections to include in calculations for methods 2 or 3.

Include SR - Includes sections marked as Excluded from State Reporting in the
calculation.

283
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¢ Include ATT-Includes sections marked as Excluded from Attendance in the

calculation.

s

Selecting either option updates the Setup Description.

By default, Synergy SIS does not include sections flagged to
exclude (from either State Reporting or Attendance) in either
FTE calculation method.

Include SR is typically used with Elementary Logic if you
use Homeroom sections to take attendance but Synergy SIS
does not use those sections to report the subjects students
are enrolled in to the state.

Include ATT is typically used in conjunction with the Hours
calculation when students are enrolled in sections where
instruction is provided but attendance is recorded daily, rather
than by period.

J
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School Setup Option

Navigate to Synergy SIS > System > Setup > Schedule Based FTE Setup — School.

2. Enter the Default Period Minutes if your school does not use Bell Schedules to determine
the number of minutes for a period.

If you do not define Bell Schedules and do not populate this field,
Synergy SIS uses a default of 60 minutes per period when
calculating FTE.

3. Usethe FTE Hours By Grade section to override settings from the Schedule Based FTE
Setup - District screen on a per school basis, as needed. To enable or disable FTE calculation
per grade at a given school, select an option in the FTE Logic field.

« The option to Use Elementary Logic is the same as method 3 defined earlier.
« Use Enrollment Activity equates with method 1.
« Use Hours corresponds to method 2.

The School Setup Description field displays the message “This is
defaulting from District Settings.” when there are no overrides
defined and modifies appropriately based on the options selected.

Schedule Based FTE Setup - School 5L e ccee
Menu - | il o Save = Undo

School Year: 2015-2018 Organization Name: Hope High School
Default Period Minutes
I |

® Grade Grid Abbreviations

Include SR - FTE Calculations will include sections that are marked as 'Exclude From State Reporting'.
Include ATT - FTE Calculations will include sections that are marked as 'Exclude From Attendance’.

NOTE: Leave drop downs blank to default back to District settings. Set values to override.

@ FTE Hours By Grade

H District Setup Description FTE Logic School Setup Description
I B

Grade 05 is using Enrollment Activities to This is defaulting from District Settings.
calculate FTE. -

Grade 09 is using Enrollment Activities to This is defaulting from District Settings.
8 po calculate FTE. -
Grade 10 is using Enrollment Activities to This is defaulting from District Settings.
3 41g calculate FTE. -
==

Schedule Based FTE Setup — School Screen
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Viewing a Student's Schedule Based FTE

1. Navigate to Synergy SIS > Schedule > Student Classes.
2. Selectthe Schedule Based FTE tab.

3. Locate the appropriate student.

s ~\
The Schedule Based FTE tab lists the student’s FTE for the
corresponding enrollment segment. When a student has multiple

a segments, the section displays the corresponding FTE for each
segment.

If there are two segments with the same FTE amount, they are

L merged and referred to as mixed.
7

Method 1 — Calculated via Enrollment Activities

7 Student Classes e
Menu v < Q IZ| ol « Save | *Undo

(]
Q
;!0
©

Student Name: Aaron, Susan School: Adams Elementary Status: Active Homeroom: 045A

Current Classes Class Enroliment History Schedule Based FTE
Last Name First Name Middle Name Suffix Perm ID Grade
Aaron Susan 41 K -
Gender
Female |«

@ FTE Segments

Start Date | End Date hool Calculation Method Resolved agalnst the ys In
Range
threshold grid

04/05/2016 | 07/15/2016 K Adams Calculated via 10000
Elementary Enroliment Activities

Student Classes Screen
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— P il
7 Student Classes PE ccshe
Menu~ | € Q| ¥ = ' Save | * Undo ®A
Student Name: Abbott, Billy C. School: Hope High School Status: Active Homeroom: 231
Current Classes Class Enrollment History Schedule Based FTE
Last Name First Name Middle Name Suffix Perm ID Grade
Abbaott Billy G 905483 12 -
Gender
Male -
@ FTE Segments
School | Calculation Hours In Days
Start Date | End Date Name Method CEERTEL s in
EREMEIE Full FTE |Range
threshold grid
Ho High Calculated via
07/14/2015 | 07/15/2016 12 Scﬁol 91 scheduled 1.0000 0.00 1400. 7171 244
Hours
Kennedy Calculated via
08/05/2015 | 07/15/2016 12 High Scheduled 0.2866  0.00 193 673.4 231
School Hours
Student Classes Screen
Method 3 — Calculated via Elementary Logic
= =i
7 Student Classes D@ cecse
menu~ € Q| » _ + Save | *Undo @G RA

Current Classes Class Enroliment History Schedule Based FTE

(@ FTE Segments

Start Date | End Date H Calculation Method
Name

07/14/2015 | 07/15/2016 g4 adams

Calculated via
Elementary  Elementry Logic

Student Name: Aaron, lan School: Adams Elementary Status: Active Homeroom: 0002

Last Name First Name IMiddle Name Suffix Perm ID Grade

Aaron lan 129442 04 -
Gender

Male -

DI
Calculated| Resolved against the Range
FTE threshold grid
1.00 247

1.0000

Student Classes Screen
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4. Click a Start Date or End Date on any line of the FTE Segments section to open the FTE
Segment Detail screen. The detail screen shows how Synergy SIS calculates the FTE

amount.

If Synergy SIS does not include a section in the FTE calculation, an
explanatory message displays in the Exclusion Reason column on

the detail screen.

T FTE Segment Detail

Menu ~ L]

@ student and School Information

Student Formated Name Grade School Name
Abbott, Billy C. 12 ~ | Hope High School

@ FTE Segment Information

07/05/2016 11/25/2016 1.0 0.285 0304 AR32 Beg Photo FTE Segment Section Detail
-07105f2016 11/25/2016 0.8 0.238 0426 EN60 Eng (brit) Lit FTE Segment Section Detail
“0710512[]16 11/25/2016 0.8 0238 0726 SC49 Science 10 FTE Segment Section Detail
-07105f2016 09/20/2016 0.8 0238 0060 EN57C Cc-Am. Lit FTE Segment Section Detail

Start Date End Date Resolved against the threshold grid Calculated FTE Days In Range Hours In Segment
07/05/2016 § 07/05/2016 @ 0.50 0.6559 1 35
@ Classes

Hours Need For Full FTE

5.3

[Line | _EnteroateLeave Date fours FTe Secton D | Gourse v T FTE segment secton oetn

FTE Segment Detail Screen

o Clickthe Hours value or the FTE Segment Section Detail link to open the FTE
Segment Section Detail screen. This screen displays the section's total minutes for the
year and the number of section minutes that apply to the student's FTE.

T FTE Segment Section Detail

Menu ~ L)

@ Section Information

@ Section Schedule Breakdown

B

@ Student Information

Student Name Student Term Code Student Enter Date Student Leave Date
Abbait, Billy C. S1 07/05/2016 @@  11/25/2016 =

@ Student Section Schedule Breakdown

BN
B—1 3 2 60

Course 1D Course Name Section ID Term Days In Term
AR32 Beg Photo 0304 1 36

Calendar Period Rotation

School Calendar Period Rotation Definition

18

18

Hours Schedule

33

| Line | Rotation Code Bell Code Combination Schedule Period(s) | Bell Period(s) | Minutes | Days In Calendar | Total Minutes |
3 3 50 18

| Line |  Rotation Code Bell Code Combination Schedule Period(s) | Bell Period(s) | Minutes | Days In Calendar | Total Minutes |
3 3 50 17

900

1080

850

1080

FTE Segment Section Detail Screen
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« Clickthe Section ID value to open the Section screen.

T Section o

Menu + [ ) « Save * Undo

Section ID: 0304 Course Title: Beg Photo  School Year. 2016-2017

Current Students. Student Enroliment History Meeting Days Additional Staff Staff History

Section ID Course ID Course Title Staff Name Room Name
0304 AR32 | & | Beg Photo| Schubert, Thorne & | | 404 &
@ section Info @ student Seat Totals
Begin Period End Period Term Code [0 Prohibit assigning additional students once the Max is reached,
3 -~ 3 - 51 - regardiess of class size limit rules in School Scheduling Options.
Attendance Option Grading Option Attendance Type Male Female Totals  Max Open Seats
Include in Attendance |~ | Include in Grading | ~ - 8 16 24 28 4

Supplemental Funding Category Max Class Size Override Password
Instructional Minutes Override Section Record Type i —

Total Max Open Seals
Instructional Strategy Insiructional Method Insiructional Content 0 0

Category Code Override
[ Distance Learning [ Independent Study

College Credit
. @ Grade Book Specialist

Online Course Override State Course Override Alternative Learning Override Grade Book Specialist Group Grade Book Main Class

- & = &

Course Quality Points Quality Points Override

@ State Reporting

Serving District Serving School Institution Type Course Excluded From State Reporting

[] special Education

Instructional Unit ID Local Master Schd ID Exclude From State Reporting NCLB Core

Cooperative Learning ~ Cooperative Learning Mins

Defined Class Type Test Window
O

[ Vocational Outside IEP
Course SOL Test Code SOL Test Code Qverride

Section Screen
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o Clickthe Course ID and Title value to open the District Course screen.

T District Course

Menu ~ L] + Save | *yUndo

Course ID: AR32 Course Title: Beg Photo

Alpha Numeric Setting (Default to Alpha)
O
Academic Type
Regular -

@ Scheduling Options

Duplicate Request

Schedule Priority School Name
Elective (Low) - &
Optimum Size Maximum Size
@ Course Restrictions
Gender Grade Low Grade High
- 10 - |12

® Other Information

Old SIS Course ID
AR32 2805

Course Description Year Override
Course ID Course Title
AR32 Beg Photo
@ Course Info
Course Duration Department
$2: Semester 2 - |AR: Art -

Pre/Corequisite

Course Short Title
Beg Photo

College Prep  Credit

O |0.500]

[ Teacher Aide

[ College Approved
[0 Pass/Fail Only

[ Dual Credit

@ status

Year Start

Year End

Category Code Instructional Level NCLB Core

Schools Teaching

Associated Courses Standards Opt In Options.

Mandatory Inactive Always Show In Course History Add

Max Credit

Post Secondary Credit Override Course History Type
| 0500

[] Extended Day

[ Distance Learning Course

[ Online Course

[ Allow School Course Title Override

[ Jobs for American Graduates Program

@ ParentVUE Options

Grade Range Low Grade Range High Schedule Priority

[ Do not show in online course requests (PYUE/SVUE)

(@ Course Subject Areas
Subject Area 1
Fine/Applied Arts
Subject Area 2
Fine/Applied Arts

Merge Course Subject Area 3

~ | | Not a core academic class under NCLB  ~ & 7

Course Fees

Quality Points

e

District Course Screen
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dent's schedule based FTE settings on the Enroliment tab and the
Student screen.

If you make a change from the Student screen and do not enter a date,

A

Synergy SIS resends the schedule based FTE information as if the
change is effective from the enrolilment date. Therefore, enter a date to

limit the information resent.

@ Enroliment Information
SAIS ID Enter Date

@ Enrollment Activity

Last Activity Date  EffectiveDate

i
Grade Previous Grade Exit Code

- -

Instructional Setting

>

v Student
Menu ~ < Q » L] = undo B FNGE X Delete
Student Name: School Homercom:  Teacher:
Demographics Parent/Guardian Other Info Emergency Enroliment Enraliment History Classes Documents Contact Log
Last Name First Name Middle Name  Suffix Perm D State Student Number Grade Gender

Enter Code Leave Date

Register ID Special Enroliment Code Special Program Code Access 504

>

Leave Code ADA/ADM Student CTDS Number DRP Participant

v & - - O

FTE Exclude from Auto-Calc FTE

0

Tuition Payer Cede District Of Residence i

-

Homebound
O

College Enrolled
O

Employed While Enrolled
O

Student Screen, Enroliment Tab

Schedule Verification

The STUB806 — Schedule Verification Extract displays Schedule Based FTE values and details for

students at the school and district level. You configure this report on the Schedule Verification
screen, which displays Schedule Based FTE values and details for students with different filter
options, such as Student, Schedule, and Section.

Navigate to Synergy SIS > Schedule > Schedule Verification.

Number.

Select Filter By to determine how students display: EdFi ID, Perm ID, or State Student

Enter Filter To criteria if selecting a Filter By option. For example, select Perm ID for Filter

By and enter a student Perm ID number. You can enter multiple values separated by commas

or returns.

Select Counselor to limit results based on the student's counselor.
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5. Select the Grade levels to filter results by.

10.

11.

12.

Schedule Verification « ZCe-e
Refresh

@ Options

@ student Filters

Filter By

Filter To

Counselor

Grade
Cos O10 @011 D12
@® Filtering Note

Schedule Verification Screen

Select the FTE value to filter results by.

These values are set up at Synergy SIS > System > Setup >
Schedule Based FTE Setup - District.

Select the Date Range in From and To. This uses the student's FTE value within the selected
range of days.

Select Use Total Student FTE to use the student's District FTE calculation instead of the
calculations used at each individual organization. For example, concurrent students or
students who leave one school and enroll in another within the same district display results for
both schools.

Select Remove FTE Segments with no valid days to remove a student's 0.00 FTE
segment from view if that day is defined as a non-school day on the school calendar. This
function only removes 0.00 FTE segments for invalid school days. It does not remove
students with a 0.00 FTE.

@ Schedule Fitters
FTE

ooo Tozs Toso Ho7s [1.00

From To [ Use Total Student FTE Use Total Student FTE looks at the student's District FTE calculation

|:| Remove FTE Segments with no valid days instead of just the calculations at each individual organization.

Schedule Verification Screen

Select Report To State to limit sections displayed in results based on if the sections report to
the state. The default option is Do not filter, which displays all sections in a student's schedule.

SelectInclude in Attendance to limit sections displayed in results based on if the sections
are included in attendance reporting. The default option is Do not filter, which displays all
sections in a student's schedule.

Select the Condition used tofilter results if entering the Number of Sections: Equal To,
Greater Than, Less Than.
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13. Enter the Number of Sections as a value used to limit output data.

@ section Filters

Report To State Include In Attendance Condition

Number of Sections

@ Filtering Note

Schedule Verification Screen

14. Click Refresh. Students display in the results section if any FTE segment matches the
selected filter criteria.

Schedule Verification « Zre-eo

I Refresh I

@ Options

@ Student Filters

Filter By

Filter To

Counselor

Grade
Dos 010 011 E 12
@ Filtering Note

Schedule Verification Screen

Students 4 Show Detail

Cne | vame  fe Scnool Names Cases |

Abbott, Billy C 0.25,0.75, 1.00 Hope High School View Schedule (1)

Schedule Verification Screen

15. Click Show Detail to view all FTE segments for the student. The Section count displays
which sections are included on the schedule based calculations.

« The following image displays student detail with Use Total Student FTE not selected.

Students I Hide Detail
m @ Schedule Detail

1  Abbott, Billy C.
mnﬁmm
07;04;201? 07/05/2017 Hope High School 0.00 1.00 1.00 Enrollment Activity
0?.'04:201? 07/05/2017 Hope High School 2 0.00 1.00 1.00 0 Enroliment Activity
07;06;2017 07/25/2017 Hope High School 17 0.000.75 0.75 1 Enrollment Activity
nor.’nemﬂ 07/25/2017 Hope High School 17 000075 075 0 Enrollment Activity
07!26!201? 09/29/2017 Hope High School 57 000075 075 1 Enrollment Activity
nomafzuﬂ 09/29/2017 Hope High School 57 0.000.75 0.75 0 Enrollment Activity
09130;201? 10/01/2017 Hope High School 1 0.000.75 0.75 1 Enrollment Activity

Schedule Verification Screen, Students Detail
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« The following image displays student detail with Use Total Student FTE selected.

Students | Wy Hide Detail |

- @ Schedule Detail

1 | Abbott, Billy C.
Valid Calculation
Hne Sartpate| Endbate|  Schoal Name e MEEE LEEE

07.’04!‘201? 07/05/2017 Hope High School 0.001.00 0 Enroliment Activity
-07l06F201 7 07/25/2017 Hope High School 17 0.000.75 0.75 0 Enroliment Activity
UTI26F201 7 09/29/2017 Hope High School a7 000075 075 0 Enroliment Activity
0]’!26!‘2017 009/29/2017 Kennedy High School 55 0.001.00 1.00 0 Enroliment Activity
09}30!2017 10/01/2017 Hope High School 1 000075 0.75 0 Enroliment Activity
EOQJSOI201T 10/01/2017 Kennedy High School 1 0.001.00 1.00 0 Enroliment Activity
10!02,"2017 10/08/2017 Hope High School 6 0.000.75 0.75 0 Enroliment Activity

Schedule Verification Screen, Students Detail

Removing FTE Segments with No Valid Day on the Student
Classes Screen

You can remove an FTE segment with no valid day on the Student Classes screen, the Schedule
Verification screen, and on the STU806 — Schedule Verification report interface screen.

1. Navigate to Synergy SIS > Schedule > Student Classes.
2. Selectthe Schedule Based FTE tab.
3. Locate the student.

This example student has classes on 07/03/2018, which the school
calendar shows as a non-valid day.

7 Student Classes f €[a ] [co]&l-le

Meu- 2| €|y B wsae AU

Student Name: *) Abbott, Billy C. School: Hope High School Status: Active Homeroom: ANHX =] | @m
Current Classes  Class Enrollment History | Schedule Based FTE

Last Hams First Name Middls Nams Suffix Perm D Grads Gendsr  EAFID

Abbott Bily c 905453 12 T

Warnings and Errors| L] Remove FTE Segments with no vaiid days

© StudentFTE
D D
0710372018 0700312018 0.000 Calculated via Scheduled Hours
0710472018 070502019 1000 Calculstad vis Scheduled Hours
@  School FTE
Hours
Start End Hours I Nesd Days
- - Grade [ T School Name T Calculation Type OHISE L 4 vsin -
Date Date Seqment For Full Range
Resolved T
FTE
wRIRNE  10ESE0NE 12 Hops High School Calculsted via Scheduled Hours 21080 87 81
URSRNIE 1025008 12 Kennedy High School Caleulated via Scheduled Hours 25280 100 489 1855 &
WEBRNIE  0UMZ0NE 12 Kennedy High School Calculsted via Scheduled Hours 22310 100 278 245 45

Student Classes Screen, Schedule Based FTE Tab
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4. SelectRemove FTE Segments with no valid days. The segment hides automatically.

A student's 0.00 FTE segment is removed from view if that day is
e defined as a non-school day on the school calendar. This function

only removes 0.00 FTE segments for invalid school days. It does not
remove students witha 0.00 FTE.

7 Student Classes

Menu~ A € Q|3 | B&| wsae S

SIS ARHREECARE

Student Name: ®! Abbott, Billy C. School: Hope High School Status: Active Homeroom: AHNX @HE®*0A
Current Classes  Class Enrollment History | Schedule Based FTE
Last Name First Name Middle Name Suffic Perm D Grade Gender  E4-FID
Abbott Bily 3 905483 12 | [male -
Warnings snd Errers | 2 Remove FTE Segments with no valid days
© StudentFTE
T T T — T v
W 071042018 071052019 1.000

Calculated via Scheduled Hours

@  School FTE

— Hours
i:: T :::: T Grade [ T SchoolName T Calculation Type T ::;:e""" T F:rFuII 4 '::: n -
Raw T| Resoved T =
FTE
w0 4820 287 S

07/03/2018 10/282018 12 Hope High Scheol Calculated via Scheduled Hours 2.1080 1
07/25/2018 10/25/2018 12 Kennedy High School Calculated via Scheduled Hours. 25280 1.00 469 1855 67
10/26i2018 010172019 12 Kennedy High School Calculated via Scheduled Hours 22310 1.00 e 1248 45

Student Classes Screen, Schedule Based FTE Tab
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Reports Overview

Four types of reports display in the PAD tree.

Schedule and Course Guide
Chapter 12: Reports

« Individual — 200-level reports are Individual reports. These print information for a single
student per page and can be printed for multiple students at once.

o List—400-level reports are List reports. These show details for multiple values, such as
students or teachers, on one page.

o Summary —600-level reports are Summary reports. These provide numerical totals for each

category specified.

« Extracts — 800-level reports are Extract reports. These export information from Synergy SIS

into a text file that can be used to import data into another program.

You can also run reports from any Synergy screen that focuses to a student or from Find results at

297

Synergy SIS > Student > Student using the Actions icon. Synergy Actions includes most reports
that have a Student section in the Sort/Output tab. The following example shows the reports
available to run for a student at Synergy SIS > Attendance > Period Attendance.

p— = Y = | g C + %} =
v Period Attendance » AL uEEPLLERGCACREY cocf-e
vew-[2] ¢ a» & V0N
Studentn | T
N .
catenc|B§ Reports @ Processes mary
Last Naml  ATD202: Daily Attendance Minutes Profile Sl & Locker Mass Assignment EdFi D
Abbott ATD403: Daily Absent List =l & Mass Assign Counselor / Administrator -
ATD404: Daily Tardy List £ Mass Assign Course Requests
@ Kenit CNF201: Student Conference Profile A& Mass Assign House And Team
FDP201: Student F rofile % Mass Assign Sections I ) :
-Th _jp U1: Studen _ Prefile . = H g C N s issue, go fo the Term Definition Grid
insc] FDP402 Student Fee Collection List %4 Mass Assign Student Groups
F 3. Student Fee Re Needed List % Mass Assign Track I ) )
-Th _jP.:lO— % udent Fee ﬁ.mm fleeded Lis - i d . s issue, go fo the Term Definition Grid
in Sc FDP405: Fee Code Detail by Payment Method ¥ Mass Change Atiendance Definition
FDP412: Fees Collected Detail £ Mass Email
1272220 lammmein m e e e | lndabn Chidant Manfacnns

@ Period Attendance Calendar

Do Not Show Special Attendance Codes (N/S, N/E, Nil)

Actions |~

Show |10
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The Job Details screen shows the Job Detail and Status during processing. Any processing errors
show in the Status section. When the report completes, the Job Details screen closes and a PDF file
of the report opens.

Job Details:

Job Detail

D 03/30/2017 10:18:35 O5M411 Class List

Status

@, in progress: Loading Data ltem 0
o

Job Details Screen

Reports use the current focus to pull data unless specified otherwise in report options. You can run
report information at the district, organization, or school level. Options selected on the Sort/Output
tab and your organization focus settings determine if inactive students display in reports.

This section covers only the customizations specific to the reports used for
LI} this guide. See the Synergy SIS — Query and Reporting Guide for more
information on additional report options.
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CRS201 - Course Catalog
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Synergy SIS > Course > Reports > Individual

The Course Catalog lists all of the courses offered with their description, ID, credit, and grade level.

Y Report CRS201: Course Catalog

& Print | Save Default Email Me

Name: Course Catalog Number: CRS201 Page Orientation: Portrait

Options Sort / Output Conditions Selection Advanced

@ Course Info

Course |D
Course Title

Department

>

@ Options

[C] Only Show Inactive Courses
[[] Page Break per Department
[7] Include Courses in Focus only
[[] Hide Grades

[[] Hide College Prep

[0 Hide Credit

1 S0

CRS201 - Course Catalog Report Interface Screen

Report Options:

« Course Info —Filter reports by Course ID, Course Title, or Department.

« Options — Select the display options for the report.

« Include Courses in Focus only — Select to only display courses the school opted-in

to.
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e
X

Dame School Distric
Eccehmi i Edusartan

Department: English

Hope High School
Course Catalog

Year:
Report: CRS201

2016-2017

9th Eng-Corr ENDO91C  Cc-Paperbk Lit EN54C
Grades: 09 - 12 College Prep: No Credit- 1.000  Grades: 10 - 12 College Prep: No Credit: 0.500
‘Gth English-Correspondence Corres. Paperback Litersture

9th Eng-Corr EN092C  Cc-Short Storie EN42C
Grades: 09 - 12 College Prep: No Credit- 1.000  Grades: 09 - 12 College Prep: No Credit: 1.000
‘Gth English-Correspondence Short Stores-Comespondence

Aa Am His & Lit EN53W  Col Prep Wrt EN45
Grades: 10 College Prep: No Credit- 1.000 Grades: 12 College Prep: No Credit: 0.500
Aa American History And Lit College-Prep Wiriting

Aa Soph Eng EN35W  Comm Coll En101 EN101
Grades: 10 - 12 College Prep: No Credit- 1.000  Grades: 11 -12 College Prep: No Credit: 0.500
Aa Sophamaore English Cormmunity College Eni101

Advanced Esl EN23 Comm Coll En102 EN102
Grades: 07 - 09 College Prep: No Credit- 1.000  Grades: 11 - 12 College Prep: No Credit: 0.500
Advanced Eng Second Langusge Community College English 102

American Lit EN5T  Cr Think&writ EN41
Grades: 11 -12 College Prep: No Credit:0.500  Grades: 11 - 12 Caollege Prep: No Credit: 0.500
American Litersture Critical Thinking And Witing

App Read lii EN8E  Creative Wrt EN44
Grades: 12 Caollege Prep: No Credit:0.500  Grades: 11 - 12 Callege Prep: No Credit: 0.500
Applied Resding li Crestive Writing

Baseball Lit EN43  Debate ENT4
Grades: 11 -12 College Prep: No Credit:0.500  Grades: 10 - 12 College Prep: No Credit: 0.500
Baseball Litersture Debate

Basic Eng EN19  Debate ENT41
Grades: 09 College Prep: No Credit-0.500  Grades: 10 - 12 College Prep: No Credit: 0.500
Basic English Debate

Beg Ela (eng) EN11-2  Eng (brit) Lit ENGO
Grades: 07 - 09 College Prep: No Credit-0.500  Grades: 11 -12 College Prep: No Credit: 1.000
Beginning Ela {english) Enghish {british) Literature

Beginning Esl EN11  Eng 9 Honors ENO09-H
Grades: 07 - 09 College Prep: No Credit-0.500  Grades: 09 College Prep: No Credit: 1.000
Beginning Esl English 9 - Honars (not Wid)

Beginning Esl EN112  Eng 9th A-Hr END912
Grades: 10 - 12 College Prep: No Credit-1.000  Grades: 09 College Prep: No Credit: 0.500
Beginning Esl English gth

Cc-Am. Lit EN5STC  English 10 PPT0
Grades: 10 - 12 College Prep: No Credit- 1.000  Grades: 10 - 12 College Prep: No Credit: 0.500
Corres American Literature English

Cc-Lit Ex EN51C  English 101 EN91
Grades: 10 - 12 College Prep: No Credit-0.500  Grades: 12 College Prep: No Credit: 0.500
Caorr Literary Explorstion English 101

Cc-POTEI EN33C  English 4th Grade ENGD4
Grades: 10 - 12 College Prep: No Credit-0.500 Grades: K -086 College Prep: No Credit: 1.000
Correspn.-Principles OfEng |

Cc-POfEI EN34C  English 5th Grade ENO5S
Grades: 10 - 12 College Prep: No Credit-0.500 Grades: K -086 College Prep: No Credit: 1.000
Corres. Principles OF Eng li

Cc-POfENI EN46C  English 7 ENOT
Grades: 10 - 12 College Prep: No Credit-0.500  Grades: 07 Caollege Prep: No Credit: 1.000
Ce-Principles Of Engish lii English 7
Printed by Admin User st D4/22/2017 1:47 PM Edupaint School District Page 50 of 185

CRS201 - Course Catalog Report Output
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Synergy SIS > Course > Reports > List

The Course List shows all courses with their ID, Title, and Department. It also indicates if a course is
College Prep, the Credits, Academic Type, and whether the course is Core or Elective.

ik Print | | Save Default

Cptions Sort / Qutput
@® Course Info

Course ID

Course Title

Department

-

@ Options

Course Activeness

-

7 Report CRS401: Course List

Mame: Course List Number: CRS401 Page Qrientation: Landscape

Conditions Selection Advanced

[ Include Courses in Focus only

Email Me

CRS401 - Course List Report Interface Screen

Report Options:

« Course Info —Filter reports by Course ID, Course Title, or Department.
« Course Activeness — Select an option to filter by only active or inactive courses.

« Only Show Active Courses — Select to display only active courses.
« Only Show Inactive Courses — Select to display only inactive courses.

« Include Courses in Focus only — Select to only display courses the school opted-in to.
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\‘j‘r Hope High Scheol Year 20162017
~~ Course List Report: CRS401
Beme, Scheed Bl
College: Max

Course |D Course Title Department Prep Credit  Credit Academic Type Schedule Priority
EN42C Ce-Short Storie English No 1.000 1.000 Regular Core (High)
EN43 Baseball Lit English Mo 0.500 0.500 Regular Caore (High)
EN44 Creative Wrt English Mo 0.500 0.500 Regular Elective (Low)
EN45 Col Prep Wit English Mo 0.500 0.500 Regular Caore (High)
EM46 Prin Eng lii English No 0500 0500 Regular Core (High)
EMN4BC Cc-P OFE i English No 0500 0500 Regular Core (High)
EN4T Soph English English No 0500 0500 Regular Core (High)
EN4T1 Soph Englsem 1 English Mo 0.500 0.500 Regular GCore (High)
EN472 Soph English English Mo 0.500 0.500 Regular Caore (High)
EMN4T3 Soph Eng Block English Mo 0.500 0.500 Regulsr Caore (High)
EMN4T32 Soph Eng Block English No 0.500 0.500 Regular Core (High)
EMN4TE Trans Soph Eng Elementary&Scheol No 0.500 0.500 Regular Core (High)
EN43 Jr English English No 0500 0500 Regular Core (High)
EMN431 Jr English English Mo 0.500 0.500 Regular Core (High)
EN432 Jr English English No 0.500 0.500 Regular Core (High)
EN42 Sr English English Mo 0.500 0.500 Regular Caore (High)
ENSO0 Senior Lit English No 0500 0500 Regulsr Core (High)
ENS1 Lit Explor English No 0500 0500 Regular Core (High)
ENS1C Ce-Lit Ex English No 0500 0500 Regular Core (High)
ENS2 Mythology English No 0500 0500 Regular Core (High)
ENS3 Sei Fiction English Mo 0.500 0.500 Regular GCore (High)
ENS54 Paperback Lit English No 0.500 0.500 Regular Core (High)
=nga Dianckle Lt S, " nEon  nEnn Bosu ik

CRS401- Course List Report Output

Edupoint Proprietary and Confidential




Schedule and Course Guide

CRS601 — Course By School

Chapter 12: Reports

303

Synergy SIS > Course > Reports > Summary

The Course By School is a simplified list of courses sorted by the schools offering each course.

Courses are listed with only their ID and title.

¥ Report CRS601: Course By School

& Print Save Default Email Me

MName: Course By School Number: CRS601 Page Orientation: Landscape
Options Sort / Output Conditions Selection Advanced
@ Filters

[0 Include Courses in Focus only
[C] Page Break per School

CRS601— Course By School Report Interface Screen

Report Options:

« Include Courses in Focus only — Select to only display courses the school opted-in to.

« Page Break per School — Separates schools with a page break

i i
Ay Hope High School Year: 2016-2017
-~ Course By School Report: CRSE01

Bos Sy e

CourseID  Course Title Course ID  Course Title Course ID  Course Title Course ID  Course Title

MUZs Beg Guitar MUZ2S Beg Guitar RD22 Begin Esl-Rdg RD22 Begin Esl-Rdg

ENT1 Beginning Esl ENT1 Beginning Esl SCa31 Biology SC491 Biology

S5C482 Biology SC452 Biology cBD1 Bus/prsnl Finan cBD1 Bus/prsnl Finan

MU18 Cadet Band MU18 Cadet Band MU24 Cadet Orch MU24 Cadet Orch

CA13B Career Aware CA13B Career Aware Muo? Chorale Chair mMuo? Cherale Choir

AS35 Colorgrdidrill AS3S Colorgrd/drill mz2 Commvengr Tech mz Comm/engr Tech

CcB10 Comp Foundation cB10 Comp Foundation cB12 Comp Graphics cB13 Comp Graphics

CB11 Computer Apps cB11 Computer Apps MU20 Concert Band MU20 Concert Band

MU127 Concert Choir MU127 Caoncert Choir MU25 Cencert Orch MU25 Concert Orch

RD18 Corr Read RD13 Comr Read RD18 Com Reading 9 RD19 Com Reading 9

PE23 Dance/gymnastic PE23 Dance/gymnastic MAD3D Domestic Skills MADZD Domestic Skills

CRS601— Course By School Report Output
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Mass Scheduling Reports
STU205 - Student Course Request Profile

Synergy SIS > Mass Scheduling > Reports > Individual

The Student Course Request Profile prints the course request profile of an individual student or
students.

¥ Report STU205: Student Course Request Profile

& Print | Save Default | Reset Default || Email Me

Name: Student Course Request Profile Number: 8TU205 Page Orientation: Portrait
Options Sort / Qutput Conditions Selection Advanced

@® Student Info

Perm 1D Gender
Last Name First Name Middle Name
Grade

- * -

@ Report Options

[C] Hide Alternate Courses [C] Show Course Credit
[T] Hide Alternate Course Requests [T Show Course Term
[C] Show Add/Drop Signature Footer

[C] Only Show Students With Missing Prerequisites

[T Show Prerequisite Violations

@ Extended Student Data Options

[C] Show Extended Student Data
Current Enrollment Year
2013-R -

@ Parent/Guardian Options

Lives With [F] Has Custody
[C] Contact Allowed [ Mailings Allowed
[CJ Ed. Rights

STU205 - Student Course Request Profile Report Interface Screen

Report Options:

« Student Info — Filter report output to include the specified student information.
« Report Options — Select which report options to display or not display.

« Show Add/Drop Signature Footer — Displays an area to describe courses under
Drop or Add and a Parent/Guardian Signature field

« Show Prerequisite Violations — Displays any course requests that are invalid due to
a student requiring a prerequisite course or course group

If you select Show Prerequisite Violations and use Run
Prerequisite Check during the scheduler process, the run
stops if there are any violations and displays this report.
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« Extended Student Data and Parent/Guardian Options — Select Show Extended Student
Data to display mailing addresses and any Parent/Guardian Options selected.

s Hope High School Year 20172018
ol Student Course Request Profile Report: STU205

General Information
Student Name: Perm ID: Gend  Grade: Birth Date:
Abbott, Billy C. 905483 M 12 03/15/2000

Periods to Schedule: Schedule Team: Schedule House:

to A HSA

Course Requests

Pref. Term
Course Alternate Course Teacher Override

Adv Ceramics (AR45)

Adv Jewelry (ARSE)

Am Govt (S851)

Am Govt (S851)

Beg Jewslry (AR54)

Beg Photo (AR32)

Ce-Am. Lit (EN5TC)

Eng (brit) Lit (ENE0)
Independent Study (NC352)
Int Stain Glass (AR42)
Intermediate Acting (PABE)
Life Science (SC422)

Life Science (SC422)

Prin Eng IIl (EN48)
Prin&prac Econ (FS77)
Robotics Tech (IT14)

Rt 6th Per (NC962)
Science 10 (SC49)
Science 10 (SC49)

Stained Glass (AR40)
Prereg Violation: (ARD1-Intro To Ar)

‘Weight Trn Boys (PE7TE1)

‘Weight Trn Boys (PETG1)

‘Weight Trn Boys (PE7TE1)

‘Weight Trn Boys (PETG2) Weight Trn Boys 51
‘Weight Trn Boys (PE7TE2)

‘World His/geog (FFPE3)

0 Aing ‘noqqy

STU205 - Student Course Request Profile Report Output

Copyright 2009-2020 Edupoint Educational Systems, LLC



Schedule and Course Guide

306 Chapter 12: Reports

OSM201 - Student Schedule Analysis

Synergy SIS > Mass Scheduling > Reports > Individual

The Student Schedule Analysis report lists all scheduled and requested classes for the students in
the selected option set. The report also shows any schedule conflicts and the alternate periods
available for each class.

Aindicates the class is available in the period. F indicates the class is full. A number indicates the
period scheduled for the class. The primary course prints in brackets on the same line as the
scheduled course if the scheduled course is an alternate.

v Report OSM201: Student Schedule Analysis

o Print Save Default Email Me

MName: Student Schedule Analysis Number: OSM201 Page Crientation: Portrait
Options Sort / Qutput Conditions Selection Advanced

Option Set

Students To Print

Schedule Conflicts Only -
[] One Student Per Page

[ Include House

[ Include Teacher's Name
Terms to Include O +~ &

U Fall [ Spring

O Indicate Prescheduled

OSM201— Student Schedule Analysis Report Interface Screen

Report Options:

Option Set — Select the option set to include in the report. Only option sets for the year and
school in focus are available.

Students to Print — Select the type of student schedules to include in the report.
One Student Per Page — Prints each student schedule on a separate page
Include House — Includes the student’s house on the report

Include Teacher’s Name — Includes the names of the teachers for each section on the
report

Terms to Include — Includes any course under the specified term. If users select no terms,
the report includes all terms.

Indicate Prescheduled — Adds a column to the output that indicates the courses that were
scheduled prior to running master schedule processes
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i

A)

L~

Demo School District

Student: Acosta, Janet A

Kennedy High School
Student Schedule Analysis
Option Set: Test

Perm ID: 164398

Grade: 11

Year: 2018-2019
Report: OSM201

Gender: Female

Course ID Course Title

eriods ——
123456789 Prd Term SectlD

Mtg Days Hse Staff Name Prescheduled
Fall i
EN11 Beginning Esl 1 F 1 51 0058 ab Gonzalez, Ricardo Y
$s830 Am Hist - Dream F2 F 2 81 0288 ab Casillas, Michael Y
PES55S Aerobics FF3 3 81 0385 ab Myrmel, Kathleen Y
RD22 Begin Esl-Rdg 4 A 4 51 0057 ab Gonzalez, Ricardo Y
MA27 Algebra | F FFSF 5 81 0263 ab Brock, Debby Y
BE39 Bus Cons Law F 6 6 81 1675 ab Jones, Richard Y

OSM201 - Student Schedule Analysis Report Output
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OSM401 — Schedule Section List by Teacher

Synergy SIS > Mass Scheduling > Reports > List

The Schedule Section List by Teacher prints a list of the scheduling sections for each teacher
showing class loads and student totals for each section.

7 Report OSM401: Schedule Section List by Teacher

* Print Save Default Reset Default Email Me

Name: Schedule Section List by Teacher Number- 0SM401 Page Orientation: Portrait
Options Sort / Output Conditions Selection Advanced

Option Set
Demo Run 3 - Load Only -

OSM401— Schedule Section List By Teacher Report Interface Screen

Report Options:

« Option Set — Select the option set to include in the report. Only option sets for the year and
school in focus are available.
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\i kg Hope High School Ve 20112012
- Schedule Section List by Teacher  Report: OSMO1
Excellence in Education Option Set: Run #1

[ Track |
Staff Name Term Per _ SectID Track MigDays CourselD AndTitle  CreditRoom _ Max Total _Left
Becker A, Alison S1 1 0001 ABC SC71 - Chemistry 1.000 104 100 125 -25
Total: 100 125 -25

Tofft, Robert YR 1 0002 ABC SCA22 - Life Science 0.500 120 0 0 D
Toal: 30 0 30

Becker A, Alison S1 2 0003 ABC SC71 - Chemistry 1.000 104 100 125 -25
1 0004 ABC SC71 - Chemistry 1.000 104 100 125 -25

Total: 200 250 -S0

Brown P., Patrica YR 7 0008 ABC SS51C - Co-Govenment  1.000236 50 0 5
Tota: 50 0 50

Diaz, Joe YR 7 0010 ABC FS32C - Cc-PersniDev.  1.000 CNSL 50 0 5
Total: S0 0 0

Baniszewski, Nancy  S1 0 con ABC ENST - American Lit 0.500220 30 0 3D
Total: 30 0 30

Blasdell W., Wendy S1 2 0012 ABC SC70- Cons Chemistry 0.500116 30 0 3
3 0013 ABC SC50 - Env Science 0.500124 30 0 30

4 0014 ABC SC50 - Env Science 0.500124 32 0 3

5 0015 ABC SC50 - Env Science 0.500 124 32 0 R

<] 0016 ABC SCT0 - Cons Chemistry 0500124 30 0 30

Total: 154 0 154

Chaisson P., Paul YR 78 (0018 ABC TI81 - loe Welding 1.000311 15 0 15
Total: 15 0 15

Brown P., Patrica YR 7 0018 ABC S521CC - Co-World Stdy | 1.000236 50 0 5
Tota: 50 0 50

Diaz, Jos YR 7 0020 ABC PEG2C - Co-Bowiing 2 1.000 CNSL 50 0 5
Total: S0 0 50

Brown P_, Patricia S1 5 0021 ABC SS522 - World History/Geog 1.000 236 50 62 -12
Tota: S0 62 -12

Summers, Kim S 0 0022 ABC EN33-PrinEng| 0.500200 28 5 23
Total: 28 5 23

Rebinscn, Robent S 1] 0024 ABC ENS51 - Lit Explor 0.500 P-21 3D 3B B
Total: 30 36 6

“Printed Dy Admin User af 110572011 1.08 FM__ EQUpOINt SChodl Disnctl Page 10074

OSM401— Schedule Section List By Teacher Report Output
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OSM402 - Schedule Section List by Room

Synergy SIS > Mass Scheduling > Reports > List

The Schedule Section List by Room prints a list of the scheduling sections for each room that shows
class loads and student totals for each section.

v Report OSM402: Schedule Section List by Room

o Print Save Default Reset Default Email Me

MName: Schedule Section List by Room Number: O8M402 Page Crientation: Portrait

Options Sort / Qutput Conditions Selection Advanced
Option Set
Demo Run 3 - Load Qnly -

OSM402 - Schedule Section List By Room Report Interface Screen
Report Options:

« Option Set — Select the option set to include in the report. Only option sets for the year and
school in focus are available.

\J‘-— Hope High School Year 2011-2012
L~ Schedule Section List by Room Report: OSM402
Demeo School District Optlon Set Run #1
Esgelignce in Educolion
Term Per Block CrsID  Course Title Sect|D Track Mtig Days  Staff Name Credit F M Max Total
Room: 104 Class Size: 30
51 1 1 SCT Chemistry 0001 ABC Becker A_, Allison 1000 62 63 100 125
125
Room: 120 Class Size: 30
YR 1 1 5C422 Life Science 0002 ABC Tofft, Robert 0500 0 0 30 1]
]
Room: 104 Class Size: 30
51 2 1 SCT1 Chemistry 0003 ABC Becker A, Allison 1.000 55 70 100 125
1 1 5CT Chemistry 0004 ABC Becker A_, Allison 1000 57 68 100 125
250
Room: 236 Class Size:
YR 7 1 SS51C  Cec-Government 0008 ABC Brown P.. Patricia 1000 0 0 50 1]
]
Room: CNSL Class Size:
YR 7 1 FS32C Cc-Persnl Dev. 0010 ABC Diaz, Joe 1000 0 0 50 ]
0
Room: 229 Class Size:
51 0 1 EN5S7  American Lit 0011 ABC Baniszewski, Nancy 0500 0 0 30 1]
0
Room: 116 Class Size: 30
51 2 1 SCT0 Cons Chemistry 0012 ABC Blasdell W., Wendy 0500 0 0 30 o
]

OSM402 — Schedule Section List By Room Report Output
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OSM403 — Schedule Section List by Course

Synergy SIS > Mass Scheduling > Reports > List

7 Report OSM403: Schedule Section List by Course

1

é Print Save Default Reset Default Email Me

Name: Schedule Section List by Course MNumber: OSM403 Page Orientation: Portrait

Options Sort / Output Conditions Selection Advanced
Option Set
Demo Run 3 - Load Only v

OSM403 - Schedule Section List By Course Report Interface Screen

The Schedule Section List by Course prints a list of the scheduling sections for each course showing
class loads and student totals for each section. It displays results by Course ID.

« Option Set — Select the option set to include in the report. Only option sets for the year and

school in focus are available.

Vi .
Y Hope High School Year: 2011-2012
beme School Distric Schedule Section List by Course Report: OSM403
Evcelence fn Educsiion Option Set: Run #1
Term Beg End SectionID Meeting Days Teacher Name Room Credit Max Total
Course ID:  ADBEW Course Title:  Academic Decath
YR 6 6 0736 ABC Canaday C.. Curt 307TA 1.000 40 0
Course Total. 40 0
Course ID:  AG29 Course Titke:  Expl Agric
YR 1 1 0088 ABC Sargent, Linda MHS 1.000 10 V]
Course Total: 10
Course ID:  AGH Course Title:  Animal Science
YR 1 1 0101 ABC Wiojcik, James AG1 1.000 30 1
Course Total: 30 1
Course ID:  AGS51 Course Title:  Landscape D&m |
YR 2 2 0201 ABC Wojcik, James AG1 1.000 28 0
Course Total: 28 0
Course ID: AR32 Course Title:  Beg Photo
51 1 1 0104 ABC Schuber, Thome 404 0.500 28 0
3 3 0304 ABC Schubert, Thorme 404 0.500 28 o
4 4 0404 ABC Schubert, Thorme 404 0.500 28 1
5 5 0504 ABC Schubert, Thome 404 0.500 28 0
6 6 0504 ABC Schubert, Thorme 404 0.500 28 1
52 ] 5 1504 ABC Schubert, Thorne 404 0.500 28 ]
6 6 1604 ABC Schuben, Thorne 404 0.500 28 o
Course Total: 196 2
Course ID:  AR33 Course Title:  Int Photo
52 1 1 1104 ABC Schubert, Thome 404 0.500 32 0
3 3 1304 ABC Schubert, Thome 404 0.500 28 0
Course Total: 60 0

OSM403— Schedule Section List By Course Report Output
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OSM404 - Class Analysis by Period and Course

Synergy SIS > Mass Scheduling > Reports > List

The Class Analysis by Period and Course prints a section-by-section analysis of scheduling results
for a particular option set. The report shows actual count results of an option set scheduling run
along with average requests per section.

7 Report OSM404: Class Analysis by Period and Course
é Print Save Default Reset Default Email Me 1

Mame: Class Analysis by Period and Course MNumber: OSM404 Page Orientation: Portrait

Options | Sort/Output  Condiions  Selection  Advanced
Option Set
| Demo Run 3 - Load Only -

OSM404 — Class Analysis By Period And Course Report Interface Screen

Report Options:

« Option Set — Select the option set to include in the report. Only option sets for the year and
school in focus are available.

7 :
\ ‘f Hope High School Year. 2011-2012
o~ Class Analysis by Period and Course Report: OSMA404
Demo School District Option Set: Run #1
freelence " etz Total Total Actual Open Average Requests Per Section

Bog End Term SeciD Track Crs 1D CourseTitle  Mig Days  Staff Name Room _ Soct Roast Sched Seats Totl F M09 10 11 12
] 0 YR 1889 BE91 Dce Sales & Mkt ABC Patenge, Sara 131 2 o a 56 0 ] 0
] 0 YR 1888 BEg$2 Dce Admin Supt ABC Patenge, Sara 131 2 1] a 56 0 ] 0
0 0 YR ®n ENO92C ShEngCom  ABC Nunes, Kathy 23 1 0o o 5 o o o
o ¢ S1 0022 EN33 PrinEng | ABC Summers, Kim 209 <l 89 88 304 2 1 1 M 5 2
0 o s2 122 EN33  PrnEngl ABC Summers, Kim 200 31 s 83 34 2 1 1 MU s 2
0 e s1 0623 EN33 PrinEng | ABC Rex, Karen P22 3 89 88 34 2 1 1 M 5 2
0 e s1 0618 ENS1 Lit Explor ABC Jackson, Michagl P09 14 1011 518 -58 72 34 a7 100 2
0 0 S1 0024 ENS1 Lit Explor ABC Robinson, Robert P21 14 1011 518 58 72 34 ki 100 2
o o s oo ENS7  Amercanli  ABC Baniszowski, Nancy 220 20 0 o0 6w o o o
0 0 S1 0628 ENST American Lit ABC Traylor, Keity 224 21 '] 0 632 0 0 0
o 0 YR 1835 FS594 HeroFacServ  ABC Patenge, Sara 121 2 [} a 28 0 o 0
0 0 YR 1887 Fs9g Hero Hospt Ser  ABC Patenge, Sara 131 2 o 4] 56 ] 0 0
o 0 S1 0975 HE92X  Pcisports Inj ABC Blackburn M., Matt ANNX 1 o [} 15 0 [} 0
0 0 S1 0641 MA30 Geometry ABC Bayer M., Mthelle 102 17 34 34 510 2 1 0 34
0 0 S1 0048 MA30 Geometry ABC Lewis, Jetf P-14 17 34 34 510 2 1 0 34
0 o S1 1048 MA302  Geometry ABC Lewis, Jeff P.14 17 ] o 260 0 0 0
0 0 S1 0047 MALO Algebra Il ABC Kretschmer, James 135 20 76 75 581 3 2 1 22 52 2
0 o 82 1047 MA402  Algebra Il ABC Kretschmor, James 135 20 '] 0 B840 0 0 0
0 0 s1 oes MA#2  Trgonometry  ABC Topoozian, Nancy 126 14 1011 518 %6 72 M %7 10 2
0 ¢ S1 0144 MAL2 Trigonometry ABC Haws, Kayle P01 14 1011 518 -88 7 34 37 100 2
] 0 51 0044 MA42 Trigonometry ABC Haws, Kayle P01 14 1011 518 98 72 34 37 100 2
0 0 S1 0649 MA42 Trigonometry ABC Nebelung. Michele 108 14 1011 518 .88 72 34 a7 100 2

OSM404 — Class Analysis By Period And Course Report Output
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OSM405 — Schedule Section List

Synergy SIS > Mass Scheduling > Reports > List

The Schedule Section List prints a scheduling section list from a particular option set. It displays

results by Course ID.

Save Default

v Report OSM405: Schedule Section List

& print

Name: Schedule Section List Number- OSM405 Page Orientation: Portrait

Reset Default Email Me

Options ~ Sort/Output  Conditons  Selection  Advanced
Option Set
| Demo Run 3 - Load Only -

OSM405— Schedule Section List Report Interface Screen

Report Options:

« Option Set — Select the option set to include in the report. Only option sets for the year and

school in focus are available.

i ’
WX Hope High School Year 2011-2012
Derme Schoel Bisirict Schedule Section List Report: OSM405
et Option Set: Run #1
Section|D Beg End Term Moeting Days Course ID  Course Title Teacher Name Room Crodit Max Open Total
0001 1 1 S1  ABC SCT1 Chemistry Becker A, Allison 104 1000 100 -25 125
0002 1 1 YR ABC SC422 Life Science Tofft, Robert 120 0500 30 30 0
0003 2 2 S1 ABC SCT1 Chemistry Becker A, Alison 104 1000 100 -25 125
0004 1 1 St ABC SC71 Chemistry Becker A, Allison 104 1.000 100 -25 125
0008 7 7 YR ABC S851C Ce-Government Brown P., Patricia 236 1000 50 50 (1]
0010 7 7 YR ABC FS32C Cc-Persnl Dev. Diaz, Joe CNSL 1000 50 50 0
0011 0 0 S1 ABC EN5T American Lit Baniszewski, Nancy 229 0500 30 30 0
0012 2 2 S1 ABC SC70 Cons Chemistry Blasdell W., Wendy 116 0500 30 30 0
0013 3 3 Ss1 ABC SC50 Env Science Blasdell W., Wendy 124 0500 30 30 O
0014 4 4 s1 ABC SCs0 Env Science Blasdell W., Wendy 124 0.500 32 32 0
0015 5 5 S1  ABC SC50 Env Science Blasdell W, Wendy 124 0500 32 32 0
0018 6 6 $1 ABC SC70 Cons Chemistry Blasdell W., Wendy 124 0500 30 30 0
0018 7 8 YR ABC Tig1 Ice Welding Chaisson P., Paul 311 1000 15 15 0
0019 7 7 YR ABC ss21cC Ce-World Stdy | Brown P., Patricia 236 1000 50 50 O
0020 7 7 YR ABC PE92C Cc-Bowling 2 Diaz, Joe CNSL 1000 &0 50 1]
0021 5 5 S1  ABC 5822 World History/Geagraphy Brown P., Patricia 236 1000 50 -12 82
0022 0 0 S1 ABC EN33 PrinEng | Summers, Kim 209 0500 28 22 6
0024 0 0 St ABC ENS1 Lit Explor Robinson, Robert  P-21 0500 30 737
0025 7 7 YR ABC SS51C Ce-Govemment Garland, Gregg P-08 1000 50 50 O
0026 7 7 YR ABC S857C Economics Garland, Gregg P-06 1000 50 50 0

OSM405 — Schedule Section List Report Output
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OSM406 — Schedule Open Periods

Synergy SIS > Mass Scheduling > Reports > List

The Schedule Open Periods displays any periods not scheduled for a student in the selected option
set by period number. All students display in alphabetical order by last name. If a period displays a

plus sign (+), a scheduled class exists for the student.

v Report OSM406: Schedule Open Periods

o Print Save Default Email Me

Name: Schedule Open Periods Number: OSM408 Page Orientation: Portrait
Options Sort / Output Conditions Selection Advanced
@ Option Set

Option Set

-

Optionally limit data by selecting specific Grades and/or Terms

GradeQ <~ & TermQ <+ &
[Co7 [Eos[Ho9 [[10 [E11 E112 [ Fall (£ Spring

@ Meeting Days
Meeting Days O < &
OA@B

@ Period Range

Start End
0 9

OSM406 — Schedule Open Periods Report Interface Screen

Report Options:

« Option Set — Select the option set to include in the report. Only option sets for the year and

school in focus are available.

« Grade — Select the grade to include in the report. To select or clear all grades, use O

« Term —Select the term to include in the report. To select or clear all terms, use 0O-@ .
« Meeting Days — Select the meeting days to include in the report. To select or clear all

meeting days, use 0O+“~@® .
« Period Range — Select the periods to include in the report.
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PR

Dema Schosl Distriet

Hope High School
Schedule Open Periods

Year: 2016-2017
Report: 0SM406

Option Set: Mass Scheduling Trial Run #1 for Periods 0-9

Spring
Day M Day W Day F
Student Perm ID Gen Grd 012345678901234567890123456789
Allen, Jeremy 3. 879216 M 10 012345678901234567890123456789
Allen, Judith D. 903040 F 10 D012345678901234567890123456789
Allen, Karen 873936 F 12 0123456780901234567890123456789
Allen, Karen 891989 F 11 0123456780901234567890123456789
Allen, Karen T. 871328 F 12 012345678901234567890123456789
Allen, Ruby D. 883116 F 11 012345678001234567890123456789
Allen, Sandra E 901631 F 10 012345678901234567890123456789
Allen, Shawn C. 877993 M 12 0123456780901234567890123456789
Allen, Tammy 901831 F 10 012345678901234567890123456789
Allinder, Benjamin R. 887820 M 11 012345678901234567890123456789
Allison, Kenneth B. 992737 M " 0123456780901234567890123456789
Allison, Pamela D. 992672 F 12 012345678901234567890123456789
Allred, David A. 888126 M 11 012345678901234567890123456789
Alnas, Kelly M_ 966707 F 11 012345678901234567890123456789
Alonso, Raymond G. 920153 M " 0123456780901234567890123456789
Alpin, Steven J. 874439 M 12 012345678901234567890123456789
Alston, Douglas G. 901639 M 10 012345678901234567890123456789
Alvis, Jeremy T. 981303 M 11 012345678901234567890123456789
Alwine, Roy M 877316 M 12 0123456780901234567890123456789
Amann, Walter A 889325 M 11 012345678001234567890123456789
Ament, Alice J. 886362 F 11 012345678901234567890123456789
Amiri, Margaret M. 371884 F 12 012345678901234567890123456789
Amos, Billy B 965573 M 10 0123456780901234567890123456789

OSM406 — Schedule Open Periods Report Output
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OSM407 — Course Request Conflict Listing

Synergy SIS > Mass Scheduling > Reports > List

The Course Request Conflict Listing prints all conflicts for each course with student requests.

7 Report OSM407: Course Request Conflict Listing <« <c @@

o Print | Save Default Reset Default Email Me

Name: Course Request Conflict Listing Number OSM407 Page Qrientation: Portrait
Options Sort / Output Conditions Selection Advanced

@ Course Filtering Options

Option Set

Show courses with no more than the following number of sections

Show courses with at least the following number of sections

@ Display Options

Show Course Titles
[C] sort Courses Vertically

OSM407 — Schedule Open Periods Report Interface Screen

Report Options:

Option Set — Select the option set to include in the report. Only option sets for the year and

school in focus are available.

Show courses with no more than the following number of sections — Limits the
courses displayed

Show courses with at least the following number of sections — Limits the courses
displayed

Show Course Titles — Shows course names along with course identifiers
Sort Courses Vertically — Displays the courses vertically across the page
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,j S .
WX Hope High Sc:ool Vear 20112012
Ci C ict Listi :
Do School District ourse Request Conflict Listing Report: OSM407
Escellence in Educolion
[ Course ID: AG3 Course Title: Animal Science Total: 1 ]
CrsiD  Title Total CrsiD Title Tatal CrsiD Title Total CrsiD  Title Total CrsiD  Title Total
ARSS  Adv Jewelry 1 MA4SW Pre-Calculus 1 PP022 Literature 1 PPO2A Prin Of Eng 1 PPO7  American Govi 1
PP70 Sr. English 1 sCT1 Chemistry 1 sca1 Physics 1 S857 Prin&prac Econ 1 WL21 Spanish | 1
[ Course ID:” AR33 Course Title: Int Photo Total: 1]
CrsiD  Title Total  Crsip  Title Total  Crsib  Title Total  CrsiD  Title Total  CrsiD  Title Total
AR43  Int Ceramics 1 ARE3  Beg Drawing 1 EN33  PrinEng | 1 EN34  PrinEng Il 1 ENS1  Lit Explor 1
MA40  Algebra Il 1 MA4z  Trigonometry 1 PPT0  Sr.English 1 SCa2  Life Science 1 SC7T1  Chemistry 1
§S22 WordHistory/Geo 1 SS51  Am Govt 123 1 W31 Gemmanl 1
| Course ID: AR43 Course Title: Int Ceramics Total: 1|
CrsiD  Title Total  CrsiD  Title Total  CrsiD  Title Total  CrsiD  Title Total  CrsiD  Title Total
AR33  IntPhoto 1 ARE3  Beg Drawing 1 EN33  PrinEng| 1 EN34  PrinEngll 1 ENS1 Lt Explor 1
MA40  Algebra Il 1 MA42z  Trigonometry 1 PP70  Sr.English 1 §C42  Life Science 1 SC71  Chemistry 1
§S22  World History/Geo 1 SS51  Am Gowt 123 1 W31 Gemmanl 1
| Course ID: ARS54 Course Title: Beg Jewelry Total 2]
CrsiD  Title Total  CrsiD  Title Total  CrsiD  Title Total  CrsiD  Title Total  CrsiD  Titie Total
EMNDZ1C 9th Eng-Corr 1 EN34  PrinEng i 1 EN40  Shakespeare 1 ENS1  Lit Explor 1 MA4D  Algebra Il 1
MA42  Trigonometry 1 PPO0  Functional Math 1 SCa9  Biology 1 SC7T1  Chemistry 1 8521 Wond Histig 1
§S22 WordHistory/Geo 1 WL31 _ German | 1

OSM407 — Course Request Confiict Listing Report Output
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OSM408 — Class Analysis by Course and Section

Synergy SIS > Mass Scheduling > Reports > List

The Class Analysis by Course and Section lists each course and shows the sections scheduled for
the course. For each section and course, the report lists the number of students scheduled both

overall and by gender, the total number of spaces available, the number of requests, and the
average number of students scheduled in a section.

v Report OSM408: Class Analysis by Course and Section

o Print Save Default Reset Default Email Me !

Name: Class Analysis by Course and Section Number: OSM408 Page Orientation: Portrait
Options Sort / Output Conditions Selection Advanced

Cption Set

-

[C] show only courses that have more requests than availability

[C] Show House

OSM408— Class Analysis By Course And Section Report Interface Screen

Report Options:

« Option Set — Select the option set to include in the report. Only option sets for the year and

school in focus are available.

« Show only courses that have more requests than availability — Only displays courses

with more student requests than seats/sections available

o Show House — Displays any house assignments
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Hope High School

\ 11 F . Year: 2012-2013
I~ Class Analysis By Course and Section Report: 0SM403
Demo School Disirict
weelience In Educolion . Restmigions

Courze D Course Title Section ID  Treck Beg End Term MigDays  Teacher Neme Room Gen  Low HighTesm Max Boys Girls osen TotDavizion

ADBBN  AcademicDecath 000
Available: 0 Scheduled: 0 Avg: 0.00
Reguest: 29 Rejected: - MAD.: U.OU—‘

AGZ9 Expl Agric 000
Awailsble: 0 Scheduled 0 Avg: 0.00
Requests: 1 Rejected: 1 MAD.: 0.00 ‘

A Animal Sci 000
Auailable 0 Scheduled: i) Avg 0.00
Requests: 30 Rejectsd: I/ MAD: 0.00 I

AGE1 Landscape D&ml 000
Available: 0 Scheduled: 0 Avg: 0.00
Request: 2 Rejected: 2 MAD.: 0.00 ‘

AR32 Beg Photo 000
Available: 0 Scheduled: 0 Avg: 0.00
Requests: 138 Rejected: 135 MAD: um—‘

AR33 Int Photo 000
Available: 0 Scheduled: Q Avg: 0.00
Requests: 47 Rejected: 47 MAD: u.ou—‘

AR34 Adv Photo 000
Awailable: 0 Scheduled: 0 Avg: 0.00
Requests: 11 Rejected: 1M1 MAD: 0.00 ‘

ARD Stained Glass 000
Available: 0 Scheduled: 0 Avg: 0.00
Requests: 171 Rejected: 171 MAD: 0.00 I

AR41 Beg Caramics 0.00
Available: 0 Scheduled: Q Avg: 0.00
Requests: 175 Rejected: 176 MAD: 0.00 ‘

AR4Z Int Stain Glass 000
Auailsble: 0 Scheduled: 0 Avg: 0.00
Requests: 59 Rejected: B MAD: 0.00 ‘

OSM408— Class Analysis By Course And Section Report Output
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OSM409 - Student Course Request Verification Listing

Synergy SIS > Mass Scheduling > Reports > List

The Student Course Request Verification Listing prints a list of course requests by student.

& pPrint | Save Default Reset Default Email Me ‘

Optic-ns Sort/ Output Conditions Selection Advanced
@ Filter Options

Course ID
Grade D ~+ &

Eog E10 E 11 B 12

Report OSM409: Student Course Request Verification Listing

Name: Student Course Request Verification Listing MNumber: OSM4098 Page Crientation: Portrait

OSM409 — Student Course Request Verification Listing Report Interface Screen

Report Options:
, , -
o Grade — Select the grades to include in the report. To select or clear all, use O ©.
« Course ID - Filter the report to include students in the selected course.
I .
X Hope High School Year. 2011-2012
Student Course Request Verification Listing Report: OSM409
Do e n ehan !

Course 1D Course Title Course ID Course Title Course D Course Title Course |0 Course Title Course 1D Course Title
[ Student.Acevedo, Andrew Perm ID: 886630 Grd: 12 Gen: Male Team: Eng1/2
MASSW  Pre-Calculus PPO2Z  Literature PPOT American Govt PP70 Sr. English scat Physics
wL21 Spanish |
| Student: Acosta, John A. Perm 1D: 150265 Grd. 12 Gen: Male Team: Eng1/2
MASW  Pre-Calculus PPOZ2 Literature PPO7 American Govt PPT0 Sr. English SC81 Physics.
w2t Spanish |
| Student: Adalr, Alan W. Perm ID: 871626 Grd: 12 Gen: Male Team: Eng1/2
MA4SW  Pre-Caleulus PPO22 Literature PPOT American Govt PPTO Sr. English SC81 Physics
w21 Spanish |
I Student: Adair, Timothy S. Perm ID: 888621 Grd: 12 Gen: Male Team: Eng1/2
MA4SW  Pre-Calculus PPOZ2  Lterature PPO7  Amercan Gowt PP70 S1. English SC81 Physics
wL21 Spanish |
l Student: Adams, Larry A. Perm 1D: 889314 Grd: 12 Gen: Male Team: Eng1/2
MAJSW  Pre-Calculus PPO22 Litecatute PPOT Amencan Govt FPT70 Sr. English SC81 FPhysics
wL21 Spanish |
| Student: Adams, Martin C. Perm ID: 887623 Grd:12  Gen: Male Team: Eng1/2
MA4SW  Pre-Calculus PPO22 Literatute PPOT Amencan Govt PPT0 Sr. English SC81 Physics.
w21 Spanish |
I Student: Aguilar, Stephen A. Perm ID: 108367 Grd: 12 Gen: Male Team: Eng1/2
MA4SW  Pre-Calculus PPO22 Literature PPOT American Govt PPT0 $r. English sCe1 Physics
w21 Spanish |
l Student: Aguirre, Mary R. Perm ID: 952375 Grd: 12 Gen: Female Team: Eng1/2
MASW  Pre-Calculus PPOZ2 Literature PPOT Amerncan Govt FPTO $r. English SCe1 Physics
wizi Spanish |
[ Student. Ahlstrom, Jack M. Perm ID: 888112 Grg:12  Gen: Male Team: Eng1/2
MASSW  Pre-Calculus PPO22  Literature PPOT American Govt PPT0 Sr. English scat Physics
w2t Spanish |
[ Student: Akagawa, Adam H. Perm ID: 165923 Grd: 12 Gen: Male Team: Eng1/2
MA4SW  Pre-Calculus PPO22 Literature PPO7 Amerncan Govt PP70 Sr. English SCe1 Physics.
w21 Spanish |
l Student: Ake, Joshua J. Perm ID: 889794 Grd: 12 Gen: Male Team: Eng1/2
MASSW  Pre-Calculus PPO22  Literature PPOT American Govt PPTO Sr. English sc81 Physics
w21 Spanish |

OSM409 — Student Course Request Verification Listing Report Output
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OSM411 - Class List

Synergy SIS > Mass Scheduling > Reports > List
The Class List produces a class list by section ID for a particular option set. The report includes
section data and student names. You can also display student demographic information.
Y Report OSM411: Class List

& Print Save Default Email Me

Name' Class List Number OSM411 Page Orientation” Portrait

Options Sort / Output Conditions Selection Advanced
@ Report Options
Option Set

Term Code

Class ID

Grade  Grade
- - =

Teacher

Hide Totals

Note: If an option is selected from the additional sort options, the sorting options selected on the "Sort/Output” tab will no longer take effect

® Meeting Days Sart Options
Meeting Days O ~ & Period, Term, Teacher Name | =
allb

@ Include the following fields

NOTE: If width text box is empty, default values are used.

Perm ID 0.75 width in inches
State ID 0.75 width in inches
Gender 0.30 width in inches
Grade 0.30 width in inches
Ethnic Code 0.80 width in inches
Birth Date 0.68 width in inches
Home Language 1.00 width in inches
Phone Number 0.88 width in inches

OSM411— Class List Report Interface Screen
Report Options:
« Option Set — Select the option set to include in the report. Only option sets for the year and
school in focus are available.
« Term Code — Filter report output for a specific term.

« Class ID —Filter report output for a specific section number or range of section numbers.
» Grade — Filter report output to include just the selected grade or grade range.
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« Teacher —Filter report output to include just the selected teacher.

« Hide Totals — Report may be produced without student totals

« Sort Options — Select the order the report displays. For example, Meeting Days, Period,

Term.

« Meeting Days — Select the meeting days to display as needed.

« Include the following fields — Select which fields to display. If Width in inches is left blank, the

system uses default spacing.

Andazola, Kathleen E.
Bettencourt, Brian J.
Brenner, Carol L
Carroll, Joseph R.
Davis, Jack L.

Davis, Jennifer M.
Donaldson, Howard A.
Downey, Howard M.
Enos, James W. Il
Famnswarth, Jerry A. JR
Friese, Lawrence J.
Funk, Jane L.

Giles, Mary N.
Gordon, Gary M.
Hawes, Craig D.
Hoffmann, Pamela A.
Holbrook, Stephanie
Jamison, John A,
Keller, Julie A.
Manoff, Lisa 5.
Martinez, Fred A,
Martinez, Heather M.
Mayes, Amanda
McMillan, Brenda
Mott, Edward A.
Paterson, Martha E.
Perkinson, Angela
Ray, Gloria M.

Reed, Amy A.

Riggs, Randy L.
Sargent, Susan M.
Schumacher, Richard P.
Steele, Kimberly L.
Stocker, Ann M.
Waits, Helen .
Wilson, Julia K.
Wilson, Kevin D. JR

Total Students:

i
PR Hope High School Year: 2011-2012
Demo Schaol Distric Class List Report: OSM411
Class ID Period Course ID Course Title Mig Days Teacher Room Name
0630 1 ENS1 Lit Explor ABC Wallace, Judy 303
Student

37 Total Female: 21

Total Male: 16

OSM411— Class List Report Output
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OSM414 — Master Schedule by Department

Synergy SIS > Mass Scheduling > Reports > List

The Master Schedule by Department prints all of the sections in the option set on a grid sorted by
department.

v Report OSM414: Schedule by Department £ &1

& Print Save Default Email Me

MName: Schedule by Department Number: 0SM414 Page Orientation: Landscape
Options Sort / Output Conditions Selection Advanced
Option Set As of Date
v | |03/31/2017 @&
This report prints a maximum of 8 period columns. Any periods outside the range will not be visible.

Period Begin Period End

0 ~| |8 -
@ Meeting Days

MeetingDay O < &

OAldB
Department
[T Fine Arts [T] Language [T Math
[l science [C] special Education [ET Art
[C] Aerospace Science [Tl Agricultural Science [Tl Business Education
[C] computer/Business [T] English [T Family and Consumer Sciences
[T industrial Technology [C] military Science/Leadership Army [C] Music/Performing Arts
[T Physical Education [[] Reading [[] sacial Studies
[C] Traffic Safety [CIworld Languages [C] Elementary&School
[ Miscellanecus [C] special Education [Tl Transfer Credit

[C] East Valley Institute of Technology [C] English Language Development [C] American History

OSM414— Schedule By Department Report Interface Screen

Report Options:
« Option Set — Select the option set to include in the report. Only option sets for the year and
school in focus are available.
« As of Date — Report prints sections as they were on the date entered.
« Period Begin/End Range — Filters output by a period or a period range
« Meeting Day — Filters the output by meeting days. To select or clear all meeting days, use
o~

« Department — Select only those departments to be included in the report output or leave
blank to include all reports.
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N Hope High School Year 20162017
- Schedule by Department Reporl: OSM414
Option Set: MSB 2016-2017, As of Date: 04/28/2017

Staff N\ame FTE Room  Day Period 0 Period 1 Period 2 Period 3 Period 4 Period 5 Period 6 Period 7 Period &

Depariment.  Art

Blahak F. 44402 M Bag Photo Int Photo Int Jewslry Bag Caramics Stained Glass
[404) (402) (404) 404) (402)

Blzhak P, 44402 T Bag Photo Int Photo Int Jewslny Bag Caramics Stained Glass
(404) (402) (40¢) 404) (402)

Blzhak P. 404402 W Bag Photo Int Photo Int Jewslry Bag Caramics Stained Glass
(404) (#02) (404) (404) (402)

Blzhak P. 44402 R Beg Photo Int Photo Int Jewelry Beg Ceramics Stained Glass
404) (402) (404) 404) (402)

Blzhak P. 44402 F Beg Photo Int Photo Int Jewelry Beg Ceramics Stained Glass
404) (402) (40¢) 404) (402)

Gunn 4034021404 M Int Ceramics Beg Jewsky Stained Glass Adv Ceramics Beg Jewelry

(401) (403) (404) (401)
Gunn 4034021404 T Int Ceramics Beg Jewsky Stained Glass Adv Ceramics Beg Jewelry
(401} (403) (404) (401)

Gunn 4034027404, W Int Caramics Beg Jewsiry Stained Glass Ady Ceramies Bag Jewelry
[402) (401} (403) (404) (401)

Gunn 403402404 R Int Ceramics Beg Jewsiy Stained Glass Ady Ceramics Bag Jewelry
0 1401 403 404y 401

OSM414 — Schedule By Department Report Output
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OSM415 — Master Schedule by Room

Synergy SIS > Mass Scheduling > Reports > Lists
The Master Schedule by Room prints all of the sections in the option set on a grid sorted by Room.

¥ Report OSM415: Schedule by Room

B print || Save Default Email Me

Mame: Schedule by Room Number: 05M415 Page Orientation: Landscape
Options Sort / Qutput Conditions Selection Advanced
Option Set As of Date
~ | 03/31/2017 i@
This report prints a maximum of 9 period columns. Any periods outside the range will not be visible.

Period Begin Period End
0 - |8 -

@ Meeting Days

MeetingDay O ~ &

OA@B
Department
[C] Fine Arts [[] Language [ math
[ science [C] special Education I Art
[C] Aerospace Science [C] Agricultural Science [T Business Education
[T computer/Business [C1 English [C1 Family and Consumer Sciences
[C] Industrial Technology [Tl military Science/Leadership Army [C] Music/Performing Arts
[T Physical Education [l Reading [C] social Studies
[C] Traffic Safety [Clworld Languages [C] Elementary&School
[[] Miscellaneous [C] special Education [Tl Transfer Credit

[T] East Valley Institute of Technology [C] English Language Development [] American History
Size limit for "small" classroom
30

Course types to show as Study Hall
[Tl Distance Learning  [C] General [C] Self-contained Multi

[[] seli-contained Single [ virtual

OSM415— Schedule By Room Report Interface Screen
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Report Options:

Option Set — Select the option set to include in the report. Only option sets for the year and
school in focus are available.

As of Date — Report prints sections as they were on the date entered.

Period Begin/End Range — Filters output by a period or a period range.

Meeting Day — Filters the output by meeting days. To select or clear all meeting days, use
O~

Department — Select only those departments to be included in the report output or leave
blank to include all reports.

Size limit for “small” classroom — Enter the class size limit of classrooms to identify as
small on the report. Classrooms with class size limits above this number entered display as full
size on the report.

Course types to show as Study Hall — Select the Course Type the report displays as
Study Hall.

Hope High School Year 20162017
Schedule by Room Report: OSM415
Option Set: MSB 2016-2017, As of Date: 04/28/2017

Room Teacher Desks Day Period 0 Period 1 Period 2 Period 3 Period 4 Period 5 Period 6 Period 7 Period 8
118 Janssan, Samusls, Fetiers M OpenF OpanF Samuels Edeistein OpenF Open-F Fettars Janssen Nedergaard
118 Janssan, Samusls, Feters T OpenF OpanF Samuels Edeistein OpenF Open-F Fettars Janssen Nedergaard
18 Janssen, Samuels, Fetiers W OpenF OpenF Samuels Edelstein OpenF Open-F Fatters Janssen Nedergaard
18 Janssen, Samuels, Fetiers R OpenF OpenF Samuels Edelstein OpenF Open-F Fatters Janssen Nedergaard
118 Janssen, Samuels, Feters F OpenE OpenF Samuels Edelstein OpenF Open-F Fetters Janssen Nedergaard
17 Vierthaler, Feters, Toft M Openf OpenF Vierthaler Tofft OpenF Open-F OpenF OpenF Fetters

"7 Vierthaler, Fetiers, Toft T Open- OpenF Vierthalar Tofft OpenF Open-F Open-F OpenF Fatters
"7 Vierthaler, Fatiers, Toft W Open-F OpenF Vierthalar Tofft OpenF Open-F Open-F OpenF Fatters
"7 Vierthaler, Fatiers, Toft R OgenF OpenF Vierthalar Tofft OpenF OpenF QpenF OpenF Fatters

"7 Vierthaler, Fetiers, Toft  F OpenF OpenF Vierthaler Tofft OpenF OpenF OpenF OpenF Fetters

18 Nedergaard. Samuels, Dur M Open-F Martensen Dunn Nederpaard Open-F Open-F Open-F OpenF Samuels
118 Nedergasrd, Samuels, Dur T OpenF Mortensen Dunn Nedergaard OpenF Open-F Open-F OpenF Samuels
13 Nedergasrd, Samuels, Dur W OpenF Mortensen Dunn Nedergaard Open-F OpenF QOpenF OpenF Samuels
118 Nedergasrd, Samuels. Dur R OpenF Mortensen Dunn Nedergaard OpenF Open-F OpenF OpenF Samuels
19 Nedergaard. Samuels. Dur F Open-F Martznsen Dunn Nederpaard Open-F Open-F Open-F OpenF Samuels
120 Vierthaler, Dunn, Samuels M Openf Vienhaler Open-F Durn OpenF Open-F Samuels OpenF OpenF
120 Vierthaler, Dunn, Samusis T Ogen-F Vierthaler Open-F Dunn Opan-F Open-F Samuels OpenF Open-F
120 Vierthaler, Dunn, Samuels W Open-F Vierthaler Open-F Dunn OpenF Open-F Samuels OpenF Open-F
120 Vierthaler, Dunn, Samuels R Openf Vignhaler Open-F Dunn OpenF OpenF Samuels OpenF Open-F
120 Vienthaler, Dunn, Samugis F OpenF Vignhaler Open-F Dunn OpenF Open-F Samuels OpenF Open-F
21 MeEride, Webster M Openf OpenF Webster McBride OpenF OpenF Openf OpenF McEride:
121 McBride, Webster T Openf OpenF Webstar McBride OpenF Open-F Open-F OpenF McEride

OSM415— Schedule By Room Report Output
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OSM417 — Department Section List

Synergy SIS > Mass Scheduling > Reports > List

The Department Section List prints a list of sections assigned to departments and includes teacher
and class size information.

7 Report OSM417

o Print Save Default Reset Default Email Me

S

Department Section List ‘

Name: Department Section List Number: OSM417 Page Orientation: Portrait
Options Sort / Qutput Conditions Selection Advanced

Option Set
Department
Room Name
Period

Staft

Subject Area

-

OSM417 - Department Section List Report Interface Screen

Report Options:
« Option Set — Select the option set to include in the report. Only option sets for the year and
school in focus are available.
« Department — Filter the report to show one department.
« Room Name - Filter the report to show a particular range of room names.
« Period —Filter the report to show a period range.
« Staff — Filter the report to show a certain staff member.
« Subject Area - Filter the report to show a particular subject area.
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I .
\ ( Hope High School Year 20132014
o~ Department Section List Report: OSM417
Demo School District Option Set: Test Section Size
Per Par
Term St End Section ID ots
AC s2 2 2 ACIDO0 []
[[Touk: ] |
Agheultural Seence 52 9 0 AG2001 AG20 - Expl Agric M AG1 10 o 10
¥R [] (-] AG-D1 AG3 - Anmal Soi M AG1 50 1] 50
¥R &8 8 AGS1-01 AGS1 - Landscape D&m | M AG1 28 o 28
[Tew |
ALSI 52 3 3 ALSI10-01 ALSI10 - Aled Signal M [ ] o
[ Tota: ) o o]
AM 82 1 1 AM 1801 AM1E - Chassis & Brake M (1] 1] (1]
¥R 10 10 AMII-0N AM11 - Tune Upiac M 124 o o o
82 10 10 AM1601 AM18 - Engine Perform M 0 1) o
52 1 1 AMZ0-01 AMZ0 - Auto Intemship M 1] o [}
| Total: [] [] [] u|
Art 82 1 1 ARE3-18 ARE3 - Beg Drawing M 404 0 1] an
52 2 2 ARE3-15 ARE3 - Beg Drawing M 30 o 30
2 2 2 ARS3-20 ARE3 - Beg Drawing M 0 1] 30
52 3 3 ARE3-22 ARE3 - Beg Drawing M 0 o 30
s2 4 4 ARB3-1T ARE3 - Beg Drawing M 403 0 L] 30
52 4 4 AREI2M ARE3 - Beg Drawing M 0 [
82 ] (-] ARS3-21 ARA3 - Beg Drawing M 30 o 30
2 8 -] ARE3-23 ARE3 - Beg Drawing M 0 1] 0
52 k) -] ARE3-18 ARE3 - Beg Drawing M 30 o 30
S2 § 9 ARG ARS3 - Beg Drawing M = L
YR 5 5 ARG4QT AR - Int Drawing M 404 W W 0
S2 10 10 ARE3I3 ARE3 - Bag Drawing M 02 20 [
S22 2 ARe2O ARA2 - Int Stain Glass [ 404 20 [
S2 5 5 ARE3OS ARES - Beg Drawing M 403 30 0 20
52 7 T  AREMT ARG - Beg Drawing " 403 0 [
S2 8 8 ARG308 AR3 - Beg Drawing M 403 ' 0 30
52 9 @ AR4ID3 ARA43 - Ink Ceramics " 403 28 0 3
YR 1 ARSI AR - Int Drawing M 403 W MW 0

OSM417 — Department Section List Report Output
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Synergy SIS > Mass Scheduling > Reports > List

The Room Section List prints a list of rooms with the sections assigned to them, along with the

teacher and class size information.

7 Report OSM418: Room Section List

o Print Save Default Reset Default Email Me

Options Sort / Qutput Conditions Selection

Option Set
Department
Room Name

Period

- -

-
Staff

Subject Area

Name: Room Section List Number: 0SM418 Page Orientation: Portrait

Advanced

OSM418— Room Section List Report Interface Screen

Report Options:

« Option Set — Select the option set to include in the report. Only option sets for the year and

school in focus are available.
« Department — Filter the report to show one department.

« Room Name - Filter the report to show a particular range of room names.

« Period —Filter the report to show a period range.
« Staff — Filter the report to show a certain staff member.

« Subject Area - Filter the report to show a particular subject area.
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\J "(* Hope High School veor 20133014
-~ Room Section List Report: 0SM418
Demo School District Option Set: Last Year copy
Excelicnce in Educotion Per Per
Room Department Staff Name Jerm $t End SectionlD Course 1D And Title g
101 Elementary School Vogl. Randy s1 1 1 0188 MASOW - Ap Cale/ana Geo. 28 0o 2
Elementary School Vegl, Randy 31 4 4 0458 MASOW - Ap Calcfana Geo 28 0 28
Elementary School Vogl. Randy 52 1 1 1156 MASOW2 - Ap Calclana Geo 28 27 1
Elementary School Vogl, Randy 52 4 4 &% MASOW2Z - Ap Calc/ana Geo 28 24 4
Math Vegl, Randy 51 3 3 08 MA4D - Algebra Il 2 0 a2
Math Vogl, Randy s1 6 & oess MA4D - Algebea If a2 o 3
Math Vogl. Randy S2 3 3 1356 MA402 - Algebra i 32 20 2
Math Vegl, Randy 52 L] L] 1858 MA4D2 - Algebra i 32 30 2
Total: 0 240 111 129
102 Math Bayer M., Michelle S1 1 1 0148 MARD - Math Standards 23 0 23
Math Bayer M., Michelle 51 2 2 ot MA4D - Algebra Il ] 0o a2
Math Bayer M, Michelle s1 3 3 0341 MA4D - Algebra Il 32 0 2
Math Bayer M., Michelle 514 4 a1 MA4D - Algebra Il a2 I -
Math Bayer M, Michelle S1 6 & 0241 MA3D - Geometry 2 0 2
Math Bayer M., Michelle $2 1 1 148 MARD2 - Std Math | 23 1% 4
Math Bayer M., Michelle 82 2 2 1241 MA4D2 - Algebra i 2 ] 3
Math Bayer M., Michelle 52 3 3 1341 MA402 - Algebra li 32 a0 2
Math Bayer M., Michelle s2 4 4 1441 MA402 - Algebra i 32 n 0
Matn Bayer M., Michelle s2 6 & 1841 MA302 - Geometry 2 @ 1
SA Guidance Off, Guidance OFf YR & 5 5971 _SA SAP9 - Student Aid 100 25 %
Total: 0 402 166 23

OSM418— Room Section List Report Output
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OSM419 - Class Analysis By Grade and Period

Synergy SIS > Mass Scheduling > Reports > List

The Class Analysis By Grade and Period prints a class analysis by grade and period based on the
scheduling results for a particular option set. The report shows the number of seats available for a
period by grade, total number of existing sections for the course, total student requests for the
course, total requests fulfilled for the course, number of seats available in a section, and average

number of fulfilled request by gender and grade.

Y

dk Print | Save Default Reset Default Email Me

Name: Class Analysis by Grade and Period MNumber: O5M419 Page Crientation: Landscape

Options Sort / Output Conditions Selection Advanced

Option Set

Report OSM419: Class Analysis by Grade and Period

4

OSM419 — Class Analysis By Grade And Period Report Interface Screen

Report Options:

« Option Set — Select the option set to include in the report. Only option sets for the year and

school in focus are available.

i )
X Hope High School ) Year: 20142015
Demo Schoo District Class Analysis By Grade and Period Report: OSM419
Ecelfenee I Educaien Trial Run
Total Total Actual Open Avg Req Per Section

End Term SecID Track CrsID _ Course Title Staff Name Room _ Sect Reqst Sched Seats Total F M
1 1 s BE20-01 BE20 Pers Typing Cc Abel, Patricia EVIT 1 1 1 g 1.00 0.00 1.00
1 1 52 070001 0700 Speech c Abel, Patricia 234 5 41 8 12 220 440 3.30
1 1 s2 AC10-01 AC10 AirCondTech A Hom, Cissy w 3 7 2 12 233 1.00 133
1 1 52 AC10-02 AC10 AirCondTech B Hom, Cissy v 3 7 3 " 233 1.00 133
1 1 52  AR43D1 AR42  IntCeramics B Attend Office, Attend Off Test P-03 2 4 8 11 456 244 21
1 1 52 ARB8-01 ARB8 Adv Drawing D Audio Visual, Audio Visual 117 12 41 4 il 342 183 158
1 1 = ARGE-02 ARS8 Adv Drawing c Attend Office, Attend Off Test EVIT 12 41 2 21 342 1.83 158
1 1 s2 BE48-01 BE48 Accounting li B Aderson, Gordon MHS 1" 41 5 19 a3 200 173
1 1 52 BE48-02 BE48 Accounting li D Atwd S.. Sharon P-11 1" 41 3 19 373 200 173
1 1 s2 BES4-01 BES4 Student Store o Cooper, Kathy EVIT 60 41 0 6 0.5e 032 028
1 1 Sz BES4IR2 BES4  StdentStore O Bayer M., Michelie MHS g2 41 o 5 05 032 02
1 1 52 BES4-03 BES4 StudentStore Al Atwd S., Sharon 17 a2 41 1] 8 0.58 0.3z 028
1 1 s2 BES4-04 BES4 StudentStore Al Audio Visual, Audio Visual 126 i) 41 1 5 0.50 032 028
1 1 52 BES4-05 BE54 StudentStore Al Bayer M., Michelle 136 a2 41 1 5 0.50 032 028
1 1 s2 BES4-08 BES4 StudentStore A Atwd S., Sharon 220 aa 41 1 5 0.50 032 028
1 1 52 BES4-0T BES4 StudentStore  C Bayer M., Michelle 224 a2 41 1] 8 .58 0.32 028
1 1 52 BES4-08 BE54 StudentStore C Becker A, Alison 228 a2 41 0 8 050 032 028
1 1 52 BES4-02 BES4 StudentStore A Cooper. Kathy i) ) 41 1 5 0.50 032 028
1 1 s2 BE54-10 BE54 StudentStore C Becker C., Chris 233 69 41 1} (] 058 032 028
1 1 52 BES4-11 BES4 StudentStore O Becker C., Chris o3 8a 41 0 5 0.50 032 028
1 1 s52 EN44-01 ENs4 Creative Wrt o Davis, Jeffrey ao 1 1 1 27 1.00 1.00 0.00
1 1 52 MA301-01 MA301 Geometry o Attend Office, Attend Off Test DCE 1 0 1} 40 0.00 0.00 0.00
1 1 52 PPD12-01 PP012 Mathematics B Behm A., Angela 078 58 1 1] 8 0.02 0.00 002
1 1 52 PPD12-02 PP012 Mathematics B Bellus G.. Genice 33 58 1 0 9 0.02 0.00 0.02
1 1 52 PP70-01 PPTD English 10 [s] Edelstein, Anne 20 86 1 1] a 0.02 0.00 002
1 1 s2 PP70-02 PPT0 English 10 A Davis, Jefirey P-05 66 1 0 g 0.02 0.00 0.02
1 1 52 PP70-03 PP70 English 10 A Edelstein, Anne P-09 86 1 0 a 0.02 0.00 0.02
1 1 52 PP70-04 PP70 English 10 [e] Diaz, Joe 224 86 1 0 a 0.02 0.00 0.02
1 1 52 PP70-05 PPT0 English 10 Cc Edelstein, Anne agz2 86 1 0 10 0.02 0.00 002
1 1 s2 PP70-06 PPT0 English 10 c Davis, Jefirey 413 66 1 1} 10 0.02 0.00 002
1 1 52 PP71-01 PPT1 Math Al Abel, Patricia 224 5 41 7 13 a20 440 330

OSM419 - Class Analysis By Grade And Period Report Output
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OSM416 — Sections Needed by Requests

Synergy SIS > Mass Scheduling > Reports > Summary

The Sections Need by Requests prints the number of sections needed based on the total number of
course requests and the maximum/optimum number of students per section, as entered on the
District Course or School Course screens.

v Report OSM416: Sections Needed by Requests ‘

& Print | Save Default Reset Default Email Me

Name: Sections Needed by Requests Number: OSM416 Page Orientation: Portrait
Options Sort/ Output Conditions Selection Advanced
® Course Info

Course ID
| =

Course Title

Linked Course Display

[[] Use Student Count Levels from District

OSM416— Sections Needed By Request Report Interface Screen

Report Options:

o Course ID — Enter a range of course IDs to print results for.
« Course Title — Enter the course title for which the report should print results.
« Linked Course Display — Display the linked courses together.
o None—Do notdisplay the linked courses (default).
e Primary Linked Only — List only the primary course from each link.
« AllLinked — List all of the linked courses.
« Use Student Count Levels from District — Only use the maximum and optimum size
numbers from the district in the report results. Synergy SIS reviews the size limits on the

School Course screen, then District Course if no values exist. Selecting this option skips
School Course entirely.
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\i""- _Hope High School Year: 2016-2017
» Sections Needed by Requests Report: OSM416
Pems el

| Organization:  Hope High School

Total Course Optimal Students Max Students # of Sections  # of Sections
Course ID Course Title Requests Per Section Per Section (Optimal Students) (Max Students)
ADBEW Academic Decath 34 NIA NIA NIA NiA
AG29 Expl Agric 2 NIA NIA NIA NiA
AGH Animal Sci 32 NIA NIA NIA NiA
AGSE1 Landscape D&m | 6 NIA NIA NIA NiA
AR32 Beg Photo 58 NIA NIA NIA NiA
AR33 Int Photo &1 NIA NIA NIA NiA
AR34 Adv Photo 10 NIA NIA NIA NiA
AR4D Stained Glass 85 NIA NIA NIA NiA
AR41 Beg Ceramics a2 NiA NiA NIA NIA
AR42 Int Stain Glass 44 NIA NIA NIA NiA

OSM416— Sections Needed By Requests Report Output
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OSM470 — Pre Schedule Edit List

Synergy SIS > Mass Scheduling > Reports > List

The Pre Schedule Edit List prints a list of students who have a problem with their course requests.

v Report OSM470: Pre Schedule Edit List

* Print Save Default Reset Default Email Me

Name: Pre Schedule Edit List Number: O3M470 Page Orientation: Portrait

Options Sort / Output Conditions Selection Advanced

Option Set Minimum Number of Periods

OSM470— Pre Schedule Edit List Report Interface Screen
Report Options:

« Option Set — Select the option set to include in the report. Only option sets for the year and
school in focus are available.

o Minimum Number of Periods — Filter report output to include only students with a minimum
number or course requests
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e
PR

Demo Scheol District

Entelience in Edueolien

Hope High School
Pre Schedule Edit List
Option Set: Run #1

Year: 2011-2012
Report: OSM470

Perm 1D Student Range Course number and Title Error Detected

124013 Abbatt, Andrew E. PPOO Functional Math Mo seats left in any section of this course

886630 Acevedo, Andrew MA4SW  Pre-Calculus No seats left in any sectien of this course
PPO22  Literature No seats left in any section of this course
PPOT  American Govt Mo seats left in any section of this course
WL21 Spanish | Mo seats left in any section of this course
PP70 Sr. English No seals left in any section of this course
5C81 Physics No seats left in any section of this course

901830 Acevedo, Ashiey WL31  German | No seats left in any section of this course
EN5S1  Lit Explor Mo seats left in any section of this course
MAd2 Trigonometry No seats left in any section of this course
5522 World History/Geography Mo seats left in any section of this course
EN34 Prin Eng Il No seats left in any section of this course

150265 Acosta, John A, PP022  Literature Mo seats left in any section of this course
PPO7  American Govt Mo seats left in any section of this course
scg Physics Mo seats left in any section of this course
FP70 Sr. English No seals left in any sectien of this course
MA4SW  Pre-Calculus No seals left in any sectien of this course
WL21  Spanish | Mo seats left in any section of this course

108086 Acuna, Teresa N. EN0S1C 9th Eng-Corr Course not offered

110412 Acunia, Kenneth O. WL31  German | Mo seats left in any section of this course

871626 Adair, Alan W. SCE1 Physics No seats left in any section of this course

PP70  Sr. English
PPO7  American Gowt
wL21 Spanish |
PPO22  Literature
Ma45W  Pre-Calculus

No seats left in any section of this course
Mo seats left in any section of this course
Mo seats left in any section of this course
Mo seals left in any section of this course

No seals left in any section of this course

OSM470— Pre Schedule Edit List Report Output
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OSM601 — Course Request Totals

Synergy SIS > Mass Scheduling > Reports > Summary

The Course Request Totals prints course request totals sorted by department.

7 Report OSM601: Course Request Totals

o Print Save Default Reset Default Email Me

Name: Course Request Totals Number: OSM801 Page Crientation: Portrait
Options Sort / Qutput Conditions Selection Advanced
@ Grade Level Filter

Grade D +~ ¥
[Foe E10 E11 @12

OSM601— Course Request Totals Report Interface Screen

Report Options:

« Grade — Filter report output to include only the selected grade or grade range. To select or

-

clear all grades, use O
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\J\fh Hope ngh School Year: 2011-2012
-~ Course Request Totals Report: OSM601
Demo School District
Eszelience I Eduenlion
Course ID Course Title Total Female Male 09 10 11 12
Department: Agricultural Science
AG3H Animal Science 1 [} 1 0 0 0 1
Total 1 [} 1 0 0 4] 1
Department: At
AR33 Int Photo 1 1 0 0 0 1 0
AR43 Int Ceramics 1 1 o 0 0 1 o
ARS4 Beg Jewelry 2 1 1 1 0 1 0
ARS8 Adv Jewelry 12 6 L] 0 0 6 ]
AR63 Beg Drawing 1 1 0 0 0 1 0
Total 17 10 7 1 0 10 [}
Department: Compuler/Business
CBA Vis Bas Prog | ] 4 2 0 0 6 0
Total & 4 k4 0 0 6 0
Department: Elementary School
MA4SW Pre-Calculus 866 409 457 0 0 1 B6S
PPO2A Prin Of Eng 1 [} 1 0 0 0 1
SCTTW2  De Chemistry 1 (] 1 0 0 1 0
Total 868 409 459 0 0 2 866
Department: English
ENO91C Sth Eng-Corr 21 12 9 21 0 0 V]
EN33 Prin Eng | 88 50 8 0 34 52 2
EN34 Prin Eng Il 1010 488 522 0 0 1008 2
EN40 Shakespeare 22 12 10 22 0 0 0
EMNS1 Lit Explor 1010 488 522 0 0 1008 2
EN52 Mythology 34 21 13 0 34 4] i}
EN84 Journalism | 4 2 2 0 0 3 1
ENBS Yearbook 1 1] 1 0 0 1 0
EMNBT MNewslab 1 [} 1 0 0 1 0
ENSS App Read Il 1 [] 1 0 0 1 V]
PP70 Sr. English 915 436 479 0 0 50 BE6S
Total 3107 1509 1598 43 68 2124 B72

OSM601— Course Request Totals Report Output
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OSM602 — Student Request Exception

Synergy SIS > Mass Scheduling > Reports > Summary

The Student Request Exception prints a list of students with either fewer or greater than a certain
number of course requests or credits.

7 Report OSM602: Student Request Exception G ccCe

é Print Save Default Reset Default Email Me

Name: Student Request Exception Number: OSMe02 Page Orientation: Portrait
Options Sort / Qutput Conditions Selection Advanced
@ Student Filter Options

Grade

- * -
Term Code O + &
[CFall [ spring

Request Filter Type
Use Course Request Totals and Credit

® Request Filter Options

Students with less than the following requests
1

Students with greater than the following requests
Students with less than the following credits

Students with greater than the following credits

Total Course Requests Made
Show all students -

@ Report Display Options

[C] Display Feeder Schools
OSM602 — Student Request Exception Report Interface Screen

Report Options:

« Grade — Enter a grade range to print results for. If left blank, all grade levels print.
o Term Code — Select the term code to print results or leave blank to print for all term codes. To

-
select or clear all terms, use O © .

Edupoint Proprietary and Confidential



Schedule and Course Guide

Chapter 12: Reports 339

« Request Filter Type — Options change depending on the choice selected.

o Use Course Request Totals and Credit — Filters the report based on student course

request parameters

« Students with less than the following requests

Students with greater than the following requests

Students with less than the following credits

Students with greater than the following credits

Total Course Requests Made:

o Show all students

« Show students with the correct number of requests only

« Show students with too few or too many requests only

« Show students with too few requests only

« Show students with too many requests only

« Use Period Range — Filters the report based on the specified period range

o Number of Periods — Filters by the selected period range

« Display Feeder Schools — Displays the last school of attendance. If the student is new to the

district, the feeder school column is blank.

Student
Akagawa, Adam H.
Ake, Joshua J.
Akin, Andrea E
Alarcon, Frank
Alcazar, Eugene
Alcazar, Eugene A.
Alder, Brenda |.
Alder, Lawrence S
Alder, Sarah C
Aldrich, Steve K
Alexander, Fred D.

Alexander, Joseph J.
Alger, Nicole C.
Alger, Phyllis A
Allen, Aaron L. JR
Allen, Andrea

Allen, Cynthia

Allen, Diane B.

Allen, Donald J.
Allen, Elizabeth
Allen, Eugene C.

Alexander, George M.

Perm ID
165923
239704
902375
836651

141666
141517
967569
910024
968416
873815
975140
975141

901626
874433
1489384
992938
904134
874997
201507
833223
836019
837238

Grade
1
1"
10
10
10
10
10
12
12
12
12
12
10
12
10
10
10
12
10
10
1
1"

Hope High School Year 2016-2017
Student Request Exception Report: OSME02
All Students

Course Course
Requests Credits Exception Reason

5

B N R e T T e e B e B BN RN NN

2.50 Too Few Credits
3.50 Too Few Credits
4.00 Too Few Credits
5.00

3.00 Too Few Credits
3.50 Too Few Credits
5.50

5.50

5.00

4.50 Too Few Credits
3.50 Too Few Credits
3.50 Too Few Credits
3.50 Too Few Credits
4.00 Too Few Credits
4.00 Too Few Credits
4.00 Too Few Credits
450 Too Few Credits
6.00

3.50 Too Few Credits
4.00 Too Few Credits
4.00 Too Few Credits
400 Too Few Credits

OSM602 — Student Request Exception Report Output
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OSM603 — Open Periods by Grade and Period

Synergy SIS > Mass Scheduling > Reports > Summary

The Open Periods by Grade and Period prints the total number of students for each term, rotation
day (if applicable), and period with an open period in their schedule.

7 Report OSM603: Open Periods by Grade and Period
& Print | Save Default Reset Default Email Me

MName: Open Periods by Grade and Period MNumber: OSME023 Page Orientation: Portrait
Options Sort / Output Conditions Selection Advanced
® Schedule Options

Option Set

Term Definition O +~ &

[C] Fall [C] Spring

Period List (O + &
COoO1Oz20z2040506 0708009

@ Student Options

GradeListQ +~ &

oo 10O 11 012
[] Show Gender Totals

OSM603— Open Periods By Grade And Period Report Interface Screen

Report Options:

Option Set — Select the option set to include in the report. Only option sets for the year and
school in focus are available.

Term Definition — Select which term to run or leave blank to print for all terms. The terms
listed are the same terms on the Term Definition section of the School Setup screen. To select

or clear all terms, use O~ @E

Period List — Filters output by a period or selection of periods. Leave blank to include all
periods on the report. To select or clear all periods, use 0O“@E

Grade List — Filters output by a grade level or selection of grade levels. Leave blank to
include all grade levels on the report. To select or clear all grades, use 0“@ .

Show Gender Totals — Select this option in order to see totals by gender for each grade
level.

Edupoint Proprietary and Confidential



Schedule and Course Guide

Chapter 12: Reports 341

\J“‘- Hope High School . Year 2016-2017

. sTln ) Open Periods by Grade and Period Repart: OSM603

emo Schaal Distric
|Term Definition: Spring Rotation Day: T

Student
Grd  Count [] 1 z 3 4 5 [ 7 2 E]
or 5 5 5 5 5 5 5 5 5 5 5
08 2 2 2 2 2 2 2 2 2 2 2
09 9 9 g 9 ] 9 a 2] 9 ] 9
10 1053 1053 1053 1083 10583 1053 1053 1053 1053 1053 1053
1 a7 amn amn am arn an a7t a7t a7 a7 a7
12 828 82a az27 828 828 828 828 a27 828 828 828
Term Definition: Spring Rotation Day: W

Student
Grd  Count [] 1 z 3 4 5 3 7 ] E]
o7 5 5 5 5 5 5 5 5 5 5 5
08 2 2 2 2 2 2 2 2 2 2 2
09 9 ] g 9 ] 9 a 9 9 ] 9
10 1053 1053 1083 1083 1053 1053 1053 1053 1053 1052 1053
1 a7 amn amn am arn an a7t a7t a7 a7 a7
12 828 828 az7 828 828 828 828 827 328 828 828
Term Definition: Spring Rotation Day: R

OSM603 — Open Periods By Grade And Period Report Output
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OSM604 — Seat Totals By Department

Synergy SIS > Mass Scheduling > Reports > Summary

The Seat Totals by Department prints the total number of seats available with the total number of
students. This prints for each period in the day, sorted by term and department.

7 Report OSM604: Seat Totals By Department <« Srvee

o Print Save Default Reset Default Email Me

Name: Seat Totals By Department Number: 0SM804 Page Orientation: Landscape
Options Sort / Output Conditions Selection Advanced

@ Schedule

Option Set

® Section Options

School Period O ~ & Term Selection O +~ &
OoOd1@z20304 0506 @7E8E9 EFall @ Spring
@ Departments

Departments O +~ &

[ Fine Arts [ Language [E Mmath [C] Science

[£] Special Education ] Art [[] Aerospace Science  [C] Agricultural Science

[C] Business Education [C] Computer/Business [] English [] Family and Consumer
[] Industrial Technology [ Military Science/Leadership Army [] Music/Performing Arts [[] Physical Education

[F] Reading [[] Social Studies [C] Traffic Safety [£] World Languages

[C] Elementary School [ Miscellaneous [] Special Education [7] Transfer Credit

[T East Valley Institute of Technology [C] English Language Development [C] American History

OSM604 — Seat Totals By Department Report Interface Screen
Report Options:

« Option Set — Select the option set to include in the report. Only option sets for the year and
school in focus are available.

« School Period — Select periods to run or leave blank to print totals for all periods. To select or
. 0+« ®
clear all periods, use )

« Term Selection — Select which term to run or leave blank to print for all terms. The terms
listed are the same terms on the Term Definition section of the School Setup screen. To select

or clear all terms, use 0“@ .

« Meeting Day — Filters the output by meeting days. To select or clear all meeting days, use
o~

« Departments — Select which departments to run. All of the sections for courses of the
selected departments print. Leave blank to see totals for all departments. To select or clear all
departments, use O~ @E .
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SvE Hope High School Year 2016-2017
—— Seat Totals By Department Report: OSME04
Pk R 2016-2017

Seat Totals For2016-2017

Meeting Day- M Term:  Fall Term-  Spring

# of Total  [#0f Total
Department Sections [P1 P2 P3 P4 P35 P& Seats Sections [P1 P2 P3 P4 P35 P& Seats
Max_|Max |Max_|Max |Max |Max Max_|Max |Max_|Max |Max_|Max

Science i a0 o 00 o 30 i a0 o 00 0 [ 30
Total by Schoal 1] 20| [} [ ] 0 0] 1 30' [} [ [] [} 30|
Seat Totals For 2016-2017

Mesting Day: W Term:  Fall Term:  Spring

# Of Total # Of Total
Department Sections [P1 P2 P3 P4 PS5 P& Seats Secfions |P1 P2 P3 P4 PS5 P& Seats
Max  [Max [max  [max  [max  [max Max  [Max  [max  [max  [max  [max

Science 1] | [ | [ 30| 1 | [ | [ 30|
[Tatal by School 1] 0| 1] 30 0] 0 0] 0 0 20|

HE
e

Seat Totals For2016-2017

Mesting Day: F Term:  Fall Term:  Spring
% 0f Total  [#0f Total
Department Secions [P |P2 [P2 [Pa |Ps  [Ps |Seats |Sections|P1 [Pz fpz [Pa fps [P [Seats
Max Max  |Max Max |Max |Max Max Max  |Max Max  |Max |Max
Science 1 30| [1] 0 [1] L) 0) 20| 1 30| [1] 0 [1] [) [} 20|
| Total E School 1 ﬂ 0 0 0 0 0) 20| 1 ﬂ 0 0 0 0 0 20|

OSM604 — Seat Totals By Department Report Output
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OSM605 — Period Load Stats Report

Synergy SIS > Mass Scheduling > Reports > Summary

The Period Load Stats Report displays the number of seats available per period, category, or grade
based on the last MSB schedule build run. If you used the loader, the report shows the number of
students scheduled per category or grade.

This report prints out a page for every grade level selected and one page for school totals. The
Grade level represents the total number of active students in the grade level, number of available
seats for a grade level, the number of students that scheduled for that time period, the count of
available sections. The percentage (%) represents the percent of seats over or under for the class.

The school totals represent the total number of students for the entire school (even when only
printing for one grade), the sum of max seats available for each section during that time period, the
total number of students scheduled (includes all grade levels), and the total number of sections
available for the school during that time period.

v Report OSM605: Period Load Stats Report

ok Print Save Default Reset Default Email Me

Name: Period Load Stats Report Number: OSMB05 Page Orientation: Portrait
Options Sort / Output Conditions Selection Advanced
® Schedule

Option Set

® Grade Options

Grade D <+

[o9 E10 E11 E12

® Period Options

Periods D +~ &
COoO1O02030405060O7 0809
® Term Options

Terms O ~ &
81082

OSM605 — Period Load Stats Report Interface Screen
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Report Options:

« Option Set — Select the option set to run the report for.

« Grade — Select which grade to run the report for or leave blank to print for all grade levels. To
select or clear all grades, use O~ @E

« Period — Select which Period to run the report for or leave blank to print for all periods. To
select or clear all periods, use O-@E .

« Meeting Days — Meeting days to print for. This report can only display five meeting days, so
the report restricts the number of meeting days that print. To select or clear all meeting days,

use U T

o Term — Select which term to run or leave blank to print for all terms. The terms listed are the
same terms on the Term Definition section of the School Setup screen. To select or clear all

-+ [V
terms, use O © .

i I
S Hope High School Year: 2016-2017
- Period Load Stats Report Report: OSM605
Derme, Sehasi Disic
me, Sehast D 2016-2017
Grade 10
Total Swdents 1053
Day 1:M [ DayZ:T | Day 3 W Il Day 4R | Day&:F ]
Term Per | Opt | Act |Sched| Sect | % || Opt | Act |Sched | Sect | % || Opt | Act |Sched| Sect | % || Opt | Act |Sched| Sect | % || Opt | Act | Sched| Sect | %
&1 1 1053 20 4 1| 831 1053 20! 4 1| -88.1 1053 20 4 1) 881 1083 20 4 1] -88.1 1053 20 4 1| 881
2 1053 20 4 1| a1 1053 20! 4 1| -88.1 1053 20 4 1) &1 1083 20 4 1| -88.1 1053 20 4 1| 881
3 1053 20 4 1| 821 1053 20! 4 1| -88.1 1053 20 4 1| 831 1053 20 4 1| -881 1053 20 4 1| 881
4 1053 20 4 1| a1 1053 20 4 1] -08.1 1053 20 4 1] 881 1053 20 4 1] -84 1053 20 4 1] 981
5 1053 20 4 1| a1 1053 20 4 1] -88.1 1053 20 4 1] 881 1053 20 4 1] -88.1 1053 20 4 1] 981
8 1033 20 4 1] a1 1053 20 4 1 08.1 1053 20 4 1] 881 1053 20 4 1] -84 1053 20 4 1] 981
s2 1 1053 28 0 1| 473 1053 28/ 0 1| -873 1053 23 L] 1| 873 1053 28 a 1| 873 1053 28 0 1| 473
1053 28 [} 1| @73 1083 I8 0 1| -7 1053 23 [] 1] erz 1083 28 0 1| -oral| wosz 23 0 1| 973
3 1053 28 0 1) e 1053 28 o 1| -87.3 1053 23 0 1) s 1033 28 a 1| 873 1053 23 0 1| 973
4 1053 28 0 1| 973 1053 28/ o 1| -87.3 1053 23 L] 1| 873 1053 28 a 1| 873 1053 23 0 1| 973
§ 1053 28 [ 1| 473 1053 28 o 1 873 1083 28 a 1] 973 1083 28 0 1] 873 1083 28 0 1] 473
] 1053 28 [ 1| 473 1083 28 o 1] 872 1083 28 a 1] 973 1083 28 0 1] 873 1083 23 0 1] 473

OSM605 — Period Load Stats Report Output
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OSM606 — Teacher Open Period Report

Synergy SIS > Mass Scheduling > Reports > Summary

The Teacher Open Period Report produces a list of all the teachers who are free during the selected
term, period, and meeting day.

v Report OSM606: Teacher Open Period Report ‘

o Print Save Default Reset Default Email Me

Name: Teacher Open Period Report Number: 05SM606 Page Orientation: Landscape
Options Sort / Qutput Conditions Selection Advanced
@ Schedule

Option Set

@ Teacher Types

Teacher Type O < &
[[] counselor [ Director [£] Maintenance [C] Principal [£] Substitute [C] Teacher

@ Period Options

Periods O + ¥
OoO1O203040s50600708 @9
@ Terms

Terms 0 + &
81082 O0YR

OSM606 — Teacher Open Period Report Interface Screen
Report Options:

« Option Set — Select the option set to run the report for.

« Teacher Type — Select which type of teacher to run the report for, or leave blank to print for
all Teacher Types. To select or clear all types, use O~ @E

« Period — Select which Period to run the report for or leave blank to print for all Periods. To
select or clear all periods, use O-@E .

« Meeting Days — Select which Meeting Days to run the report to run for or leave blank to print
for all Meeting days. To select or clear all meeting days, use 0“@®

« Terms — Select which term to run or leave blank to print for all terms. The terms listed are the
same terms on the Term Definition section of the School Setup screen. To select or clear all

- [y
terms, use O © .
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\J;(- HOpe High SFhOOI Year: 2016-2017
Deme sehoo! Disit Teacher Open Period Report Report: OSME06
e 2016.2017

Term Day Period Free Teachers

Adams, Ronald Aderson, Gordon Andrews, Mark Arthur A, Andrea
Altend Office, Attend Off Atwood S., Sharon Audio Visual, Audio Visual Baniszewski, Nancy
Bayer M., Michelle Becker A, Allison Becker C., Chris. Behm A_, Angela
Bellus G, Genice Berg, Justin Blackburn M., Matt Blahak P, Pete
Blasdell W., Wendy Bonjour R, Richard Bookstore, Bookstore Bordwell R, Robert
Brady J., James Brandt, Paula Breiland C., Cheryl Brook C._, Clayton

OSM606 — Teacher Open Period Report Output

Copyright 2009-2020 Edupoint Educational Systems, LLC



348

Schedule and Course Guide
Chapter 12: Reports

OSM607 — Room Open Period Report

Synergy SIS > Mass Scheduling > Reports > Summary

The Room Open Period Report lists all rooms free during the listed term, period, and meeting day. It
includes the room type code in parentheses if you have a room type selected on the School Room
screen.

7 Report OSM607: Room Open Period Report cCcee
é Print Save Default Reset Default Email Me
Name: Room Open Period Report Number: OSM807 Page Orientation: Landscape
Options Sort / Output Conditions Selection Advanced
@ Schedule

Option Set

® Room Types

Room Type O + &
[ None [[] Auditorium  [C] Class Room [[] Cafeteria [[] Computer Lab [C] Chem Lab [ Field [[] Gym [C] Homeroom [C] L
[T Physics Lab [[] Science Lab [[] Shop

@ Period Options

Pericds O < &

O0O1 20304 E5M6 @7 E8 M9
@ Term Options

Terms O <~ &
Fs1Es2E0OYR

OSM607 — Room Open Period Report Interface Screen

Report Options:

Option Set — Select the option set to run the report for.

Room Type — Select which type of room to run the report for, or leave blank to print for all
Room Types. To select or clear all types, use 0*“@E

Period — Select which period to run the report for, or leave blank to print for all periods. To
select or clear all periods, use O-@E .

Meeting Days — Select which meeting days to run the report to run for, or leave blank to print
for all meeting days. To select or clear all meeting days, use 0“@E

Terms — Select which term to run or leave blank to print for all terms. The terms listed are the
same terms on the Term Definition section of the School Setup screen. To select or clear all

L N A
terms, use O © .
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o

Term Day Period Free Rooms

Hope High School
Room Open Period Report
2016-2017

Year:

Report:

2016-2017

0OSMe07

113 119
133 135
21 212
225 226
303 304
403 404
BSBL BSOC
GSFB Gs0C
NURS OFC
P-14 P-15
SEM SFTB

137
214
228

BTRK
GTRK
P-01
P-17
STOR

122 123 124 125
201 202 203 204
215 216 217 218
229 230 2 232A
307A 3078 308 309
409 410 411 412

GVLB GXC GYM JRFE

P43 PA8 P21 P22
SWIM  Test  TRNG  VFB

WRST

OSM607 — Room Open Period Report Output

210
223

BADM
GBBL
NIA
P-11

349
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OSM801 — Course Request Conflict Matrix

Synergy SIS > Mass Scheduling > Reports > Summary

The Course Request Conflict Matrix prints a report of all scheduling conflicts based on the options
selected.

7 Report OSM801: Course Request Conflict Matrix G CCee

o Print Save Default Reset Default Email Me

Name: Course Request Conflict Matrix Number: OSM801 Page Orientation: Portrait
Options Sort / Output Conditions Selection Advanced
® Course

Number of Requests
h > 1

@ Course Group

Course Group

m

Academic Type O ~ &
[T Honors [C] Non-Academic [C] Regular
Department O +

[C] Fine Arts [ Language [ math [[] science

[ Art [[] Aerospace Science [] Agricultural Science [] Business Education

[C] English [] Family and Consumer Sciences [[] Industrial Technology [C] Military Science/Leadershif
[] Physical Education [[] Reading [[] Social Studies [[] Traffic Safety

[] Elementary School [[] Miscellaneous [[] Special Education  [] Transfer Credit

[C] English Language Development [C] American History
[C] Show Only Requested Courses

@ Course Subject Areas

Subject Areas College Areas University Areas
[[] Fine/Applied Arts [ History [[] History

[[] English 9th Grade [] English [ English

[C] English Writing [ Mathematics [C] Mathematics

[C] English Literature [[] Lab Science [[] Lab Science

OSM801— Course Request Confilict Matrix Report Interface Screen

Report Options:

« Number of requests — Displays courses falling within a number range of requests

o Course Group — Displays only those courses within a particular course group

« Academic Type — Shows courses of a particular range of academic types. To select or clear
all types, use 0“°@®

« Department — Shows courses of a particular range of departments. To select or clear all
departments, use O~ @E .

« Show only requested courses — Displays only courses requested by students

« Subject Areas — Displays only courses falling within a range of subject areas
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« College Areas — Displays only courses falling within a range of college areas
« University Areas — Reports only courses falling within a range of university areas

i
\/J Hope High School Year. 2011-2012
Demo School District Course Request Conflict Matrix Report: OSM&01
pree b e Courses with 1 to 100 Requests

CrsiD  Course Title ARI3  ARSE ARSI ENO9IC_EN4O_  ENSA_ENST_ FS41  MAJ0  MASO  PPO0_ PPT02___ PPT6__ SCA2_ SCTTW2

AG31 AR43 ARSE cBi1 EN33 ENS2 ENBE ENB8 MA27 MA40 MUS0  PPO2A PPTS SC13 SC49
AG31  Animal Science | 4 1 1
AR33  IntPhoto 101 1 1 1 1
AR43 Int Ceramics 1 1 1 1 1 1
ARS4  Bag Jewelry 2 1 1 1 1 1
ARS8 Adv Jewelry 1 12 4 & 3 6 1 6
ARE3  Beg Drawing 0l 1 1 1 1
cen Vis Bas Prog | 4 ] L) 3 L L]
ENOSIC  $th Eng-Cormr 1 2 2 2 2 21
EN3 PrinEng | 1 1 6 1 1] 88 M 3 1 1 1 1 M 5 1 1 1 1 M 853 1 1
EN4D Shakespeare 1 1 2 1 22 2 1 1 22
ENS2 Mythology 34 u u 4 1
ENB4  Joumalism | 3 3 3 4 3 3
ENBS Yearbook 1 1 1 1 1
ENS7  Newslab 1 1 1 1 1
ENES  AppRead M 1 1 1 1 1 1
FS41  Culinary Arts 1 1 1 1 1
MA27  Algebral 1 1 1 1 1 1 1
MA30  Geometry 34 u M 4 1
MASO Algebra Il 1 1 1 & 1 6 2 53 22 3 1 1 1 1 15 1 1 22 1 2 52 2 1
MAS0  Math Standards 1 1 1 1
Muso Concert Band 1 1 1 1 1
PPOO Functional Math 1 2 2 1 22 2 1 1 22
PPO2A Prin Of Eng 1 1 1
PP702  English 1 1 1 1 1 1 1
PP7S  AmHistory | 1 1 1 1
PP7T6 Am Govt 1 1 1 1 2 1 1 2 1 1 1
SC13 Earth Science 34 4 k) M 1
sc4a2 Life Science 1 1 & 1 6 53 3 1 1 1 1 1 1 1 1 53 1
SC49 Biology 1 Fil 1 22 1 1 1 22 2 1 1 1 2
SCTTW2 De Chemistry 1 1 1 1 1
§521 World Hist'g 1 21 2 1 2 2 1 1 22
55M4 Amer History | 33 a3 3 Ex] Tl
5535 Amer History Il
§851 Am Govt 123 1 1 6 1 6 53 3 1 1 1 1 52 1 1 1 1 53 1
8857 Prin&prac Econ 1 1 1
WL1E  AmSignLang| 1 1 11 1
Printed by Admin User at 0472172011 355 PM Edupoint School District 1a

OSMB801— Course Request Conflict Matrix Report Output
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Schedule Reports
MST401 — Section List by Course

Synergy SIS > Schedule > Reports > List

The Section List by Course lists each section assigned to a course. The report includes the Teacher,
Room, Period, Credits, and student totals.

7 Report MST401: Section List by Course “ zdee

& Print Save Default Email Me

Name: Section List by Course Number: M§T401 Page Orientation: Portrait
QOptions Sort / Output Conditions Selection Advanced

Term Filter

O suppress Course Totals
Student totals as of

MST401 - Section List By Course Report Interface

Report Options:

« Term Filter — Select the term to display sections for.

« Suppress Course Totals — Removes student totals for the course from displaying in the
results

« Student totals as of — Show student totals only as of a specific date

e Hope High School Year 2016-2017
. ;:"m Section List by Course Report: MST4D1
emo Schaol District
e As of 05/01/2017
Course ID Course Title
cB10 Comp Foundation
Section ID Meeting Days Teacher Room Begin Period End Period Term  Credit Max Students  Total Students
0309 MT Becker C., Chris 127 3 3 51 0.500 30 28
0809 MT Becker C., Chris 127 B 6 81 0.500 30 30
1108 MT Frommer, Kathy 112 1 1 82 0.500 30 27
1210 MT Richardson, Jerry 111 2 2 82 0.500 30 24
1407 MT Sehl, Marty 129 4 4 82 0.500 30 28
1609 MT Becker C., Chris 127 B ] 82 0.500 30 21
Course Total: 158

MST401 - Section List By Course Report Output
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MST402 — Section List by Teacher

353

Synergy SIS > Schedule > Reports > List

The Section List by Teacher displays all section information for the specified teacher and includes

Meeting Days, Course Title, Room, and student totals.

7 Report MST402: Section List by Teacher

o Print Save Default Email Me

MName: Section List by Teacher Number: MST402 Page Orientation: Portrait
Options Sort / Output Conditions Selection Advanced
@ Teacher Filters

Teacher

@ Section Filters

Periods - Blank will return all periods O +
OoO1 020304050607 0s @9
Term  Term

- =
Student totals as of

MST402 - Section List By Teacher Report Interface Screen
Report Options:

« Teacher — Only display sections for a specific teacher.

« Periods — Leave blank to display all periods. To select all or clear all periods, use O

« Term —Displays results for a term or term range

« Student totals as of — Show student totals only as of a specific date

/ .
N\ Hope High School Year 2016-2017
o~ Section List by Teacher Report: MST402
Oegme Schoeh Gt
Staff Name Term Per Sect D Meeting Days Course ID And Title Room Max Total Left
Blasdell W., Wendy S1 5 0016 MT SC70 - Cons Chemistry 124 30 20 10
S22 1012 MT SC702 - Con Chemistry 116 30 17 13
3 1013 MT SC502 - Env Science 2nd 124 30 29 1
4 1014 M T SC502 - Env Science 2nd 124 30 31 -1
5 1015 M T SC502 - Env Science 2nd 124 30 24 5]
6 1016 M T SCT702 - Con Chemistry 124 30 19 M
YR 2 5_074_SA98 M T SAG9 - Student Aid 403 100 0 100
7 0017 M T IT14 - Robotics Tech 30 0 30
Total: 434 243 191
Bonjour R, Richard S1 1 0112 M T EN33 - Prin Eng | 301 28 27 1
2 0212 M T ENB84 - Journalism | 301 28 17 11
3 0312 M T ENB8T - Newslab 301 30 21 9
5 0512 M T EN51 - Lit Explor 302 30 30 0
6 0612 M T EN51 - Lit Explor 302 30 29 1

MST402 - Section List By Teacher Report Output

-
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MST403 — Section List by Course and Term

Synergy SIS > Schedule > Reports > List

The Section List by Course and Term lists each section for all courses. It also shows student totals
and seat totals.

Y Report MST403: Section List by Course and Term

o Print Save Default Email Me

Name: Section List by Course and Term Number: M8T403 Page Crientation: Portrait

Options Sort / Output Conditions Selection Advanced
Term Filter Section ID
Course ID
-

O] Suppress Course Totals
Student totals as of

MST403 - Section By Course And Term Report Interface
Report Options:

o Term Filter — Select the term to display sections for.
« Section ID — Enter the section to display results for.
« Course ID — Select the course or course range to display results for.

« Suppress Course Totals — Removes student totals for the course from displaying in the
results

« Student totals as of — Show student totals only as of a specific date

\i kn ~ Hope High School Year: 2016-2017
R Section List by Course and Term Report; MST403
Excelience n Eduroiien
Term Beg End Section ID Meeting Days Staff Name Room Name Credit Max Total Open
Course ID: MA45WX Course Title:  Trig/Pre-Calc
YR 1 1 0150 M T O'Neill, Patrick P-25 1.000 32 21 "
Course Total: 32 21 1
Course ID:  MAS0W Course Title:  Ap Calclfana Geo
S1 1 1 0156 MT Wogl, Randy 101 0.500 28 0 28
303 0342 M T Hansen, Craig 106 0.500 28 0 28
4 4 0456 M T Wogl, Randy 101 0.500 28 0 28
Course Total: 84 0 84
Course ID:  MA50W2 Course Title:  Ap Calclana Geo
S2 1 1 1156 M T Wogl, Randy 101 0.500 28 27 1
3 3 1342 M T Hansen, Craig 106 0.500 28 24 4
4 4 1456 M T Wogl, Randy 101 0.500 28 24 4
Course Total: 84 73 9
Course ID:  MA5IW Course Title:  Ap Calc Bc
S1 3 3 0340 M T Aderson, Gordon 128 0.500 30 0 30
Course Total: 30 0 30
Course ID: MAS1W2 Course Title:  Ap Calculus Be
S2 3 03 1340 M T Aderson, Gerdon 128 0.500 30 11 19
Course Total: 30 1 19

MST403 - Section List By Course And Term Report Output
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Synergy SIS > Schedule > Reports > List

The Open Periods list displays all students with an open period. A + indicates that the period has a
class scheduled while a number indicates that no scheduled class for that period.

@ 3ection Options
As of Date

05/01/2017 |&

Grade D ~

@ Meeting Days

@ Period Range

Option Sort / Output

Meeting Days O < &
OMOTOWEORDOF

T Report MST406: Open Periods

& Print || Save Default

Mame: Open Periods MNumber: MST406 Page Orientation: Portrait

Conditions

Oprr‘ona.'fy limit data b}r‘ SE.‘E‘CW}Q S;}EC{??'C Grades and/or Terms
TermQ - @
[Clo7 Cos [og 10 [ 11 12 [ Fail [ Spring

Email Me

Selection Advanced

start End
0 9
MST406 — Open Periods Options Report Interface
Report Options:

« Section Options — To select or clear all grades or terms, use 0“@

« Meeting Days — To select or clear all meeting days, use O~ @E

» Period Range — Enter the Start and End periods to display results for.

-

S

L

Demo School District
Encelience in Educalisn

Hope High School Year: 20162017
Open Periods Report: MST406
As of: 05/01/2017 for Periods 1-4
Fall Spring

DayM DayT DayW DayR DayF DayM DayT DayW Day R DayF

Student Perm ID Gen Grd 1234123412341234123412341234123412341234
Abbott, Billy C. 905483 M 12 ++++++++1234123412341+3+1+3+123412341234
Adams, Howard T. 873985 M 12 ++++++++123412341234+*+++"++123412341234
Adams, Scott M 933208 M 12 ++++++++123412341234+*+++*++123412341234
Adams, Sean B. 877340 M 12 *+*+*+* 4123412341234 +*+++*++1234123412314
Addington, Paula M. 871686 F 12 +**++**+123412341234++++++++123412341234
Aelvoet, Jesse J. 944233 M 12 ++++++++123412341234++++++++123412341234
Aguado, Karen C 135319 F 12 TH+F+ T+ 4123412341234 +++"+++123412341234
Aguilar. Roger F. 991071 M 12 ++++++++123412341234+*+++*++123412341234
Aguirre, Jason K. 952357 M 12 ++++++++123412341234++*+++*+123412341234
Aitchison, Alice E. 87T F 12 ++++++++123412341234++++++++123412341234
Alder, Lawrence S. 910024 M 12 ++++++++123412341234++++++++123412341234
Alder, Sarah C. 968416 F 12 ++++++++4123412341234++++++++123412341234
Aldrich, Steve K. 873815 I 12 ++++++++123412341234++++++++123412341234
Alexander, Fred D 975140 M 12 ++++++++123412341234++++++++123412341234

MST406 — Open Periods Report Output
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MST408 — Class Analysis by Course and Section

Synergy SIS > Schedule > Reports > List

The Class Analysis by Course and Section lists all sections scheduled for each course. For each
section, the report lists the student totals by gender, the number of seats available, the number of
requests, and the average number of scheduled students.

v Report MST408: Class Analysis by Course and Section

o Print Save Default Email Me

Name: Class Analysis by Course and Section Number: MST408 Page Orientation: Portrait
Options Sort / Output Conditions Selection Advanced
[T Show only courses who have more requests than availability

[Z] show only courses with sections
Period Begin Period End

MST408 - Class Analysis By Course And Section Options Report Interface
Report Options:

« Show only courses who have more requests than availability — Displays only these
courses on results
« Show only courses with sections — Only displays courses with created sections

« Period Begin/Period End — Enter the beginning and ending periods to display results for.

S Hope High School ) Year 20162017
-~ Class Analysis by Course and Section Report MST408
—— Restrictions ——
Course 1D Course Title Section ID Beg End Term Mtg Days Teacher Name Room Gen Low High Team Max Boys Girls Tot Deviation
CB12 Comp Apps li 1410 4 4 52 MT Richardson, Jerry ] 30 18 12 N 4.00
1510 5 5 52 MT Richardson, Jerry m 0 14 8 A 3.00
Ayailable: 60 Scheduled 53 Avg. 26.00
‘ Requests: 52 Rejected: 1 MAD. 3.50 ‘
CB18 Desktop Publish 0510 5 5 S1 MT Richardson, Jemry m ! 12 5 17 4.00
1310 303 82 MT Richardson, Jerry 1 n N 5 26 5.00
Available: 60 Scheduled 43 Avg.: 21.00
‘ Reguests: 7 Rejected: 16 MAD. 4.5?‘
CB20 Web Page Design 0310 3 3 S1 MT Richardson, Jemy m ! 16 7 23 0.00
Available: 30 Scheduled 3 Avg 23.00
Requests: 2 Rejected Fal MAD. 0.00
CB32 Vis Bas Prog li 1307 3 3 52 MT Sehl, Marty 129 M 17 5 22 0.00
Available: 30 Scheduled 22 Avg.: 22.00
Reguests: 22 Rejected: 0 MAD. 0.(;‘
CB44 Comp Mnt&rpr | 1107 1 1 52 MT Sehl, Marty 129 3 20 3 3 0.00
Available: 30 Scheduled 23 Avg.: 23.00
Reguests: 23 Rejected: o M.AD. 0.00
CO15C Corr Drugs/soc 0647 7 7 YR MT Dizz. Joe CNSL 2 1 01 0.00
Available: 25 Scheduled 1 Avg 1.00
Reguests: 1 Rejected: 0 M.AD. 0.00

MST408 - Class Analysis By Course And Section Report Output
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MST412 — Class Load Analysis

Synergy SIS > Schedule > Reports > List

The Class Load Analysis displays all course information by section number for the specified term. It

also shows a variety of information, such as Staff Name, Room, and student totals.

7 Report MST412: Class Load Analysis

& print | Save Default Email Me

Name: Class Load Analysis Number: MST412 Page Orientation: Portrait
Options Sort / Qutput Conditions Selection Advanced

Section ID

Period  Period
- - =
Term Code O = &
[T1 semester 1 [ semester 2 [ Year

MST412—- Class Load Analysis Report Interface

Report Options:

« Section ID — Displays only the class load for the entered section
« Period — Select the period or period range.

-
o Term Code —To select all or clear all terms, use O © .

Sk Hope High Scheol Year 20162017
e Class Load Analysis Repart MSTA12
Restrictions
Section ID  Periods Term Meeting Days Course ID Course Title Staff Name Room Max Male Female Low High 07 08 09 10 11 42 Total Open
0127 1 s1 MT EN52 Mythology Stauffer, P. P24 30 15 13 1 4 23 28 2
0128 1 §1 MT EN33 Prin Eng | Traylor, K. 224 28 15 12 25 1 1 27 1
0129 6 YR MT PP25 Woe Explor Prgm Sargent, L SHAR 2 0 1 1 1 1
0130 1 51 MT EN51 Lit Explor Wallace, J 303 30 13 17 28 1 30 0
03 1 1 MT EN34 Prin Eng li Sligh Aj, A 227 28 15 [ 21 pal 7
0132 1 S1 MT ENST American Lit Wrather, L. 302 30 12 14 124 1 % 4
0133 1 s1 MT Fsa1 Culinary Arts 1 Cole N N 136 30 12 14 9 7 W0 2% 4
0134 1 1 MT Fs51 Child Dev | Krogman, D. 137 30 4 25 13 10 & 20 1
0135 1 YR MT F580 Hero - Foods Patenge, 5 131 28 0 B [ [ 22
0136 1 1 MT e Auto Tech | Brook C., ©. 308 32 24 3 w 7 3 7 5
0137 1 1 MT &1 Woodwork Tech 1 Chaisson P., P. 3 30 19 2 15 4 2 9
0133 1 51 MT 71 Welding | Fromm, D 309 24 » 0 13 7 2 22 2
039 1 YR MT 33 Cad - Arch li Kish, L. 32 ] 3 1] 3 3 2
0140 1 1 MT MA4D Algebra Il Aderson, G, 128 28 13 18 10 19 29 -1
0141 1 51 MT MA30 Geometry Lewis, J. P-14 32 13 13 28 3 Ell 1

MST412— Class Load Analysis Report Output
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MST413 — Student Schedule Analysis

Synergy SIS > Schedule > Reports > List

The Student Schedule Analysis lists the schedule for each student. It includes the Meeting Days,
Period, Room, and Teacher.

v Report MST413: Student Schedule Analysis

ol Print Save Default Email Me

Name: Student Schedule Analysis MNumber: M8T413 Page Orientation: Portrait
Options Sort / Output Conditions Selection Advanced
® schedule Info

Term  Term
- || | -

Section ID

® Student Info
Grade

Gender

O One Student Per Page

® Grouping Info

Output will be sorted Teacher Name (ascending) for the Sections defined by Term/Period.

Term Code Period

® Course Info

[J Indicate Prescheduled Courses

MST413 - Student Schedule Analysis Report Interface

Report Options:
« Schedule Info — Displays only schedules for the selected criteria
» Student Info — Displays only students that meet the selected criteria
« One Student Per Page — Separates students by page break

« Grouping Info — Groups results alphabetically by teacher for the Term Code and/or Period

« Indicate Prescheduled Courses — Adds a column to the output indicating the courses that
were scheduled prior to running master schedule processes
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\J? Kennedy High School- Year 2018-2019
o~ Student Schedule Analysis Report: MST413

Demo Schaol District

Student: Abbott, Billy C. Perm [D: 905483 Grade: 12 Gender: Male
Meet Days

Prd CrsiID Course Title Sect ID Tm a b Staff Name Room _ _Prescheduled
Fall

1 AR32 Beg Photo 1100 s1 - - Benitez, Steven 415 ]
2 AR33 Int Photo 0200 s1 - - Benitez, Steven 415 M
2 AR41 Beg Ceramics 0202 51 - - Waorm, Fred 334 M
3 AR41 Beg Ceramics 1301 51 - - Worm, Fred 334 ]
4 AREG3 Beg Drawing 0400 81 - - ‘Weorm, Fred 336 ]
4 AR32 Beg Photo 0300 s1 - - Benitez, Steven 415 N
5 ARB3 Beg Drawing 1505 S - - ‘Worm, Fred 338 M
i1 ARS4 Beg Jewelry 1501 51 - - Hargrove, Chad 324 Y
8 WES0 Yearbook Committee 1821 51 = - Snapp, Joy 014 Y

MST413—- Student Schedule Analysis Report Output
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MST414 — Master Schedule by Department

Synergy SIS > Schedule > Reports > List

The Master Schedule by Department is a graphical look at the master schedule. Information is
grouped by department and shows the Teacher, Room, and Period.

7Y Report MST414: Master Schedule by Department

& print || Save Default Email Me

Name: Master Schedule by Department Number: MST414 Page Orientation: Landscape
Options Sort / Output Conditions Selection Advanced
As of Date
05/01/2017 |
This report prints a maximum of 9 period columns. Any periods outside the range will not be visible.

Period Begin Period End
0 - |8 -

® Meeting Days
Meeting Days O = &
AMBTEOWEREF

Department

CIFine Arts [[JLanguage [T math

[ science [T] special Education [ Art

[l aerospace Science [0 Agricuttural Science [ Business Education

[T computer/Business [CIEnglish [C] Family and Consumer Sciences
[Tl Industrial Technology [Tl military Science/Leadership Army [l Music/Performing Arts

[CI Physical Education [ reading [[] social Studies

[T Traffic Safety [T world Languages [T] Elementary&School

[[] Miscellaneous [7] special Education [T] Transfer Credit

[7] East valley Institute of Technology [C] English Language Development  [©] American History

MST414 - Master Schedule By Department Report Interface
Report Options:

« As of Date — Display results as of the selected date
« Period Begin/Period End — Enter the beginning and ending periods to display results for.

« Meeting Day — To select or clear all meeting days, use 0O“E®
« Department — Select which departments to display results for.
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Hope High School Year 20162017
Master Schedule by Department Report: MST414
As of Date: 05/01/2017
Staff Name FTE Room  Day Period 1 Period 2 Period 3 Period 4 Period 5 Period 6 Period 7 Period 8
Depariment.  English
Traylor 24 M Frin Eng | Frin Eng|| FrinEng | American Lit American Lit
Tuzzing = M Faperback Lit Mythology Prin Eng li Mytnology Prin Eng li
Udall 7 M Prin Eng li Amencan Lit American Lit Prin Eng |
Wiz iz M Lit Explor Lit Explor A3 Am His & Lit Aa Am His & Lit Lit Explor Co-Am. Lit
CeLit Ex
Ce-Paperbi Lit
Webster 26 M American Lit American Lit American Lit English Composition English Compasition
Wirather 3023 M Amenican Lit American Lit Prin Eng | Yearbook Yearbook
(302) @z @) 1) @on
Department  Family and Consumer Sciences
Clow-Hennedy 132138 M Culinary Arts 2 Culinary Arts 2 Faads For Today
(139 133 1128)
Cole N. 138 M Culinary Arts 1 Culinary Ans 1 Food Science i Food Science |
Craft 18 M Food Science li
Jackson CNSL M Ce-Persnl Dev.
Krogman 12713132 M Child Dev li Child Dev li Design & Merch Deesign & Merch Faods For Today
{137) {137) (137) {131} (132)
Fatenge 121 M Hero - Foods Frin&prac Ecan Teacher TmPrg  Prin&prac Econ Hero - Foods Here - Foods
Hero Fac Senv Hero Child Care Hero Child Care
Hero Hospit Ser HerolntDesign  Hero Int Design
Hero Apparides Here Fac Senv Hera Fac Sanv
Hero Child Care: Hero Hospit Ser  Heno Hosgit Ser
Hero Int Design Hero Apparides  Hero Apparides
Sargent MHE M Expl Facs.

MST414— Master Schedule By Department Report Output
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MST415 — Master Schedule by Room

Synergy SIS > Schedule > Reports > List

The Master Schedule by Room displays a list of rooms in the school and shows which teacher is in
the room for each period. It also lists open classrooms or rooms used for study halls.

7 Report MST415: Master Schedule by Room

o Print Save Default Email Me

Name: Master Schedule by Room MNumber: MST415 Page Crientation: Landscape
Options Sort / Output Conditions Selection Advanced
As of Date
05/01/2017 @
This report prints a maximum of 9 period columns. Any periods outside the range will not be visible.

Period Begin Period End
1 v |5 -

@ Meeting Days

Meeting Days O + &

OvOTEwOREF

Department

[CI Fine Arts [ Language [ math

[7] science [7] special Education [E1 Art

[T] Aerospace Science [T] Agricultural Science [C] Business Education

[T computer/Business [T English [T1 Family and Consumer Sciences
[[industrial Technology [Tl military Science/Leadership Army [C] Music/Performing Arts

[C] Physical Education [[1Reading [[] social Studies

[T Traffic Safety [CIworld Languages [C] Elementary&School

[ Miscellaneous [T] special Education [C] Transfer Credit

[0 east valley Institute of Technology [C] English Language Development [C] American History
Size limit for "small” classroom
30

Course types to show as Study Hall
[[I Distance Learning [l General [[] Self-contained Multi

[7] self-contained Single [ Virtual

MST415— Master Schedule By Room Report Interface

Report Options:

« As of Date — Display results as of the selected date

« Period Begin/Period End — Enter the beginning and ending periods to display results for.
- ©

« Department — Select which departments to display results for.

« Size limit for a "small" classroom — Class size cannot exceed the entered limit for small
classrooms.

« Course types to show as Study Hall - Lists the selected course types as study hall to
condense results

« Meeting Day — To select all or clear all meeting days, use O
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\j‘f‘ Hope High School Year. 2016-2017
-~ Master Schedule by Room Repart: MST415
Demo Schaol District

As of Date: 05/01/2017
Room_ Teacher Desks Day Period 1 Period 2 Period 3 Period 4 Period 5
0 Wogl M Vgl Open-F Vogl ogl OpenF
0 Vogl T Vgl CpenF Vogl Vgl Cpen-F
102 Bayer M. M Bayer M. Bayer M. Bayer M. Eayer M. Cpen-F
0 Eayer M. T Bayer M. Bayer M. Bayer M. Bayer M. CpenF
103 Harder M Harder Open-F Harder Harder Harder
103 Harder T Harder Open-F Harder Harder Harder
104 Becker A M Becker A Becker A. Open-F Becker A Becker A
104 Becker A T Backer A Backer A. Open-F Backer A Becker A
108 Hangen M Hansen Hansen Hansen Hansen Hansen
1048 Hansen T Hansen Hansen Hansen Hansen Hansen
108 Nebelung M Mebehing Nebelung Mebelung Open-F Nebelung
108 Nebelung T Mebehing Nebelung Mebelung Open-F Nebelung
109 Shackelford M Ogen-F ‘Shackelford
109 Shackelford T Ogen-F ‘Shackelford
112 Frommer M OpenF Frommer Frommer Open-F OpenF

Frommer

MST415 - Master Schedule By Room Report Output
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MST416 — Department Section List

Synergy SIS > Schedule > Reports > List

The Department Section List displays all sections grouped by Department, Teacher, Term, Period,
and Section. It also displays room and seat information.

v Report MST416: Department Section List

& Print Save Default Email Me

Name: Department Section List Number: MST416 Page Orientation: Portrait
Options Sort / Output Conditions Selection Advanced
Department
Room Name
Period  Period
- - -

Staff

Subject Area

MST416 — Department Section List Report Interface

Report Options:

« Department — Select which departments to display results for.
« Room Name — Select the room or room range.

« Period — Select the period or period range .

Staff — Only displays results for the specified staff
Subject Area — Only displays results for the specified subject area

L]
Hope High School Year: 20162017
Department Section List Report MST416
Per Per
Department Staff Name Term St End Section ID Course ID And Title Meeting Days Room | Optimal _ Max__Total _Open
English Gomez, Foriino 51 2 2 o217 EM32 - Prin Eng | MT P-04 28 o 28
Gomez, Forfino 51 3 3 0317 EN44 - Creative Wrt MT P-04 28 o P
Gomez, Fortino 81 5 5 0517 EM32 - Prin Eng | MT P-04 28 o 28
Gomez, Foriino 81 & & 0817 EM32 - Prin Eng | MT P-04 28 o 28
Gomez, Fortino 52 1 1 "7 EMNS0 - Humanities MT 413 45 33 12
Gomez, Foriino k>3 2 2 1217 EN32 - Prin Eng | MT P-04 28 a7 1
Gomez, Foriino k>3 3 3 1217 ENSD - Senior Lit MT P-04 28 1" 17
Gomez, Foriino sz & £ 1517 EM32 - Prin Eng | MT P-04 28 26 2
Gomez, Foriino k>3 L] G 1817 EN32 - Prin Eng | MT P-04 28 a7 1
Gordon, Kim =1 1 1 one EN46 - Prin Eng lii MT 31 28 a I3
Gordon, Kim 81 2 2 0216 EN62 - World Lit MT 231 20 o o
Gordon, Kim 51 4 4 04186 EN46 - Prin Eng li MT pi ] 28 o pra:)
Gordon, Kim 51 5 5 05186 EN46 - Prin Eng li MT pi ] 28 o pra:)
Gordon, Kim =1 L] L] 0816 ENB2 - World Lit MT 31 30 1] 0

MST416 — Department Section List Report Output
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MST417 — Room Section List

Synergy SIS > Schedule > Reports > List

The Room Section list displays all the sections that are taught in a particular room. This report is
grouped by Department, Term, Period, Section, Course ID, and Meeting Days. It also displays seat
information for each section.

Y Report MST417: Room Section List

& print Save Default Email Me

Name: Room Section List Mumber- M8T417 Page Orientation: Portrait
Options Sort / Output Conditions Selection Advanced

Department

Room Name

Period  Period
- = -

Staff

Subject Area

MST417 — Room Section List Report Interface

Report Options:

« Department — Select which departments to display results for.
« Room Name - Select the room or room range.

« Period — Select the period or period range.

Staff — Only displays results for the specified staff

Subject Area — Only displays results for the specified subject area

L[]
\i“‘ Hope High School Year. 20162017
Room Section List Report: MST417
pee, Sehas Digtnet
Per Per
Room Department Staff Name Term St End Section D Course ID And Title Meeting Days | Optimal Max  Total Open
220 English Munes, Kathy YR T T 0285 EN34C - Co-P OfE| MT 10 2 8
English MNunes, Kathy YR T T 0888 EN33C - Cc-P OfE | MT 10 o 10
English MNunes, Kathy YR T T oe28 EN42C - Cc-Short Storie MT 10 2 8
English Munes, Kathy YR T T 0e38 EN46C - Co-P OfE i MT 10 1 a
English Munes, Kathy YR T T 0es57 END21C - 9th Eng-Comr MT 5 o -4
English Munes, Kathy YR T T oeTo END22C - 9th Eng-Comr MT 5 1 4
Total: 0 35%  151 2|ﬁ|
231 English Gordon, Kim 51 1 1 0118 EN48 - Prin Eng lii MT 28 o 28
English Gordon, Kim 51 3 3 0318 ENB2 - World Lit MT 20 o 230
English Gordon, Kim 51 4 4 o8 EN48 - Prin Eng lii MT 28 o 28
English Gordon, Kim 51 5 ] 0818 EN48 - Prin Eng lii MT 28 o 28
English Gordon, Kim 51 L L] 0618 ENG2 - World Lit MT a0 o 30
English Gordon, Kim 52 1 1 1118 EN48 - Prin Eng lii MT a2 20 3
English Gordon, Kim 52 3 3 1318 ENG2 - World Lit MT a0 az -2
English Gorden, Kim 52 4 4 1418 EN48 - Prin Eng lii MT 28 T 1
English Gorden, Kim 52 5 5 1518 EN48 - Prin Eng lii MT 28 12 10
English Gorden, Kim 52 a8 8 1618 EN82 - World Lit MT a0 19 1"
[ Total: 0 292 125 187

MST417 - Room Section List Report Output
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MST418 — Class Load Analysis by Department

Synergy SIS > Schedule > Reports > List

The Class Load Analysis by Department report allows you to select and sort class load information
by department.

v Report MST418: Class Load Analysis by Department

& Print Save Default Email Me

Name: Class Load Analysis by Department Number: MST418 Page Orientation: Landscape
Options Sort / Output Conditions Selection Advanced

Section ID

Period
- - -

TermCode 0 + &
[[151- Semester 1 [ 52 Semester 2 [ YR Year

Department 0 ~ &

[C] FA: Fine Arts [[] LA: Language [C1 MA: Math [CIsc: science

[7] SE: Special Education [ AR: Art [T] AS: Aerospace Science [l AG: Agricultural Science

[0 BE: Business Education [ cB: computer/Business O En: English I Fs: Family and Consumer Sciences
[T Industrial Technology [C] ms: military Science/Leadership Army [C] MU: Music/Performing Arts [C] PE- Physical Education

[T RD: Reading [T] s5: social Studies [T Ts: Traffic Safety [CIwL: World Languages

[C] EL: Elementary School [CI mI: Miscellaneous [C] sP: Special Education [CI TR: Transfer Credit

[F1 v East valley Institute of Technology [Z] ELD- English Language Development [£] PP American History

MST418— Class Load Analysis By Department Report Interface Screen

Report Options:

« Section ID — Only displays results for the specified section
« Period — Select the period or period range.

- [
Term Code — To select all or clear all terms, use O © .

Meeting Day — To select all or clear all meeting days, use O+~ G .

« Department — Select which departments to display results for.

\‘::" Hope High School Year 20162017
. Class Load Analysis by Department Report: MST418
—Period— ——Code — Seats ~——Requests——

SectionID  Course ID Course Title Start End Term Meeting Days Room Staff Name House Dept. Credit Beg Assigned Open Optimal Max Course Alt

Department: EN  English
0011 ENS7 American Lit 0 0 =2 M T 228 Aderson, G EM D500 30 328 2 29 353
1011 ENST American Lit o 0 52 MT 225 Baniszewski, N. EN 0500 30 28 2 20= 353
1022 EN33 Prin Eng | 0 0 =2 M T 208 Summers, K EM D500 28 33 5 a5 435
1024 ENS1 Lit Explor o 0 52 MT P-21  Robinson, R EN 0500 30 32 2 24 397
1112 EN33 Prin Eng | 1 1 52 MT 301 Bonjour R., R. EN 0500 28 20 g 25 435
1113 EN45 Col Prep Wit 11 =2 M T P10 Bunger T, T EN 0500 28 20 & 22 45
1115 EN34 Prin Eng li 1 1 52 MT P-11  Tormente, J. EN 0500 28 25 3 26 344
1116 EN46 Prin Eng lii 11 =2 M T 231 Gordon, K EM D500 32 28 3 26 160
1117 ENB0 Humanities 1 1 52 MT 413 Gomez, F. EN 0500 45 33 12 33 33
1119 ENBD Eng (brit) Lit 1 1 52 MT 230 Nunes, K. EN 0500 30 30 o 28 S
1121 EN34 Prin Eng li 11 =2 M T 228 Petersen A EN 0500 28 20 & 26 344
1122 EN33 Prin Eng | 1 1 52 MT 208 Summers, K. EN 0500 28 28 o 25 435

MST418—- Class Load Analysis By Department Report Output
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Synergy SIS > Schedule > Reports > List

The Master Schedule Matrix report allows you to select and sort staff schedule load information.
Results sort by teacher name and Section ID. When a teacher has multiple sections for a period,

results sort by day, then Section ID.

7 Report MST419: Master Schedule Matrix

= Print Save Default Email Me

Name: Master Schedule Matrix MNumber: MST419 Page Orientation: Portrait

Options Sort / Output

@ Filters

As of Date
04/01/2019 =]

Period Begin Period End

Term Code O ~ &

[ Year

Department 0 < &

[ CTE: Career/Tech Ed
[JLA: Language Arts

[] PED: Physical Ed
[JRCIV: Req. Civics
[JRGEOQ: Req. Geometry

[J RWS: Req. World Study
[ WLA: World Language

@ Display Options
[] Show Staff Badge Num
[J Show House Code
[] Group by Department
[ Hide Additional Staff
Additional Staff to Display Limit

Staff Responsibility O + &

[JR: Reqular Class
[11: Lead Team Teacher

Conditions Selection

This report prints a maximum of 8 period columns. Any periods outside the range will not be visible.

(] FA: Fine Arts

[ MAT: Math

[JRAH: Reg. AK History
[JREN1: Req. English 1
[JRH: Req. Health

[JRPHS: Req. Physical Science [] RUSG: Req. US Government [[] RUSH: Req. US History

[ SCI: Science

[]S: Special Education Consultant [] C: Co-Teacher

[ 2: Assisting Teacher

[0 A: Absent Teacher of Recard (] P: Course Proctor

Advanced

CIHEA: Health

] OTH: Other

[JRALG: Reqg. Algebra
[JRENZ: Req. English 2
[JRLFS: Req. Live Science

[1S0C: Social Studies

[J U: Long Term Substitute
] L: Student Teacher

MST419— Master Schedule Matrix Report Interface Screen

Report Options:

« As of Date — Display results as of the selected date

« Period Begin/Period End — Enter the beginning and ending periods to display results for.

« Term Code —To select all or clear all terms, use O

- E

« Department — Select which departments to display results for.
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« Display Options — Select which items to display or hide on the report.

« Hide Additional Staff - Removes additional staff from results

« Additional Staff to Display Limit — Only displays the specified number of additional
staff

. Staff Responsibility — Select which staff roles to display as additional staff. To select

- v
all or clear all types, use O ©.

- Hope High School Year 2016-2017
- Master Schedule Matrix Report MST419
Deme Scha! District
pibiiy> As of 05/01/2017
Staff Period 1 Period 2 Period 3 Period 4 Period 5 Period 6 Load
Baniszewski, N 1411 American Lit 24

LD: 26 Day MT
T S2 Gk 0.500
Rm: 228

Bonjour R, R. |12 Prin Eng 1 1212 Prin Eng | 1212 Newslab 1512 Lit Explor 1612 Lit Explor 11
ID: 20 Day: MT  [LD: 24 Day MT LD:23 Day MT LD 24 Day MT LD: 20 Day MT
Tm:S2  Cndk 0500 (Trm:S2  Crd: 0500 [Tom:S2  Crd: 0500 T S2 Cnk 0500 Tm:S2 Crd: 0500
Rmc 301 Fm: 301 Fem: 301 Rm: 302 Rm: 302
Bunger T, T. 1113 Col Prep Wit 1213 Lit Explor 1313 Col Prep Wit 1413 Lit Explor 20
ID: 20 Day: MT  [LD:31 Day MT LD:23 DayMT LD:25 Day MT
Tm:S2 O 0500 Trm: 2 Crk 0500 [Tm:S2  Crdk 0800 Tom 82  Cra: 0500
Rm: P-10 Rm: P10 Rm: P-10 Rm: P10
Creaser. L 1214 Lit Explor 1314 Lit Explor 47
D23 Day MT LD:24 Day MT
T S2 Ced: 0500 [TomS2  Crd: 0.500
Rm: 223 Rm: 223
Gomez, F. 1117 Humanities 1217 Prin Eng | 1317 Senior Lit 1517 Prin Eng | 1617 Prin Eng | 123
ID: 33 Day MT  [LD: 27 Day MT LD: 11 Day MT LD: 25 Day MT LD: 27 Day MT
Tm:S2  Cnd 0500 Trm:S2  Crd: 0500 [Tm:S2  Crd: 0500 TSz Cnk 0500 Tm:S2  Crd: 0500
Rmc 413 R P04 Rm: P04 R P04 Rm: P-4
Gordon, K 1116 Prin Eng lii 1316 Worid Lit 1418 Prin Eng li 1516 Prin Eng li 1616 World Lit 125
ID: 28 Day: MT LD:32 DayMT LD: 27 Dy MT LD: 18 Day MT LD: 18 Day MT
Tm: 82 Crd: 0500 Tom S2  Cr: 0500 Tom 52  Crdt 0500 TamS2 Ok 0500 Trm 52 Crd: 0500
Rm: 231 Rm: 231 Rm: 231 Rm: 231 Rm: 231

MST419 - Master Schedule Matrix Report Output
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MST801 — Program of Recitation Report

Synergy SIS > Schedule > Reports > List

The Program of Recitation Report prints a list of enrolled students in each section with spaces to
make notations for each student. Use this report for student tracking in each section.

¥ Report MST801: Program of Recitation Report

& Print Save Default Email Me

Name: Program of Recitation Report Number: MSTBO1 Page Orientation: Portrait
Options Sort / Qutput Conditions Selection Advanced
As of Date
05/01/2017 |EH
This report prints a maximum of 9 period columns. Any periods outside the range will not be visible.

Period Begin Period End

0 * 9 -

[C] Show Additional Staff

[T show Department Total

[C] Hide Room Name and Widen Load
Term Code ) ** &

[Clyear [ semester 1 [[] semester 2 [l quarter 1

[l Quarter 2 [Clquarter 3 [l Quarter 4 [CI Trimester 1
[C] Trimester 2 [Tl Trimester 3 [C] Hybrid Sem 1 [T Hybrid Sem 2
[C1 Hybrid Qtr 1 Ol Hybrid Qir 2 [CT Hybrid Qtr 3 O Hybrid Qir 4
[T Hybrid Qir 5 O Hybrid Qir 6 [CI Hybrid Qtr 7 O Hybrid Qir 8

[C] summer Semester 1 [l Summer Semester 2 [C] Special Summer Session

Department O + &

[T Fine Arts [C1 Language [C1 math

[T science [7] special Education [ Art

[C] Aerospace Science [T] Agricultural Science [C] Business Education

[C] computer/Business [T English [T Family and Consumer Sciences
[T] Industrial Technology [T] military Science/Leadership Army [C] Music/Performing Arts

[T Physical Education [C] Reading [[] social Studies

[C] Traffic Safety [Cl'world Languages [C] Elementary&School

[ Miscellaneous [C] special Education [l Transfer Credit

[C] East valley Institute of Technology [C] English Language Development [C] American History

MSTB801 - Program Of Recitation Report Interface
Report Options:

« As of Date — Display results as of the selected date

« Period Begin/Period End — Enter the beginning and ending periods to display results for.

« Hide Room Name and Widen Load — Hides the room name to allow extra report space for
notations

o Term Code —To select all or clear all terms, use 0O“E®

« Department — Select which departments to display results for.
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I Hope High School
N, P 9 20 Year: 20162017
. s/‘h " Program of Recitation Report Report: MST801
emo Schsl Distr
e As of Date: 05/01/2017
Badge Period 1 Period 2 Period 3 Period 4 Period 5 Period 6 Dept.
Num Staff Name Crs Title. Room Ld CrsTitle Room Ld  CrsTitle Room Ld Crs Title Room Ld CrsTitle Room Ld CrsTitle Room d  Load
Department: English

1000 Aderson, G. 0
1145 Summers, K Prin Eng | 209 25 FundEngli 209 2 Lt Explor 209 25_Lit Explor 209 % 104
1112 Robinson, R, FundWrting b P-21 1 1
1094 Nunes, K. Eng (orit) Lit 230 30 Prin Eng lii 230 30 Prin Eng lii 230 31 Eng (brit) Lit 230 24 Prin Eng lii 230 20 135
1007 Baniszewski, N ‘American Lit 229 ] 8
1016 BonjourR., R Prin Eng | 301 20 PrinEng | 301 24 Newslab 301 23 302 24 Lit Explor 302 20 1
1024 Bunaer T..T. P10 20 Lit Explor P-10 21 Col Prep Wit P10 23 Lit Explor =0} 3
1152 Torrente, J. P-11 Prin Eng Ii P11 25 Speech P-11 Forensics. P11 9 72
1061 Gordon, K 231 5 World Li 231 32_Prin Eng li 231 231 18 World Lit 231 18 125
1059 Gomez, F. 413 3 Prin Ena | P04 27 Senior Lit P04 11 P04 25 PrnEnal P04 Fij 123
1102 Petersen, A 228 Mythology 228 30 Mythology 228 228 27 Prin Eng i 228 26 132
1105 Rex. K P2 Prin Ena | P22 24 Prin Eng | P22 Engl P22 19 PrinEnal P22 2 121
1167 Webster, M. 29 American Lit 226 20 American Lit 226 30 English Composition 226 15 English Composition 226 19 122
1143 Staufter, P P24 29 Mythooay P24 30 FundEngl P24 18 Prin Eng | P24 25 102
1153 Traylor, K. PrinEna | 2 2 PrinEna | 24 26 PrinEnal 224 30 American Lit 24 31 Americanlit 224 Fij 137
1163 Wallace, J. Lit Explor 203 29 Lit Expior 303 25 Aa AmHis & Lit 303 27 A2 Am His & Lit 303 27 Lit Explor 303 20 128
1134 Sligh Aj, A. Prin Eng 227 24 Prin Eng li 227 27 51
1174 Wrather. L. American Lit 302 30 Americanlit 302 29 PrinEnal 302 25 Vearbook 301 15 Yearbook 30 115
1035 Creaser, L. Lit Explor 223 23 Lit Expior 223 24 a7
1070_Jackson, M Lit Explor P08 21 Lt Explor P09 21_Lit Explor P08 i) [}
11585 Tuzzino, V. Paperback Lit 221 24 Mythology 21 32 PrinEngli 21 23 Mythology 221 26 Prin Eng li 221 2 132
1156 Udall, H. Prin Eng 227 23 American Lit 221 23 American Lit 227 30 Prin Eng | 227 21 103
1099 Parker, D, Prin Eng 225 24 PrinEngli 225 30_PrinEng 25 E3 8
1084 Meik, J. Inter Esi(Lang) 204 11 Inter Esi(Lang) 204 6 204 8 204 3 6
1138 Snyder,J. Cr Think&wit 22 % %
1124 Sawyer, K. App Read li 207 13 App Read li 207 10 E

MSTB801 - Program Of Recitation Report Output
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STU202 - Student Schedule

Synergy SIS > Schedule > Reports > Individual or
Synergy SIS > Schedule > Walk In Schedule > Menu > Reports

The Student Schedule report prints a student schedule that can include personal information. You
can leave all options blank and print the report for all students in the school or select options to print
schedules for select students. School counselors and staff use this report to hand a student their
schedule of classes.

¥ Report STU202: Student Schedule i cee-
Aprint 2 Save Default Email Me
Name: Student Schedule Numoer $TU202 Page Orientation: Portrait
Optons | Sort/Ouput  Condiions  Selection  Advanced
@ Schedule Info

NOTE: Fitter Date is not a mandatory field.

Filter Date

L]
Term Fiter Start  Term Fiter End

Schedule Type

© Student Info

Pem ID
Last Name First Name
Grade  Grade

I

Hide Al Personal Information

Personal Information ® Show Parent Address

Show Parent Address
Hide Perm ID

@ Period Range
Period Begin PeriodEnd @ Perlod Filter
- Periods O =~ &
0018203040506070809

© Grouping Info

Output will be sorted by Teacher Name (ascending) for the Sections defined by Term/Period

Term Period

© sort Options

© Teacher Info

@ Hide Teacher's First Name

© Concurrent Courses

‘Show Courses at Concurrent Schools

@ Include the folowing felds

NOTE: The text box value s displayed if no data is present

Show House Not Assigned
Show Counselor See Counseling Office
Show Locker Number Not Assigned

Show Locker Combination | Not Assigned
Locker Type  Locker Combination to Print

Show Homeroom Teacher

Show Homeroom Number

Show Dropped Classes

Hide Class Perlod

Hide Class Teacher

Hide Class Room

Show Course Fees

Show Additional Staft

© Audt Class Options

Only show audited classes

© Additional Filters
Section ID
-
Course ID
-
Mesting Days  Section Teacher Homeroom Teacher Schedule House (Student) Schedule Team (Student) House (Section) Team (Section)

@ identty Options
Student dentry

Preferred Identiy (Default): The report wil print student name as it appears on the Student > Demographics tab page.

Legal Identity:The report will print student name as it appears on the Student > Protected Information tab page. If values exist. If no values exist on the
Student > Protected Information tab page, then the report will print student name as it appears on the Student > Demographics tab page.

If the user does not make a selection, the report will print name as it appears on the Student > Demographics tab page.

STU202 - Student Schedule Report Interface Screen
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Report Options:

« Schedule Info — Select the date of the report to display or filter the report output for a specified
starting or ending term.

« Schedule Type — Select Full Schedule (Default) or Condensed Schedule.
« Student Info — Select the student information to display results for.
« Personal Information — Select the student and/or parent information to display results for.

« Show Student and Parent Personal Information (Default) or blank — Displays student
and parent personal information.

o Show Student Personal Information — Hides parent personal information
o Show Parent Personal Information — Hides student personal information
« Hide All Personal Information — Hides student and parent personal information

« Period Range — Enter the Period Begin and Period End to display results for
« Period Filter — Filters the report output by selected Periods.

4 3\
Only courses matching the periods selected in the Period Filter
display on the STU202 report.

Selecting Condensed Schedule as the Schedule Type does not
follow the Sort Options selected, but instead sorts by Period, Term,
E and Section ID.

Selecting Blank or Full Schedule (Default) options follow the Sort
Options selected.

The Terms sort and display alphabetically on the STU202 report.

\.

« Grouping Info — Groups results alphabetically by teacher for the Term Code and/or Period
« Sort Options — Select the option used for sorting results.

« Teacher Info— Display or hide the teacher's first name.

« Concurrent Courses — Display or hide concurrent courses.

« Include the following fields — Select to populate fields with a default message if no data is
found.

« Audit Class Options — Select to only display audited classes.
« Section ID — Section ID or a range of section IDs
o Course ID —Course ID or arange of course IDs

« Meeting Days — Displays Meeting Days codes added on the School Scheduling Options
screen

« Section Teacher — Teachers assigned to sections

« Homeroom Teacher —List of all teachers assigned to a class during the designated
homeroom period

Homeroom period is assigned in the Homeroom Period field on
the School Setup screen.

Edupoint Proprietary and Confidential
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Schedule House (Student) — House descriptions added in the House Codes setion on the
House/Team/Exclusion tab of the School Scheduling Options screen

Schedule Team (Student) — Team descriptions added in the Team Codes section on the
House/Team/Exclusion tab of the School Scheduling Options screen

House (Section) — House descriptions added in the House Codes section on the
House/Team/Exclusion tab of the School Scheduling Options screen

Team (Section) — Team descriptions added in the Team Codes section on the
House/Team/Exclusion tab of the School Scheduling Options screen

You can also modify the Student Schedule Sort Options on the
Report Preferences tab of the User Password and Preferences
screen.

Show Additional Staff — Select to show Additional Staff in the Schedule Information section
of the report.

Student Identity — Select the Protected Identity information to display on the report.

o Blank or Preferred Identity (Default) — Prints the student's name as it displays on the
Demographics tab of the Student screen.

« Legal Identity — Prints the student's name as it displays on the Protected Information

tab of the Student screen.

( N\
If the student's name does not exist on the Protected
Information tab of the Student screen, the report prints the
student's name as it displays in the Student Information
section on the Demographics tab of the Student screen. If

E the Student Information section does not contain the student's
name, the student's name prints as it displays on the topmost
section on the Demographics tab of the Student screen.

Student Screen, Protected Information Tab
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\,‘i ‘e Hope High School Year: 2018-2019
e Student Schedule Report: STU202
Student Infarmation
Student Mame Student 1D Gender Grade Address }
Abbott, Billy C. 905483 Mo 12 g
“Last Mame Goes By Mick Mame Birth Date 1955 S Val vista -
Junior 03/14/2001  Mesa Az8sz4 @
Fhane 2-Home Language Resohved Race/Ethnicity Enter Date Leave Date \E
480-867-5309 English White 12/21/2018 o
Schedule Information )
Per Term Section ID Course Meat Days Teacher Room
Fall
0 S1 0840 SC48 - Science 10 Einstein, A. 121
0 S1 0077 5551 - Am Govt Jackson, K. 216
Additional Staff Salcido, Valorie
0 S1 0048 MA30 - Geometry Lewis, J. P-14
1 S1 0153 MA3D0 - Geometry Shacketford, J. 109
1 S1 0106 AR54 - Beg Jewelry Williams, B. 403
Additional Staff Daviz, Paul
Disbrow, Michelle
Donaldson, Keldon
2 S1 0252 MA30 - Geometry Becker A., A 104
2 YR 0258 PABE - Intermediate Acting Chaplin, F. 408
2 S1 0962 PE761 - Weight Tm Boys Shorts, K. ANNX
3 S1 0963 PE761 - Weight Tm Boys Shorts, K. ANNK
4 YR 0402 ARBOW - Ap Studio Art Gunn. G. 401
5 S1 0725 SC48 - Science 10 Schrute, P. 120
& S1 0726 SC49 - Science 10 Schrute, P. 120
7 T 0060 ENSTC - Cc-Am. Lit Twain, P. 230
8 T o046 AGS1 - Landscape D&m | MWF TTh Twain, P. 230
Spring
1 52 1831 PETG2 - Weight Tm Boys Ferrigno, L. ANNX
2 YR 0258 PABSG - Intermediate Acting Chaplin, F. 409
2 52 1242 MA45W2 - Pre-Calculus Hansen, C. 106
2 S52 1962 PE762 - Weight Tm Boys Shorts, K. ANNX
3 52 1369 5551 - Am Gowt Jackson, K. 216
Additional Staff Adams, Mark
4 YR 0402 ARBOW - Ap Studio Art Gunn. G. 401
Parent Information
Parent Name Phone Extension @ Type
MAaron, Kathleen 480-555-1214 Home
MAaron, Phillip EEE- - RRRR Work
* = Audit Class
Printed by Admin User at 01/08/2019 1:49 PM Edupaint School District Part 1 of 1/ Page 1 of 1
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\J

Demo Scheol District
Ercelience i Eduatien

Student Information

Parent Information

Parent Name Phone Extension Type
Ackley, Eugene 480-555-6641 Home
Ackley, Paula 480-555-6641 Home

~— Hope High School
-~ Student Schedule

Student Name Perm ID Gender Grade Track  Address }
Ackley, Brian R. 913948 Mo 12 x
@
Last Mame Goes By Nick Name Birth Date 3945 E Kael Ci ':<
03/11/2001  TemPeAZ8%83 o
Phone Home Language Resolved Race/Ethnicity Enter Date Leave Date E’
480-555-6641 Korean White 07/05/2018 S
Schedule Information I'
Per Term SectionID Course Meet Days Teacher Room
] 52 1011 EN57 - American Lit Keating, J. 229
3 S1 0310 CB20 - Web Page Design Richardson, J. 111
5 51 0522 EN32 - Fund Eng Il Johnson, L. 209
6 51 0616 EN62 - World Lit Shakespear, B. 231
i YR 0957 EN091C - 9th Eng-Corr Twain, P. 230

Year: 2018-2019
Report: STU202

Address

3945 E Kael Ci
Tempe, AZ 85663
3945 E Kael Ci
Tempe, AZ 85663

STU202 - Condensed Student Schedule Output

In this example, the Terms sort and display in alphabetical order on the STU202 report output for the

following selections made on the STU202 Report Interface screen.

7 Report STU202: Student Schedule

& Print Save Default

Name: Student Schedule Number: $TU202 Fage Orientation: Portrait

Options Sort / Output Conditions Selection Advanced

@ Schedule Info

NOTE: Filter Date is not a mandatory field.

Filter Date

&

Term Filter Start  Term Filter End

Schedule Type

Condensed Schedule |
® Student Info
@ Period Range

Period Begin Period End @® Period Filter

T v Periods O = &
O102M3M40506 078910

STU202 - Student Schedule Report Interface Screen
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Hope High School Voo 0163019
Student Schedule Report ST
Information
i Hare e 10 Cander Casds Aodress
Abbott, Billy 1315252 [ ] 12
O M Mick Hame Bt Umiw 1268 2 val M
- 0SHAr2000 | Mesa Az 08

Fhone Home Langusga Fadera Enic Coda E=im Carla Lewve [hrla
5512314 Columbia White 0ARERA1E
Sechedue Infamation
Per Termmn | ZecSon ID COuUrcs Moot Daye Teacher Rooem
3 27 | TI00E3-04 730032 -Healn A FE S & CE (Eobl, K YR
3 &2 TI00E202 730032 -Healn A FE 2 A CE Eorobl, K GYH
4 | =001 T 500 - Driver Ed Class cE Mlier, B
4 a2 TOHS0002 701500 - Driver Ed Class ocE Mlier, M.
4 3 TH=0003 T 500 - Driver Ed Class cE Milier, B
4 = TOHS0004 701500 - Driver Ed Class ocE Mlier, WM. Mod 2
4 &l A9 15032 - Tirigonamestry & Person, G, [Espy
4 &2 INs=E320 315432 - Disorete Maih . Person, O, Loy
T | IL30002 314300 - Geometry AT Wilkames, ) 126
T a2 34430008 314300 - Geomeiny AT Moga, M. LG o=
T 3 JL3000s 314300 - Geometry A Tayior, B e B
T =4 i ZR516 - Adw Treble Thoms AT Besbbooach, L. 1158
B 3 Tan=ss1 740559 - Healkh & FE 10 ACE FCPS OnlineCamp 599
2] 24 S T-04 33847 - Adwanced Orchesira A& CE Momson, A 120
B &l B1AT=S3 812099 - Ecom & Pers An ACcE FCPS OnlneCamp 599
g -y ] ooa114-08 DO0A11 - L=aming Samirar 1 4] Ecabnooach, L.
L 22 ooo114-47 DO011 - Leaming Semirar 1 c Browm, HL
g 23 ooo1 1402 DO0A11 - L=aming Samirar 1 4] Ao, B
L 24 ooo114-10 DO011 - Leaming Semirar 1 c B, A
g 27 | ooo114-42 D001 - L=aming Samirar 1 B Bascifiord, .
L B2 ooo1110s DO011 - Leaming Semirar 1 B ARE, .
g YR ooa114-e3 D001 - L=aming Samirar 1 & Hugrss, &
Parent Information
Parant Mams Fheoris Extencion |Type Agdrecs
Abatris Mol GEE-1234 Parert Cal 14E0 5 Val Wikls

Mesa, AT 55206
Ahatris Sobin GEE-1234 Parert Cal 14E0 5 Val Wikls

Mesa, AT 55206

Ang ‘nogay

STU202 - Student Schedule Report Output
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377

Synergy SIS > Schedule > Reports > List or
Synergy SIS > Schedule > Section > Menu > Reports

The Class List prints the list of enrolled students in each section on a separate page with a space to

make notations for each student. Use this report for student tracking.

7 Report STU408: Class List .

o= Print Email Me

Save Default Resel Saved Default

MWame: Class List Number: STU408 Page Crientation: Portrait

Options Sort § Quiput Conditions Selection Advanced

® Report Options

Term Code Students Active in Class as of
= E
Section ID
-
Course ID
-
Grade Grade
- - -
Period Period
- -
Teacher
Depariment
Hide Totals

Exclude Students with Term Override not in Term Code

@ Include the following fields

MOTE: If width text box is empty, default values are used.

Student Name 1.40 width in inches
Ferm ID 0.75 width in inches
State ID 0.75 width in inches
Ed-Fi 1D 0.75 width in inches
Gender 0.29 width in inches
Grade 0.30 width in inches
Ethnic Code 1.00 width in inches
Birth Date 0.65 width in inches
Enter Date 0.68 width in inches
Home Language 1.00 width in inches
Phone Mumber 0.88 width in inches
House 1.00 width in inches

ACJE

cCeeo

STU408- Class List Report Interface Screen
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Report Options:

« Report Options — Select the information to display results for.

« Hide Totals — Hides total students from the report

« Exclude students with Term Override not in Term Code — Only hides override
students

« Include the following fields — Select which fields to display. If Width in inches is left blank, the
system uses default spacing.

\J\.._ Hope High SChOO' Year 2016-2017
e st i Class List Report: STU403

Section ID Period Meet Days Course ID Course Title Staff Name Room Name
0152 1 MT MA40 Algebra ll Becker A., Allison 104
Student Name Perm ID Grd

Barlingay, Jessica C. 148570 12

Brooks, Jerry W. 889742 11

Duffel, Alice N. 887967 1

Ertl, Katherine L. 957922 10

Falkenberg, Beverly M. 902953 10

Fares, Julia C. 133744 11

Ferrin, Rebecca 887438 11

Flynn, Heather A. 905698 11

Geddes, Sara 856261 11

Gerber, Eric M. 894068 11

Harris, Ann L. 868416 11

Harris, Dennis J. 883194 11

Hiatt, Kelly M. 888751 1

Huish, Patrick A 909255 10

Johnson, Chris J 936554 10

Joy, Randy P. 908356 11

Kumar, Willie 153876 10

Lindstrom, Dorig G. 8585993 11

Lynn, Stephanie N. 892178 1"

Neumann, Johnny T. Il 937495 "

Okamura, Keith K. 950254 11

Ortega, Pamela 937071 11

Russell, Judith 903176 10

Saager, Philip T_ 109614 1"

Stapley, Phillip D. 886244 11

Teague, Ann R. 143045 10

Tipton, Ryan J. 903277 10

Udall, Wanda 908194 10

Zamudio, Jane 135300 12

Total Students: 29 Total Female: 16 Total Male: 13

STU408- Class List Report Output
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STU408.L — Class List

Synergy SIS > Schedule > Reports > List or
Synergy SIS > Schedule > Section > Menu > Reports

The Class List prints the list of enrolled students in each section on a separate page with a space to
make notations for each student. Use this report for student tracking.

¥ Report STU408.L: Class List

& Print Save Default Email Me L

.
IS
p-

Mame: Class List Number: STU408.L Page Orientation: Portrait
Options Sort / Output Conditions Selection Advanced

® Report Options

Term Code Students Active in Class as of:
~ | | 043002019 ]
Section ID
-
Courze ID
=

Grade  Grade
- | =* -

Period Period
- - -

Teacher
Department

[] Hide Totals
|:| Exclude Students with Term Override not in Term Code

|:| Group Students By Period

Mote: Additional Sort Options display if Show Term is selected. Meeting Days are not displayed if Do Not Show Meeting Days is
selected. If an option is selected from the additional zort options, the sorting opticns selected on the "Sort/Output™ tab will no

longer take effect.
Do Mot Show Meeting Days Show Term
(Il
® Meeting Days @ Sort Options
WMeeting Days Sort Options
D WWE D TTh |:| Test WMeeting Days, Period, Term | =

STU408.L - Class List Report Interface Screen
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® Include the following fields

NOTE: If width text box is empty, default values are used.
Student Name 1.40 | width in inches
[0 perm ID 0.75 | width in inches
[0 state ID 0.75 | widih in inches
[[] Gender 0.29 |width in inches
[[] Grade 0.30 |width in inches
[C] Ethnic Code 1.00 | width in inches
[T Birth Date 0.68 | width in inches
[C] Enter Date 0.68 |width in inches
[C] Home Language | 4.00  width in inches
[T Phone Number 0.88 |width in inches
[ House 1.00 2 width in inches
[[] Team 1.00 & width in inches
[T Counselor 1.40 2% width in inches

STU408- Class List Report Interface Screen
Report Options:

« Hide Totals — Hides total students from the report

o Exclude students with Term Override not in Term Code — Only hides override students
« Do Not Show Meeting Days — Select this option to hide the Meeting Days section.

« Meeting Days section — Select the meeting days as needed.

« Show Term — Select this option to show the Sort Options section.
« Sort Options section — Select the order the report displays. For example, Meeting Days,
Period, Term.

« Include the following fields — Select which fields to display. If Width in inches is left blank, the
system uses default spacing.

Hope High School Year: 20182019
Class List Report: STU408.L

Section ID Period Term Course ID
0140 I 1 51 I MA40

Meet Days
MWEF-1

Course Title
Algebra ll

Teacher Name

Room Name Secfion”
Cruise, Thomas 128

Student Name Stud
Adams, Billy A

Bingham, Janice

Bowser, Kathryn J.

Cabrera, Daniel C.

Clark, Martha K.

STU408.L — Class List Report Output
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STU414 — Student Schedule Preprinted Cards

Synergy SIS > Schedule > Reports > List

The Student Schedule Preprinted Cards are designed to be printed on perforated stock to create
wallet-sized cards with each student’s schedule. Four cards print per page.

o Print

Options
(® Schedule Info

As of Date

@ Student Info

Perm ID

Last Name

Grade

-

Grade
v =

@® Display Options

@ Flags

Ed. Rights
Has Custody
#| Lives With

@ Locker Info

@ Grouping Info

Term

7 Report STU414: Student Schedule Preprinted Cards

Save Default

Name: Student Schedule Preprinted Cards Number STU414 Page Orientation: Portrait
Sort / Output

Display Teacher Name

@ Parent/Guardian Relations

Contact Allowed

Mailings Allowed

Locker Combination

Qutput will be sorted Teacher Name (ascending) for the Sections defined by Term/Period. Grouping by Term or Period
will override a Counselor Name sort.

ALE

Email Me !

Conditions Selection Advanced

Term Filter Start  Term Filter End

- -

First Name

Hide Room Number Use Course Short Title

@ Type
Relation O ~ &

Biological Father [ Biological Mother

Father Father in Home
Foster Father Foster Mother
Grandfather Grandmother
Guardian Mother

Maother in Home Other

Step-Father Step-Mother

-

Period

STU414 - Student Schedule Preprinted Cards Report Interface Screen
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Report Options:
« Schedule Info — Select the schedule information to display. The report prints up to nine
classes for a student.
« Student Info — Select the student information to display results for.
« Display Options — Select which items to display or hide on the report.
« Parent/Guardian Relations — Select which parents/guardians to print on the reports
» Locker Info—Displays the Locker Combination
« Grouping Info — Groups results alphabetically by teacher for the Term Code and/or Period

Abbott Paulette 997053 10123/2003 08 Chartton Wiolet 997051 02/28/2017 1)
Hope High School 20-15-41 oso12mT Hope High School 020172017

1 6005 SC402 Biology 1 6005 SC40Z Biology

2 0205 AR4Z  IntStein Glass Smith, Christine 02 2 0208 ARS4  Beg Jewelry Sullivan, Joe 403

3 0332 EN33  PrinEngl Wrather, Lendon 302 3 0328 ENST  American Lit Traylar, Kelly 224

4 8002 AG31  Animal Soi Baniszewski, Nancy 108 4 D421 ENS2  Mythology Petersan, Angela 228
Abbott, Virginia 430-100-2000 0441112017 Chartton, Vivian 021282017
748 W Keating Cir Newport Beach 92661 3434 N Fairview Mesa 85204
Dysert Holly 997046 03r14/2002 09 Haase Susan 997037 071372001 [es)
Hope High Schoal 05012017 Hope High School 05/01/2017

1 8005 BSC402 Biology 1 6005 SC402 Biology

2 0205 AR42  IntSisin Glass Smith. Christine 402 2 0205 AR42  Int Stain Glass Smith, Christine 402

3 0317 EN44  Creative Wit Gomez, Fortino P04 3 0217 EN44  Crestive Wrt Gomez. Fortine P-D4

4 6002 AG21  Animal Sci Baniszewski, Nancy 100 4 6002 AG31  Animal Sci Baniszewski, Nancy 100
Miller, Lomraine 02062017 Haase, Edmond 01/0472017
1855 5 Val Vista Dr Mesa 85204 1855 5 Val Vista Or Mesa 85204

STU414 - Student Schedule Preprinted Cards Report Output
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STU415 — Student Schedule List

Synergy SIS > Schedule > Reports > List

The Student Schedule List prints each student’s schedule with basic information about each section,
including Period, Term, Section ID, Course ID, and Meeting Days.

7 Report $TU415: Student Schedule List

o= Print Save Default Email Me

Mame: Student Schedule List Number: 5TU415 Page Orientation: Portrait
Options Sort / Qutput Conditions Selection Advanced
@ Schedule Info

NOTE: A= of Date i= not a mandatory field.
As of Date

=
Term Fitter Start ~ Term Filter End

- -

@ Student Info
Perm ID

Last Mame First Name

Grade Grade
- - -

Hide Perm ID

@ Grouping Info

Output wil be sorted by Teacher Name (ascending) for the Seclions defined by Term/Period.

Term Period

@ Sort Options

@ Teacher Info

Hide Teacher's First Name

@ Concurrent Courses

[] show Courses at Concurrent Schools

@ Course Info

|:| Indicate Prescheduled Courses

STU415- Student Schedule List Report Interface Screen
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Report Options:

» Schedule Info — Select the schedule information to display.

« Student Info — Select the student information to display results for.

« Grouping Info — Groups results alphabetically by teacher for the Term Code and/or Period
« Sort Options — Select the option used for sorting results.

« Teacher Info — Display or hide the teacher's first name

« Concurrent Courses — Display or hide concurrent courses

« Indicate Prescheduled Courses — Adds a column to the output that indicates the courses
that were scheduled prior to running master schedule processes

a Kennedy High School Year 2018.2019
-~ Student Schedule List Report: STU415
Deme School Districk
Per Term Section ID Course Meet Days Teacher Room Prescheduled
Student Name Abbott, Billy C. Perm ID 905483 Gender M Grade 12
Fall
1 & 1100 AR32 - Beg Photo Benitez, 5. 415 Y
1 81 1100 AR32 - Beg Photo Benitez, S. 415 N
2 51 0200 AR33 - Int Photo Benitez, S. 415 N
2 5 0202 AR41 - Beg Ceramics Waorm, F. 334 N
3 1301 AR41 - Beg Ceramics Worm, F. 334 N
4 81 0300 AR32 - Beg Photo Benitez, S. 415 N
4 81 0400 ARE3 - Beg Drawing Warm, F. 336 N
5 s 1505 ARE3 - Beg Drawing Worm, F. 336 N
6 S1 1501 ARS4 - Beg Jewelry Hargrove, C. 324 Y
& 31 1501 ARS54 - Beg Jewelry Hargrove, C. 324 N
8§ 51 1821 WES0 - Yearbook Committ Snapp, J. 014 N
8 3 1821 WES0 - Yearbook Commit! Snapp, J. 014 Y

STU415 - Student Schedule List Report Output
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Synergy SIS > Schedule > Reports > List

The Section Seating Chart reports all students in a class and their location in the classroom based

on the seating chart created in TeacherVUE.

7 Report STU419: Section Seating Chart

o Print Save Default Email Me

Name: Section Seating Chart Number: STU419 Page Crientation: Landscape
Options Sort / Output Conditions Selection Advanced

Section ID Staff

TermCode O + &
Quarter 4 L) Semester 1 L Semester 2 L Year
(® Content Options

Absences Text Field 1
Absences Text Field 2

Absences Text Field 3

(® Display Options

Show Primary Section Only  Page Crientation

cre-e

STU419 - Section Seating Chart Report Interface

Report Options:

Section ID — Select the section to report.
Staff — Select the Staff to display results for.

- I
Term Code — To select all or clear all term codes, use O © .

Content Options — Enter custom text in the Absences Text Field 1-3 to create abbreviations

for the absence codes displayed under student portraits.
Display Options

« Show Primary Section Only — Displays only the primary section in the section area

on the report output rather than the entire list of sections

« Page Orientation — Allows you to select Portrait or Landscape orientation. Landscape

is the default.
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Deme Schasl Distriet
Excutare n teusaiten

Staff Becker A_, Allison

Barlingay, Jessioa C.

148570

abs[] Tay[] Pres[]

BAGT42
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STU420 — Lunch Count Totals

Synergy SIS > Schedule > Reports > List

The Lunch Count Totals lists all homerooms at an elementary school and the lunch counts for each
section entered through TeacherVUE. You can set up items tallied for each section on the
TeacherVUE tab within the School Setup screen.

v Report STU420: Lunch Count Totals

& Print | | Save Default Email Me

Name: Lunch Count Totals Number: $TU420 Page Orientation: Portrait
Options Sort / Qutput Conditions Selection Advanced

Run Date
05/01/2017 &

STU420- Lunch Count Totals Report Interface Screen

Report Options:

o Run Date — Select the date to run reports as of

e Adams Elementary e B01E.2017
n Lunch Count Totals Regon: STU420
Crganization Namea ©  Adams Elementany Fun Date - DSAOAI204T
ty
X of
Eecton D Teacher Same 5 F mf
mas Everin, Casey =2 g =
1) u] Eingram, Cars 11 *6 -]
1 Bayriz, Cymitnia 5 28 ri
Exchool Totsks = 2 i o 1] 1] a 1] o a

STU420- Lunch Count Totals Report Output
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STU423 — Student Classes Audit

Synergy SIS > Schedule > Reports > List

The Student Classes Audit shows each class assigned to a student and any changes that made to
the schedule for the date range. It displays the user that made the change and the date they edited

information.
v Report STU423: Student Classes Audit
& Print || Save Default Email Me

Name: Student Classes Audit Number: 8TU423 Page Orientation: Landscape
Options Sort / Output Conditions Selection Advanced
@ Schedule Information
Start Date End Date

07/04/2016 @ 09/01/2017 &=

@ student Information

First Name Last Name
abbott

Perm 1D

Grade

[lo7 o8 [0 [E10 E11 12

[ Exclude Deletes  [C] Exclude Inserts

STU423 - Student Classes Audit Report Interface

Report Options:

» Schedule Information — Select the schedule information to display.
« Student Information — Select the student information to display results for.
« Exclude Deletes/Exclude Inserts — Excludes deleted or inserted classes from results
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i\r Hope High School ) Year  2016-2017
—— Student Classes Audit Report: $TU423
e e From 07/04/2016 to 05/01/2017

Student Name Gender Grade Student ID
Abbott, Billy C. M 12 905483
Property Name Old Value | New value | Timestamp | Updatea By | IP Address System
Period:1  [Term: S1 Section 1D: D077 [Course ID: s851 |Course Title: Am Govt |Teacher: Jackson, Kathy |Room: 216
LeaveDate 0972012016 09/21/2016 10:4028 | User, Admin 102001191 SYNERGY
TxpAckDrop Y 09/22/2016 124531 | Jackson, Kathy 9622920966 | TVUE
EnterDate D7/05/2016 07/D6/2016 10/02/2016 065046 | User, Admin 1020011107 | SYNERGY
LeaveDate DO/20/2016 09/19/2016 10/26/2016 104317 | User, Admin 1020011 111 SYNERGY
Period:1  [Term: YR | Section ID: 100000000 [Course ID: SC422 [Course Title: Life Science [Teacher: Tofft, Robert |Room: 120
TxpAckAdd Y 10/31/2016 15:42:46 | Tofft, Robert 10.200.11.130 | TVUE
LeaveDate 1172512016 11/30/2016 14:0021 | User, Admin 1020011130 | SYNERGY
TxpAckDrop Y 12/09/2016 16:13:48 | Tofft, Robert 1020011 84 TVUE
Period:2  [Term: 52 Section ID: 000000123 [Course ID: AD26W  [Course Title: Academic Decath  [Teacher: Arthur A, Andr [Room:
EnterDate D3/22/2017 | 0172812017 | 0312612017 07:22:52 | Sherwood, Bev | 10.200.11.80 SYNERGY
Period:2  [Term: 51 Section ID: 0206 [Course ID: AR54 |Course Title: Beg Jewelry |Teacher: Sullivan, Joe |Room: 403
LeaveDate 1112512016 02/24/2017 142641 | User, Admin 10.200.11.93 SYNERGY
AuditClass N 10/25/2016 10:33:02 | User, Admin 102001191 SYNERGY
EnterDate 10/25/2016 10/25/2016 10:33:02 | User, Admin 10.200.11.91 SYNERGY
QualifiesForAlt N 10/25/2016 10:33:02 | User, Admin 102001191 SYNERGY

STU423- Student Classes Audit Report Output
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STU806 — Schedule Verification Extract

Synergy SIS > Schedule > Reports > Extracts

The Schedule Verification Extract displays the student results generated on the Schedule
Verification screen. This displays Schedule Based FTE values and details for students with different
filter options, such as Student, Schedule, and Section.

[\
See Schedule Verification for more information.

7 Report STU806: Schedule Verification Extract i sde-

& print 2 Save Default Email Me

Name: Schedule Verification Extract Number STU806 Page Orientation: Portrait

Options Sort / Qutput Conditions Selection Advanced
©® student Filters
Filter By
Filter To

&

Counselor
Grade

0g 10001 12
Exclude ADAADM O = &

Needs Cnly (No ADM) L] Concurrent [ Exclude From State Reporting

EnterCodes O = &

E1 E2 JE3 B4 JES OJE6 LJE7 [ EB E9
R1 R2 LJR3 LJR4 LIRS LIR6 LIR9 LIR10 LIRM
RD CIRP

E10
R12

® Schedule Filters
FTE

From To

il

® Section Filters

Report To State  Include In Attendance Condition

Use Student FTE Use Total Student FTE looks at the student's District FTE calculation
& Remove FTE Segments with no valid days instead of just the calculations at each individual organization

Section Threshold

STU806 — Schedule Verification Extract Report Interface Screen
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Report Options:

« Student Filters — Select the student information to display on the report. These are the same

fields as those located on the Schedule Verification screen.
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7

\.

The Exclude ADA/ADM and Enter Codes filter options allow you to filter

students by Enter Code and exclude certain students’ enrollment segments

from displaying on the report based on the student's ADA/ADM selection

on the Enrollment History tab of the Student screen.

Needs Cnly (No ADM)

# E1
R1
RD

Exclude ADA/ADM O <= &

EnterCodes O < &

E3 /B4 LIES
R3 LIR4 LIRS

BES LJEV LIEB
R6 LIRS LIR10

Concurrent # Exclude From State Reporting

E9 E10
R11 LI R12

STUB806 — Schedule Verification Extract Report Interface Screen

J

» Schedule Filters — Select the FTE values to display on the report. These are the same fields

as those located on the Schedule Verification screen.

« Section Filters — Select the sections to display on the report. These are the same fields as

those located on the Schedule Verification screen.

i . .
\,-» Edupoint Mlddlt? School Vear 2016.2017
e School Disric Schedule Verification Extract Report: STUS06
Student Sis Number Organization Dates Grade FTE Method
Aaron, lan 12345 Edupoint Middle School 09/07/2016 - 06/16/2017 08 1.00 Hours
Aaron, Robert 12346 Edupoint Middle School 09/07/2016 - 09/30/2016 08 1.00 Hours
Abbott, Billy 12347 Edupoint Middle School 10/03/2016 - D6/16/2017 08 0.00 Hours
Abbott, Bobby 12348 Edupoint Middle School 09/07/2016 - 09/07/2016 08 0.00 Hours
Abbott, Jane 12349 Edupoint Middle School 09/08/2016 - 06M16/2017 08 1.00 Hours
Atbott, Matthew 12350 Edupoint Middle School 09/07/2016 - 09/07/2016 o7 0.00 Hours
Atbott, Susan 12351 Edupaint Middle School 09/08/2016 - 06/16/2017 o7 1.00 Hours

STUB806 — Schedule Verification Extract Output
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STU810 — Grade Book Extract

Synergy SIS > Schedule > Reports > Extracts

The Grade Book Extract is a text file designed to be imported into a third-party grade book program.
It includes the student’s Last Name, First Name, Perm ID, Gender, Grade, and Email.

s Select Excel as the File Type in the Sort/Output tab in order to view all
=l data.

Y Report STU810: Grade Book Extract «Tree

o print Save Default Email Me

Name: Grade Book Extract Number: STU810 Page Orientation: Portrait

Options Sort / Output Conditions Selection Advanced
@ Sstudent Info
Perm ID
Last Name First Name:
Grade Grade
- - -

@ Grade Book Extract

Extract Type
Easy Grade Pro Extract | =

STU810- Grade Book Extract Report Interface Screen
Report Options:

« Student Info — Select the student information to display results for.
» Grade Book Extract — Select which Extract Type format to print the extract in: Easy Grade

Pro Extract or Grade Quick.

A B = D E F G H [} ] L M
1 |Abbott Billy 905483 12 person@mail 444-444-4444 5407 N Alma SchoolRd ~ Tempe  AZ 85204 206 AR5 Beg Jewelry
2 Abbott  Billy 905483 12 person@mail 444-444-4444 5407 N Alma SchoolRd ~ Tempe AZ 85204 426 EN6O Eng (brit) Lit
3 Abbott  Billy 905483 12 person@mail 444-444-4444 5407 N Alma SchoolRd ~ Tempe  AZ 85204 77 5851 Am Govt
4 Abbott  Billy 905483 12 person@mail 444-444-4444 5407 N Alma SchoolRd  Tempe  AZ 85204 957 EN09LC 9th Eng-Corr
5 Abbott  Billy 905483 12 person@mail 444-444-4444 5407 N Alma SchoolRd ~ Tempe  AZ 85204 1504 AR32 Beg Photo
6 |Abbott  Billy 905483 12 person@mail 444-444-4444 5407 N Alma SchoolRd ~ Tempe  AZ 85204 304 AR32 Beg Photo
7 Abbott  Billy 905483 12 person@mail 444-444-4444 5407 N Alma SchoolRd ~ Tempe  AZ 85204 726 SC49 Science 10
8 Abbott  Billy 905483 12 person@mail 444-444-4444 5407 N Alma SchoolRd ~ Tempe  AZ 85204 60 ENS7C Cc-Am. Lit
9 Abbott  Billy 905483 12 person@mail 444-444-4444 5407 N Alma SchoolRd  Tempe  AZ 85204 800 5C422 Life Science
10 Abbott  Billy 905483 12 person@mail 444-444-4444 5407 N Alma SchoolRd  Tempe  AZ 85204 1207 AS33 Afjrotc i
11 Abbott  Billy 905483 12 person@mail 444-444-4444 5407 N Alma SchoolRd ~ Tempe  AZ 85204 123 ADSEW Academic Decath
12 Acosta Eugene 873921 12 person@mail 480-555-6396 1144 N Loma Vista Tempe AZ 85662 123 ADBEW Academic Decath
13 Adams  Howard 873985 12 person@mail 480-555-1964 1328 N 22nd St Tempe AZ 85662 870 NC301 Rel Time A Hr
14 Adams  Howard 873985 12 person@mail 480-555-1964 1328 N 22nd St Tempe AZ 85662 28 NC501 Study Hall
15 Adams  Howard 873985 12 person@mail 480-555-1964 1328 N 22nd St Tempe AZ 85662 1571 S552W2 Ap Amer Govt
16 Adams  Howard 873985 12 person@mail 480-555-1964 1328 N 22nd St Tempe AZ 85662 571 SS52W Ap Gov&econ Wip
17 Adams  Howard 873985 12 person@mail 480-555-1964 1328 N 22nd St Tempe AZ 85662 996 NC401 Pers Rel Time
18 Adams _ Howard 873985 12 person@mail 480-555-1964 1328 N 22nd 5t Tempe A7 85662 123 ADBEW Academic Decath

STU810- Grade Book Extract Output
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Security Overview

The PAD Security screen (Synergy SIS > System > Security > PAD Security) and the Security
Definition screen (Synergy SIS > System > Security > Security Definition) define security for
each of the screens discussed in this guide. This section outlines the security location for each of the
screens within Security Definition.

4 )
Edupoint recommends that users only secure reports through PAD

L Security instead of the Security Definition screen. )

7

See the Synergy SIS — Security Administrator Guide for more details

L regarding security definitions.
7
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Screen

Assign Students to
Sections

Bell Schedule
Definition

Class Assignment

Course Group

Course Request
Analysis

District Course

End Term

PAD Location

Schedule

Schedule > Setup

Schedule

Course

Mass Scheduling

Course

Schedule

Tab

By Student
N/A

N/A

N/A

N/A

Course
Description

N/A

Course

Description

Year Override

Pre/Corequisite

Opt In Options
N/A

Grid/Pop-Out
Screen

Students

Allexcept Students
Bell Schedule
Definition
Allexcept Bell
Schedule Definition
Students

Classes

Group Courses
N/A

N/A

All

Allexcept Alternate
Codeand CTE
Programs
Alternate Code
CTE Programs

All

Alternate Code

Course Subject
Areas

Qualifies for Alt
State Funding

Technical Course
Corequisite

Prerequisite

OptIn Types
N/A

Field

All
All

All

All

All
All
All
Name
All

All

All

All
All
All
All

All

All

All
All

All except Valid
Marks

Valid Marks
All
All
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Security Node

K12.Schedulelnfo.MassAssignmentSectionGrid
K12.Schedulelnfo.MassAssignSections

K12.Schedulelnfo.BellScheduleGrid

K12.Schedulelnfo.SchoolYearBellSched

K12.Schedulelnfo.MassAssignStuGrid
K12.Schedulelnfo.MassAssignSectGrid
K12.Courselnfo.CourseGroupCourses

K12.Courselnfo.SchoolYearCourseGroup

K12.Schedulelnfo.MassSchedulelnfo.CourseRegAnalysisGrid

K12.Courselnfo.Course

K12.Courselnfo.CourseAltCode
K12.Courselnfo.CourseToCTEProgram
K12.Courselnfo.Course
K12.Courselnfo.CourseAltCode

K12.Courselnfo.CourseOverride

K12.Courselnfo.CourseAltFunding

K12.Courselnfo.CourseTechnicalCourse
K12.Courselnfo.CourseCoReq

K12.Courselnfo.CoursePreReq

K12.Courselnfo.CoursePreRegMark
K12.Courselnfo.CourseSchoolType
N/A
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Screen

PAD Location

Grid/Pop-Out
Screen

Security Node

Mass Assign
Course Requests

Mass Assign House
and Team

Mass Assign
Sections

Mass Assign Track

Option Set Wheel
(Open Option Set
Wheel under Quick

Links)

Period Rotation
Definition

Prerequisite Course
Group

Schedule Control

Mass Scheduling

Mass Scheduling
or Schedule

Mass Scheduling

Schedule

Mass Scheduling
> Schedule
Control, then select
a Scheduler option
set

Schedule > Setup

Course

Mass Scheduling

Mass Assign

Selected Students
Other Info
Options
Additional Filters

Mass Assign

Student Selection
N/A

N/A

Rotation Days
Rotation Periods

N/A

N/A

All except Courses
To Add and
Courses To Find
and Replace
Courses To Add
Course To Find and
Replace

All

All

All

All

Allexcept sections
noted below
Sections To Add
Sections To Find
and Replace
Student Filters

All

All

All except Option
Grid Detail

Option Grid Detail

All
All

All except
Prerequisite Detail
Prerequisite Detail
All

Edupoint Proprietary and Confidential

All

All

All
All
All
All

All
All
All

Grade
All
All

All

All

All
All

All

All
All

K12.Schedulelnfo.MassSchedulelnfo.SchedMassAssign

K12.Schedulelnfo.MassSchedulelnfo.SchedMassAssignToGrid
K12.Schedulelnfo.MassSchedulelnfo.SchedMassAssignFromGrid

K12.Schedulelnfo.MassSchedulelnfo.SchedMassAssignStuGrid
K12.Schedulelnfo.MassSchedulelnfo.SchedMassAssign
N/A

K12.Schedulelnfo.MassAssignStudentConditionGrid
K12.Schedulelnfo.MassSchedulelnfo.SchedMassSectionUpdate
K12.Schedulelnfo.MassSchedulelnfo.SchedMassSectionUpdate ToGrid
K12.Schedulelnfo.MassSchedulelnfo.SchedMassSectionUpdateFindGrid

K12.Schedulelnfo.MassSchedulelnfo.SchedMassSectionUpdateGrades
K12.Schedulelno.MassSchedulelno.SchedMassSectionUpdateStu
N/A

K12.Schedulelnfo.MassSchedulelnfo.OptionSchedWheelGrid

K12.Schedulelnfo.MassSchedulelnfo.OptionSchedWheelDetailGrid

K12.Schedulelnfo.RotationDefinitionGrid
K12.Schedulelnfo.RotationPeriodDefinitionGrid

K12.Courselnfo.PreReqGroupCourse

K12.Courselnfo.PreReqGroupCourseMark
K12.Schedulelnfo.MassSchedulelnfo.OptionSet
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Grid/Pop-Out
Screen

Schedule and Course Guide

Chapter 13: Security 397

Security Node

Schedule Option
Set

Schedule Request

Schedule Section
(Open Schedule
Section under
Quick Links)

Schedule Student

(Open Student

Schedule under
Quick Links)

Mass Scheduling
> Schedule
Control, then select
a Scheduler option
set

Mass Scheduling

Mass Scheduling
> Schedule
Control, then select
a Scheduler option
set

Mass Scheduling
> Schedule
Control, then select
a Scheduler option
set

Options

Fill Open Periods

Requests

Restrictions

Current Students

Meeting Days

Requests
Analysis

Schedule

Enforce the
following rules

Quick Links

Exclude the
following students

All
Student Requests

Alternatives for
Electives

Student Restrictions

Teacher
Restrictions

Allexcept Students

All

Course Requests
All

All

Exceed max class
size for CORE
classes by this
%, Exceed max
class size for
ELECTIVE
classes by this
%, Exceed max
class size for
OTHER classes
by this %

All K12.Schedulelnfo.MassSchedulelnfo.OptionSetUI
Do Not Process
the Following
Grade Levels

K12.Schedulelnfo.MassSchedulelnfo.OptionSet

K12.Schedulelnfo.MassSchedulelnfo.OptionSetGradeList

Do Not Process
the Following
Houses

K12.Schedulelnfo.MassSchedulelnfo.OptionSetHouseList

Do Not Process

the Following K12.MassSchedulelnfo.OptionSetTeamList

Teams

All K12.Schedulelnfo.MassSchedulelnfo.OptionSet

All K12.Schedulelnfo.MassSchedulelnfo.StudentRequestGrid

All K12.Schedulelnfo.MassSchedulelnfo.StudentScheduleRequestAlternate
All K12.Schedulelnfo.MassSchedulelnfo.StudentScheduleRestrictions

All K12.Schedulelnfo.MassSchedulelnfo.StudentSchedule TeacherRestrictions
All K12.Schedulelnfo.MassSchedulelnfo.SchedSection

All K12.Schedulelnfo.MassSchedulelnfo.SchedSectionMetGrid

All K12.Schedulelnfo.MassSchedulelnfo.SchedStudentGrid

All K12.Schedulelnfo.MassSchedulelnfo.SchedAnalysisGrid

All K12.Schedulelnfo.MassSchedulelnfo.SchedSchedulesGrid
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PAD Location

Grid/Pop-Out
Screen

Security Node

Allexcept Students Al K12.Schedulelnfo.Section
Current Students
Students All
Student Enroliment K12.Schedulelnfo.ClassStudent
. All All
History
Meeting Days All All K12.Schedulelnfo.SchYrSecMetGrid
Additional Staff Additional Staff All K12.Schedulelnfo.SchoolYearSectionStaff
Historical Staff All K12.Schedulelnfo.SchoolYearSectionStaffHistory
Section Schedule Staff Histo : . P
Siony g:::c(f)rlcal gedions All K12.Schedulelnfo.SchoolYearSectionStaff
Synchronize Section
Meeting Day
N/A Periods All K12.Schedulelnfo.SynchronizeSectionMeetingDayPeriods
NOTE: Thisisa
Menu selection.
All except Linked All K12.Courselnfo.SchoolCourse
School Course Course N/A Courses
Linked Courses All K12.Courselnfo.SchoolCourselLinkedCourse
School Course Opt- - Course or N/A Al Al K12.Courselnfo.Setup.CourseOptinGrid
In Schedule
Section Options Meeting Days All K12.Schedulelnfo.SchoolYearMetDay
Allexcept Override K12.Schedulelnfo.Setup.SchoolYearOptSchedule
Course Request and Term Codes
Walk-In Options i
School Schedu"ng Mass Scheduling P gzzrerlsde Term All K12.Schedulelnfo.Setup.SchoolOverrideTerm
Options > Setup - =
erm Exclusion Al K12.Schedulelnfo.Exclusion
. Codes
House/Team/Exclusion House Codes All K12.ScheduleInfo.House
Team Codes All K12.Schedulelnfo.Team
Student Classes Schedule N/A All All K12.Schedulelnfo.StudentClassGrid
StudentClasses | g pqule N/A Al Al K12.Schedulelnfo.StudentClassDelete
Deleted
Update Schedule Mass Scheduling N/A All All N/A
Quick Placement All All K12.Schedulelnfo.MassSchedulelnfo.SchedManualGrid
WalkIn Schedul Mass Scheduling Request All All K12.Schedulelnfo.MassSchedulelnfo.WalkinCourseRequestGrid
alk In Schedule
or Schedule Analysis All All K12.Schedulelnfo.MassSchedulelnfo.WalkinSchedAnalysisGrid
Schedule All All K12.Schedulelnfo.MassSchedulelnfo.WalkinScheduleGrid
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PAD Location Grid/Pop-Out Security Node
Screen
Mass Scheduling Allexcept Course
) All K12. Info. Wheel
Wheel Definiion > Setup or N/A Grid Courselnfo.CourseVWhee
Schedule > Setup Course Grid All K12.Courseinfo.CourseWheelCourse
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